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1 信号発生器の概要

注意 MXGの損傷や性能低下を避けるために、 RF入力の逆パワー ・ レベルが最大33 dBm(2W)を超えないよ うに

して ください。 www.agilent.co.jpのTips for Preventing Signal Generator Damageも参照してください。

注記 N5161A/62A MXG ATEは、 フロン ト ・ パネル機能を備えていない （ディ スプレイ、 キーがない） 点を除いて、

N5181A/82A と同じです。 すべての機能は、 SCPIコマンドまたはWebイネーブルMXG経由で制御されます。 信

号発生器の機能については、 『ユーザーズ ・ ガイ ド』 を参照してください。 WebイネーブルMXGの詳細について

は、 『インス トール ・ ガイ ド』、 『プログラ ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照して ください。

MXG ATEブランク ・ フロン ト ・パネル ・モデルN5161AおよびN5162A信号発生器は、 MXG測定器ファ ミ リの一

部であ り、 特に記載のない限り、 MXGという表記はMXG ATE測定器を含みます。

オプシ ョ ンALB LXI–B機能の完全なインプ リ メンテーシ ョ ンは、 ファームウェアA.01.50以上の測定器でのみ使

用できます。 この機能を有効にするためにはA.01.50以上のファームウェア ・ バージ ョ ンのダウンロードには、

ラ イセンスが必要な場合があ り ます。 新しいファームウェア ・ リ リースについては、 http://www.agilent.co.jp/
find/upgradeassistantをご覧ください。

• 「信号発生器の特長」 （2ページ）

• 「動作モード」 （4ページ）

• 「フロン ト ・ パネルの概要 ： N5181A/82A MXG」 （5ページ）

• 「フロン ト ・ パネルの概要 ： N5161A/62A MXG ATE」 （9ページ）

• 「フロン ト ・ パネル ・ ディ スプレイ ： N5181A/82A/83A MXG」 （11ページ）

• 「ブランク ・ フロン ト ・ パネル ・ ディ スプレイ ： N5161A/62A MXG ATE」 （13ページ）

• 「 リ ア ・ パネルの概要 ： N5161A/62A1/81A/82A MXG」 （15ページ）
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 1



信号発生器の概要

信号発生器の特長
信号発生器の特長
• N5161A1 /N5181A、 RFアナログ ・ モデル ： 100 kHz～12、 3、 6 GHz （オプシ ョ ン5012、 503、 506）

N5162A1/N5182A、 RFアナログ ・ モデル ： 100 kHz～3、 6 GHz （オプシ ョ ン503、 506）

N5183A、 マイ ク ロ波アナログ ・ モデル ： 100 kHz～20、 31.8、 40 GHz （オプシ ョ ン520、 532、 540）

• 電子式アッテネータ （N5161A/62A/81A/82Aのみ）

• メカニカル ・ アッテネータ （N5183A＋オプシ ョ ン1E1のみ）

• 周波数、 パワーまたは周波数とパワーのステップ／リ ス ト掃引

• ベク トル ・ モデルはリ ス ト掃引の波形を内蔵可能

• パルス変調 （オプシ ョ ンUNU）

• 高速パルス変調 （オプシ ョ ンUNW）

• アナログ差動I/Q出力 （ベク トル ・ モデル、 オプシ ョ ン1EL）

• アナログ変調AM、 FM、 ΦM （オプシ ョ ンUNT）

• 最高125 Mサンプル/sの速度での任意I/Q波形の再生 （ベク トル ・ モデル、 オプシ ョ ン654）

• 自動レベル ・ コン ト ロール (ALC) ； パワー校正

• 帯域幅制御 （ALC）

• 大きい変調度の振幅変調による広いダイナミ ッ ク ・ レンジ

• 便利なアセンブリ交換

• 外部AM、 FM、 ΦM入力 （オプシ ョ ンUNT）

• 外部アナログI/Q入力 （ベク トル ・ モデル）

• 広帯域AM （ベク トル ・ モデル、 オプシ ョ ンUNT）

• 柔軟性の高い基準入力、 1～50 MHz （オプシ ョ ン1ER）

• GPIB、 USB 2.0、 100Base-T LANインタフェース

• 改善されたS/N比

• LO入出力 （オプシ ョ ン012）

• LXIのサポート （オプシ ョ ンALB）

• PXBとのデジタル ・ バス入出力互換性

• 手動パワー ・ サーチ （ALCオフ） （オプシ ョ ン099またはシ リ アル番号の先頭が4818以上の測定器）

• 複数の信号発生器を使用する際の複数のベースバンド ・ ジェネレータの同期 （マスタ／スレーブ ・ セッ ト アップ）

• 高速パルス変調 （オプシ ョ ンUNW）

1N5161A/62A ATE(Automated Test Equipment)は、 ブランク ・ フロン ト ・ パネルを装備しています （フロン ト ・ パネル ・ディ スプ

レイ、 ハードキー、 ソフ ト キーがあ り ません）。
2オプシ ョ ン501はN5161Aでは使用できません。
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 信号発生器の概要

信号発生器の特長
• 位相雑音干渉 （ベク トル ・ モデル、 オプシ ョ ン432）

• 内部チャネル補正 （ベク トル ・ モデル、 オプシ ョ ンU01）

• SCPI/IVI-COMド ラ イバ

• ユーザ ・ フラ ッ ト ネス補正

• ユーザ設定可能な最大パワー ・ リ ミ ッ ト

• 2チャネル ・ パワー ・ メータ表示

• 10 MHz基準発振器 （外部出力装備）

• 8648/ESGコード対応

• リ アルタイム変調フ ィルタ リ ング

• Signal Studioソフ ト ウェアをベク トル・モデルで使用するこ とで、802.11無線LAN、W-CDMA、cdma2000、1xEV-DO、

GSM、 EDGEなどを発生可能

ハード ウェア、 ファームウェア、 ソフ ト ウェア、 マニュアルの特長およびオプシ ョ ンの詳細については、 信号発生器に付

属のデータシート をご覧ください。 データシートはAgilent TechnologiesのWebサイ トから も入手できます。

1. 次のページを開きます ： http://www.agilent.co.jp/find/mxg

2. 目的のモデル番号を選択します。

3. オプシ ョ ン／価格表の価格表を選択します。
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 3



信号発生器の概要

動作モード
動作モード

Agilent MXG信号発生器には、モデルと インス トールされているオプシ ョ ンに応じて、最大4種類の基本的な動作モードが

あ り ます。 連続波(CW)モード、 掃引信号モード、 アナログ変調モード、 デジタル変調モードです。

連続波

このモードでは、 信号発生器は連続波信号を発生します。 信号発生器は単一の周波数およびパワー ・ レベルに設定されま

す。 N5161A/81AとN5162A/82Aはどちら もCW信号を発生できます。

掃引信号

このモードでは、 信号発生器はある範囲の周波数またはパワー ・ レベルで掃引を行います。 N5161A/81A と N5162A/82A
はどちら も リ ス ト掃引とステップ掃引の機能を備えています。

アナログ変調

このモードでは、 信号発生器はCW信号をアナログ信号で変調します。 使用可能なアナログ変調方式は、 インス トールさ

れたオプシ ョ ンによ り異な り ます。

オプシ ョ ンUNTでは、 AM、 FM、 ΦM変調が使用できます。 これらの変調の一部は組み合わせて使用できます。

注記 Mod On/OffハードキーとLED機能は、 オプシ ョ ンUNTがインス トールされたMXGでのみ有効です。

14. Mod On/OffとLEDを参照して ください。

オプシ ョ ンUNUおよびUNWは、 それぞれ標準パルス変調と高速パルス変調の機能を提供します。

デジタル変調 （N5162A/82A ＋ オプシ ョ ン651、 652、 654のみ）

注記 内蔵ベースバンド ・ ジェネレータの速度アップグレード ・ オプシ ョ ン670、 671、 672は、 オプシ ョ ンのアップグ

レードであ り、オプシ ョ ン651および652が工場でインス トールされている必要があ り ます（詳細についてはデー

タシート を参照）。 651、 652、 654に関する記述は、 すべて671、 672、 674も含みます。

このモードでは、 信号発生器はCW信号を任意I/Q波形で変調します。 I/Q変調は、 N5162A/82Aでのみ使用できます。 内蔵

ベースバンド ・ ジェネレータ （オプシ ョ ン651、 652、 654） によ り、 次のデジタル変調フォーマッ トが追加されます。

• カスタム任意波形発生器モードでは、 単一の変調搬送波または複数の変調搬送波を発生できます。 各変調搬送波波形

は、 出力する前に計算して作成しておく必要があ り ます。 この信号作成は、 内蔵ベースバンド ・ ジェネレータで行わ

れます。 作成された波形は、 保存して リ コールできます。 これによ り、 テス ト信号を繰り返し再生できます。 詳細に

ついては、 「任意波形発生器の使用」 （269ページ） を参照してください。

• マルチトーン ・ モードは、 最大64個の連続波信号 （ トーン） を発生します。 2 トーン ・ モード と同様に、 信号の周波数

間隔と振幅は調整可能です。詳細については、「カスタム・マルチトーン波形の作成」（295ページ）を参照して ください。
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 信号発生器の概要

フロン ト ・ パネルの概要 ： N5181A/82A MXG
• 2 トーン ・ モードは、 異なる2つの連続波信号 （ トーン） を発生します。 信号の周波数間隔と振幅は調整可能です。 詳

細については、 第12章 「マルチトーン/2 トーン波形 （オプシ ョ ン430）」 を参照して ください。

• デュアルARBモードは、 内蔵ベースバンド ・ ジェネレータのARBメモ リに書き込まれた波形セグメン トのシーケンス

を再生します。 これらの波形は、 カスタム任意波形発生器モードを使って内蔵ベースバンド ・ ジェネレータで作成す

るこ と も、 リモート ・ インタフェース経由でARBメモ リにダウンロードするこ と もできます。詳細については、 「デュ

アルARBプレーヤ」 （140ページ） を参照してください。

フロン ト ・ パネルの概要 ： N5181A/82A MXG

1. ホスト USB

このユニバーサル・ シ リ アル ・バス(USB)を使用して、データ転送用のUSBフラ ッシュ ・ ド ラ イブ(UFD)を接続します。信

号発生器をシャ ッ ト ・ ダウン／再起動しな くても、 USBデバイスを接続したり、 取り外した りできます。 測定器の裏面に

はデバイスUSBコネク タ （17ページを参照） もあるので、 このコネクタを使って リモート制御するこ と も可能です。

2. ディスプレイ

液晶表示(LCD)画面には、 現在の機能に関する情報が表示されます。 スタータス ・ インジケータ、 周波数、 振幅設定、 エ

ラー ・ メ ッセージなどの情報が表示されます。 ディ スプレイの右側には、 ソフ ト キーのラベルが表示されます。 「フロン

ト ・ パネル ・ ディ スプレイ ： N5181A/82A/83A MXG」 （11ページ） も参照してください。

3. ソフ トキー

ソフ ト キーは、 キーの左側に表示されている機能を実行します。

コネクタ タイプA

USBプロ ト コル 2.0

22. 電源スイッチとLED 

21. MoreとLED 

20. Return 

18. ノブ 

19. Incr Set 

15. Page Down 

16. I Input （ベク ト

ル ・ モデルのみ） 
17. Q Input （ベク ト

ル ・ モデルのみ） 

12. RF 
Output 

13. RF On/OffとLED 

14. Mod On/OffとLED 

7. メニュー 
および
10. Help 

11. Presetと
User Preset 

9. Local 
Cancel/(Esc) 

5. 矢印とSelect 

6. Page Up 

8. Trigger 

4. テンキー 3. ソフ トキー 2. ディスプレイ  1. ホストUSB 

MXGÉxÉNÉgÉãêMçÜî¦ê¹äÌ
N5181A 100 kHzÅ`6 GHz
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信号発生器の概要

フロン ト ・ パネルの概要 ： N5181A/82A MXG
4. テンキー

テンキーは、 0～9のハードキー、 小数点ハードキー、 マイナス記号ハードキー、 バッ クスペース ・ ハードキーから構成さ

れます。 「数およびテキス トの入力／編集」 （43ページ） を参照してください。

5. 矢印とSelect

Select と矢印ハードキーを使って、 信号発生器のディ スプレイ上に表示されている項目を選択して編集するこ とができま

す。 「数およびテキス トの入力／編集」 （43ページ） を参照して ください。

6. Page Up

テーブル ・ エディ タで、 前のページを表示するにはこのハードキーを使用します。 「例 ： テーブル ・ エディ タの使用法」

（44ページ） を参照してください。 テキス トが表示エリ アの1ページに収ま り きらない場合は、 このキーとPage Downキー

（7ページ） を併用してテキス ト をスク ロールします。

7. メニュー

これらのハードキーは、測定器の機能を設定したり、情報にアクセルするためのソフ ト キー・ メニューをオープンします。

8. Trigger

ト リ ガ ・ モードがTrigger Keyに設定されている場合にこのハードキーを押すと、 リ ス ト掃引やステップ掃引などの機能に

対して ト リガ ・ イベン トが即座に開始されます。

9. Local Cancel/(Esc)

このハードキーを押すと、 リモートオペレーシ ョ ンがオフにな り、信号発生器はフロン ト ・パネル制御に戻り ます。 また、

アクティブ機能の入力やIQ校正などの長い処理をキャンセルします。

25ページを参照

75ページを参照

70ページを参照

63ページを参照

45ページを参照

77ページを参照

129ページを参照

ベク トル ・ モデル

のみ有効。

45ページを参照

48ページを参照 42ページを参照

139ページを参照

将来のため

の予備。
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 信号発生器の概要

フロン ト ・ パネルの概要 ： N5181A/82A MXG
10. Help

ハードキーやソフ ト キーの説明を表示するには、 このキーを使用します。 「キーの説明の表示」 （42ページ） を参照してく

ださい。

11. PresetとUser Preset

これらのハードキーは、 信号発生器を既知の状態 （工場設定またはユーザ定義） に設定します。 「信号発生器のプ リセッ

ト 」 （42ページ） を参照して ください。

12. RF Output

13. RF On/OffとLED

このハードキーは、 RF OUTPUTコネク タのRF信号の動作状態を切り替えます。 RF出力をオンにする と、 RF On/Off LED
が点灯します。

14. Mod On/OffとLED

このハードキーは、 アクティブ変調方式による出力搬送波信号の変調のオン／オフを切り替えます。 このハードキーを使

用して、 フォーマッ ト を設定した り、 アクティブにするこ とはできません （「搬送波信号の変調」 （61ページ） を参照）。

出力変調をオンにする と、 MOD ON/OFF LEDが点灯します。

注記 Mod On/OffハードキーとLED機能は、 オプシ ョ ンUNTがインス トールされたMXGでのみ有効です。

15. Page Down

テーブル ・ エディ タで、 次のページを表示するにはこのハードキーを使用します。 「例 ： テーブル ・ エディ タの使用法」

（44ページ） を参照してください。 テキス トが表示エリアの1ページに収ま り きらない場合は、 このキーとPage Upキー （6
ページ） を併用してテキス ト をスク ロールします。

16. I Input （ベク トル ・ モデルのみ）

「I/Q変調」 （198ページ） も参照して ください。

コネクタ 標準 ：

オプシ ョ ン1EM ：

インピーダンス ：

N型 （メ ス）

リ ア ・ パネル、 N型 （メ ス）

50 Ω　

損傷レベル 50 Vdc、 2 Wの最大RFパワー

コネクタ タイプ ： BNC （メ ス） インピーダンス ： 50 Ω

信号 外部から供給されたI/Q変調のアナログ同相成分。

信号レベルは ＝0.5 Vrms （校正済み出力レベル）。

損傷レベル 1 Vrms
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信号発生器の概要

フロン ト ・ パネルの概要 ： N5181A/82A MXG
17. Q Input （ベク トル ・ モデルのみ）

「I/Q変調」 （198ページ） も参照して ください。

18. ノブ

ノブを回すこ とによ り、数値を増減したり、 リ ス トの次の桁、文字または項目を強調表示するこ とができます。 「フロン ト

パネルのノブの分解能」 （28ページ） も参照して ください。

19. Incr Set

このハードキーを使用して、 現在のアクティブ機能の増分値を設定するこ とができます。 増分値は、 ノブの現在の比率設

定に応じて、 ノブを回すたびにアクティブ機能の値がどれだけ変化するかにも影響します （「フロン トパネルのノブの分解

能」 （28ページ） を参照）。

20. Return

このハードキーを押すこ とによって、キーを押す前の状態に後戻りするこ とができます。複数の階層を持つメニューでは、

Returnキーを押すと前のメニュー ・ ページに戻り ます。

21. MoreとLED

メニューにソフ ト キー ・ ラベルをすべて表示できない場合は、 More LEDが点灯し、 ラベルの下にMoreメ ッセージが表示

されます。 次のラベル ・ グループを表示するには、 Moreハードキーを押します。

22. 電源スイッチとLED

このスイ ッチによって、 待機モードまたは電源投入モードを選択します。 待機位置にする と、 黄色のLEDが点灯し、 信号

発生器の機能はすべてオフになり ます。 信号発生器は電源に接続されたままなので、 一部の内部回路によって多少電力が

消費されます。 オン位置にする と、 緑色のLEDが点灯し、 信号発生器の機能がオンになり ます。

コネクタ タイプ ： BNC （メ ス） インピーダンス ： 50 Ω

信号 外部から供給されたI/Q変調のアナログ直交位相成分。

信号レベルは ＝0.5 Vrms （校正済み出力レベル）。

損傷レベル 1 Vrms
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 信号発生器の概要

フロン ト ・ パネルの概要 ： N5161A/62A MXG ATE
フロン ト ・ パネルの概要 ： N5161A/62A MXG ATE

N5161A/62A MXG ATEのフロン ト ・ パネル機能

MXG ATE と フロン ト ・ パネル ・ ディ スプレイを持つMXG との違いは、 フロン ト ・ パネル、 ハードキー、 ソフ ト キーの機

能が、 SCPIコマンドまたはWebイネーブルMXG経由でのみ使用できるこ とです。 WebイネーブルMXGの詳細については、

『インス トール ・ ガイ ド』、 『プログラ ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照してください。

MXG ATEに固有の機能 ：

• LAN LED （10ページ）

• 1588 LED （10ページ）

• ERROR LED （10ページ）

• LAN Resetハードキー （10ページ）

詳細については、 『サービス ・ ガイ ド』 を参照して ください。

1. ホスト USB

このユニバーサル・ シ リ アル ・バス(USB)を使用して、データ転送用のUSBフラ ッシュ ・ ド ラ イブ(UFD)を接続します。信

号発生器をシャ ッ ト ・ ダウン／再起動しな くても、 USBデバイスを接続したり、 取り外した りできます。 測定器の裏面に

はデバイスUSBコネク タ （17ページを参照） もあるので、 このコネクタを使って リモート制御するこ と も可能です。

コネクタ タイプA

USBプロ ト コル 2.0　

2. 電源スイッチとLED 3. LAN 

6. LAN Reset

4. 1588 

5. ERROR 

1. ホスト USB 
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信号発生器の概要

フロン ト ・ パネルの概要 ： N5161A/62A MXG ATE
2. 電源スイッチとLED

このスイ ッチによって、 待機モードまたは電源投入モードを選択します。 待機位置にする と、 黄色のLEDが点灯し、 信号

発生器の機能はすべてオフになり ます。 信号発生器は電源に接続されたままなので、 一部の内部回路によって多少電力が

消費されます。 オン位置にする と、 緑色のLEDが点灯し、 信号発生器の機能はすべてオンになり ます。

3. LAN LED

LAN LEDはLANのステータスを示します。

• LEDがオフの場合、 LANは動作していません。

• LEDが点滅している場合、 LANは設定中です （デューティ ・ サイ クル1.2秒）。

• デューティ ・ サイ クルが400 msの場合、 測定器がLAN識別モードに入ったこ とを示します （:INPut:LAN[:SET]:
IDENtifierコマンドを参照）。

• LEDが常時点灯している場合、 LANは動作しています。

• LEDに異常がある場合は、 『サービス ・ ガイ ド』 を参照してください。

4. 1588 LED

1588 LEDは、 測定器が外部1588ク ロ ッ クにロ ッ ク されているこ とを示します。

• 緑の1588 LEDがオンの場合、 リ ア ・ パネルのTRIG OUT BNCで1588信号が検出されています。

• 緑の1588 LEDがオフの場合、 リ ア ・ パネルのTRIG OUT BNCで1588信号が検出されていません。

• LEDに異常がある場合は、 『サービス ・ ガイ ド』 を参照してください。

5. ERROR LED

ERROR LEDは、 エラー待ち行列に読み取られていないエラーがあるこ とを示します。

• 自動リブートがオフの場合、 電源投入時に例外が発生する と、 LEDは点滅します。

• LEDに異常がある場合は、 『サービス ・ ガイ ド』 を参照してください。

6. LAN Resetハードキー

注記 このハードキーは、 フェール ・ セーフおよび診断モードで有効になる もので、 通常はほとんど使用しません。

LAN Resetハードキーを押した後で測定器の電源を入れ直すと、 リブート後にWebサーバが有効になり ます。

LAN Resetは、 電源投入時に診断モードにアクセスするために使用します。

• 相当する リモート ・ コマンドについては、 『SCPI Command Reference』 を参照してください。

• LAN Resetに異常がある場合は、 『サービス ・ ガイ ド』 を参照してください。
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 信号発生器の概要

フロン ト ・ パネル ・ ディスプレイ ： N5181A/82A/83A MXG
フロン ト ・ パネル ・ ディスプレイ ： N5181A/82A/83A MXG 

1. アクテ ィブ機能エリア

このエ リ アには、 現在アクティブ状態にある機能が表示されます。 例えば、 周波数がアクティブ機能の場合、 現在の周波

数設定が表示されます。 現在のアクティブ機能に対応する増分値がある場合は、 その値も表示されます。

2. 周波数エリア

このエ リ アには、 現在の周波数設定が表示されます。

3. インジケータ

インジケータは、信号発生器の一部の機能の状態とエラー状態を示します。1つのインジケータの位置が複数のインジケー

タによって用いられる場合もあ り ます。 この場合、 同じインジケータ位置を使用する機能が同時にアクティブになるこ と

はあ り ません。

インジケータ ど ういった場合に表示されるか

ΦM　 位相変調がオンの場合。 周波数変調をオンにした場合、 ΦMに代わってFMインジケータが表示されます。

ARB　 ARB発生器がオンの場合。 ARBが動作中で、 ト リガ待ち中ではあ り ません。

ALC OFF　 ALC回路がオフの場合。 ALCがオンで、 出力レベルを維持できない場合は、 UNLEVELインジケータが同じ位置に表示されます。

AM　 振幅変調がオンの場合。

ARMED　 掃引が開始され、 信号発生器が掃引ト リガ ・ イベン ト を待っている場合。

ATTNHOLD　 アッテネータ ・ ホールド機能がオンの場合。 この機能がオンになっている と、 アッテネータの現在の設定が維持されます。

AWGN　 リ アルタイムI/Qベースバンド相加性白色ガウス雑音がオンの場合。

5. エラー ・ メ ッセージ ・ エリア 6. テキスト ・ エリア 7. ソフ トキー ・ ラベル ・ エリア 

4. 振幅エリア 3. インジケータ  2. 周波数エリア 1. アクテ ィブ機能エリア 

スクロール ・バー

テキス トが一画面に

収まり きらない場合

は、スクロール・バー

がここに表示されま

す。 Page Upキーと

Page Downキーを使

用して、 テキス ト を

スクロールします。
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信号発生器の概要

フロン ト ・ パネル ・ ディスプレイ ： N5181A/82A/83A MXG
4. 振幅エリア

このエ リ アには、 現在の出力パワー ・ レベル設定が表示されます （RF出力がオフの場合、 このエリ アはグレー表示になり

ます）。

BBG DAC　 DACのオーバーフローが発生している場合。 BBG DACインジケータがオフになるまで、 ランタイム ・ スケーリ ング調整を実行してくださ

い。 同じ位置に表示されるUNLOCKインジケータは、 BBG DACインジケータよ り も優先します （下のUNLOCKを参照）。

CHANCORR　 内部チャネル補正がオンになっている場合。

DETHTR　 ALCディテクタのヒータの温度が規定温度に達していない場合。ALC仕様を満たすには、 ヒータの温度が規定温度である必要があ り ます。

DIGBUS デジタル ・ バスが使用されている場合。

DIGMOD カスタム任意波形発生器がオンの場合。

ERR エラー ・ メ ッセージがエラー待ち行列に置かれている場合。 このインジケータは、 エラー ・ メ ッセージをすべて表示するか、 エラー待ち

行列をク リ アするまでオフになり ません （「エラー ・ メ ッセージの読込み」 （75ページ） を参照）。

EXTREF 外部周波数基準が適用されている場合。

FM 周波数変調がオンの場合。 位相変調をオンにした場合、 FMに代わってΦMインジケータが表示されます。

I/Q I/Qベク トル変調がオンの場合。

L 信号発生器がリ スナ・モードにあ り、GPIB、USBまたはVXI-11/ソケッ ト (LAN)インタフェース経由で情報やコマンドを受信している場合。

MTONE マルチトーン波形発生器がオンになっている場合。

MULT 周波数乗数が設定されている場合 （「周波数乗数の設定」 （117ページ） を参照）。

OFFS 出力オフセッ トが設定されている場合 （「出力オフセッ トの設定」 （115ページ） を参照）。

PN 位相雑音干渉がオンになっている場合。

PULSE パルス変調がオンの場合。

R 信号発生器がGPIB、USBまたはVXI-11/ソケッ ト (LAN)インタフェース経由でリモート制御されている場合。信号発生器がリモート ・モー

ドの場合、 キーパッ ドはロ ッ ク されます。 キーパッ ドをロ ッ ク解除するには、 ローカルを押します。

REF 出力基準が設定されている場合 （「出力基準の設定」 （116ページ） を参照）。

RF OFF 信号発生器のRF出力がオンになっていない場合。

S 信号発生器がGPIB、 USBまたはVXI-11/ソケッ ト (LAN)インタフェース経由でサービス ・ リ クエス ト (SRQ)を出した場合。

SWEEP 信号発生器が現在、 リ ス ト ・ モードまたはステップ ・ モードで掃引を行っている場合。

SWMAN 信号発生器が手動掃引モードにある場合。

T 信号発生器がトーカ ・ モードにあ り、 GPIB、 USBまたはVXI-11/ソケッ ト (LAN)インタフェース経由で情報を送信している場合。

TTONE 2 トーン波形発生器がオンになっている場合。

UNLEVEL 信号発生器が適切な出力レベルを維持できない場合。 このインジケータが表示されても、 測定器に異常がある とは限り ません。 正常に動

作している場合でも発生する可能性があ り ます。 ALC回路がオフの場合は、 同じ位置にALC OFFとい う別のインジケータが表示されます

（上のALC OFFを参照）。

UNLOCK いずれかのフェーズ ・ ロ ッ ク ・ ループがフェーズ ・ ロ ッ クを維持できない場合。 どのループがロッ クできないかは、 エラー ・ メ ッセージ

を見ればわかり ます （「エラー ・ メ ッセージの読込み」 （75ページ） を参照）。

WATRG 現在の変調モードが任意波形ト リガを待っている場合。

WINIT 信号発生器がシングル掃引が開始されるのを待っている場合。

インジケータ ど ういった場合に表示されるか
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 信号発生器の概要

ブランク ・ フロン ト ・ パネル ・ ディスプレイ ： N5161A/62A MXG ATE
5. エラー ・ メ ッセージ ・ エリア

このエ リ アには、 省略されたエラー ・ メ ッセージが表示されます。 複数のメ ッセージが発生した場合は、 最新のメ ッセー

ジだけが表示されます。 「エラー ・ メ ッセージの読込み」 （75ページ） を参照してください。

6. テキスト ・ エリア

このエ リ アには、 信号発生器のステータス情報 （変調ステータスなど） やその他の情報 （掃引リ ス トやファ イル ・ カタロ

グなど） が表示されます。 このエリ アを使って、 情報の管理 （情報の入力、 ファ イルの表示／削除など） などの機能を実

行するこ と もできます。

7. ソフ トキー ・ ラベル ・ エリア

このエ リ アには、ディ スプレイの右隣にあるソフ ト キーの機能を定義するラベルが表示されます。 ソフ ト キー・ ラベルは、

選択された機能に応じて変化します。

ブランク ・ フロン ト ・ パネル ・ ディスプレイ ： N5161A/62A MXG ATE

N5161A/62A MXG ATE ： Webイネーブル ・ ディスプレイ

MXG ATEのディ スプレイ情報は、 WebサーバへのLAN接続経由でのみ利用できます （ 「11. LAN」 （17ページ） ） 。 Webイ

ネーブルMXGの詳細については、 『プログラ ミ ング ・ ガイ ド』 を参照してください。

インジケータ

注記 N5161A/62Aでは、次のリ ス ト中のインジケータはWebイネーブルMXGでのみ表示されます。『プログラ ミ ング・

ガイ ド』 の 「Using the Web Browser」 を参照してください。

インジケータは、 信号発生器の一部の機能の状態とエラー状態を示します。 1つのインジケータ位置が複数のインジケー

タによって用いられる場合もあ り ます。 この場合、 同じインジケータ位置を使用する機能が同時にアクティブになるこ と

はあ り ません。

インジケータ ど ういった場合に表示されるか

ΦM　 位相変調がオンの場合。 周波数変調をオンにした場合、 ΦMに代わってFMインジケータが表示されます。

ARB　 ARB発生器がオンの場合。 ARBが動作中で、 ト リガ待ち中ではあ り ません。

ALC OFF　 ALC回路がオフの場合。 ALCがオンで、 出力レベルを維持できない場合は、 UNLEVELインジケータが同じ位置に表示されます。

AM　 振幅変調がオンの場合。

ARMED　 掃引が開始され、 信号発生器が掃引ト リガ ・ イベン ト を待っている場合。

ATTNHOLD　 アッテネータ ・ ホールド機能がオンの場合。 この機能がオンになっている と、 アッテネータの現在の設定が維持されます。

BBG DAC　 DACのオーバーフローが発生している場合。 BBG DACインジケータがオフになるまで、 ランタイム ・ スケーリ ング調整を実行してくださ

い。 同じ位置に表示されるUNLOCKインジケータは、 BBG DACインジケータよ り も優先します （下のUNLOCKを参照）。

DETHTR　 ALCディテクタのヒータの温度が規定温度に達していない場合。ALC仕様を満たすには、 ヒータの温度が規定温度である必要があ り ます。

AWGN　 リ アルタイムI/Qベースバンド相加性白色ガウス雑音がオンの場合。
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信号発生器の概要

ブランク ・ フロン ト ・ パネル ・ ディスプレイ ： N5161A/62A MXG ATE
DIGBUS　 デジタル ・ バスが使用されている場合。

DIGMOD　 カスタム任意波形発生器がオンの場合。

ERR エラー ・ メ ッセージがエラー待ち行列に置かれている場合。 このインジケータは、 エラー ・ メ ッセージをすべて表示するか、 エラー待ち

行列をク リ アするまでオフになり ません （「エラー ・ メ ッセージの読込み」 （75ページ） を参照）。

EXTREF 外部周波数基準が適用されている場合。

FM 周波数変調がオンの場合。 位相変調をオンにした場合、 FMに代わってΦMインジケータが表示されます。

I/Q I/Qベク トル変調がオンの場合。

L 信号発生器がリ スナ・モードにあ り、GPIB、USBまたはVXI-11/ソケッ ト (LAN)インタフェース経由で情報やコマンドを受信している場合。

MTONE マルチトーン波形発生器がオンになっている場合。

MULT 周波数乗数が設定されている場合 （「周波数乗数の設定」 （117ページ） を参照）。

OFFS 出力オフセッ トが設定されている場合 （「出力オフセッ トの設定」 （115ページ） を参照）。

PN 位相雑音干渉がオンになっている場合。

PULSE パルス変調がオンの場合。

R 信号発生器がGPIB、USBまたはVXI-11/ソケッ ト (LAN)インタフェース経由でリモート制御されている場合。信号発生器がリモート ・モー

ドの場合、 キーパッ ドはロ ッ ク されます。 キーパッ ドをロ ッ ク解除するには、 ローカルを押します。

REF 出力基準が設定されている場合 （「出力基準の設定」 （116ページ） を参照）。

RF OFF 信号発生器のRF出力がオンになっていない場合。

S 信号発生器がGPIB、 USBまたはVXI-11/ソケッ ト (LAN)インタフェース経由でサービス ・ リ クエス ト (SRQ)を出した場合。

SWEEP 信号発生器が現在、 リ ス ト ・ モードまたはステップ ・ モードで掃引を行っている場合。

SWMAN 信号発生器が手動掃引モードにある場合。

T 信号発生器がトーカ ・ モードにあ り、 GPIB、 USBまたはVXI-11/ソケッ ト (LAN)インタフェース経由で情報を送信している場合。

TTONE 2 トーン波形発生器がオンになっている場合。

UNLEVEL 信号発生器が適切な出力レベルを維持できない場合。 このインジケータが表示されても、 測定器に異常がある とは限り ません。 正常に動

作している場合でも発生する可能性があ り ます。 ALC回路がオフの場合は、 同じ位置にALC OFFとい う別のインジケータが表示されます

（上のALC OFFを参照）。

UNLOCK いずれかのフェーズ ・ ロ ッ ク ・ ループがフェーズ ・ ロ ッ クを維持できない場合。 どのループがロッ クできないかは、 エラー ・ メ ッセージ

を見ればわかり ます （「エラー ・ メ ッセージの読込み」 （75ページ） を参照）。

WATRG 現在の変調モードが任意波形ト リガを待っている場合。

WINIT 信号発生器がシングル掃引が開始されるのを待っている場合。

インジケータ ど ういった場合に表示されるか
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 信号発生器の概要

リア ・ パネルの概要 ： N5161A/62A1/81A/82A MXG
リア ・ パネルの概要 ： N5161A1 /62A1/81A/82A MXG

1. AC電源コンセン ト

AC電源コード ・ コンセン トには、 信号発生器に付属の3極AC電源コードを接続します。 電源設定要件および電源コードの

詳細については、 『インス トール ・ ガイ ド』 を参照してください。

注意 不揮発性メモ リに永久的に保存されていないデータ、 GPIB設定、 または現在のユーザ機器ステートが失わ

れるのを防ぐために、 MXGの電源をオフにする場合は、 必ずMXGのフロン ト ・パネルの電源ボタンまたは

適切なSCPIコマンドを使用してください。 ラ ッ ク ・システムにインス トールされているMXGが、 MXGのフ

ロン ト ・ パネル ・ スイ ッチでな くシステム ・ ラ ッ クの電源スイ ッチによって電源をオフにされた場合は、

MXGの電源が適切にオフにされなかったためにError -310が表示されます。

2. SWEEP OUT

1N5161AおよびN5162Aは、 常にオプシ ョ ン1EM付きです。

コネクタ BNC （メ ス）

2 kΩの負荷をド ライブ可能

インピーダンス<1Ω

信号 電圧レンジ ： 掃引幅に関係なく 0～＋10 V

掃引モード ： 掃引の開始＝0 V、 掃引の終了＝＋10 V

CWモード ：出力なし

これは多目的コネクタです。 信号ルーティングの選択については、 49ページと129ページを参照してください。

2. SWEEP OUT 

3. AM 

4. FM 

5. PULSE 

6. TRIG IN 

7. TRIG OUT 

8. REF IN 

10. GPIB 

11. LAN 

12. デバイスUSB 

9. 10 MHz OUT 

1. AC電源コンセン ト  

オプシ ョ ン

１ EMのみ

次を参照 ：

7ページ

「デジタル変調コネクタ （ベク トル ・ モデルのみ）」 （18ページ）
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信号発生器の概要

リア ・ パネルの概要 ： N5161A/62A1/81A/82A MXG
3. AM

4. FM

5. PULSE

6. TRIG IN

7. TRIG OUT

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 指定の変調度を実現する外部からの±1 Vp信号。

損傷レベル 5 Vrmsおよび10 Vp

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 指定の偏移を行うための外部からの±1 Vp信号。

損傷レベル 5 Vrmsおよび10 Vp

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 外部供給 ： ＋1 V＝オン、 0 V＝オフ

損傷レベル 5 Vrmsおよび10 Vp

コネクタ BNC （メ ス） 高インピーダンス

信号 手動掃引モードのポイン ト ツーポイン トや外部掃引モードのLF掃引などの ト リ ガ動作用の外部からのTTLまたは

CMOS信号。

立ち上がりエッジまたは立ち下がりエッジで ト リガするこ とができます。

損傷レベル ≦–0.5 Vおよび≧＋5.5 V

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 待ちシーケンスの開始時、 または手動掃引モードでポイン ト ・ ト リ ガを待っている と きにハイになるTTL信号。

待ちシーケンスが終了するか、 ポイン ト ・ ト リ ガが受信される と、 ローにな り ます。

ロジッ ク極性は反転できます。

これは多目的コネク タです。 信号ルーティングの選択については、 49ページと129ページを参照してください。
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 信号発生器の概要

リア ・ パネルの概要 ： N5161A/62A1/81A/82A MXG
8. REF IN

工場設定モードでは、 信号発生器はこのコネクタの有効基準信号を検出して、 内部基準動作から外部基準動作に自動的に

切り替わり ます。 「信号発生器のプリセッ ト 」 （42ページ） を参照して ください。 オプシ ョ ン1ER （フレキシブル基準入力）

を使用する場合は、使用したい外部基準周波数を信号発生器に明示的に知らせる必要があ り ます。 フロン ト ・パネルから、

またはリモート ・ インタフェース経由で情報を入力します。

9. 10 MHz OUT

10. GPIB

このコネクタは、 外部コン ト ローラなどの互換デバイス との通信を可能にするもので、 信号発生器のリモート制御に使用

可能な3つのコネクタの うちの1つです。 （11. LANおよび12. デバイスUSBも参照して ください）。

11. LAN

信号発生器はこのコネクタを経由したローカル ・ エ リ ア ・ ネッ ト ワーク (LAN)ベースの通信に対応しているので、 LANに

接続しているコンピュータによって リモートからプログラムできます。 LANインタフェースは、 auto−MDIXをサポート し

ます。 信号発生器は1本のケーブルで最大100 mに制限されています(100Base-T)。 LANの詳細については、 『プログラ ミ ン

グ ・ ガイ ド』 を参照してください。

12. デバイスUSB

このユニバーサル ・ シ リ アル ・ バス(USB)コネク タを使用してPCを接続して、 信号発生器を リモート制御します。

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 ±1 ppm以内の外部タイムベース基準からの–3.5～＋20 dBmの信号。

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 ＞4 dBmの公称信号レベル。

コネクタ Mini–B

USBプロ ト コル バージ ョ ン2.0
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信号発生器の概要

リア ・ パネルの概要 ： N5161A/62A1/81A/82A MXG
デジタル変調コネクタ （ベク トル ・ モデルのみ）

I OUT、 Q OUT、  OUT、  OUT

EXT CLK

コネクタ タイプ ： BNC （メ ス） インピーダンス ： 50 Ω

DC結合

信号

I OUT 内蔵ベースバンド ・ ジェネレータからのI/Q変調のアナログ同相成分。

Q OUT 内蔵ベースバンド ・ ジェネレータからのI/Q変調のアナログ直交位相成分。

 OUT I OUTコネク タ との併用によ り、 平衡a ベースバンド信号を供給します。

a平衡信号は、 2本の導線に存在する、 グランドに対して対称で、 極性が逆 （位相が180 °異なる） の信号です。

 OUT Q OUTコネクタ との併用によ り、 平衡aベースバンド信号を供給します。

損傷レベル > 1 Vrms DC原点オフセッ ト 代表値<10 mV

出力信号レベル （50 Ω負荷終端）

• 0.5 Vpk （代表値）、 I/Qベク トルの1単位長に相当

• 0.69 Vpk (2.84 dB) （代表値）、 π/4 DQPSKのピークに対応する最大クレス ト ・ ファ ク タ、 α ＝ 0.5

• 0.71 Vpk (3.08 dB) （代表値）、 π/4 DQPSKのピークに対応する最大クレス ト ・ ファ ク タ、 α ＝ 0.35

• 代表値1 Vp-p （最大）

コネク タ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 立ち上がりエッジが開始データ ・ ビッ ト と一致する外部からのTTLまたはCMOSビッ ト ・ ク ロ ッ ク信号。

立ち下がりエッジを使って外部信号の同期がと られます。

この信号は、 デジタル変調アプリ ケーシ ョ ンに用いられます。

損傷レベル < –4および>＋8 V 最高クロ ッ ク速度50 MHz

I Q

I
Q
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 信号発生器の概要

リア ・ パネルの概要 ： N5161A/62A1/81A/82A MXG
EVENT 1

PAT TRIG

DIGITAL BUS I/O

Agilent Technologiesの信号作成ソフ ト ウェアによって使用されるバス。 このコネクタは一般用ではあ り ません。信号作成

ソフ ト ウェア・オプシ ョ ンがインス トールされている場合にのみ信号が存在します （詳細については、http://www.agilent.
co.jp/find/signalcreationをご覧ください）。

注記 MXGのDigital BUS I/Oコネク タは、 Agilent Technologies N5106A PXB MIMOレシーバ ・ テスタ と組み合わせて

動作させる場合に使用します。

コネクタ BNC （メ ス） インピーダンス ： 50 Ω （公称値）

信号 データ ・ パターン、 フレーム、 タイムスロ ッ トの開始を ト リ ガするのに用いるこ とができるパルス。

±1タイムスロ ッ ト まで調整可能。 分解能＝1ビッ ト

マーカ

各任意波形ポイン トは、 対応するマーカ ・ オン／オフ条件を持っています。

マーカ1レベル＝＋3.3 V CMOSハイ （正の極性を選択した場合）、 –3.3 V CMOSロー （負の極性を選択した場合）。

任意波形のマーカ1がオンになる と、このコネクタで出力が発生します（「波形マーカの使用」（155ページ）を参照）。

損傷レベル < –4および>＋8 V

コネクタ BNC （メ ス） インピーダンス ： 50 Ω （公称値）

信号 TTL/CMOSロー－TTL/CMOSハイまたはTTL/CMOSハイ－TTL/CMOSロー ・ エッジでの ト リガ。

このコネクタへの入力によ り、 内蔵のデジタル変調パターン ・ ジェネレータは、 シングル ・パターン出力を開始し

た り、 連続的に出力されているパターンを停止して再同期させたり します。 ト リガとデータ ・ ビッ ト ・ ク ロ ッ クを

同期させるために、 ト リ ガ ・ エッジがラ ッチされ、 内部データ ・ ビッ ト ・ ク ロ ッ クの立ち下がりエッジの間にサン

プ リ ングされます。

これは全ARB波形発生器ト リガの外部ト リガです。

最小ト リガ入力パルス幅 （ハイまたはロー） ＝100 ns

最小ト リガ遅延 （ ト リ ガ ・ エッジからフレームの第1ビッ ト ） ＝1.5～2.5ビッ ト ・ ク ロ ッ ク周期

損傷レベル < –4および>＋8 V
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信号発生器の概要

リア ・ パネルの概要 ： N5161A/62A1/81A/82A MXG
AUX I/O

リア ・ パネルの50ピン ・ コネクタ （メス） を正面から見た図

25 1

2650

ピン1＝イベン ト 1
ピン2＝イベン ト 2
ピン3＝イベン ト 3
ピン4＝イベン ト 4
ピン5＝サンプリング ・ レート ・ クロック出力

ピン6＝パターン ・ ト リガ2

ピン7～25＝予約*

ピン26～50＝グランド

*将来の機能

イベン ト 1、 2、 3、 4 （ピン1 –4)
データ ・ パターン、 フレーム、 タイムスロ ッ トの開始を ト リガするのに用いるこ とができるパルス。

±1タイムスロ ッ ト まで調整可能。 分解能＝1ビッ ト

マーカ

各任意波形ポイン トは、 対応するマーカ ・ オン／オフ条件を持っています。

マーカ ・ レベル＝＋3.3 V CMOSハイ （正の極性を選択した場合）、 –3.3 V CMOSロー （負の極性を選択した場合）。

パターン ・ ト リガ2 （ピン6）
TTL/CMOSロー－TTL/CMOSハイまたはTTL/CMOSハイ－TTL/CMOSロー ・ エッジでのト リガ。

このコネクタへの入力により、 内蔵のデジタル変調パターン ・ ジェネレータは、 シングル•パターン出力を開始したり、 連続的に出力されているパターンを停止

して再同期させたり します。

ト リガとデータ ・ ビッ ト ・ クロッ クを同期させるために、 ト リガ ・ エッジがラッチされ、 内部データ ・ ビッ ト ・ クロッ クの立ち下がりエッジの間にサンプリン

グされます。

これは全ARB波形発生器ト リガの外部ト リガです。 最小パルス幅＝100ns。 損傷レベル ： < –0.5 V および > ＋5.5 V

サンプリング ・ レート ・ クロッ ク出力 （ピン5）
この信号は、 内蔵ベースバンド ・ ジェネレータで用いられます。 このピンを経由して、 シリアル ・ データを同期させるためのCMOSビッ ト ・ クロッ ク信号が送ら

れます。

損傷レベル ： < –0.5 V および >＋5.5 V

AUX I/Oコネクタは、 シールド付きの.050シリーズ ・ ボード ・ マウン ト ・ コネクタです。
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 信号発生器の概要

リア ・パネルの概要 ： N5183A MXG
リア ・ パネルの概要 ： N5183A MXG

1. AC電源コンセン ト

AC電源コード ・ コンセン トには、 信号発生器に付属の3極AC電源コードを接続します。 電源設定要件および電源コードの

詳細については、 『インス トール ・ ガイ ド』 を参照してください。

注意 不揮発性メモ リに永久的に保存されていないデータ、 GPIB設定、 または現在のユーザ機器ステートが失わ

れるのを防ぐために、 MXGの電源をオフにする場合は、 必ずMXGのフロン ト ・パネルの電源ボタンまたは

適切なSCPIコマンドを使用してください。 ラ ッ ク ・システムにインス トールされているMXGが、 MXGのフ

ロン ト ・ パネル ・ スイ ッチでな くシステム ・ ラ ッ クの電源スイ ッチによって電源をオフにされた場合は、

MXGの電源が適切にオフにされなかったためにError -310が表示されます。

2. SWEEP OUT

コネクタ BNC （メ ス）

2 kΩの負荷をド ライブ可能

インピーダンス<1 Ω

信号 電圧レンジ ： 掃引幅に関係なく 0～＋10 V

掃引モード ： 掃引の開始＝0 V、 掃引の終了＝＋10 V

CWモード ：出力なし

これは多目的コネクタです。 信号ルーティングの選択については、 49ページと129ページを参照してください。

2. SWEEP OUT 

3. AM 

4. FM 

5. PULSE 

6. TRIG IN 

7. TRIG OUT 

8. REF IN 

10. GPIB 

11. LAN 

12. デバイスUSB 

9. 10 MHz OUT 

1. AC電源コンセン ト  

オプシ ョ ン

1EMのみ

次を参照 ：

7ページ

14. ALC INPUT 

13. Z AXIS OUTPUT 
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信号発生器の概要

リア ・ パネルの概要 ： N5183A MXG
3. AM

4. FM

5. PULSE

6. TRIG IN

7. TRIG OUT

8. REF IN

工場設定モードでは、 信号発生器はこのコネクタの有効基準信号を検出して、 内部基準動作から外部基準動作に自動的に

切り替わり ます。 「信号発生器のプリセッ ト 」 （42ページ） を参照して ください。 オプシ ョ ン1ER （フレキシブル基準入力）

を使用する場合は、使用したい外部基準周波数を信号発生器に明示的に知らせる必要があ り ます。 フロン ト ・パネルから、

またはリモート ・ インタフェース経由で情報を入力します。

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 指定の変調度を実現する外部からの±1 Vp信号。

損傷レベル 5 Vrmsおよび10 Vp

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 指定の偏移を行うための外部からの±1 Vp信号。

損傷レベル 5 Vrmsおよび10 Vp

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 外部供給 ： ±1 V＝オン、 0 V＝オフ

損傷レベル 5 Vrmsおよび10 Vp

コネクタ BNC （メ ス） 高インピーダンス

信号 手動掃引モードのポイン ト ツーポイン トや外部掃引モードのLF掃引などの ト リ ガ動作用の外部からのTTLまたは

CMOS信号。

立ち上がりエッジまたは立ち下がりエッジで ト リガするこ とができます。

損傷レベル ≦–0.5 Vおよび≧＋5.5 V

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 待ちシーケンスの開始時、 または手動掃引モードでポイン ト ・ ト リ ガを待っている と きにハイになるTTL信号。

待ちシーケンスが終了するか、 ポイン ト ・ ト リ ガが受信される と、 ローにな り ます。

ロジッ ク極性は反転できます。

これは多目的コネクタです。 信号ルーティングの選択については、 49ページと129ページを参照してください。

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 ±1 ppm以内の外部タイムベース基準からの–3.5～＋20 dBmの信号。
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 信号発生器の概要

リア ・パネルの概要 ： N5183A MXG
9. 10 MHz OUT

10. GPIB

このコネクタは、 外部コン ト ローラなどの互換デバイス との通信を可能にするもので、 信号発生器のリモート制御に使用

可能な3つのコネクタの うちの1つです （11. LANおよび12. デバイスUSBも参照してください）。

11. LAN

信号発生器はこのコネクタを経由したローカル ・ エ リ ア ・ ネッ ト ワーク (LAN)ベースの通信に対応しているので、 LANに

接続しているコンピュータによって リモートからプログラムできます。 LANインタフェースはLXIをサポート しています

が、 auto−MDIXには対応していません。 信号発生器は1本のケーブルで最大100 mに制限されています(100Base-T)。 LAN
の詳細については、 『プログラ ミ ング ・ ガイ ド』 を参照して ください。

12. デバイスUSB

このユニバーサル ・ シ リ アル ・ バス(USB)コネク タを使用してPCを接続して、 信号発生器を リモート制御します。

13. Z AXIS OUTPUT

このBNC （メ ス） コネク タは、 ステップ／リ ス ト掃引の再ト レースおよびバンド切り替えインターバルの間に、＋5 V （公

称値） のレベルを供給します。 ステップ／リ ス ト掃引中に、 このBNC （メ ス） コネクタは、 RF周波数がマーカ周波数に一

致し、 輝度マーカ ・ モードがオンになっている と きに、 –5 V （公称値） レベルを供給します。 この信号はオペアンプ出力

から導かれるため、 負荷インピーダンスは5 kΩ以上である必要があ り ます。

コネクタ BNC （メ ス） インピーダンスは50 Ω （公称値）

信号 ＞4 dBmの公称信号レベル。

コネクタ MiniB

USBプロ ト コル バージ ョ ン2.0
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信号発生器の概要

リア ・ パネルの概要 ： N5183A MXG
14. ALC INPUT

この入力コネクタは、 外部ネガティブ ・ ディテク タによるレベリ ングに使用します。

コネクタ BNC （メ ス） インピーダンスは公称値100 kΩ

信号 –0.2 mV～–0.5 V

損傷レベル –12～1 V
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2 プリファレンスの設定とオプシ ョ ンの有効化

注記 N5161A/62A MXG ATEでは、 本書に記述されているソフ ト キー ・ メニューと機能は、 WebイネーブルMXGまた

はSCPIコマンド経由でのみ使用できます。 WebイネーブルMXGの詳細については、 『インス トール ・ ガイ ド』 、

『プログラ ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照してください。

Utility メニューからは、 ユーザ操作／リモート操作用のプリ ファレンスや測定器オプシ ョ ンを有効化するためのメニュー

にアクセスできます。

「ディスプレイの設定」 （26ページ）

「フロン トパネルのノブの分解能」 （28ページ）

「電源投入とプリセッ ト」 （27ページ）

「オプシ ョ ンの有効化」 （37ページ）

「GPIBアドレスと リモート言語」 （30ページ）

「LANインタフェースの設定」 （31ページ）

「LANサービスの有効化 ： ブラウザ、 ソケッ ト、 VXI–11、 LXI–B」 （32ページ）

「リモート言語の設定」 （33ページ）

ユーザ ・ プリファレンス

リモート操作用プリファレンス

「時間／日付の設定」 （28ページ）

「フ ァームウェアのアップグレード」 （29ページ）

「LXI入門」 （124ページ）

「ハードウェア ・ アセンブリのインストールおよび取り外し用ソフ トキー」 （39ページ）

「基準発振器のチューニング」 （29ページ）
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プリファレンスの設定とオプシ ョ ンの有効化

ユーザ ・ プリファレンス
ユーザ ・ プリファレンス

Utilityメニューから、 以下のユーザ ・ プ リ ファレンスを設定できます。

• 下の 「ディ スプレイの設定」

• 「電源投入とプ リセッ ト 」 （27ページ）

• 「フロン トパネルのノブの分解能」 （28ページ）

ディスプレイの設定

注記 明度と コン ト ラス ト を最小値に設定する と、暗すぎてソフ ト キーが見えない場合があ り ます。 この場合には、上

の図を参照してBrightnessソフ ト キーとContrastソフ ト キーの位置を確認し、表示がよ く見えるよ うに値を調整

してください。

範囲 ： 15～100

範囲 ： 35～55

範囲 ： 1～12時間 （1時間単位）

Light Only ： ディスプレイのライ ト をオフにし、 テキストは低輝度で表示したままにします。

Light & Text ： ディスプレイのライ ト とテキスト をオフにします。

ディスプレイが長期間変化しない場合は、 このモードを使用してテキストがディスプレイに

焼きつかないようにします。

オンにすると、 リモート制御バスによって実

行されたコマンドに応じて、 信号発生器の

ディスプレイが更新されます。

色なし、 高い明度

Utility > Display

「セキュア ・ ディスプレイの使用 （オプシ ョ ン006のみ）」 （313ページ） も

参照して ください。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

312ページ

明るい背景に黒い

テキスト。

暗い背景に明るい

テキスト。
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プリファレンスの設定とオプシ ョ ンの有効化

ユーザ ・ プリファレンス
電源投入とプリセッ ト

プリセッ ト後の目的のGPIB言語を選択します。

『プログラ ミング ・ ガイ ド』 および 『SCPI Command Reference』 も

参照して く ださい。

Utility > Power On/Preset >

恒久設定

（電源の入れ直し *、 プリセッ ト、

リコールの影響を受けないもの）

を工場設定に復元します。

プリセッ ト言語またはGPIBリモート言語として8648が選択されている

場合のみ使用可能です （30ページを参照）。

*注意

不揮発性メモリに永久的に保存されていないデータ、GPIB設定、または現在のユーザ機器ステートが失われるのを防ぐために、 MXG
の電源をオフにする場合は、必ずMXGのフロン ト ・パネルの電源ボタンまたは適切なSCPIコマンドを使用して ください。 ラ ッ ク ・ シ

ステムにインストールされているMXGが、 MXGのフロン ト ・パネル・ スイッチでな く システム・ ラ ックの電源スイッチによって電源

をオフにされた場合は、 MXGの電源が適切にオフにされなかったためにError -310が表示されます。

注記

ユーザ ・ プリセッ ト を定義するには、 測定器を必要に応じて設定し、 User Preset > Save User Presetを押します。
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プリファレンスの設定とオプシ ョ ンの有効化

ユーザ ・ プリファレンス
フロン トパネルのノブの分解能

時間／日付の設定

信号発生器のファームウェアは、 時間と日付を ト

ラ ッキングして、 時間／日付基準ポイン ト に設定

されている最新の時間と日付を使用します。

時間／日付を進める

時間や日付を進める場合は、 インス トールされているタイムベース ・ ラ イセンスを使い果してしまい、 信号の時間／日付

基準ポイン ト を リセッ トする こ とになるので注意して ください。 信号発生器の現在の基準ポイン ト よ り後の時間または日

付を新たに設定した場合は、 その日付が新たな基準ポイン ト とな り ます。 後で日付を戻すと、 次のセクシ ョ ンで説明する

よ うな危険を冒すこ とにな り ます。

時間／日付を戻す

時間を戻した場合、 信号発生器は時間が基準ポイン トから後退したこ とに気付きます。 時間を数時間以上戻した場合、 時

間を戻す時点でインス トールされているライセンスがな くても、 信号発生器はタイムベース ・ ラ イセンスを使用できなく

な り ます。 この場合、 信号発生器が再びタイムベース ・ ラ イセンスを使用できるよ うにするには、 クロ ッ クを元の時間ま

で進めるか、 単にその分の時間だけ待ちます。

時間や日付を変更する と、 タイムベース ・ ラ

イセンスがインス トールされていない場合

でも、信号発生器のタイムベース ・ ラ イセン

ス使用能力に影響が及ぶ可能性があ り ます。

現在の機能の増分値をアクテ ィブ入力に設定します。

Utility > Instrument Adjustments >
増分値とステップ／ノブ比によって、 ノブを回すたびに変化するアクテ ィブ機能の

値の量が決まります。

例えば、 アクテ ィブ機能の増分値が10 dB、 ステップ／ノブ比が50 ： 1の場合、 ノブ

を回すたびにアクテ ィブ機能の値が0.2 dB (10 dBの1/50) 変化します。

ノブ1回転の変化量を変更するには、 増分値、 ステップ／ノブ比またはその両方を

変更します。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

 29ページ

 28ページ

ALC変調器のバイアス調整を実行します。 ALCを開ループ ・ モードで使

用している場合、 これにより温度と湿度に起因する開ループ ・パワー ・
ド リフ トが補正されます。

SCPIコマンド ：

:CALibration:ALC:MODulator:BIAS

Utility >
Instrument Adjustments >注意

元の時間／日付基準ポイン ト

時間

新たな時間／日付基準ポイン ト
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プリファレンスの設定とオプシ ョ ンの有効化

ファームウェアのアップグレード
基準発振器のチューニング

ファームウェアのアップグレード

新しいファームウェア ・ リ リースについては、 http://www.agilent.co.jp/find/upgradeassistantをご覧ください。

内部VCTXCO発振器の周波数をチューニングします。

ユーザが指定した値は、工場でチューニングされた値に対するオフセッ ト となりま
す （値は工場校正のDAC値に加算されます）。 チューニング値0は、 工場校正値を設
定します。

範囲 ： –8192～8192。 フロン ト ・ パネルのキーパッ ド、 ノブ、 またはリモート ・ コ
マンドで設定できます。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。
『SCPI Command Reference』 も参照して く ださい。

Utility > Instrument Adjustments >
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プリファレンスの設定とオプシ ョ ンの有効化

リモート操作用プリファレンス
リモート操作用プリファレンス

信号発生器のリモート操作の詳細については、 『プログラ ミ ング ・ ガイ ド』 を参照してください。

GPIBアドレスと リモート言語

31ページ

32ページ

注記

USBも使用可能です。 設定が一切不要なので、 メニューには示されていません。

リモートでの測定器の使用法の詳細については、 『プログラ ミング ・ ガイ ド』 を参照して ください。

目的の言語を選択します。

この設定は恒久的でな く、 測定器プリセッ ト を実行するとクリアされま

す。 ほとんどの場合、 Utility > Power On/Preset > Languageで恒久的に言

語を変更するのが最善です。 33ページを参照して ください。

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。
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プリファレンスの設定とオプシ ョ ンの有効化

リモート操作用プリファレンス
LANインタフェースの設定

注記

信号発生器のLANへの接続には、100Base-T LANケーブ

ルを使用して く ださい。

信号発生器をPCに直接接続する場合は、 クロスオー

バー ・ ケーブルを使用して く ださい。

リモートでの測定器の使用法の詳細については、 『プ

ログラ ミ ング ・ ガイ ド』 を参照して く ださい。 また、

www.agilent.co.jpでAgilent MXGに関するFAQ：Hardware
Configurations and Installationを検索して ください。

Utility > I/O Config

『プログラ ミング ・ ガイ ド』

に記載

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。

 32ページ
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プリファレンスの設定とオプシ ョ ンの有効化

リモート操作用プリファレンス
LANサービスの有効化 ： ブラウザ、 ソケッ ト、 VXI–11、 LXI–B1

1オプシ ョ ンALB LXI-Bは、 シ リ アル番号の前半部分がUS/MY/SG4818以上の測定器でのみ使用できます。

測定器のファイル・システム

へのリモート （ブラウザ） ア

クセスを可能にします。 ブラウザを使って信号発生器

を制御します。

Utility > I/O Config

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

License Manager Server (On)は、測

定器ライセンスの更新を可能に

します。測定器のセキュリテ ィ を

強化するにはオフにします。

詳細については、 『プログラ ミング ・ ガイ ド』 を

参照して く ださい。

 
124ページ
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プリファレンスの設定とオプシ ョ ンの有効化

リモート操作用プリファレンス
リモート言語の設定

図2-1　N5161A/62A/81A/82A

Utility > I/O Config

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

目的のリモート言語を選択します。

『SCPI Command Reference』 を参照して ください。
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プリファレンスの設定とオプシ ョ ンの有効化

リモート操作用プリファレンス
図2-2　N5183A

目的のリモート言語を選択します。

Utility > I/O Config >

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

『SCPI Command Reference』 を参照して く ださい。
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プリファレンスの設定とオプシ ョ ンの有効化

リモート操作用プリファレンス
プリセッ ト言語の設定

図2-3　N5161A/62A/81A/82A

Utility> Power On/Preset

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

目的のリモート言語を選択します。

27ページ

『SCPI Command Reference』 を参照して く ださい。
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プリファレンスの設定とオプシ ョ ンの有効化

リモート操作用プリファレンス
図2-4　N5183A

目的のリモート言語を選択します。Utility > Power On/Preset >

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

27ページ

『SCPI Command Reference』 を参照して ください。
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プリファレンスの設定とオプシ ョ ンの有効化

オプシ ョ ンの有効化
オプシ ョ ンの有効化

オプシ ョ ンを有効にするには次の2つの方法があ り ます。

• ラ イセンス ・ マネージャ ・ ソフ ト ウェア ・ ユーティ リ ティ を使用する。

1. ユーティ リ ティ を実行し、 プロンプ トに従います。

2. www.agilent.co.jp/find/LicenseManagerからユーティ リ ティ をダウンロード し、 外部USBフラ ッシュ ・ ド ラ イブ

(UFD)からライセンス(.lic)ファ イルを選択します。

• SCPIコマンドを使用する （『プログラ ミ ング ・ ガイ ド』 を参照）。
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プリファレンスの設定とオプシ ョ ンの有効化

オプシ ョ ンの有効化
オプシ ョ ン／ライセンスの表示

Utility >
Instrument Info

サービス・ソフ トウェア・ライセンスが

一部の Signal Studio アプリケーシ ョ ンからの

測定器オプシ ョ ンがここに表示されます。

チェ ッ ク ・マークはオプシ ョ ンが使用可能

であることを示しています。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

波形ライセンスがここに表示されます。

ここに表示されます。
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プリファレンスの設定とオプシ ョ ンの有効化

オプシ ョ ンの有効化
ハードウェア ・ アセンブリのインス トールおよび取り外し用ソフ トキー

N5162A/82Aのみ

N5183Aのみ

ソフ トキーが使用できるかどうかは、

MXGのモデルによって異なります。

注記 ： これを押すと、 RF、 BBG、 MWの各アセンブリに対しても、 Confirm
Removalメニュー （ここで示したCPUアセンブリに関するものと同様のもの）
が表示されます。

ソフ トキーが使用できるかどうかは、

MXGのモデルによって異なります。

N5162A/82Aのみ

N5183Aのみ

注記 ： これを押すと、 RF、 BBG、 MWの各アセンブリに対しても、 Confirm
Installメニュー （ここで示したCPUアセンブリに関するものと同様のもの）が
表示されます。

Utility > More  2 of 2 > Service 各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

注記 ：

Remove Assemblyソフ トキー (CPU/RF/BBG/MW)をオンにすると、ディスプレイの左下部分に、 アセンブリの取り外しの準備ができたか、取り外しが中止された
という メ ッセージが表示されます。

Install Assemblyソフ トキーをオンにすると、 ディスプレイの左下部分に、 アセンブリのインストールの準備ができたか、 インス トールが中止されたという メ ッ
セージが表示されます。

『サービス ・ ガイ ド』 も参照して ください。
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プリファレンスの設定とオプシ ョ ンの有効化

オプシ ョ ンの有効化
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3 基本操作

注意 N5161A/62Aでは、 本書に記述されているソフ ト キー ・ メニューと機能は、 WebイネーブルMXGまたはSCPIコ
マンド経由でのみ使用できます。 Webイネーブル MXGの詳細については、 『インス トール ・ガイ ド』、 『プログラ

ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照してください。

この章では、 基本的なフロン ト ・パネルの操作を紹介します。 リモート操作については、 『プログラ ミ ング ・ ガイ ド』 を参

照して ください。

• 「信号発生器のプリセッ ト 」 （42ページ）

• 「キーの説明の表示」 （42ページ）

• 「数およびテキス トの入力／編集」 （43ページ）

• 「周波数およびパワー （振幅） の設定」 （45ページ）

• 「ALC帯域幅制御の設定」 （47ページ）

• 「掃引出力の設定」 （48ページ）

• 「搬送波信号の変調」 （61ページ）

• 「ファ イルの操作」 （63ページ）

• 「エラー ・ メ ッセージの読込み」 （75ページ）
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基本操作

信号発生器のプリセッ ト
信号発生器のプリセッ ト

キーの説明の表示

信号発生器を既知の状態に戻すには、 PresetかUser Presetを押します。

Presetは工場プリセッ トで、 User Presetはカスタム ・ プリセッ ト **です （27ページも参照）。

恒久設定 （プリセッ ト、 ユーザ ・ プリセッ ト、 電源の入れ直しの影響を受けない設定*） をリセッ トするには、

以下を押します ： Utility > Power On/Preset > Restore System Defaults

*注意

不揮発性メモリに永久的に保存されていないデータ、 GPIB設定、 または現在のユーザ機器ステートが失われるのを防ぐために、 MXG
の電源をオフにする場合は、 必ずMXGのフロン ト ・ パネルの電源ボタンまたは適切なSCPIコマンドを使用して ください。 ラ ッ ク ・ シ

ステムにインストールされているMXGが、 MXGのフロン ト ・ パネル ・ スイッチでな く システム ・ ラッ クの電源スイッチにより電源を

オフにされた場合は、 MXGの電源が適切にオフにされなかったためにError -310が表示されます。

**保存する各ステート ・ ファイルに異なる名前を付けることにより、 複数のユーザ ・ プリセッ ト を作成できます （図3-12 （73ページ） を参照）。

Helpハードキーを押すことにより、 ハードキーまたはソフ トキーの説明を表示できます。

ヘルプ ・ テキストを表示する手順 ：

1. Helpを押します。

2. 目的のキーを押します。

ヘルプが表示されます。 キーの通常の機能は実行されません。
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 基本操作

数およびテキス トの入力／編集
数およびテキストの入力／編集

数の入力とカーソルの移動

アルファベッ トの入力

データ入力用の ソ フ ト キーは各種 メ

ニューにあ り ます。 各メニューのソフ ト

キーの機能を確認するには、ヘルプ・キー

を使用して （42ページを参照）、説明を表

示して ください。 アルファベッ ト ・ テー

ブルのヘルプを表示するには、 テーブル

の隣のソフ ト キーを使用します。

アルファベッ トの使用が可能なデータを

選択す る と、 右側に示 さ れてい る メ

ニューのうちの1つが表示されます。

矢印キーまたはノブを使って目的の文字

を強調表示し、 Selectハードキー （また

はアルファベッ ト ・ テーブルの隣のソフ

ト キー） を押します。 誤り を訂正するに

は、 Bk SpまたはClear Textを使用します。

入力を終了するには、 Enterソフ ト キーを押します。

16進文字の場合は、 このメニューの一部が表示されます。文字メニューには、 AからFまでの文字だけが表示されます （他

の値についてはテンキーを使用して ください）。

上下の矢印キーは、 選択 （強調表示） した数値を増減したり、 カーソルを垂直方向に移動したり します。

バックスペースはカーソルを左に移動しながら、

文字を削除します。

左右の矢印キーは、カーソルを水平方向に移動します。

Page up/down キーは、データ・テーブルを表示エリア内で上下に移動します。

 

数字キーと小数点を使って数値データを入力します。

各キーの詳細については、 42ページを参照して ください。

エン ト リの一部を選択するには、 アルファベッ ト を入力する場合と同様に、 Selectハードキー

を使用します。一部のメニューでは、 Selectキーはターミネータの役割も果たし、 Enterソフ ト

キーに相当します。

注記： ノブを回すことにより、数値を増減したり、

強調表示されている桁または文字を変更したり、

リス ト または行内の項目を順次確認するこ とが

できます。

フロン トパネルのノブの分解能 （19ページ） も

参照して ください。

負の値を指定するには、 数値の前または後に負符

号を入力します （このキーはトグル ・ キーです）。

アルファベッ ト ・ テー

ブル内ではな く、 アク

テ ィ ブ値内で カーソ

ルを移動するには、 ア

ルファベッ ト ・ テーブ

ルをオフにします。

保存されている機器ステート ・ファイルのコ メン

ト を追加／編集します （70ページを参照）。

注記 ： ファイル名は25文字までです。
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基本操作

数およびテキストの入力／編集
例 ： テーブル ・ エディ タの使用法

テーブル ・ エディ タは設定作業を容易にします。 以下の手順では、 テーブル ・ エディ タの基本的な機能を、 リ ス ト ・ モー

ド値テーブル ・ エディ タを用いて説明します。

1. 信号発生器をプリセッ ト します ： Presetを押します。

2. テーブル ・ エディ タを開きます ： Sweep > More > Configure List Sweepを押します。

下の図のよ うなエディ タが表示されます。

3. 目的の項目を強調表示します。 矢印キーまたはノブを使用してカーソルを移動します。

4. （オプシ ョ ン） 選択した項目をアクティブ機能エリアに表示します ： Selectを押します。

5. 値を編集します ：

• 値がアクティブ機能エリ アに表示されている場合は、 ノブ、 矢印キーまたはテンキーを使って値を変更します。

• 値がアクティブ機能エ リ アに表示されていない場合は、 テンキーを使って目的の値を入力します （入力した値が

アクティブ機能エリアに表示されます）。

6. 入力を終了します ：

• 目的の単位 （使用可能な場合） を押します。

• 単位が表示されていない場合は、 Enter （使用可能な場合） またはSelectを選択します。

変更した項目がテーブル内に表示されます。

カーソル

テーブル・エディ タ用ソフ トキーテーブル・エディ タ名 テーブル項目

編集を行う場合に、 アクテ ィブ項目を表示します。 選択項目が強調表示されます。 選択した項目をアクテ ィブ （編集可能） 項目にするには、

Selectを押すか、 目的の値を入力します。

テ ー ブ ル項目はデー タ ・

フ ィールド とも呼ばれます。

テーブル項目値のロード、 検索、 変更、

保存に使用します。 各キーの詳細につい

ては、キーのヘルプを使用して ください。

Helpハー ド キーを押し てから、 目的の

キーを押します。

アクテ ィブ機能エリア

現在のページ番号／全ページ数

別のメニューが使

用可能であるこ と

を示し ています。

別のメニューを表

示するには、 More
を押します。

（ベク トル ・ モデルのみ）
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 基本操作

周波数およびパワー （振幅） の設定
周波数およびパワー （振幅） の設定

図3-1　 Frequencyソフ トキーとAmplitudeソフ トキー

 

115ページ

以下のメニューを表示するには、 Moreを押します。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

46ページ

『SCPI Command Reference』 を参照して ください。

Atten/ALC 
Control
メニューを

開きます。

S/N比最適化ステート (Optimize S/N)をオンまたはオフにします。

S/N比最適化ソフ トキーは、 アッテネータと ALCの設定を変更して、 S/N比性能を最高にします。 RF出力パワーは変

更しません。

注意 ： S/N比最適化ステートをオンにした場合は、 高調波歪みレベルが増加する場合があります。 この高調波歪みの

増加により、 ACPRとEVMが悪化する可能性があります。

注記： このモードは、 アッテネータ ・ホールド (Atten Hold)およびすべての変調方式との組み合わせでは使用できませ

ん。 S/N比最適化がアクテ ィブ(ON)のときにアッテネータ ・ ホールドまたは変調をオンにすると、 設定衝突エラーが

発生します。

47ページ

このソフ トキーは、ユーザ定

義の測定器の最大パワー・レ

ベルを恒久的に設定します。

User Power Max　
ソフ トキーを

オンにします。

90ページ

振幅モードの場合は、 フロン ト ・パネル・キー

パッ ドで数値を入力すると、 このメニューが

自動的に表示されます。

周波数モードの場合は、 フロン ト ・ パネル ・

キーパ ッ ド で数値を入力する と、 こ の メ

ニューが自動的に表示されます。

RF出力信号の電流の相対位相をゼロ基

準に設定します。

以降のすべての調整はこの調整値が基

準になります。

dBuVemf は、 値を

dBuV 単位の起電

力と して確定しま

す。Emfは、無負荷

での出力電圧で

す。 この単位は外

部のみです。 内部

表現 と 増減値は

dBm単位です。

注記 ： dBuV、 mV、
nVemfの動作は共

通です（すなわち、

値は外部のみで、

内部表現と増減値

はdBm単位です）。
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基本操作

周波数およびパワー （振幅） の設定
例 ： 700 MHz、 –20 dBmの連続波出力の設定

1. 信号発生器をプリセッ ト します。

最大仕様周波数と最小パワー ・ レベルが表示されます （11ページのフロン ト ・ パネルの表示エリアを参照）。

2. 周波数を700 MHzに設定します ： Freq > 700 > MHzを押します。

ディ スプレイのFREQUENCYエリ アとアクティブ入力エリ アに、 700 MHzと表示されます。

3. 振幅を–20 dBmに設定します ： Amptd > –20 > dBmを押します。

ディ スプレイのAMPLITUDEエリ アの表示が–20 dBmに変わり、振幅値がアクティブ入力になり ます。別のファンクシ ョ

ン ・ キーを押すまでは、 振幅がアクティブ機能であ り続けます。

4. RF出力をオンにします ： RF On/Offを押します。

RF出力LEDが点灯し、 700 MHz、 –20 dBmのCW信号がRF OUTPUTコネクタに出力されます。

外部基準発振器の使用

外部基準を使用する場合は、 狭帯域幅モードまたは広帯域幅モードが選択できます。

 

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。

レンジ ： 1～50 MHz

2 MHzより下で保証された動作を実現するには、 Narrow帯域幅を選択します。 Wide帯域幅を使用した場合は、

2 MHzより下の周波数での動作は保証されません。

Freq > More

図3-2は、 広帯域幅モードで近傍位相雑音が優れていることを示します。 使用する外部基準にノイズや

スプリアスがある場合は、 狭帯域幅モードを使用します。

Wide帯域幅を選択した場合は、 2 MHzより低い周波数を選択すると、 警告メ ッセージが表示されます。

信号発生器の内蔵基準発振器を使用します。

REF INコネクタから周波数基準を取得します。 注記 ： 基準が接続されていないか、

正しい周波数に同調されていない場合は、 エラー画面が表示されます。

リア ・パネルのREF INコネクタに信号が存在しない場合は、 信号発生器の内蔵基準

を使用します。 外部信号が存在する場合は、 その信号が基準として使用されます。
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 基本操作

ALC帯域幅制御の設定
図3-2　外部基準発振器の使用

ALC帯域幅制御の設定

図3-3　Amplitudeソフ トキー

以下のメニューを表示するには、

Moreを押します。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。
『SCPI Command Reference』 を参照して ください。

自動ALC帯域幅

モード (Auto)を
オンにします。

Auto ALC モー

ド をオフにし、

帯域幅を200 Hz
に設定します。
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基本操作

掃引出力の設定
掃引出力の設定

信号発生器は、 周波数ポイン ト と振幅ポイン トのセッ ト を2つの方法で掃引するこ とができます。

ステップ掃引 （49ページ） では、 1つの選択した周波数／振幅から別の周波数／振幅に向って リニアまたはログ掃引され、

掃引中にリニア／ログ間隔のポイン ト （ステップ） で休止状態になり ます。 掃引は、 順方向／逆方向に、 または手動で行

う こ とができます。

リ ス ト掃引 （57ページ） では、周波数と振幅を、一定でない間隔で入力したり、非直線的な昇順または降順で入力したり、

ランダムな順序で入力したりできます。 リ ス ト掃引では、 現在のステップ掃引値をコピーした り、 任意波形を掃引に含め

たり （ベク トル ・ モデル）、 リ ス ト掃引データをファイル ・ カタログに保存したりするこ と も可能です （68ページ）。
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 基本操作

掃引出力の設定
図3-4　Sweepソフ トキー

信号のルーティング

Sweep > More > More > Route Connectors

ステップ掃引

ステップ掃引では、 1つの選択した周波数／振幅から別の周波数／振幅に向って リ ニアまたはログ掃引され、 掃引中にリ

各ポイン ト でのト リガを待つこ とな
く掃引します。
ポイン ト ・ ト リガは最初の掃引の前に
持続時間だけ休止します。
119ページを参照して く ださい。

TTL/CMOS信号をTrigger Inコネクタに印加。

ソースに選択したものには、 ト リガ ・ イ
ベン ト を定期的に発行。

タイマ ・ ト リガとシングル掃引を併用す
ると、最初の掃引の前に遅延が生じます。
119ページを参照して く ださい。

リモート ・ コマンドで ト リガ。

ス ト ッ プ周波数／振幅か
らスター ト周波数／振幅
に向ってダウン掃引。

スター ト周波数／振幅か
らス ト ッ プ周波数／振幅
に向ってアップ掃引。

57ページ

選択した掃引タイプにより、 表示されるパラ メータが決まります。
ステップ掃引を選択すると、 ステップ間隔 （LinまたはLog） も表示されます。

ベク トル ・ モデル ：
Sweep Type ＝ Listの
場合に使用可能

61ページ

掃引中は、 掃引するパラ メータ （周波数、 振幅、 またはその両方） はグレーになり、 パラ メータの掃引とともに変化します。

進捗度バー ： 超高速掃引はランダムまたは逆方向
に掃引しているように見えることがあります。

49ページ

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。

 49ページ

Source Settled と し て

ルーテ ィ ングされて
いるSweep Out BNC
またはTRig Out BNC
信号には影響し ませ
ん（49ページを参照）。

ト リガ ・ ソースを、 有効
になっている任意のLXI
ト リ ガ入力イベン ト に
設定します。

掃引またはポイン ト ・ ト リ
ガ中のLXIアラームを設定

します。アラームはSCPI経
由でのみ設定できます。
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基本操作

掃引出力の設定
ニア／ログ間隔のポイン ト （ステップ） で休止状態になり ます。 掃引は、 順方向／逆方向に行う こ と も、 手動で変更する

こ と もできます。
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 基本操作

掃引出力の設定
図3-5　Step Sweepソフ トキー

ステップまたはリス ト掃引
信号をルーティ ングします。

これらのソフ トキーは、BBG
を搭載したN5162A/82Aでの

み使用できます。

Source Settledは、Trig
Out Polarity Neg Pos
ソフ トキーの選択に
は影響 さ れません
（49ページを参照）。

N5161A1/62A1/81A/82A
のみ

N5183Aのみ

N5183Aのみ ：

N5183Aの10 Vステップ

掃引(Sweep Out) BNC設
定を8757Dに対し て最

適化します。 *

* N5183A信号発生器は

8757システム ・ インタ

フ ェースをサポート し
ません。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

1 N5161AおよびN5162Aとフロン ト ・パネル ・ ディスプレイを持つMXGとの違いは、 フロン ト ・パネル、 ハードキー、 ソフ

トキーの機能が、 SCPIコマンドまたはWebイネーブルMXG経由でのみ使用できることです。 WebイネーブルMXGの詳細に

ついては、 『インス トール ・ ガイ ド』、 『プログラ ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照して く ださい。

非ステ ッ プまたは
リス ト掃引信号を
ルーテ ィ ングしま
す （SCPI コマン ド

開発の場合）。

ステップまたはリス
ト 掃引信号 を ルー
ティ ングします。

非ステップまたはリス ト掃引
信号をルーテ ィ ング し ます
（SCPIコマンド開発の場合）。

これらのソ フ ト キー
は、 BBG を搭載し た

N5162A/82Aでのみ使

用できます。

このソフ トキーは、リ
ア・パネルのTRIG OUT
BNC コネク タのイベ

ン ト 2マーカ ・ コン ト

ロール （N5162A1/82A
のみ） を制御します。

125ページ
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基本操作

掃引出力の設定
N5183Aでは、 測定中にステップ掃引と測定器の周波数マーカを組み合わせて使用できます （ 「周波数マーカの使用

（N5183Aのみ）」 （55ページ） を参照）。

注意 N5183Aは8757システム ・ インタフェースをサポート しません。

図3-6　Sweepソフ トキー

例 ： 連続リニア ・ ステップ掃引の設定

1. 測定器をプリセッ ト し、 Sweep/Listメニューを開きます ： Preset > SWEEPを押します。

デフォルトでは掃引の繰り返し と して連続が、 ステップ間隔と して リ ニアがそれぞれ選択されるため、 これらのパラ

メータを設定する必要はあ り ません。

2. ステップ掃引メニューを開きます ： Configure Step Sweepを押します。

3. 以下のパラ メータを設定します。

4. 周波数と振幅の両方を掃引します ： Return > Return > Sweep > Freq Off On > Amptd Off Onを押します。

連続掃引がスタート周波数／振幅からス ト ップ周波数／振幅に向って開始されます。 SWEEPインジケータが表示され、

掃引の進捗度が、 周波数表示、 振幅表示、 進捗度バーに表示されます。

5. RF出力をオンにします。 RF On/Offを押します。

RF LEDが点灯し、 RF Outputコネクタでの連続掃引が可能になり ます。

出力 ： 500～600 MHzおよび–20～0 dBmまで、 500 msの持続時間、 6つの等間隔のポイン トで連続的に掃引される信号。

スタート周波数500 MHz ： Freq Start > 500 > MHzを押します。

ス ト ップ周波数600 MHz ： Freq Stop > 600 > MHzを押します。

掃引の開始時の振幅、 –20 dBm ： Amptd Start > −20 > dBmを押します。

掃引の終了時の振幅、 0 dBm ： Amptd Stop > 0 > dBmを押します。

6つの掃引ポイン ト ： # Points > 6 > Enterを押します。

各ポイン トでの持続時間、 500 ms ： More > Step Dwell > 500 > msecを押します。

持続時間＝信号が安定し、掃引が以下のポイン トに移るまでの測定が可能な
時間。

（ポイン ト ツーポイン ト時間は持続時間の設定値と処理時間、 スイッチング
時間、 セ ト リング時間の合計です）。

Lin＝掃引全体を通して等間隔のステップ。 出力はリニアに変化します。

Log＝ステップ間隔は掃引全体を通して対数的に増加。 出力は指数関数的に

変化します。

ステップ掃引の持続時間と リス ト掃引の持続時間は別個に設定します。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

N5183Aのみ ：周波数マーカ ・ メニューを開きます。 55ページを参照して く ださい。

（N5183AはAgilent 8757システム ・ インタフ ェースをサポート しません）。
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 基本操作

掃引出力の設定
基本ステップ掃引機能の使用

こ こでは、 以下の手順を示します。

• 「周波数掃引の設定 （N5183Aのみ）」 （53ページ）

周波数掃引の設定 （N5183Aのみ）

この例では、 N5183Aを使用して、 7.5 ～10.0 GHzの周波数掃引を、 バンドパス ・ フ ィルタの被試験デバイスに対して実行

し、 その応答を8757Dスカラ ・ アナライザに表示します。

1. 図3-7に示すよ うに機器をセッ ト アップします。

注記 N5183A信号発生器は8757システム ・ インタフェースをサポート しません。

スカラ ・ アナライザの設定は、 信号発生器の設定と必ず一致する必要があ り ます。

図3-7　機器セッ トアップ

2. 8757DとN5183Aを両方と もオンにします。

3. 8757Dで ：

a. SYSTEM > MORE > SWEEP MODEを押し、 SYSINTFソフ ト キーがOFFに設定されているこ とを確認します。

b. SYSTEM > MORE > DCを押します。

N5183A
MXGマイクロ波信号発生器 8757D　

スカラ ・

ネッ トワーク ・

アナライザ*
* N5183A信号発生器では8757システム ・ インタフェースは使用できません。
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c. SYSTEM > Freq LABELS > START FREQ > 7.5 GHzを押します。

d. SYSTEM > FREQ LABELS > STOP FREQ > 10.0 GHzを押します。

e. SYSTEM > TRACE # POINTS > 801を押します。

4. N5183Aで ：

a. コネク タのルーティングを8757Dシステムに変更して、 N5183Aがステップ掃引動作中に掃引出力を8757Dに供給

できるよ うにします。 Sweep > More > More > Route Connectors > Route to Sweep Out BNC > Sweep Out (Optimized
for 8757D System)を押します。

b. Sweep > Configure Step Sweep > # Points > 801を押します。

c. Sweep > Configure Step Sweep > Freq Stop > 10.0 GHzを押します。

d. Sweep > Configure Step Sweep > Freq Start > 7.5 GHzを押します。

e. Sweep > Sweep > Freq On Offを押します。 Onに設定します。

注記 RF出力の掃引中は、 掃引対象に応じて、 信号発生器ディ スプレイのFREQUENCYまたはAMPLITUDE領域がグレー

表示にな り ます。 この例では、 周波数が掃引されているので、 ディ スプレイのFREQUENCY領域がグレー表示に

なり ます。

5. 8757Dで：被試験デバイス(DUT)のスタート／ス ト ップ周波数応答の設定を調整して、8757Dのディ スプレイに応答が

はっき り と表示されるよ うにします。

振幅をよ り正確に評価するには、 8757Dの応答のスケール変更が必要な場合があ り ます。 図3-8 （55ページ） にバンド

パス ・ フ ィルタの応答の例を示します。
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掃引出力の設定
図3-8　 8757Dでのバンドパス ・ フ ィルタ応答の表示

周波数マーカの使用 （N5183Aのみ）

ステップ掃引モードでは、 N5183Aを使用して、 最大20個の周波数マーカを作成して測定機器に表示できます。

注意 N5183Aは8757システム ・ インタフェースをサポート しません。
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 55



基本操作

掃引出力の設定
図3-9　 Frequency Markerソフ トキー

Sweep > Configure Step Sweep > 
More > Markers

強調表示されたマーカ番号の周波

数を設定します。 最大20個の周波

数マーカを設定できます。

選択した周波数マーカをオンにし

ます。

強調表示されたマーカを、 他の周

波数マーカに対する周波数基準

マーカとして選択します。

Delta Ref Set ソ フ ト キーが押され

ている場合は、 このソフ トキーに

よ りMarker Delta機能がオンにな

り、Refマーカが他のマーカに対す

る周波数マーカ基準として使用さ

れます。

測定器に表示されるマーカ振幅

値を設定します （範囲 ： –10 dB
～10 dB）。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

掃引の中心周波数を、 強調表示

されたマーカ （行） の値に設定

します。

掃引のスタート周波数をマーカ

1(M1)の値に、 スト ップ周波数を

マーカ2(M2)の値に設定します。
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リス ト掃引

リ ス ト掃引では、 周波数と振幅を、 一定でない間隔で入力したり、 非直線的な昇順または降順で入力したり、 ランダムな

順序で入力したりできます。 リ ス ト掃引では、現在のステップ掃引値をコピーした り、波形を掃引に含めたり （ベク トル・

モデル）、 リ ス ト掃引データをファ イル ・ カタログに保存するこ と も可能です （68ページ）。 持続時間は各ポイン トで編集

できます。 最高の掃引スイ ッチング速度を得るには、 リ ス ト掃引を使用します。

図3-10　 リス ト掃引設定用のソフ トキーおよびディスプレイ

58ページを参照

選択した掃引により、信号発生器が使用する持続時間が決まります。 ステップ掃引の持続時間はすべてのポイ
ン トで同じですが、 リスト掃引の持続時間はポイン トごとに異なる場合があります。

持続時間＝信号が安定し、 掃引が以下のポイン トに移るまでの測定が可能な時間。

ポイン ト ツーポイン ト時間＝持続時間の設定値と処理時間、 スイッチング時間、 セト リング時間の合計です。

各行は対応する掃引ポイン ト
を定義します。例えば、行1は
ポイン ト 1を定義します。

49ページ

ベク トル ・ モデル、
および 
Sweep Type＝Listの場合のみ使用可能。

選択された掃引タ イプ ・ パラ
メータを表示します （58ページ

を参照）。

ベク トル ・ モデルのみ

49ページ

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

波形エン ト リが選択されている
場合のみ使用可能
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例 ： ステップ掃引データを使用したリスト掃引の設定

1. 必要なステップ掃引をセッ ト アップしますが、 掃引はオンにしません。 この例では、 52ページで設定したステップ掃

引を使用します。

2. SWEEPメニューで、 掃引タイプを リ ス トに変更します ：

SWEEP > Sweep Type List Stepを押してListを強調表示します。

ディ スプレイには掃引リ ス ト ・ パラ メータが表示されます （下の図を参照）。

3. ステップ掃引メニューを開きます ： More > Configure List Sweepを押します。

4. 以前に設定した値がメ ニューにあればク リ アし、 ステップ掃引で定義されたポイン ト を リ ス ト にロード し ます ：

More > Preset List > Preset with Step Sweep > Confirm Presetを押します。

図のよ うに、 ステップ掃引からロード した値でディ スプレイが更新されます。

5. 周波数と振幅を掃引します ： SWEEP （ハードキー） > Sweep > Freq Off On > Amptd Off Onを押します。

掃引を設定する と、 掃引機能がオンになり ます。 連続掃引が開始されます。 ディ スプレイ上にSWEEPインジケータが

表示され、 進捗度バーには掃引の進捗状況が示されます。

6. オンになっていない場合は、 RF出力をオンにします ： RF On/Offを押します。

RF出力LEDが点灯し、 RF OUTPUTコネク タでの連続掃引が可能になり ます。

ベク トル ・ モデル ：

リ ス ト をプ リセ ッ ト する と、

以前に選択した波形がすべて

クリアされます。

リス ト掃引波形の選択方法に

ついては、 「例 ： リス ト掃引ポ

イン トの編集」 （59ページ） を

参照して ください。

波形はベク トル ・ モデルでのみ
使用可能です。
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掃引出力の設定
例 ： リス ト掃引ポイン トの編集

テーブル ・ エディ タの使い方がよ くわからない場合は、 44ページを参照して ください。

1. 必要な リ ス ト掃引を作成します。 この例では、 前の例で作成した リ ス ト掃引を使用します。

2. 掃引がオンの場合は、オフにします。掃引がオンの場合は、 リ ス ト掃引パラ メータを編集する とエラーが発生します。

3. 掃引タイプがリ ス トに設定されているこ とを確認します ： SWEEP > Sweep Type List Stepを押して、 Listを強調表示し

ます。

4. リ ス ト ・ モード値テーブル ・ エディ タで、 ポイン ト 1の持続時間 （行1で定義） を100 msに変更します ：

a. More > Configure List Sweepを押します。

b. ポイン ト 1の持続時間を強調表示します。

c. 100 > msecを押します。

テーブルの以下の項目 （ポイン ト 2の周波数値） が強調表示されます。

5. 選択した周波数値を445 MHzに変更します ： 445 > MHzを押します。

6. ポイン ト 4とポイン ト 5の間に新しいポイン ト を追加します。 行4の任意のエン ト リ を強調表示して、 Insert Rowを押し

ます。

これによ り、 行4のコピーが行4の下に挿入され、 新しいポイン ト 5が作成され、 後続の行の番号が付け直されます。

7. 周波数値をポイン ト 5から1行ずつ下にずらします：行5の周波数エン ト リ を強調表示し、More > Insert Itemを押します。

これによ り、 強調表示された周波数値のコピーが行6に挿入され、 行6と7の元の周波数値が1行ずつ下にずれます。 新

しい行8には周波数値だけが含まれます （パワーと持続時間のエン ト リは下にずれません）。

8. 行5の今もアクティブな周波数値を590 MHzに変更します ： 590 > MHzを押します。 行 5のパワーがアクティブなパラ

メータになり ます。

9. ポイン ト 5の新しいパワー値 （–2.5 dBm） を挿入して、ポイン ト 5と6の元のパワー値を1行下にずらします： Insert Item
> –2.5 > dBmを押します。

10. ポイン ト 8のエン ト リ を完成するために、 既存の値のコピーを下にずらして、 ポイン ト 7の持続時間の複製を挿入しま

す ：行7の持続時間を強調表示して、 Insert Itemを押します。

11. アナログ測定器の場合は、 ステップ14に進んでください。 ベク トル測定器の場合は、 ステップ12を続けて実行してく

ださい。

12. ポイン ト 2の波形を選択します ：

a. ポイン ト 2の波形エン ト リ を強調表示して、 More > Select Waveformを押します。

使用可能な波形が表示されます （以下の例を参照して ください）。

b. 目的の波形 （この例では、 SINE_TEST） を強調表示し、 SelectハードキーまたはSelect Waveformソフ ト キーを押し

ます。

波形を選択するか、

または

変調なしを選択します。
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13. 必要に応じて、 波形を選択したい残りのポイン トに対してステップ12を繰り返します。 下の図は、 表示例を示したも

のです。

14. 掃引をオンにします ：

Return > Return > Return > Sweep > Freq Off On > Amptd Off On > Waveform Off Onを押します。

15. RF出力をオンにします （オンになっていない場合） ：

RF On/Offを押します。

ディ スプレイ上にSWEEPインジケータが表示され、 信号発生器が掃引中であるこ とが示されます。 また、 進捗度バー

には掃引の進捗状況が示されます。

注意 測定器が手動掃引の場合 （61ページ）、 アクティブ行 （上の図では行6） が選択された （手動） ポイン トであ り、

RF出力をオンにする と信号発生器はこの選択された設定を出力します。

例 ： シングル掃引の使用法

1. ステップ掃引 （52ページ） またはリ ス ト掃引 （58ページ） を設定します。

2. List/Sweepメニューで、 掃引の繰り返しをシングルに設定します ：

Sweep Repeat Single Contを押して、 Singleを強調表示します。

ト リガするまで掃引は発生しません。

ディ スプレイ上にWINITインジケータが表示され、 掃引の開始待ち中であるこ とが示されます。

3. オンになっていない場合は、 RF出力をオンにします ： RF On/Offを押します。

4. 掃引を開始します ： Single Sweepを押します。

RF Outputコネク タでは、 設定した掃引が1回だけ繰り返されます。

信号発生器の掃引時には、WINITインジケータに代わってSWEEPがディ スプレイ上に表示され、進捗度バーには掃引の

進捗状況が示されます。

掃引の終了時に、 進捗度バーは消え、 SWEEPインジケータに代わってWINITインジケータが表示されます。

空のエン ト リはCW （変調なし） を

選択したのと同じです。
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例 ： 掃引の手動制御

1. ステップ掃引 （52ページ） またはリ ス ト掃引 （58ページ） を設定します。

2. Sweep/Listメニューで、 掃引するパラ メータを選択します ： Sweep > parameter > Returnを押します。

3. 手動モードを選択します ： More > Manual Mode Off Onを押します。

手動モードを選択した場合は、 現在の掃引ポイン トが選択された手動ポイン トになり ます。

4. RF出力をオンにします （オンになっていない場合） ： RF On/Offを押します。

5. 目的の出力ポイン ト を選択します ： Manual Point > 番号 > Enterを押します。

進捗度バーが変化して、 選択されたポイン ト を示します。

6. ノブまたは矢印キーを使って、 ポイン トからポイン トへ移動します。 各ポイン ト を選択するたびに、 RF出力がその選

択の設定に変わり ます。

搬送波信号の変調

搬送波信号を変調するには、 以下の2つが必要です。

• アクティブ変調フォーマッ ト

および

• RF出力の変調がオン

例

1. 信号発生器をプリセッ ト します。

2. AM変調をオンにします ： AM > AM Off Onを押します （オプシ ョ ンUNTが必要）。

変調フォーマッ トは、 信号パラ メータを設定する前でも後でもオンにできます。

変調フォーマッ ト を作成しても、 搬送波信号は変調されません。

信号が作成される と、 フォーマッ ト名を示すインジケータが表示され、 変調フォーマッ トがアクティブであるこ とが

示されます。

選択した掃引ポイン ト （この例ではポイン ト 6個のう ちの3番
目） のパラ メータにより、 RF Outputコネクタに出力される信号

が定義されています。

手動ポイン ト を入力した場合は、 進捗
度バーが選択したポイン トに移動して
停止します。

SWMANインジケータは、 掃引

が手動掃引モードにあること
を示します。

手動モードをオンにした場合は、 現在の掃引
ポイン トが手動ポイン トになります。

現在掃引中のパラ メータが停止
し、 選択されたポイン ト を表示
します。
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3. RF出力の変調をオンにします ： LEDが点灯するまでMod On/Off キーを押します。

アクティブ変調フォーマッ トがない場合に変調をオンにしても、 変調フォーマッ ト をオンにするまでは搬送波信号は

変調されません。

注意 変調をオフにするには、 LEDがオフになるまでMod On/Offキーを押します。

Mod On/Offキーがオフの場合は、 アクティブな変調フォーマッ トがあっても、 搬送波信号は変調されません。

4. RF出力コネクタに変調搬送波を出力するには、 LEDが点灯するまでRF On/Offキーを押します。

「アナログ変調の使用法 （オプシ ョ ンUNTのみ）」 （77ページ）

「パルス変調の使用法 （オプシ ョ ンUNUまたはUNW）」 （129ページ）

「I/Q変調」 （198ページ）

も参照して ください。

 
AM変調フォーマッ トはオン。

LEDが点灯し ている場合は、 アク

テ ィ ブ変調フォーマッ ト によ り搬

送波の変調が可能であるこ とを示

します。

アクテ ィブAM変調インジケータ
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ファイルの操作
同時変調

注意 Agilent MXGには、 同時変調機能があ り ます。 すべての変調方式 （AM、 FM、 φM、 パルス） を同時にオンにで

きます。 ただし、 いくつか例外があ り ます。 表3-1を参照してください。

ファイルの操作

• 「Fileソフ ト キー」 （64ページ）

• 「保存されているファイルのリ ス トの表示」 （65ページ）

• 「ファ イルの保存」 （66ページ）

• 「保存されているファイルのロード （ リ コール）」 （68ページ）

• 「別のメディアへのファ イルの移動」 （69ページ）

• 「機器ステート ・ ファ イルの場合」 （70ページ）

• 「デフォルト記録メディアの選択」 （74ページ）

信号発生器が認識するファ イルのタイプには、 機器ステート ・ ファ イル、 ライセンス ・ ファ イル、 リ ス ト掃引ファ イルな

どがあ り ます。 ファ イルは、 信号発生器の内部記憶装置またはUSBメディアに保存できます。 このセクシ ョ ンでは、 信号

発生器のファ イル ・ メニューの操作方法と、 ファ イルの表示／保存／ロード／移動の方法を説明します。

Agilent MXGの不揮発性内部メモリは、 Microsoft互換のFATファ イル ・ システムを採用しています。 『プログラ ミ ング ・ ガ

イ ド』 を参照してください。

「波形セグメン トの保存、 ロード、 再生」 （142ページ） も参照して ください。

表3-1　同時変調方式の組み合わせ

AMa

aリニアAMと指数関数AMは同時にオンにできません。 第4章を参照して く ださい。

FM φM パルスb

bパルス変調にはオプシ ョ ンUNUまたはUNWが必要です。 第6章を参照して ください。

AM -- x x x

FM xc

cFMとφMは同時にオンにできません。

-- 適用不可 x

φM xc 適用不可 -- x

パルス x x x --
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 63



基本操作

ファイルの操作
Fileソフ トキー

測定器の操作パラ メータ （70ページを参照）。

リス ト ・ モード値テーブル ・ エディ タからデータを掃引します。

ユーザ ・ フラ ッ トネス校正補正。

310ページ

注記 ：使用できるファイル ・ タイプは、 インス トールされたオプシ ョ ンにより異なります。

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。

削除には確認が必要です。

USBが接続されている場合のみ使用できます

（外部USBが接続されていない場合は、ソフ ト

キーはグレー表示になります）。

74ページ

このキーは、 選択されているファイル
に応じて変化します。 68ページを参照

して ください。

現在のディ レク ト リを表示します。

69ページ

69ページ

確認が必要

現在のディ レク ト リがデフォルトの保存パスである場合は、 ディスプレイに
そのように表示されます。
デフォルトの保存パスの設定方法については、 74ページを参照して ください。

USBメディアを測定器に接続した場合は、 信号発生器のディスプレイには、 USB Mediaメニューと、 External USB Storage attached （外部USBスト レージが接続されています） という メ ッセージが

表示されます。 USBメディアを取り外すと、 External USB Storage detached （外部USBスト レージが取り外されました） という メ ッセージが表示されます。 USBメディアを接続せずにExternal Media
メニューをオープンした場合は、 Eternal Media Not Detected （外部メディアが検出されません） という メ ッセージが表示されます。

信号発生器では、外部メディアのフォー
マッ ト とフ ァイル・パーミ ッシ ョ ンの変
更はできません。 これらの操作は、 コン
ピュータを使って実行します。

現在のディ レク ト リが最上位ディ
レク ト リでない場合のみ使用でき
ます。

選択されている記録メディアに

応じて、 内部またはUSBファイ

ルを表示します。

65ページ

IQファイルを

表示します。

FSKファイルを

表示します。

FIRファイルを

表示します。
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 基本操作

ファイルの操作
ARB Fileソフ トキー

保存されているファイルのリス トの表示

このセクシ ョ ンの内容は、 デフォルトの記録メディアがAutoに設定されている と仮定しています （74ページを参照）。

信号発生器に保存されているファイルのリストの表示

1. USBメ ディ アが接続されている場合は、取り 外します。信号発生器の記録メ ディ アが内部に切り 替わり 、 ファ イル・ カ

タログを使用して信号発生器に保存されているファイルを参照できるよ うにな り ます。

2. 目的のファイル ・ カタログを選択します ： > Catalog Type > 目的のカタログ （この例ではAll） を押します。 選択された

ファイルが、 ファ イル名のアルファベッ ト順に表示されます （下の図を参照）。

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。

波形ファイルと対応する
マーカ／ヘッダ情報。

注記 ：使用できるファイル ・ タイプは、 インス トールされた

オプシ ョ ンにより異なります。

選択されたファイル ・ カタログと
記録メディア
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基本操作

ファイルの操作
USBメディアに保存されているファイルのリストの表示

USB メディアが接続されている場合は、 USBメディア上のファイルを表示するには、 ファ イル ・ カタログを使用する方法

（選択したタイプのファ イルだけを表示） と、 USBファイル ・ マネージャを使用する方法 （すべてのファ イルを表示） があ

り ます。

ファ イル ・ カタログの使用 ：

• USB メディアが接続された状態で、 目的のファイル ・ カタログを選択します。> Catalog Type > 目的のカタログを押し

ます。 選択されたファイルが、 ファ イル名のアルファベッ ト順に表示されます。

USBファ イル ・ マネージャの使用 ：

• USBメディアが接続された状態で、 USBファ イル ・ マネージャを開きます。 File > More > USB File Managerを押します。

USBメディア上のデフォルト ・ディ レク ト リが表示されます （下の図を参照）。 USBメディアを接続する と、 ディ スプ

レイにはこのメニューがダイレク トに表示されます。

ファイルの保存

測定器パラ メータを保存するには、 いくつかのメニューが使用できます。 例えば、 機器ステート、 リ ス ト 、 波形を保存で

きます。

• 機器ステート ・ ファ イルには測定器の設定が保存されています。 このタイプのファイルの場合は、 Saveハードキーを

使用します （図3-11 （70ページ） を参照）。

• 他のタイプのデータの場合は、 ファイル作成用メニューにあるLoad/Storeソフ ト キー （下を参照） を使用します。

Page UpおよびPage Downハー ドキーを

使って、 ディ レク ト リの内容をスクロー

ル表示します。
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 基本操作

ファイルの操作
このメニューを使ってフ ァ イル名を入力し
ます （43ページを参照）。

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。

ファイル ・ タイプ

リス ト

ステート

波形

ユーザ ・ フラ ッ トネス

ユーザ ・ プリセッ ト

使用メニュー

Sweepメニュー

Saveメニュー

Modeメニュー

Amplitudeメニュー

User Presetメニュー

ファイル長 （拡張子を含む）

内部メディア ： 25文字

USBメディア ： 39文字
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基本操作

ファイルの操作
保存されているファイルのロード （リ コール）

保存されているファ イルをロード （ リ コール） するには、 いくつかの方法があ り ます。

• 機器ステート ・ ファ イルの場合は、 Recallハードキーを使用します （図3-11 （70ページ） を参照）。

• 他のタイプのデータの場合は、 ファイル作成用メニューにあるLoad/Storeソフ ト キー （下を参照） を使用します。

USBメディアからのファイルのロード

USBメディアからファ イルをロードするには、 下に示すUSBファ イル ・ マネージャを使用します。

ファイル ・ タイプ

リス ト

ステート

波形

ユーザ ・ フラ ッ トネス

ユーザ ・ プリセッ ト

使用メニュー

Sweepメニュー

Saveメニュー

Modeメニュー

Amplitudeメニュー

User Presetメニュー

このキーは、 選択されている

ファイルに応じて変化します。

File > Catalog Type > <タイプ> > More > USB File Manager
または

File > More > USB File Manager
または

USBメディアを挿入

Copy & Select User Flatness

Copy & Play Waveform

Copy & Play Sequence

Enter Directory

Recall Instrument State

Load List

Install licenses

No action （USBを切断）

Use As

信号発生器がファイルを認識できない場合は、ファイルの
使用方法を選択する必要があります。

ファイル ・ タイプ

リス ト

ステート

波形

ユーザ ・ フラッ トネス

ユーザ ・ プリセッ ト

ライセンス

拡張子

.list　

.state　

.waveform 　

.uflat　

.uprst　

.lic 　

フ ァイルを強調表示してSelectを押す...
リスト をロード し、 掃引を開始する

機器ステートをロードする

波形をロード し、 再生する

ユーザ ・ フラッ トネスをロード し、 適用する

ユーザ ・ プリセッ ト をロード し、 実行する

購入したライセンスをインス トールする

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。
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 基本操作

ファイルの操作
別のメディアへのファイルの移動

USBと内部メディアの間でファ イルを移動するには、 USBメディア ・ マネージャを使用します。

波形または不明なフ ァ イル ・ タ
イプを選択すると、 このソフ ト
キーが表示されます。

File > Catalog Type > <タイプ> > More > USB File Manager
または

File > More > USB File Manager
または

USBフラッシュ・ドライブ(UFD)を挿入

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。

このキーは、 選択 さ れている
フ ァ イルに応じて変化します。
68ページを参照

メニューが使用できるかどうかは、 選択

されているファイルに応じて変化します。

確認が必要

Catalog Type メニュー

64ページ

確認が必要

1つ上のディ レク ト リ ・ レベルに

移動します。

これらのソフ トキーは、BBG

を搭載し た N5162A1/82A で

のみ使用できます。

こ れ ら の ソ フ ト
キーは、BBGを搭載

したN5182Aでのみ

使用できます。

1 N5162Aとフロン ト ・ パネル ・ ディスプレイを持つMXGとの違いは、 フロン ト ・ パネル、 ハードキー、 ソフ トキーの機能

が、 SCPIコマンドまたはWebイネーブルMXG経由でのみ使用できることです。 WebイネーブルMXGの詳細については、 『イ

ンス トール ・ ガイ ド』、 『プログラ ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照して く ださい。

ファイル・ タイプが認識された場合
は、 "Filename.xxx copied to Internal
Storage"が表示されます。
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 69



基本操作

ファイルの操作
機器ステート ・ ファイルの場合

• 「機器ステートの保存」 （71ページ）

• 「ユーザ ・ プ リセッ トの保存」 （71ページ）

• 「機器ステートの リ コール」 （71ページ）

• 「機器ステート と対応する波形ファイルのリ コール」 （72ページ）

• 「機器ステート と対応する リ ス ト ・ ファ イルのリ コール」 （72ページ）

• 「保存されている機器ステートの移動またはコピー」 （73ページ）

図3-11　Saveソフ トキーとRecallソフ トキー

ステート ・ ファ イルには、 以下の情報は保存されません。

システムのセキュ リ ティ ・ レベル リ ス ト ・ モード周波数 ホス ト名 リモート言語 FM偏移

システムのセキュ リ ティ ・ レベル表示 リ ス ト ・ モード ・ パワー IPアドレス FTPサーバ PM偏移

システムのセキュ リ ティ ・ レベル状態 リ ス ト ・ モード持続時間 サブネッ ト ・ マスク 手動DHCP MAC　

Webサーバ (HTTP) リ ス ト ・ モード ・ シーケンス デフォルト ・ ゲート ウェイ VXI–11 SCPI　 ユーザ ・ パワー補正

ソケッ ト SCPI (TELNET) ステート表示のオン／オフ ARBファイル リ ス ト ・ ファ イル I/Q校正データ

信号発生器に保存した機器設定 （ステート） は、 機器ステート ・ メ

モリに保存されます*。 機器ステート ・ メモリは10シーケンス （1～
9） に分割され、 各シーケンスは100個のレジスタ （00～99） から構

成されます。

SaveおよびRecall メニューの削除用ソフ トキーを使って、 特定のレ

ジスタの内容やステート ・ ファイル ・ カタログの全シーケンスの内

容を削除することができます。

削除の確認が必要です。

*注意
不揮発性メモリに恒久的に保存されていないデータ、 GPIB設定、 ま

たは現在のユーザ機器ステートが失われるのを防ぐために、 MXGの
電源をオフにするには、 必ずMXGのフロン ト ・パネルの電源ボタン

または適切なSCPIコマンドを使用して く ださい。 ラッ ク ・ システム

にインス トールされているMXGが、 MXGのフロン ト ・ パネル ・ ス

イッチでな く システム ・ ラ ッ クの電源スイッチにより電源をオフに

された場合は、 MXGの電源が適切にオフにされなかったためにError
-310が表示されます。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。
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 基本操作

ファイルの操作
機器ステートの保存

1. 信号発生器をプリセッ ト し、 以下を設定します。

2. （オプシ ョ ン、 ベク トル ・ モデルのみ） 波形ファイルをこれらの設定と対応付けます。

a. Mode > Dual ARB > Select Waveformを押します。

b. 目的のファイルを強調表示し、 Select Waveformを押します。 ファ イルがリ ス ト されていない場合は、 最初にファ

イルを内部／外部メディアからBBGメディアに移動する必要があ り ます （142ページを参照）。

3. 目的のメモ リ ・ シーケンス （この例の場合は1） を選択します ： Save > Select Seq > 1 > Enterを押します。

4. 目的のレジスタ （この例の場合は01） を選択します ： Select Reg > 1 > Save Regを押します。

波形が現在選択されている場合は、 機器ステート を保存する と波形ファ イル名へのポインタも保存されます。

5. 説明のコ メン ト をシーケンス1のレジスタ01に追加します。

Add Comment to Seq[1] Reg[01]を押してコ メン ト を入力し、 Enterを押します。 Recallを押すと、 Saved States リ ス トに

コ メン トが表示されます。 機器ステートに対応する波形がある場合は、 波形名をコ メン トに入力するこ とによ り、 ど

の機器ステートがどの波形に対応するかを簡単に確認できます。

ユーザ ・ プリセッ トの保存

ユーザ ・ プ リセッ トは、 特別な種類の機器ステート ・ ファ イルです。

1. 信号発生器をプリセッ ト し、 必要な設定を行います。

2. User Preset > Save User Presetを押します。

これによ り、 USER_PRESET とい う名前のステート ・ ファ イルが保存されます。 これはユーザ ・ プ リセッ ト情報を含

むものと して信号発生器に認識されます。

複数のプリセッ ト条件を異なる名前で保存できます。

1. ユーザ ・ プ リセッ ト を保存した後、 USER_PRESET以外の名前に変更します （73ページを参照）。

2. 必要な回数だけユーザ ・ プ リセッ ト を保存し、 そのたびにUSER_PRESETファ イルの名前を変更します。

3. 目的のファイルの名前をUSER_PRESETにします。

機器ステートのリコール

1. 信号発生器をプリセッ ト します。

2. Recallを押します。

Select Seqソフ ト キーによ り最後に使用したシーケンスが示されます。ディ スプレイには、そのシーケンスのレジスタ

に保存されているステートがすべて リ ス ト されます。 RECALL Regがアクティブ ・ エン ト リです。

3. 目的の機器ステート を選択します。

目的のステートが現在選択されているシーケンス内にリ ス ト されている場合は、 目的の番号 > Enterを押します。

リ ス ト されていない場合は、 Select Seq > 目的の番号 > Enter > RECALL Reg > 目的の番号 > Enterを押します。

 • 周波数 ： 800 MHz • 振幅 ： 0 dBm • RF ： オン
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基本操作

ファイルの操作
機器ステート と対応する波形ファイルのリコール

1. 目的のファイルが存在しているこ と、 BBGメディア内にあるこ とを確認して ください （142ページ）。

波形ファ イルがBBGメディア内にない場合は、 この手順を実行する とエラーが発生します。

対応する波形ファ イルを持つ機器ステート を リ コールしても、 波形名がリ コールされるだけです。 すでに削除されて

いる波形ファ イルが再現されたり、 内部またはUSBメディアにあるファイルがBBGメディアにロード されたりするこ

とはあ り ません。

2. 目的の機器ステート を リ コールします （前の例を参照）。

3. 機器ステート と一緒にリ コールする波形ファイルの名前を表示します ： Mode > Dual ARBを押します。

名前は、 選択した波形で表示されます。

4. 波形ファ イルをオンにします ： Mode > Dual ARB > ARB Off Onを押します。

機器ステート と対応するリス ト ・ ファイルのリコール

機器ステート を リ コールしても、 リ ス ト掃引のセッ ト アップがリ コールされるだけです。 周波数／振幅値はリ コールされ

ません。 リ ス ト ・ ファ イルはファ イル ・ カタログからロードするので、 リ ス ト ・ ファ イルを保存する際に、 わかりやすい

名前 （最長25文字） を付けるよ うにします。

1. 目的の機器ステート を リ コールします （前の例を参照）。

2. 必要な リ ス ト ・ ファ イルを リ コールします。

a. Sweep > More > Configure List Sweep > More > Load/Storeを押します。

b. 目的のファイルを強調表示し、 Load From Selected File > Confirm Load From Fileを押します。

測定器コ メン トのコ メン トの編集

Saveキーで保存した機器ステートのコ メン ト を変更するには、以下の手順を使用します。 これはStateカタログに表示され

るファ イル名 （ファ イルのメモ リ位置） とは異な り ます。

1. Saveを押します。

2. 目的のレジスタを強調表示します。

3. Edit Comment In Seq[n] Reg [nn]を押します。

4. ReSAVE Seq[n] Reg[nn]を押します。

これによ り、 以前に保存した機器ステート設定が新しいコ メン トで上書きされます。
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 基本操作

ファイルの操作
保存されている機器ステートの移動またはコピー

図3-12　機器ステート ・ ファイル ・ カタログ

ユーザ作成のステート ・ ファ イルのデフォルト名は、 ファ イルのメモ リ位置 （シーケンス とレジスタ） です。

ファ イルを移動するには、 目的のシーケンス とレジスタに名前を変更します。 既存のファイルと同じ名前を付けるこ とは

できません。ステート ・ファ イルの名前を有効でないシーケンス／レジスタ名に変更した場合は、SaveメニューにもRecall
メニューにもファイルは表示されません。

シーケンス レジスタ

信号発生器は、 USER_PRESETという名前のファイルだけをユーザ ・ プリセッ ト情報として認識します （71ページ）。
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基本操作

ファイルの操作
デフォルト記録メディアの選択

信号発生器がユーザ・ ファイルを内部記憶装置と外部USBメ ディ アのどちらに保存するかを設定できます。USBメ ディ アが接続

されているかどう かに応じてUSBメ ディ アと 内部記憶装置を自動的に切り 替えるには、Automatically Use USB Media If Present
を選択します。 測定器内部に機密情報を記憶するこ とを避けるには、 Use Only USB Mediaを選択します。 USB メディアに

機密情報を記憶するこ とを避けるには、 Use Only Internal Storageを選択します。

この選択は、 電源を入れ直してもプリセッ ト を行っても変更されません。

File > More >

現在の選択

測定器内部のメモリが使用され、 USBメディアは無視されます。

フロン ト ・パネルのUSBコネクタに接続されたメディアが使用され、内部記憶装置には

ユーザ ・ データは保存されません。

これは推奨される選択です。 USBメディアがフロン ト ・ パネルに接続されると、 USB
メディアが選択されます。 接続されていない場合は、 内部記憶装置が使用されます。

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。

USB メディ アが接続されて使用可能になったときにすべてのファイル操作に使用する

USBメディア上のディ レク ト リを選択します。
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 基本操作

エラー ・ メ ッセージの読込み
エラー ・ メ ッセージの読込み

エラー状態が発生した場合は、 信号発生器は、 フロン ト ・ パネル ・ディ スプレイ ・ エラー待ち行列とSCPI （ リ モート ・ イ

ンタフェース） エラー待ち行列の両方にレポート します。 これら 2つの待ち行列は、 個別に表示／管理されます。 SCPIエ
ラー待ち行列については、 『プログラ ミ ング ・ ガイ ド』 を参照してください。

エラー ・ メ ッセージの

フォーマッ ト

特性 フロン トパネル ・ディ スプレイ ・ エラー待ち行列

容量 （エラー数） 30

オーバーフロー処理 新しいエラーが入ってく るたびに、 最も古いエラーが破棄されます。

エン ト リの表示 以下を押します ： Error > View Next （または Previous） Error Page

待ち行列のク リ ア 以下を押します ： Error > Clear Error Queue(s)

未解決のエラーa

a解決する必要のあるエラー。 例えば、 アンロック。

待ち行列のク リ ア後に再レポート。

エラーなし

待ち行列が空の場合 （待ち行列内のすべてのエラーが読み込まれたか、 待ち行列がク リ アされた場合）、 以下のメ ッセージが

待ち行列に表示されます ：
No Error Message(s) in Queue 0 of 0

エラー番号 エラー ・ メ ッセージ
エラーの概要

（ディスプレイ上では省略される場合があります）

-222 Data out of range; value clipped to lower limit.

ユーザが特定のリ ミ ッ ト値を超える偏移、変調度または内部信号源周波数

を入力したことを示しています

説明はエラー ・ メ ッセージ ・ ファイルに出力されます （322ページを参照）

（測定器のディスプレイ上には表示されません）

メ ッセージ番号と詳しい説明

newは、直近のメ ッセージ表示後に作成され

たメ ッセージを示します。

このインジケータは、 未読メ ッセージを示します。

エラー ・ メ ッセージは、 発生と同時にディスプレイの
左下に表示されます。
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4 アナログ変調の使用法 （オプシ ョ ンUNTのみ）

注記 Mod On/OffハードキーとLED機能は、 オプシ ョ ンUNTがインス トールされたMXGでのみ有効です。

こ こに記載の内容を理解するには、 信号発生器の基本動作についての知識が必要です。 パワー ・ レベル／周波数の設定な

どの機能を簡単に操作できない場合は、 第3章 「基本操作」 （41ページ） を参照して、 内容をよ く理解してください。

• 「基本的な手順」 （78ページ）

• 「外部変調源の使用法」 （79ページ）

• 「DCオフセッ トの除去」 （79ページ）

• 「広帯域AMの使用」 （79ページ）

図4-1　アナログ変調用ソフ トキー

79ページ79ページ 79ページ

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。
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アナログ変調の使用法 （オプシ ョ ンUNTのみ）
基本的な手順
基本的な手順
1. 信号発生器をプリセッ ト します。

2. 搬送波(RF)周波数を設定します。

3. RF振幅を設定します。

4. 変調を設定します ：

5. 変調をオンにします ：

対応する変調インジケータが表示され、 変調がオンになったこ とが示されます。

6. RF出力をオンにします。

RF出力LEDが点灯し、 RF Outputコネク タから信号が送られているこ とが示されます。

変調が正常に行われていないよ うであれば、 「RF出力に変調がない」 （316ページ） を参照して ください。

「搬送波信号の変調」 （61ページ） も参照して ください。

AM FM  ΦM

a. AMを押す

b. AMタイプ （ リ ニアまたは指数関数） を設定する ：

AM Typeで目的のタイプを強調表示する

c. AMモード （ノーマルまたはディープ） を設定する。

デフォルトはディープ。 Normalを選択するには、 More

を有効にして目的のタイプを強調表示する。

d. AM変調度を設定する ： AM Depth > 値

デフォルト 0.01 ％

範囲 0.01～100 ％

e. 周波数を設定する ：

AM Rate > 値 > 周波数単位

a. FM/ΦMを押す

b. 偏移を設定する ：

FM Dev > 値 > 周波数単位

c. 周波数を設定する ：

FM Rate > 値 > 周波数 単位

a. FM/ΦM > FM ΦMを押す

b. BW （ノーマルまたはハイ） を設定する ：

FM ΦMで目的のタイプを強調表示する

c. 偏移を設定する ：

ΦM Dev > 値 > pi rad

d. 周波数を設定する ：

ΦM Rate > 値  > 周波数 単位

AM FM  ΦM

AM Off Onソフ ト キーをOn FM Off Onソフ ト キーをOn  ΦM Off Onソフ ト キーをOn
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 アナログ変調の使用法 （オプシ ョ ンUNTのみ）
外部変調源の使用法
外部変調源の使用法

DCオフセッ トの除去

外部から印加されたFMまたはΦM信号のオフセッ ト を除去するには、 DCFMまたはDCΦM校正を実行します。

注記 この校正は内部発生信号に対して実行するこ とはできますが、 DCオフセッ トは通常は内部発生信号の特性では

あ り ません。

1. 目的の変調を設定し、 オンにします。

2. FM/ΦM > More > DCFM/DCΦM Calを押します。

DC信号を印加して校正を行う こ とによ り、 DC信号による偏移がすべて除去され、 適用されたDCレベルが新しいゼロ基準

ポイン トにな り ます。 DC信号を切断する場合は、 校正を再度実行して、 搬送波を適切なゼロ基準にリセッ ト します。

広帯域AMの使用

広帯域AMは、 I/Q変調システムのI入力を使用します。 Q入力は、 1.0 Vでバイアスされている必要があ り ます。 広帯域AM
をオンにした場合は、 I/Qがオンになり、 I/Q信号源は外部に設定されます。 I/Qをオフにするか、 I/Q信号源を外部以外に

設定した場合は、 広帯域AMはオフになり ます。

AM 入力

リア ・パネルの入力については

次を参照 ： 15ページ

FM または ΦM 入力

デフォルト

外部変調を使用する場合に選択

現在選択されている変調。
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アナログ変調の使用法 （オプシ ョ ンUNTのみ）
外部変調源の使用法
図4-2　広帯域AMソフ トキー ・ メニュー

広帯域AMの設定

1. 目的の変調方式を設定し、 オンにします。

2. AM > More > AM WBを押してOnにします。

AM > More

広帯域AM機能をオン／オフ

にします。

注記： I/Qをオフにするか、 I/Q
信号源を外部以外に設定した

場合は、 広帯域AMはオフにな

ります。

各キーの詳細については、 42ページ

の説明に従ってキーのヘルプを使用

して く ださい。

広帯域AMがオンの場合は、 以下のフ ィールドが

アクティブになります。
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5 性能の最適化

注記 N5161A/62Aでは、 本書に記述されているソフ ト キー ・ メニューと機能は、 WebイネーブルMXGまたはSCPIコ
マンド経由でのみ使用できます。 WebイネーブルMXGの詳細については、 『インス トール ・ ガイ ド』、 『プログラ

ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照してください。

こ こに記載の内容を理解するには、 信号発生器の基本動作についての知識が必要です。 パワー ・ レベル／周波数の設定な

どの機能を簡単に操作できない場合は、 第3章 「基本操作」 （41ページ） を参照して、 内容をよ く理解してください。

• 「デュアル ・ パワー ・ メータ表示の使用」 （82ページ）

• 「フラ ッ ト ネス補正の使用」 （90ページ）

• 「内部チャネル補正の使用 （オプシ ョ ンU01以上が必要）」 （99ページ）

• 「外部レベリ ングの使用 （N5183Aのみ）」 （104ページ）

• 「レベリ ングなし動作モードの使用法」 （112ページ）

• 「出力オフセッ ト 、 基準、 乗数の使用」 （115ページ）

• 「フ リーラン、 ステップ持続時間、 タイマ ・ ト リ ガの使用」 （119ページ）

• 「LXIの使用 （オプシ ョ ンALB）」 （122ページ）

• 「USBキーボードの使用」 （128ページ）
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デュアル ・パワー ・ メータ表示の使用
デュアル ・パワー ・ メータ表示の使用

デュアル ・ パワー ・ メータ表示は、 1個または2個のパワー ・ センサの現在の周波数とパワーを表示するために使用できま

す。パワー・センサで測定された現在の周波数とパワーが、大きな中央のディ スプレイ と画面の右上コーナに示されます。

図5-2、 図5-2、 図5-3を参照して ください。

注記 デュアル・パワー・ メータ表示機能は、シ リ アル番号の前半部分がUS/MY/SG4818以上の測定器でのみ使用でき

ます。

MXGで2個のU2000 USBシ リーズ ・パワー ・ センサを使用するには、 USBハブ （電源付き） をMXGのフロン ト ・

パネルのUSBコネク タに接続します。

図5-1　パワー ・ センサAとBが校正されたデュアル ・パワー ・ メータ表示

パワー ・ メータの読み値
をオンにすると、 後で他
の測定器機能 （掃引、 AM
など） を選択しても、 読
み値は常に表示されてい
ます。

このエリアは、デュアル・パ
ワー ・ メータの校正周波数
と現在のパワー測定値のメ
イン ・ ディスプレイです。

チャネルAまたはチャネルB
のパワー ・ センサまたはそ
の両方が表示されていると
きに、 AMPTDまたはFREQソ
フ トキーを押すと、 大きい
パワー ・ メータ測定値が表
示されたままになります。

最初の接続の後で、 接続が
成功すると、 パワー ・ セン
サのモデル番号とシリアル
番号が表示されます。

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。
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 性能の最適化

デュアル ・パワー ・ メータ表示の使用
図5-2　デュアル ・ パワー ・ メータ表示メニュー

以下を参照 ： 84ページ

チャネルAのパワー ・ センサを
オンにします。

チャネルBのパワー・センサをオンにします。

チャネルBはチャネルA と同様に設定され
ます。 以下を参照 ： 84ページ

各キーの詳細については、 キーのヘルプを使
用して ください （42ページを参照）。
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デュアル ・パワー ・ メータ表示の使用
図5-3　パワー ・ センサ ・ チャネルの設定

AUX Fctn > Power Meter 
Measurements 

Sockets LAN ： IPポー ト を5025
（標準） または5023(telnet)プロ
グラ ミングに設定します。

パワー ・ メ ー タの IP ア ド レスまたは
LAN-GPIBゲートウェ イのIPアド レスを
設定します （Sockets LANおよびVXI–11
LANのみ）。

ソフ トキーが使用できるかどうかは、選択され

ているConnection Typeに応じて変化します。

VXI–11 LAN：使用中のパワー・
メータのデバイス名を入力す
るメニューを開きます。

以下のいずれかのパワー・ メータ
接続タイプをオンにします ：
Sockets LAN、 VXI–11 LAN、 USB

注記： VXI–11ソフ トキーは、GPIB
コネクタを備えたパワー・ メータ
と LAN-GPIBゲー ト ウェ イ経由で
リモー ト通信する場合に使用し
ます。

USB U2000Aシリーズ・パワー・セン
サを使用する場合は、センサの校正
は不要です。

MXGは、 USB U2000Aシリーズ ・ パ
ワー ・ センサの内部ゼロを使用し
ます。 USB U2000A シ リ ーズ ・ パ
ワー ・ センサのドキュ メ ン ト を参
照して く ださい。

Zero SensorおよびCalibrate Sensor
ソフ トキーは測定中は使用不可に
なります。

チャネルAが校正された周波数を選択し
ます。

パワー・センサが接続されている外部パ
ワー ・ メータのチャネルを選択します。

現在のチャネルのパワー ・ オフセッ ト
をdB単位で設定します。

アベレージングをオンにします。
デフォルトはAutoで1024ポイン トです。

注記 ： この図はチャネルAを示しますが、 チャネルBも同様です。

各キーの詳細については、 キーのヘルプを
使用して ください （42ページを参照）。
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 性能の最適化

デュアル ・パワー ・ メータ表示の使用
例 ： デュアル ・ パワー ・ メータ校正

以下の例では、 U2004A USBパワー ・ センサをチャネルAに、 N1912A Pシ リーズ ・ パワー ・ メータおよび8482Aパワー ・

センサをチャネルBに接続して、 必要に応じてゼロ調整と校正を行います。

MXGで ：

1. MXGでステップ掃引を設定します。 「掃引出力の設定」 （48ページ）

注意 先に進む前に、 RF出力パワーがオフになっているこ とを確認します。

2. チャネルAのパワー ・ センサの接続 ： USBセンサをMXGに接続します。 MXGの画面下部に、 以下のメ ッセージが表示

されます ： USB TMC488 device (USB POWER SENSOR,MY47400143) connected

図5-4　MXGがU2000 USBパワー ・ センサとの接続を表示

3. Aux Fctn > Power Meter Measurements > Channel A Setup > Connection Settings > Connection Type > USB Device (None) > 

USB POWER SENSOR (MY47400143)を押します。

4. Return > Zero Sensorを押します。

シ リ アル番号が異なるU2000シ リーズ ・ パワー ・ センサを最初にMXGに接続したと きに、 診断ダイアログ ・ ボッ クス

が表示されます （図5-5を参照）。 U2000がMXGに認識される と、 U2000パワー ・ センサはソフ ト キーと して測定器に

保存され、図5-5のダイアログ ・ボッ クスは表示されなくな り ます （このメ ッセージが表示された場合は、 DONEを押し

ます）。

図5-5　USBセンサの診断ダイアログ ・ ボックス

MXGにRunning Calibration(s)バーが表示されます。 図5-6 （86ページ） を参照して ください。
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デュアル ・パワー ・ メータ表示の使用
図5-6　Running Calibration(s)バー （センサのゼロ調整）

注記 U2000Aシ リーズUSB パワー ・ センサには50 MHz校正は不要です。 U2000シ リーズ ・ パワー ・ センサを校正し

よ う と した場合は、 MXGは以下のメ ッセージを表示します。

The U2000 series power sensor does not require a 50 MHz calibration.（U2000シ リーズ・パワー・

センサには50 MHz校正は不要です） 図5-7 （86ページ） を参照してください。

図5-7　U2000パワー ・ センサの診断ダイアログ ・ ボッ クス

5. Return > Return > Channel Aを押してOnにします。

現在のパワー・ メータのセンサ読み値が、測定器ディ スプレイのChA部分と、ディ スプレイの右上コーナのPower Meter
の下に表示されます。 図5-8を参照して ください。

各キーの詳細につい
ては、キーのヘルプを
使用して ください（42
ページを参照）。

各キーの詳細につい
ては、キーのヘルプを
使用して く ださい（42
ページを参照）。
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 性能の最適化

デュアル ・パワー ・ メータ表示の使用
図5-8　MXGに表示されたチャネルAのパワー ・ センサ

6. N1912A Pシ リーズ ・パワー ・ メータ （チャネルBのパワー ・ センサ） で ： N1912A Pシ リーズ ・パワー ・ メータをLAN
に接続します。

7. パワー ・ メータのセンサをパワー ・ メータのチャネルBに接続します。

注記 N1912Aでは、 必須ではあ り ませんが、 チャネルBを使用するこ とをお勧めします。 これは、 MXGのデュアル ・

ディ スプレイ との一貫性のためです。この例では、MXGのチャネルAはU2004Aによ りすでに使用されています。

8. パワー ・ センサの入力をパワー ・ メータの50 MHz基準に接続します。

9. Channel B Setupを押します。

10. Connection Settings > Socketsを押します。

11. IP Address > IP address > Enterを押します。

注記 パワー ・ メータのIPアドレスがディ スプレイのChBセクシ ョ ンに表示されます。

図5-9　チャネルBのパワー ・ センサのIPアドレスの入力

12. Return > Channel Settings > External Power Meter Channelを押してBにします。

各キーの詳細につい
ては、キーのヘルプを
使用して ください（42
ページを参照）。

各キーの詳細につい
ては、キーのヘルプを
使用して く ださい（42
ページを参照）。
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13. MXGで ： Channel Bを押してOnにしてから、 Offに戻します。 これによ り、 MXGが外部パワー ・ メータに対して初期

化されます。

14. Return > Zero Sensorを押します。

外部パワー ・ メータの使用中にZero SensorまたはCalibrate Sensorソフ ト キーを押すと、 診断ダイアログ ・ ボッ クス

が表示されます （図5-10 （88ページ） を参照）。

パワー ・ センサがパワー ・ メータの50 MHz基準に接続されているこ とを確認します。

図5-10　チャネルBの診断ダイアログ ・ ボッ クス

15. Doneを押します。

Running Calibration(s)バーに次のよ うに表示されます：Zeroing Sensor Please wait... （センサのゼロ調整

中、 お待ちください…）

16. Running Calibration(s)バーが消えたら ： Calibrate Sensorを押します。

パワー ・ センサがパワー ・ メータの50 MHz基準に接続されているこ とを確認するために、 診断ダイアログ ・ ボッ クス

が表示されます （図5-11 （88ページ） を参照）。

図5-11　校正用の診断ダイアログ ・ ボックス

各キーの詳細につい
ては、キーのヘルプを
使用して く ださい（42
ページを参照）。

各キーの詳細につい
ては、キーのヘルプを
使用して ください（42
ページを参照）。
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デュアル ・パワー ・ メータ表示の使用
17. Doneを押します。

校正の進捗度バーが表示されます。 図5-12 （89ページ） を参照してください。

図5-12　Running Calibration(s)バー （センサの校正）

18. Return > Channel Bを押してOnにします。

19. 現在のパワー ・ メータのセンサ読み値が、 MXGのディ スプレイのChB部分と、 ディ スプレイの右上コーナのPower 
Meterの下と、 パワー ・ メータのパワー ・ センサ読み値の左側に表示されます。

図5-13　MXGに表示されたチャネルBのパワー ・ センサ

20. これで、 パワー ・ センサを測定セッ ト アップに接続できるよ うにな り ました。

各キーの詳細につい
ては、キーのヘルプを
使用して く ださい（42
ページを参照）。

各キーの詳細につい
ては、キーのヘルプを
使用して ください（42
ページを参照）。
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フラッ トネス補正の使用

ユーザ・フラ ッ ト ネス補正によ り、最大1601個の連続する リニア間隔または任意間隔の周波数ポイン トのRF出力振幅をデ

ジ タル調整し て、 ケーブル、 ス イ ッ チま たはその他のデバイ スの外部損失を補正する こ と がで き ます。 Agilent
N1911A/12A、 E4419A/B、 またはU2000シ リーズ ・パワー ・ メータ／センサを使用して測定システムを校正するこ とによ

り、 パワー ・ レベルの変動や損失が発生する周波数に対してパワー ・ レベル補正テーブルを自動的に作成できます。 パ

ワー ・ メータ／センサに対する接続タイプと しては、 ソケッ ト LAN、 VXI–11 LAN、 USB、 GPIB （E5810Aまたは同等の

LAN–GPIBゲート ウェイを使用したVXI–11 LAN経由） がサポート されています。

注記 GPIB接続のパワー・ メータを制御するには、 Connection Type VXI–11ソフ ト キーとLAN-GPIBゲート ウェイを

使用する必要があ り ます。 『Agilent Connectivity Guide USB/LAN/GPIB Connectivity Guide』 (E2094–90009)、
Agilent MXG FAQ “How do I connect to the LAN?”、E5810Aまたは同等のLAN/GPIBゲート ウェイの 『ユーザー

ズ ・ ガイ ド』 を参照してください。

Agilent N1911A/12AまたはE4419A/Bパワー ・ メータ、 またはU2000A/01A/02A/04Aパワー ・ センサがない場合、 または

お使いのパワー・ メータにLAN、 GPIB、 またはUSBインタフェースがない場合は、補正値を手動で信号発生器に入力でき

ます。

テス ト ・ セッ ト アップや周波数レンジごとに異なる補正配列を使用するには、 個々のユーザ ・ フラ ッ ト ネス補正テーブル

を信号発生器のメモ リ ・ カタログに保存し、 必要に応じて リ コールします。

以下のセクシ ョ ンの手順で、ユーザ・ フラ ッ ト ネス補正を作成して信号発生器のRF出力に適用します （94ページを参照）。

その後、 「ユーザ ・ フラ ッ ト ネス補正配列のリ コールおよび適用」 （98ページ） の手順を実行して、 メモ リ ・ カタログから

ユーザ ・ フラ ッ ト ネス ・ ファ イルを リ コールし、 信号発生器のRF出力に適用します。
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フラッ トネス補正の使用
図5-14　ユーザ ・ フラ ッ トネス補正用のソフ トキー

確認

各キーの詳細については、 42ページの説明に
従ってキーのヘルプを使用して ください。

94ページ

を参照

ユーザ ・

フラ ッ トネス

校正を開始し

ます。
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ユーザ ・ フラ ッ トネス補正配列の作成

この例では、 ユーザ ・ フラ ッ ト ネス補正配列を作成します。 フラ ッ ト ネス補正配列には、 500 MHz～1 GHzの10個の周波

数補正ペア （指定された各周波数での振幅補正値） が含まれています。

Agilent N1911A/12AまたはE4419A/Bパワー ・ メータ と E4413Aパワー ・ センサを使用して、 指定された補正周波数でRF
出力振幅を測定し、 結果を信号発生器に転送します （パワー・ メータおよびE4413Aパワー・センサの代わりに、 U2000シ
リーズ ・パワー ・ メータ／センサを使用するこ と もできます）。 信号発生器は、 パワー ・ レベル ・データをパワー ・ メータ

から読み取り、 補正値を計算し、 補正ペアをユーザ ・ フラ ッ ト ネス補正配列に記録します。

必要なAgilentパワー ・ メータがない場合、 またはパワー ・ メータにLAN、 GPIB、 またはUSBインタフェースがない場合

は、 補正値を手動で入力します。

注記 N5183Aで、 セッ ト アップが外部レベリ ング構成を使用している場合は、 「必須機器」 （92ページ） の機器セッ ト

アップは、 RF出力のレベルを正し く調整するための手順がすでに実行されているこ とを仮定しています。 外部

レベリ ングの詳細については、 「外部レベリ ングの使用 （N5183Aのみ）」 （104ページ） を参照してください。

必須機器

• Agilent N1911A/12AまたはE4419A/Bパワー ・ メータ （U2000A/01A/02A/04Aパワー ・ センサにはパワー ・ メータは

不要）

• Agilent E4413A Eシ リーズCWパワー ・ センサまたはU2000A/01A/02A/04Aパワー ・ センサ

• 必要なGPIB、 LAN、 またはUSBインタフェース ・ ケーブル

• 必要なアダプタ とケーブル

注記 各パワー ・ メータ／センサの操作方法については、 それぞれの操作ガイ ドを参照してください。

機器の接続

「機器の接続」 （93ページ） に示すよ うに機器を接続します。

注記 ユーザ ・ フラ ッ ト ネス補正配列の作成中は、 パワー ・ メータは信号発生器から リモート制御されます。
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機器の接続

• Agilent N1911A/12AまたはE4419A/Bパワー ・ メータa

• Agilent U2000A/01A/02A/04Aパワー ・ センサa

a動作情報については、 パワー ・ メータ／センサのドキュ メン ト を参照して く ださい。

• 必要なLAN、GPIB、またはUSBインタフェー

ス ・ ケーブル

• 必要なアダプタ とケーブル

LAN、GPIB*、USB接続は、便宜のためです。パワー・

メータにLAN、 GPIB、 USBがない場合は、 このセ

クシ ョ ンの補正値入力の手順に従って、 手動で補

正値を入力します。

*パワー ・ メータをGPIB制御するには、 LAN-GPIBゲートウェ

イを使用し、接続タイプと してVXI–11を選択する必要があり

ます。 『Agilent Connectivity Guide USB/LAN/GPIB Connectivity
Guide』(E209490009)、Agilent MXG FAQ “How do I connect to the
LAN?”、E5810Aまたは同等のLAN/GPIBゲートウェイの『ユー

ザーズ ・ ガイ ド』 を参照して く ださい。

パワー ・ センサ

パワー ・ メータ

（該当する場合）

信号発生器

被試験デバイス

出力 入力

入力ポート

RF出力

ケーブル
およびその他の

デバイス

フラ ッ トネス
補正済み
出力ポート

LAN/

注記：Agilent U2000シリーズUSBパワー・

センサは、信号発生器のフロン ト ・パネ

ルのUSBポー ト に直接接続します （パ

ワー ・ メータは使用しません）。

USB互換パワー・メータ／センサ
（N1911A/12A パワー ・ メ ータ、
U2000AシリーズUSBパワー ・ セ
ンサなど）を接続するためのUSB
ポート

GPIB
E5810A
LAN/GPIBゲートウェイ
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図5-15　Configure Power Meterメニューのソフ トキー

基本的な手順

1. ユーザ ・ フラ ッ ト ネス配列を作成します。

a. パワー ・ メータ／センサを設定します。

b. 機器を接続します。

c. 信号発生器を設定します。

d. ユーザ ・ フラ ッ ト ネス補正値を入力します。

2. 必要に応じて、 ユーザ ・ フラ ッ ト ネス補正データを保存します。

3. ユーザ ・ フラ ッ ト ネス補正をRF出力に適用します。

AMPTD > More > User 
Flatness > Configure 
Power Meter

Sockets LAN ： IPポー ト を5025
（標準） または5023(telnet)プロ
グラ ミングに設定します。

パワー・ メータのIPアドレスまた
はLAN–GPIBゲートウェイのIPア
ド レ ス を 設定 し ます （Sockets
LANおよびVXI–11 LANのみ）。

このソフ トキーは、選択されてい

るConnection Typeに応じて変化し

ます。

VXI–11 LAN：使用中のパワー・
メータのデバイス名を入力す
るメニューを開きます。

以下のいずれかのパワー ・ メータ
接続タイプをオンにします ：
Sockets LAN、 VXI–11 LAN、 USB

注記：VXI–11ソフ トキーは、GPIBコ
ネク タを備えたパワー ・ メータ と
LAN-GPIB ゲー ト ウ ェ イ経由で リ
モート通信する場合に使用します。

USB U2000A シ リ ーズ ・ パワー ・
メータを使用する場合は、センサ
の校正は不要です。

各キーの詳細につい
ては、キーのヘルプを
使用して ください（42
ページを参照）。

USBデバイス
名を入力する
メニューを開
きます。
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U2000A/01A/02A/04Aパワー ・ センサの設定

1. パワー ・ センサを信号発生器のフロン ト ・ パネルのUSBポートに接続します。 「機器の接続」 （93ページ） を参照して

ください。

2. 信号発生器のソフ ト キーを使用して、 パワー ・ センサのゼロ調整を行います。

注意 パワー ・ メータのゼロ調整を行う前に、 信号発生器のRF出力パワーが必要な振幅に設定されているこ とを確認

します。 信号発生器はゼロ調整の際にRF出力振幅をチェッ ク しません。

注記 信号発生器のRF Output LEDは、 パワー・センサのゼロ調整中には変化しません （例えば、 パワー・センサのゼ

ロ調整を開始する前にRF Output LEDがオンになっていた場合は、ゼロ調整／校正中もLEDはオンのままです）。

ただし、 実際には測定器ファームウェアがRF出力パワーをオフにしています。

各パワー ・ センサの操作方法については、 それぞれの操作ガイ ドを参照してください。

E4419A/BおよびN1911A/12Aパワー ・ メータの設定

1. パワー ・ メータの リモート言語と してSCPIを選択します。

2. 信号発生器のソフ ト キーまたはパワー ・ メータのフロン ト ・ パネルを使用して、 パワー ・ センサのパワー ・ メータに

対するゼロ調整と校正を行います。

3. 必要に応じて、 パワー ・ センサの校正係数をパワー ・ メータに入力します。

4. パワー ・ メータの校正係数配列をオンにします。

注記 信号発生器のRF Output LEDは、 パワー・センサのゼロ調整中には変化しません （例えば、 パワー・センサのゼ

ロ調整を開始する前にRF Output LEDがオンになっていた場合は、ゼロ調整／校正中もLEDはオンのままです）。

ただし、 実際には測定器ファームウェアがRF出力パワーをオフにしています。

各パワー ・ メータ／センサの操作方法については、 それぞれの操作ガイ ドを参照してください。

例 ： 500 MHz～1 GHzのフラッ トネス補正配列 （10個の補正値）

ユーザ ・ フラ ッ ト ネス配列の作成

1. 信号発生器を設定します。

a. 信号発生器をプリセッ ト します。

b. 信号発生器の接続タイプをパワー ・ メータ／センサに合わせて設定します。

i. AMPTD > More > User Flatness > Configure Power Meter > Connection Type > 接続タイプを押します。

ii. 接続タイプがUSBの場合 ：

1. センサのゼロ調整を行います。

2. ステップcに進みます。
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それ以外の場合

Sockets LANまたはVXI–11 LANの場合 ： Power Meter IP Address > パワー ・ メータまたはLAN–GPIBゲート

ウェイのIPアドレス > Enterを押します。

iii. Sockets LANの場合 ： Power Meter IP Port > IPポート  > Enter

それ以外の場合

VXI–11の場合 ： PM VXI–11 Device Name > デバイス名 > Enterを押します。

パワー ・ メータに直接接続する場合は、 デバイス名はパワー ・ メータのドキュ メ ン トに指定されている通り

に入力します。 通常これはinst0であ り、 パワー ・ メータによって大文字小文字が区別されます。 パワー ・

メータのドキュ メ ン ト 、 『Agilent Connectivity Guide USB/LAN/GPIB Connectivity Guide』 (E209490009)、
Agilent MXG FAQ “How do I connect to the LAN?”を参照してください。

LAN–GPIBゲート ウェイ経由で接続する場合は、 パワー ・ メータのSICLアドレスを入力します。 通常これは

gpib0,13です。 こ こで、 gpib0はゲート ウェイのGPIB SICLインタフェース名であ り、 13はパワー ・ メータ

のGPIB ア ド レ スです。 『Agilent Connectivity Guide USB/LAN/GPIB Connectivity Guide』 (E209490009)、
Agilent MXG FAQ “How do I connect to the LAN?”、 E5810Aまたは同等のLAN/GPIBゲート ウェイの 『ユー

ザーズ ・ ガイ ド』 を参照して ください。

c. ユーザ ・ フラ ッ ト ネス ・ テーブル ・ エディ タを開き、 校正配列をプリセッ ト します ：

Return > Configure Cal Array > More > Preset List > Confirm Preset with Defaultsを押します。

d. Step Arrayメニューで、 必要なフラ ッ ト ネス補正済みスタート／ス ト ップ周波数とポイン ト数を入力します ：

e. ユーザ ・ フラ ッ ト ネス補正配列に前のステップで設定したステップ配列を設定します ：

Return > Load Cal Array From Step Array > Confirm Load From Step Dataを押します。

f. 出力振幅を0 dBmに設定します。

g. RF出力をオンにします。

More > Configure Step Array >

Freq Start > 500 > MHz >

Freq Stop > 1 > GHz >

# of Points > 10 > Enter

を押します。
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2. パワー ・ メータをRF出力に接続して、 補正値を入力します ：

ユーザ ・ フラ ッ ト ネス補正配列のタイ トルにはUser Flatness:(UNSTORED)と名前なしで表示されます。 これは、現

在のユーザ ・ フラ ッ ト ネス補正配列のデータがファイル ・ カタログに保存されていないこ とを示します。

オプシ ョ ン ： ユーザ ・ フラ ッ ト ネス補正データの保存

1. Load/Store > Store to Fileを押します。

2. ファイル名 （この例の場合は、 FLATCAL1） を入力し、 Enterを押します。

ユーザ・ フラ ッ ト ネス補正配列ファイルがUSERFLATファイルと してファ イル ・ カタログに保存されます。 カタログに

保存されているユーザ ・ フラ ッ ト ネス補正ファ イルを リ コールし、 補正配列にロード し、 RF出力に適用するこ とで、

特定のRF出力フラ ッ ト ネス要件を満たすこ とができます。

3. Returnを押します。

RF出力でのフラ ッ ト ネス補正

• Return > Flatness Off Onを押します。

UFインジケータがディ スプレイのAMPLITUDEエリアに表示され、 配列の補正データがRFに適用されます。

LAN、 GPIB、 USB接続のパワー ・ メータの場合 手動

i. 補正値を作成します ：

More > User Flatness > Do Calを押します。

信号発生器がユーザ ・ フラ ッ ト ネス校正を開始し、

進捗度バーを表示します。

振幅補正値が自動的にユーザ ・ フラ ッ ト ネス補正配列に

ロード されます。

ii. 記録された振幅補正値を表示します ：

Configure Cal Arrayを押します。

i. ユーザ ・ フラ ッ ト ネス ・ テーブル ・ エディ タを開き、

行1の周波数値を強調表示します ：

More > User Flatness > Configure Cal Arrayを押します。

RF出力が、 カーソルを含むテーブル行の

周波数値に変化します。

ii. パワー ・ メータの測定値を書き留めます。

iii. 差の値の符号を変えます （例えば、 0 dBm基準値 （ステップf） と

iiでの測定値の差が–0.34の場合は、 値を＋0.34に変えます）。

iv. 行1の補正値を強調表示します。

v. 以下を押します。

Select > ステップiiiで計算した差を入力 > dBを押します。

（この例では＋0.34を入力します）

入力した補正値に基づいて、 信号発生器の出力振幅が

調整されます。

vi. パワー ・ メータの読み値が0 dBmになるまでステップii～vを
繰り返します。

vii. 以下の行の周波数値を強調表示します。

viii. 残りの行に対して、 ステップii～viiを繰り返します。
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 97



性能の最適化

フラッ トネス補正の使用
ユーザ ・ フラ ッ トネス補正配列のリコールおよび適用

以下の例は、 ユーザ ・ フラ ッ ト ネス補正配列が作成／保存されているこ とを前提条件と します。 作成／保存していない場

合は、 「例 ： 500 MHz～1 GHzのフラ ッ ト ネス補正配列 （10個の補正値）」 （95ページ） を実行して ください。

1. 信号発生器をプリセッ ト します。

2. 必要なユーザ ・ フラ ッ ト ネス補正ファイルを リ コールします ：

a. AMPTD > More > User Flatness > Configure Cal Array > More > Preset List > Confirm Presetを押します。

b. More > Load/Storeを押します。

c. 目的のファイルを強調表示します。

d. ユーザ ・ フラ ッ ト ネス補正配列に選択したファ イルに含まれているデータを設定します ：

Load From Selected File > Confirm Load From Fileを押します。

ユーザ ・ フラ ッ ト ネス補正配列のタイ トルにはUser Flatness: Name of Fileと表示されます。

3. 配列内の補正データをRF出力に適用します ： Return > Flatness Off Onを押してOnにします。
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内部チャネル補正の使用 （オプシ ョ ンU01以上が必要）

内部チャネル補正機能は、任意の中心周波数に対して、100 MHzベースバンド帯域幅のフラ ッ ト ネス と位相を補正します。

この機能はデフォルトではオフであ り、 オンにする と測定器のスイ ッチング速度性能が低下します。

この校正は、 前回の校正時の周囲温度から±5 ℃以上の周囲温度変化があった場合に実行すべきです。

注記 オプシ ョ ン 651、 652、 654のいずれかを搭載した機器では、 内部校正ルーチンを実行して、 ベースバンド と RF
の振幅／位相誤差に関する補正データをRF周波数レンジ全体に渡って収集できます。少な く と も1回補正を実行

した後でなければ、 内部チャネル補正をオンにするこ とはできません。

ファームウェア ・ バージ ョ ンがA.01.60以上の新しい測定器では、 内部フラ ッ ト ネス補正校正は出荷時にすでに

実行されています。

この機能がオフの場合は、 機器の動作はこれまでと同じです。 この機能がオンで、 内部I/Q経路がアクティブであ り、 I/Q
補正最適化経路がRF出力のと きに、 周波数が1 kHzよ り大き く変更された場合は、 ファームウェアは指定された周波数か

ら±50 MHzのチャネル補正フ ィルタを計算します。 リ ス ト／掃異なるでは、波形掃引がアクティブであるか、ベースバン

ドがオンで測定器が内部経路に最適化されている場合は、 この計算は指定された周波数を使用した最初の掃引の前に行わ

れます。 この計算は、 キャ ッシュ ・ ポイン トの最大数(256)まで補正値をキャ ッシュします。 リ ス ト／掃引では、 再実行前

に掃引が休止し、 補正キャ ッシュが再計算されます。

注意 任意周波数スイ ッチングの場合は、 補正キャ ッシュがいっぱい （256個の異なる周波数ポイン ト ） になる と、 新

しい周波数が選択されたと きに最も古い周波数補正値が消去されます。

I/Q Timing Skew、 I/Q Delay、 Quadrature Angle Adjustment、 Int Equalization Filterのいずれかを調整した場

合は、 すべてのキャ ッシュが消去されます。

内部チャネル補正のその他の特性 ：

• 内部チャネル補正がオンの場合は、 ベースバンドがオンのと きの任意周波数スイ ッチングには、 その周波数が最初に

指定されたと きに最大290 ms （代表値72 ms） の時間が追加でかかり ます。 2回目以降にその周波数が選択されたと き

には、 スイ ッチングにかかる追加の時間は1 msです。

• 周波数掃引をアクティブにした場合は、 最初の256個の異なる周波数に対する計算とキャ ッシングが最初に実行され、

それ以降の異なる周波数は任意周波数スイ ッチングと同じ動作をします。

• I/Q Correction Optimized Pathソフ ト キーがExt I/Qに設定されている場合は、 ベースバンド補正のみが適用され、 周

波数スイ ッチングは影響されません。

• ACP内部I/Qチャネル最適化フ ィルタ と イコラ イゼーシ ョ ン ・ フ ィルタがオンの場合は、 これらは内部チャネル補正と

畳み込み演算されます。 ハミ ング窓が適用され、 結果のフ ィルタが256タ ップに切り詰められます。
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図5-16　内部チャネル補正用のソフ トキー

内部チャネル補正の設定

MXGの内部チャネル補正を使用するための基本的な設定を以下に示します。 図5-16を参照してください。

MXGで ：

1. 中心周波数を設定します。

Freq > 3 > GHzを押します。

2. I/Qを内部 （デフォルト ） に設定します ：

I/Q > I/Q Source > Internalを押します。

3. I/Qを押してOnにします。

4. 内部チャネル補正を実行します ：

More > Int Channel Correction > Execute Calを押します。

5. Int Channel Correction to Onを押します。

SCPIコマンド ：

[:SOURce]:DM:INTernal:CHANnel:CORRection[:STATe] ON|OFF|1|0
[:SOURce]:DM:INTernal:CHANnel:CORRection[:STATe]?
:CALibration:BBG:CHANnel 各キーの詳細については、 キーのヘルプを使用し

て く ださい （42ページを参照）。

このソフ トキーは、内部チャネル補正が以
前に実行された場合のみ使用可能です。現
在の周波数から100 MHzのベースバン ド
帯域幅にわたる現在のRF/ベースバン ド
振幅／位相補正をオン／オフします。

注意：この機能をオンにした場合は、ベー
スバン ド をオンに した と きの周波数ス
イッチングには、その周波数が最初に指定
されたときに、 290 ms （代表値72 ms） の
時間が追加でかかります。 2回目以降にそ
の周波数が選択されたときは、スイッチン
グにかかる追加の時間は1 msです。

100 MHzのベースバンド帯域幅にわたる内
部ベースバンド ・ ジェネレータのRF/ベー
スバン ド振幅／位相補正の内部校正を開
始します。

I/Q > More
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I/Q変調スキュー校正の使用

I/Q変調スキュー校正は、 I/Q変調器 （RF出力経路） のI/Qタイ ミ ング ・ スキューの外部校正を開始します。 この機能によ

り、 チャネル外イ メージ除去が改善されます。

この校正を実行するには、 測定器のRF出力をスペク ト ラム ・ アナライザのRF入力に接続する必要があ り ます。

注記 この校正は、 ハード ウェアの特定の組み合わせに対して1回だけ実行する必要があ り ます。

ファームウェア ・ リ リースA.01.60以降を搭載した測定器の場合は、 測定器内部のハード ウェアを修理または交

換しない限り、 この校正は実行する必要はあ り ません。

A.01.60ファームウェアのリ リースよ り前に出荷された測定器の場合は、 フル内部チャネル補正機能をオンにす

るには、 オプシ ョ ンR2C ： コア ・ ファームウェア機能拡張A.01.60以降を購入する必要があ り ます。 これは、 内

部ベースバンド ・ジェネレータのRF/ベースバンド振幅／位相をすべてのRF周波数で100 MHzのベースバンド帯

域幅に渡って補正するものです。

ファームウェア ・ リ リースA.01.60よ り前に出荷された測定器にオプシ ョ ンR2C ： コア ・ ファームウェア機能拡

張A.01.60以降をインス トールした場合は、内部チャネル補正機能でフル補正を実現するには、校正を1回実行し

ておく必要があ り ます。
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図5-17　 I/Q変調スキュー校正用ソフ トキー

SCPIコマンド ：

:CALibration:BBG:SKEW:RFOut

各キーの詳細については、 キーのヘルプを
使用して ください （42ページを参照）。

ステータス ・ウィ ンドウに、校正の
現在の状態と、校正の実行手順が表
示されます。

Configure Spectrum Analyzerキーで設定
されたスペク ト ラム・アナライザを使用
して、 I/Q変調器 （RF出力経路） のI/Qタ
イ ミ ング・スキューの外部校正を開始し
ます。

I/Q > More > Int Channel Correction (Option U01)
または

I/Q > More > I/Q Mod Skew Cal

このキーの詳細については、 図5-18を
参照して く ださい。
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図5-18　SA Configソフ トキー

各キーの詳細については、 キーのヘルプを
使用して く ださい （42ページを参照）。

SCPIコマンド ：

:SYSTem:SANalyzer:COMMunicate:TYPE SOCKets|VXI11
:SYSTem:SANalyzer:COMMunicate:LAN:DEVice <"deviceName">
:SYSTem:SANalyzer:COMMunicate:LAN:DEVice?
:SYSTem:SANalyzer:COMMunicate:LAN:IP <"ipAddr">
:SYSTem:SANalyzer:COMMunicate:LAN:IP?
:SYSTem:SANalyzer:COMMunicate:LAN:PORT <portNum>
:SYSTem:SANalyzer:COMMunicate:LAN:PORT?
:SYSTem:SANalyzer:COMMunicate:TYPE SOCKets|VXI11
:SYSTem:SANalyzer:COMMunicate:TYPE?

ステータス ・ ウィ ンドウには、 スペク ト ラム ・
アナライザの接続ステータスが表示されます。

指定した外部スペク ト ラム ・ アナライザ
を接続し、"*IDN?"SCPIコマンドの実行を
試みます。 結果が"Connected, but no
'*IDN?' response"の場合は、IPアドレスは
どこかにつながっていますが、ソケッ ト・
ポートまたはVXI-11デバイス名が正し く
ありません。

現時点で認識されるスペク ト ラム ・ アナ
ライザのモデルは以下のとおりです ：
E4440A、 E4443A、 E4445A、 E4446A、
E4448A、 N9020A

I/Q > More > Int Channel Correction > Int Chan Corr

スペク ト ラム ・ アナライザの接続タイプ
をソケッ ト (LAN)に設定します。

スペク ト ラム ・ アナライザの接続タイプ
をVXI-11(LAN)に設定します。 この接続タ
イプは、 GPIBスペク ト ラム ・ アナライザ
をLAN-GPIBゲー ト ウェ イ経由で接続す
るためにも使用できます。
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外部レベリングの使用 （N5183Aのみ）

注意 外部レベリ ング ・ モードで動作している場合は、 信号発生器とディテクタの間のRFまたはDC接続に異常がある

と、信号発生器の最大パワーが発生する可能性があ り ます。 この場合は、被試験デバイスに過大な負荷がかかる

おそれがあ り ます。

外部レベリ ングでは、ALCフ ィードバッ ク信号源を被試験デバイス(DUT)の近くに移動して、テス ト ・セッ ト アップのケー

ブルやコンポーネン トに固有のパワーの不確かさのほとんどを考慮するこ とができます。 図5-19を参照して ください。

Ext Detectorを選択すると、 Atten HoldはOnに設定され、 グレー表示 （非アク
テ ィブ） になります。 Internalを選択すると、 ソフ トキーはアクテ ィブにな
りますが、 アッテネータ ・ ホールドはオンのままです。 必要に応じて、 手
動でオフにします。

オプシ ョ ン1E1機能：Ext Detectorを選択した場合は、Set Attenは出力パワー・
レベルに影響しません。 外部ディテクタの使用中に、 負のdBmパワー ・ レ
ベルを使用する場合は、 アッテネータを使用してALCパワー ・ レベルを約0
dBmに維持します。 107ページを参照して ください。

これらの設定は、 MXGの出力パワー振幅を変更しません。単
に、 カップラ／スプリ ッ タの出力で測定されるパワー ・ レベ
ルにできるだけ近く なるように、 フロン ト ・パネルに表示さ
れる振幅値を変更するだけです。 111ページを参照して く だ
さい。

このソフ トキーは、 Ext Detectorが選択されている場合のみ使用できます。
これは、 ゼロ基準点として16 dBを使用します。
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図5-19　ALC回路

外部ディテク タは、 ディテク タでのパワー ・ レベルに基づいて、 信号発生器のリ ア ・パネルのALC INPUTコネク タに負電

圧を出力します。 カップラ／パワー ・ スプ リ ッ タ入力でのRFパワー ・ レベルが変化する と、 外部ディテク タは補正のため

の負電圧を返します。 ALC回路は、 この負電圧を使用して信号パワーを増減するこ とによ り、 RF出力パワーをレベリ ング

します。 これによ り、 検出ポイン ト （外部ディテク タ） でのパワー ・ レベルが一定に保たれます。 検出ポイン トはディテ

クタが接続されているデバイスの出力とは異なる位置にあるので、 外部ディテクタでは補正されないパワー損失が多少存

在します。 例えば、 カップラの場合は、 結合ポートが外部ディテクタをド ライブするために信号エネルギーの一部を消費

します。 さ らに、 カップラの結合ポート と出力との間には挿入損失があ り ます。

図5-21 （107ページ） に、Agilentの代表的なダイオード ・ディテク タの入力パワー対出力電圧特性を示します。 このチャー

ト を使用する と、 外部ディテク タの出力電圧を測定するこ とによ り、 ダイオード ・ ディテク タの入力でのレベリ ングされ

たパワーを決定できます。 カップラの場合は、 レベリ ングされた出力パワーを決定するには結合係数を加算する必要があ

り ます。

外部ディテク タを使用する場合は、 信号発生器のパワー出力範囲がデータシートに記載された値と異なる可能性があ り ま

す。 これは主に、 ディテク タの効率が原因です。 ディテク タ、 カップラ／パワー ・ スプ リ ッ タの仕様が、 目的のパワー／

周波数レンジをカバーするこ とを必ず確認して ください。 外部レベリ ング使用時の信号発生器の実際のパワー出力範囲を

決定するには、 「信号発生器の振幅範囲の決定」 （109ページ） を参照して ください。

外部レベリ ングを使用した場合は、 表示される振幅値は、 外部ディテク タが接続されているカップラ／パワー ・ スプ リ ッ

タの実際の出力パワーと大幅に異なる可能性があ り ます （図5-20を参照）。 これは、 カップラ／パワー・ スプ リ ッ タ自体の

信号特性 （挿入損失、 結合係数など） が信号発生器にとって不明なので、 正確な振幅値を表示できないからです。 また、

信号発生器と外部ディテク タの間にあるコンポーネン ト も、 カップラ／パワー ・ スプ リ ッ タの出力パワーに影響するこ と

があ り ます。このパワー表示値の不一致を補正するには、Ext Leveling Amptd Offsetソフ ト キーまたはAmptd Offsetソフ ト キー

を使用します。 この2つのソフ ト キーの違いは、 Ext Leveling Amptd Offsetが外部レベリ ングがオンのと きだけ機能するこ と

です。 外部レベリ ング ・ オフセッ ト機能の使用法の詳細については、 「信号発生器の表示振幅値の調整」 （111ページ） を

参照して ください。

外部ディテクタ

パワー・スプリ ッ タ

コンポーネン ト

DUT
RF 出力

ケーブル

ALC 入力

ALC 変調器

ALC
内部ディテクタド ライバ

信号発生器

レベリング出力

（アンプ、フ ィルタ、

アッテネータなど）

（負の出力）

またはカップラ

オプシ ョ ン1E1
出力アッテネータ
（107ページを参照）
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図5-20　外部レベリング使用時のパワー値の不一致

カップラの出力パワー
測定値

信号発生器で設定されたパワー ・ レベル
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図5-21　代表的なダイオード ・ ディテクタの25 ℃での応答

オプシ ョ ン1E1出力アッテネータの動作と使用法

内部ディテク タを使用する場合は、 オプシ ョ ン1E1出力アッテネータを使用するこ とで、 信号発生器のRF出力コネクタで

のパワー ・ レベルを–135 dBmまで下げるこ とができます。 これは、 ALC検出回路の後で出力信号を減衰するこ とによ り

実現されます。 出力パワー値 （ディ スプレイのAmplitudeエ リ アに表示） は、 Set Atten と Set ALC Levelの値に基づきます

（104ページを参照） 。 外部ディテク タを選択した場合は、 検出回路のフ ィードバッ クが出力アッテネータの後に移動され

ているので、 出力アッテネータは出力信号を減衰しません。 アッテネータは出力信号の振幅に影響しないために、 出力振
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幅はSet ALC Levelソフ ト キーだけで決ま り ます。

外部レベリ ングを選択した場合は、 信号発生器はアッテネータ ・ ホールドをオンにし、 パワー出力範囲は標準オプシ ョ ン

（アッテネータなし） の信号発生器の範囲にほぼ一致します （データシート を参照）。 すでに説明したよ うに、 実際の出力

パワーは、 外部ディテク タ とカップラ／パワー ・ スプ リ ッ タの性能特性によ り異なる可能性があ り ます。

注記 内部ディテク タ （Internal） を再選択した場合は、 信号発生器はアッテネータ ・ ホールドをオフにしません。

出力アッテネータは出力パワーに影響しな くな り ますが、 ALC回路を約0 dBmの中間パワー ・ ポイン トにド ライブするた

めには有効です。 これは内部レベリ ング回路にとって最適なポイン トであ り、 通常は振幅フラ ッ ト ネスを最高にする効果

があ り ます。 これは、 –5 dBm以下の負のパワー値の場合に有用です。例えば、 –20 dBmのパワー設定でALCを中間パワー

程度でド ライブするには、 25 dBの減衰を加えます。 これによ り、 ALC回路は5 dBm （–20＋25） に設定されます。

注記 減衰が大きすぎる と、 ALC 回路が過大にド ライブされて、 信号発生器がレベリ ングなしになる可能性があ り ま

す。 パワー ・ レベルを上げた場合は減衰を減らすよ うにして ください。

外部レベリングの設定

基本的なセッ トアップ ・ プロセス

• 単一周波数信号を扱う場合は、 ステップ1～5を実行します。

• 複数の周波数を扱う場合 ：

a. ステップ1～4を実行します。

b. ユーザ ・ フラ ッ ト ネス補正を実行します。 「フラ ッ ト ネス補正の使用」 （90ページ） を参照してください。

• 掃引を行う場合 ：

a. ステップ1～4を実行します。

b. 掃引をセッ ト アップします。 「掃引出力の設定」 （48ページ） を参照して ください。

1. 機器をセッ ト アップします。 「機器セッ ト アップ」 （108ページ） を参照してください。

2. 搬送波信号を設定します。 「搬送波の設定」 （109ページ） を参照してください。

3. 外部レベリ ングを選択します。 「外部レベリ ングの選択」 （109ページ） を参照してください。

4. 出力振幅範囲を決定します。 「信号発生器の振幅範囲の決定」 （109ページ） を参照して ください。

5. 表示パワー ・ レベルを設定します。 「信号発生器の表示振幅値の調整」 （111ページ） を参照してください。

機器セッ トアップ

図5-22 （109ページ） に示すよ うに機器をセッ ト アップします。 外部ディテク タ （ディテク タ とカップラ／パワー ・ スプ

リ ッ タ） をDUTのできるだけ近くに配置します。
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 性能の最適化

外部レベリングの使用 （N5183Aのみ）
推奨機器

• Agilent 8474Eネガティブ ・ ディテク タ

• Agilent 87301D方向性結合器

• 必要なケーブルとアダプタ

図5-22　方向性結合器を使用した、 代表的な外部レベリング ・ セッ トアップ

搬送波の設定

1. Presetを押します。

2. 搬送波周波数を設定します。

3. パワー ・ レベルを0 dBmに設定します ：

• 信号発生器に出力アッテネータがない場合 （オプシ ョ ン1E1なし）、 またはオプシ ョ ン1E1と532または540がイン

ス トールされている場合 ：

AMPTD > 0 > dBmを押します。

• 信号発生器にオプシ ョ ン1E1および520が搭載されている場合は、 出力アッテネータを0 dBmに設定します ：

a. AMPTD > Atten/ALC Control > Atten Hold Off Onを押してOnにします。

b. Set Atten > 0 > dBを押します。

c. Set ALC Level > 0 > dBmを押します。

外部レベリングの選択

AMPTD > Leveling Control > Leveling Mode > Ext Detectorを押します。

信号発生器の振幅範囲の決定

最大出力振幅は周波数に依存します。 したがって、 複数の周波数ポイン ト を使用していて、 各周波数ポイン トの最大出力

振幅を知りたい場合は、 MXGデータシートの振幅のセクシ ョ ンを参照してください。 その後、 この手順で各バンドの最大

振幅を決定します。

レベリングされた信号

信号発生器 カップラ増幅器

ネガテ ィブ・ディテクタ

RF OUTPUT

ALC INPUT
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外部レベリングの使用 （N5183Aのみ）
外部レベリ ングとオプシ ョ ン1E1を使用する場合は、信号発生器のパワー出力範囲は、標準オプシ ョ ンの測定器 （オプシ ョ

ン1E1なし） とほぼ一致します。 しかし、 オプシ ョ ン1E1を使えば、負の振幅値を使用する場合に、 アッテネータを使って

ALCを中間パワー ・ ポイン トにド ラ イブできます。 ただし、 減衰を追加する とレンジの上限は低下します。 詳細について

は、 「オプシ ョ ン1E1出力アッテネータの動作と使用法」 （107ページ） を参照して ください。

1. オプシ ョ ン1E1がインス トールされている場合は、 アッテネータを目的のレベルに調整します。

注記 オプシ ョ ン1E1出力アッテネータの値が大きすぎる場合 （約55 dB以上） は、 RF出力をオンにしたと きにレベリ

ングなし条件が発生します。

a. AMPTD > Atten/ALC Control > Set Attenを押します。

b. アッテネータ値を入力します。

2. RF出力をオンにします ： RF On/Offを押してOnにします。

3. AMPTDのステップ増分値を1 dBに設定します。

• AMPTD > Incr Set > 1 > dBを押します。

4. 最小振幅値を決定します ：

a. 振幅を–25 dBmに設定します。

b. 下矢印キーを使って、 UNLEVELインジケータが表示されるまで振幅を下げていきます。

c. 上矢印キーを使って、 UNLEVELインジケータが消えるまで振幅を上げていきます。

UNLEVELインジケータが消えたと きに表示されている値が、 振幅範囲の最小値です。

5. 最大振幅値を決定します ：

a. 信号発生器がレベリ ングなしにならない値に振幅を設定します。

b. 上矢印キーを使って、 レベリ ングなしになるか、 上限に達したとい うエラー ・ メ ッセージがディ スプレイの下部

に表示されるまで、 振幅を上げていきます。

c. 振幅値を下げます ：

• レベリ ングなしインジケータが表示された場合は、 インジケータが消えるまで振幅を下げていきます。 イン

ジケータが消えたと きの値が、 範囲の最大値です。

• 信号発生器ディ スプレイの下部にError:501, Attenuator hold setting over rangeが表示された場合

は、 表示されている値が範囲の最大値です。

エラー・ メ ッセージを消すには、 メ ッセージが消えるまで下矢印キーを押します。 このエラーは、現在のアッ

テネータ設定に関連する最大値を超えて振幅を上げよ う と した場合に表示されます。
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外部レベリングの使用 （N5183Aのみ）
信号発生器の表示振幅値の調整

外部レベリ ングを使用する場合は、 信号発生器に表示される振幅値は、 カップラ／スプ リ ッ タの出力での信号のレベリ ン

グされたパワーには一致しません。 この差を補正するために、 信号発生器に表示されるパワー値がカップラ／スプ リ ッ タ

の出力での測定値にできるだけ近くなるよ うに設定する方法が2つあ り ます。

1. 測定機器の接続と設定 ：

a. カップラ／スプリ ッ タの出力をパワー ・ メータまたはシグナル ・ アナライザに接続します。

b. 信号のパワー ・ レベルを測定するよ うにパワー ・ メータ／シグナル ・ アナライザを設定します。

2. 信号発生器の表示振幅値の調整 ：

• Ext Leveling Amptd Offsetソフ ト キーを使用する場合 ：

このソフ ト キーは、 ゼロ基準と して16 dBを使用します。 16 dBは内部ディテク タの結合係数です。

a. 信号発生器で、 AMPTD > Leveling Control > Ext Leveling Amptd Offsetを押します。

b. 信号発生器のディ スプレイで搬送波振幅値を観察しながら 、 RPGノブ （デテン ト ・ ノブ） を使用して、 表示さ

れている振幅値の整数部が測定値の整数部と一致するよ うに、 オフセッ ト値を調整します。

1つのデテン ト位置につき値は1 dB変化します。

c. 数字キーを使用して、 表示された振幅値の小数部を調整します。

• Amptd Offsetソフ ト キーを使用する場合 ：

a. 信号発生器で、 AMPTD > Leveling Control > More > Amptd Offsetを押します。

b. 信号発生器に表示された振幅値と測定値との差を計算します。

c. 数字キーを使って、 この差をAmptd Offsetソフ ト キーの値と して入力します。
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レベリングなし動作モードの使用法
レベリングなし動作モードの使用法

図5-23　Power Searchソフ トキーとALC Offソフ トキー

ALCオフ ・ モード

ALCをオフにする と、 信号発生器の自動レベリ ング回路が無効になり ます。 ALCをオフにする と よいのは、 変調がALCの

パルス幅仕様を超える超高速パルスで構成される場合や、外部I/Q信号のアップコンバージ ョ ンの際に、変調を構成する振

幅変動やバース トがきわめて低速なために、自動レベリ ングでは除去されたり歪んだりする場合です。内蔵I/Qベースバン

ド ・ ジェネレータを使用する場合は、 上記のタイプの信号に対しては、 ALCをオフにするよ り も、 ALCホールド ・ マーカ

機能を使用した方が良好な結果が得られます。

注記 ALCをオフにした場合は、 フロン ト ・パネルで指定した出力パワー ・ レベルを正し く設定するために、 パワー ・

サーチを実行する必要があ り ます。 パワー ・ サーチはデフォル ト では自動的に実行されますが、 この設定は

Manualモードを使用するこ とでオーバーライ ドできます。

以下の場合のみ使用可能

ALC ＝ Off

以下の場合のみ使用可能

Power Search Reference ＝

以下の場合のみ使用可能

Power Search ＝ Span

Auto：出力周波数または振幅が変化すると必ず校正ルーチンが
実行されます。

Span ： Do Power Searchを押すと、 選択された周波数レンジに
渡ってパワー ・ サーチ校正ルーチンが一度実行されます。

補正値が記録され、校正済みの周波数レンジ内に信号発生器を
同調した場合はその値が用いられます。

各キーの詳細については、 42ページの説明に
従ってキーのヘルプを使用して く ださい

RMS：値は、ファイルのヘッ
ダから得られた値または現在
のI/Qデータから計算された
値と等価なDCバイアスです。

Fixed： 0.5 Vrmsの固定値を使
用します（Ext I/Qデータでも
同じ値が用いられます）。

Manual ： ユーザがDCバイア
ス電圧値を指定できます
(0～1.414 Vrms)。

Modulated ： 実際の変調信号
のACバイアスを使用します。

Manual

User ： ユーザが信号
発生器の周波数を設
定できます。

Full ：信号発生器がパ
ワー ・ サーチの全周
波数レンジを選択し
ます。

I/Qがオンの場合のみ
使用可能です。

これらのソ フ ト キー
は、ARB波形がメモリ
上で再生中である場
合のみ使用できます。

Manual：開ループALCレベルを校正するためにユーザが明示的
にパワー ・サーチを実行する必要があります。

注記 ：
1) この機能はN5183Aでは使用できません。

2) この機能が使用できるのは、 シリアル番号の先頭が4818
以上またはオプシ ョ ン099を搭載した測定器の場合だけです。
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レベリングなし動作モードの使用法
パワー ・ サーチ ・ モード

注記 パワー ・ サーチ ・ モードは、 外部I/Q入力からのバース ト信号入力に対しては使用できません。

MXGには、 3種類のパワー ・ サーチ ・ モード （内部および外部I/Q変調用） と4種類のパワー ・ サーチ基準 （外部I/Q変調専

用） があ り ます。 図5-23 （112ページ） を参照して ください。

パワー・サーチは、ALCを一時的にオンにし、現在のRF出力のパワーを校正し、ALC回路を切断するルーチンを実行します。

パワー ・ サーチ ・ モード （外部および内部I/Q変調で使用可能）

• Auto ： 周波数またはパワーが変更されるたびに、 またAM、 バース ト、 パルス、 またはI/Q変調ステートへの変更が行

われるたびに、 パワー ・ サーチが実行されます。

• Span ： ユーザ定義の周波数レンジに渡ってパワー ・サーチが実行されます。 パワー ・サーチは記録され、 MXGがユー

ザ定義のレンジ内に同調されたと きに使用されます。Spanソフ ト キーを押した後、FullまたはUserを選択します。User
を選択した場合は、 スタート／ス ト ップ周波数を選択する必要があ り ます。

• Manual ： Power SearchをManualに設定した場合は、 Do Power Searchを押すと、 現在のRF周波数／振幅に対するパ

ワー ・ サーチ校正ルーチンが実行されます。 このモードでは、 RF周波数または振幅を変更した場合は、 も う一度Do
Power Searchを押す必要があ り ます。

パワー ・ サーチ基準 （内部I/Q変調のみで使用可能）

4つのパワー ・ サーチ基準は、 パワー ・ サーチ機能を制御します。 これら4つの基準は、 RF信号がI/Q変調されている と き

に使用される基準電圧を選択します （パワー ・ サーチ基準はアナログ変調、 すなわちFM、 φM、 パルス変調では用いられ

ません）。

注意 パワー・サーチ基準のRMS電圧が正し くない場合は、出力パワーは正し くあ り ません。図5-24 「単一波形サンプ

ル ・ ポイン トに対する出力パワー誤差の計算」 と図5-25 「波形のRMS電圧の計算」 を参照してください。

注記 パワー ・ サーチが成功するかど うかは、 パワー ・ サーチ基準の有効性にかかっています。

• Fixed ： 基準レベルは0.5 Vrmsです。

この基準は、 内部、 外部I/Q、 バース ト信号に対して使用できます。 これはデフォルトの設定です。

• RMS ： 波形ヘッダに指定されたユーザ定義の0～1.414 Vrmsの基準レベル。 「波形の設定とパラ メータの保存」 （149
ページ） を参照して ください。

この基準は、 内部I/Qおよびバース ト信号に対して使用できます。

• Manual ： ユーザ定義の0～1.414 Vrmsの基準レベル。

この基準は、 内部、 外部I/Q、 バース ト信号に対して使用できます。

• Modulated ： I/Q変調信号を基準レベルに使用します。

この基準は、内部またはI/Qに対して使用できます。バース ト信号や、Vrmsが変化する信号に対しては使用できません。
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レベリングなし動作モードの使用法
図5-24　単一波形サンプル ・ ポイン トに対する出力パワー誤差の計算

図5-25　波形のRMS電圧の計算

RMSおよびMANUAL基準は、 最も強力な選択です。 ユーザが基準レベルを指定します。 I/Q信号は、 バース ト信号 （レー

ダ） でも、 RMSレベルが変動しても （無線信号） かまいません。 RMS/MANUAL基準レベルを設定した場合は、 パワー ・

サーチは波形の現在のVrms値とは無関係に実行されます。

基準レベルが1.0 VrmsのRMSおよびMANUAL基準は、 計算されたrms値1と等価であ り、 SINE_TEST_WFMを使用して測

定できます。

FIXED、 RMS、 MANUAL基準は、 DACを使用して基準電圧を印加するので、 I/Q信号が存在する必要はあ り ません。

注記 MXGの基準電圧は、 公称0.1 Vrms～1 Vrmsで動作するよ うに設計されていますが、 1.414 Vrmsまでのオーバー

レンジが可能です （RMSの1.414までのオーバーレンジは、 定数値が手動でロード され、 I と Qの値にすべて1が
入力された場合に可能です）。 「波形の設定とパラ メータの保存」 （149ページ） も参照して ください。

注意 パワー ・ サーチが成功する最小の基準レベルは、 RF周波数、 RF振幅、 温度に依存します。 1 GHzの0 dBmに対

する基準レベル0.1 VrmsのMXGパワー ・ サーチは失敗する可能性があ り ます。

20 10 V1( ) V2( )⁄( )log×=

ここで ：

V1は実際の波形のRMS電圧

V2は入力されたRMS電圧

出力パワー誤差

注記 ：入力されたRMS電圧値が実際のRMS電圧よりも小さい場合は、 出力パワーは目的のレベルよりも高く なります。

入力されたRMS電圧値が実際のRMS電圧よりも大きい場合は、 出力パワーは目的のレベルよりも低く なります。

MXGはRMS値を自動的に計算できます。 連続する複数のI/Qデータ ・ ポイン トがゼロ

の場合は、 MXGの計算はこれらのゼロポイン ト を無視します。 また、 信号発生器に

よるRMS計算は時間がかかり、アプリケーシ ョ ンによっては適切でない可能性がある

ので、 ユーザがRMS値を計算して波形ファイルに入力してお く ことをお勧めします。

波形のRMS値＝

SCPIコマンド ：

[:SOURce]:RADio:ARB:HEADER:RMS <"file_name">,<val>|UNSPecified
[:SOURce]:RADio:ARB:HEADER:RMS?<"file_name">

波形のRMS電圧の決定のプログラ ミング例については、 測定器に付属する 『プログラ ミング ・ ガイド』 と ドキュ メン ト CDを参照して ください。
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出力オフセッ ト、 基準、 乗数の使用
パワー ・ サーチ設定

パワー ・ サーチ ・ ルーチンを実行するには、 測定器が以下の条件を満たす必要があ り ます。

• I/Q変調がオン

• RF出力がオン

• 自動レベリ ング回路がオフ

• RFブランキングがオン

この機能は、パワー・サーチ中のパワー・ スパイ クを防ぎます （「RFブランキング ・マーカ機能を使用する」 （166ペー

ジ） を参照）。

• 内部ARB と外部I/Qの加算を使用する場合は、 4つのパワー基準モード （Fixed、 RMS、 Manual、 Modulated） がすべ

て使用できます。

• 外部I/Q入力を使用する場合は、 MANUAL基準モードを使用し、 パワー ・ サーチ実行時に外部I/Q信号が存在するこ と

を確認します。 外部I/Q信号が存在しない場合は、 パワー ・ サーチは失敗します。

例 ：自動パワー ・ サーチ

1. 信号発生器をプリセッ ト します。

2. 目的の周波数を設定します。

3. 目的の振幅を設定します。

4. RF出力をオンにします。

5. 信号発生器の自動レベリ ング制御をオフにします ：

AMPTD > ALC Off Onを押して、 Offを強調表示します。

信号発生器の自動レベリ ング制御をオフにするこ とは測定器の大きな変更なので、 パワー ・ サーチが自動的に開始さ

れます。

Autoに設定した場合は、測定器の設定に重大な変更がある と、パワー・サーチが自動的に実行されます。Do Power Search
機能を使用すれば、 温度ド リ フ トや外部入力の変化などを補正するためにいつパワー ・ サーチを実行するかをユーザが決

定できます。

出力オフセッ ト、 基準、 乗数の使用

出力オフセッ トの設定

出力オフセッ ト を使用すれば、 入力値から一定のオフセッ ト （正または負） を持つ周波数／振幅を出力できます。

RF出力＝入力値 – オフセッ ト値

表示値＝出力周波数＋オフセッ ト値

オフセッ ト を設定する手順 ：

• 周波数 ： Freq > Freq Offset > オフセッ ト値 > 周波数単位を押します。
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 115



性能の最適化

出力オフセッ ト、 基準、 乗数の使用
• 振幅 ： Amptd > More > Amptd Offset > オフセッ ト値 > dBを押します。

例

信号発生器を局部発振器(LO) と して使用している場合は、 オフセッ ト を使って目的の周波数を表示するこ とができます

（下の図を参照）。

出力基準の設定

出力基準を使用すれば、 選択した基準値から入力値分のオフセッ ト （正または負） を持つ周波数／振幅を出力できます。

RF出力＝基準値＋入力値

基準を設定する手順 ：

1. 周波数または振幅を出力基準レベルにしたい値に設定します。

2. 周波数 ： Frequency > Freq Ref Setを押します。

周波数は0.00 Hzと表示されます。 これがRF出力周波数のゼロ ・ レベルであるこ とを示しています。

入力した周波数はすべて、 この基準周波数を基準にしているものと解釈されます。

パラ メータ
例
#1

例
#2

例
#3 コ メン ト

入力 （表示） 値 ： 300 MHz 300 MHz 2 GHz 入力値は正の値でなければなり ません。

オフセッ ト ： 50 MHz –50 MHz –1 GHz オフセッ ト値は正／負どちらの値も設定できます。

出力周波数 ： 250 MHz 350 MHz 3 GHz 出力周波数または振幅が範囲外の場合は、 警告が発生します。

オフセッ トがオンであることを示します

IF増幅器RF増幅器 ミキサ フ ィルタ

信号発生器
（局部発振器）

出力周波数＝ 1000 MHz

IF ＝ 321 MHz

アンテナを 1321 MHz にチューニング

選択オフセッ ト

321 MHz　
–679 MHz　

信号発生器の表示

1321 MHz （アンテナ周波数）

321  MHz （IF出力）

IF 出力

321 MHz
116 Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド



 性能の最適化

出力オフセッ ト、 基準、 乗数の使用
振幅 ： Amptd > More > Amptd Ref Setを押します。

振幅は0.00 dBと表示されます。 これがRF出力振幅のゼロ ・ レベルであるこ とを示しています。

入力した振幅はすべて、 この基準振幅を基準にしているものと解釈されます。

例

新しい周波数／振幅基準を設定するには、 周波数基準をオフにし、 上の手順を実行します。

周波数乗数の設定

周波数乗数を使用すれば、 出力値の倍数 （正または負） の周波数を表示できます。

表示値＝乗数×出力周波数

出力周波数＝表示値÷乗数

周波数乗数を設定する手順 ：

1. Frequency > Freq Multiplier > 乗数 > xを押します。

2. 目的の周波数を設定します。

出力周波数に乗数を掛けた値が表示されます。

パラ メータ
例
#1

例
#2

例
#3 コ メン ト

基準 ： 50 MHz 50 MHz 2 GHz 基準値は正の値でなければなり ません。

入力 （表示） 値 ： 2 MHz –2 MHz –1 GHz 入力値は正／負どちらの値も設定できます。

出力周波数 ： 52 MHz 48 MHz 1 GHz 出力周波数／振幅がレンジ外の場合は、 警告が発生します。

基準がオンであることを示します
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例

信号発生器をシステムへの入力と して使用している場合は、 下の図のよ うに逓倍器を使用して、 信号発生器にシステムの

出力が表示されるよ うに周波数乗数を設定するこ とができます。

ミ キサの測定では、 周波数乗数と周波数オフセッ ト を組み合わせて使用するこ とがよ く あ り ます。 下のアップコンバータ

パラ メータ
例
#1

例
#2

例
#3 コ メン ト

周波数乗数 ： 3 –3 4 乗数値は以下の範囲で設定できます。

 ＋0.001～＋1000

–1000～–0.001

入力 （表示） 値 ： 600 MHz –600 MHz 8 GHz

出力周波数 ： 200 MHz 200 MHz 2 GHz 出力周波数がレンジ外の場合は、 警告が発生します。

周波数乗数がオンであることを示します

信号発生器 逓倍器

出力＝ 4 GHzX2入力＝ 2 GHz
選択された乗数

2

信号発生器出力

2 GHz

入力／表示周波数

4 GHz
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の例では、 信号発生器にfRFが表示されるよ うに、 乗数が–1、 オフセッ トが3 GHzにそれぞれ設定されています。

周波数および位相基準ソフ トキーの使用

MXGは、 ユーザ定義の周波数または位相基準を使用するよ うに設定できます。

図5-26　周波数基準および周波数オフセッ ト用ソフ トキー

フ リーラン、 ステップ持続時間、 タイマ ・ ト リガの使用

Free Run （フ リーラン）、 Step Dwell （ステップ持続時間）、 Timer Trigger （タ イマ ・ ト リ ガ） を使えば、 ステップ掃引ま

たはリ ス ト掃引の任意のポイン トで費やされる時間を調整できます。 測定の組み合わせと しては以下の2種類が可能です。

フ リーランと ステップ持続時間 （図5-27 （121ページ）） 信号発生器は信号のセ ト リ ングを待ち、 その後でステップ持続時

間だけ待ってから、 以下の周波数ポイン トに進みます。 さ らに、 掃引全体の完了までの時間も異なる可能性があ り ます。

各周波数ポイン トにおいて、 常に最小のステップ持続時間がかかり ます。 各ポイン トの最小ステップ持続時間は、 100 μs
に固定されています。周波数ポイン トの間の時間は、セ ト リ ング時間とステップ持続時間の合計です。セ ト リ ング時間は、

周波数、振幅、バンド交差、その他の要因によ り異なるために、周波数ポイン トの間の時間は変化する可能性があ り ます。

ミキサ

信号発生器
（局部発振器）

fLO ＝ 800 ～ 600 MHz

fIF ＝ 3000 MHz

選択された
乗数

−1

−1

信号発生器
出力 (fLO)

800 MHz

600 MHz

fRF ＝ 2200 ～ 2400 MHz

選択された
オフセッ ト

3000 MHz

3000 MHz

入力／表示
周波数 (fRF)

2200 MHz

2400 MHz
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フ リーランの代わりにタイマ ・ ト リ ガ （図5-27 （121ページ）） 信号発生器は等間隔のト リガを発生し、 各ト リガで次のポ

イン トに移動します。 この方法の利点は、 ポイン ト間の時間と、 掃引全体の時間が一定になるこ とです。 ただし、 ト リ ガ

が高速すぎる と、 以下のポイン トに移動するまでに信号がセ ト リ ングしないおそれがあ り ます。

フリーラン、 ステップ持続時間、 タイマ ・ ト リガ設定について

信号の各ポイン トでの最小セ ト リ ング時間が決まっていて、 ポイン ト間の時間が一定でなくてもかまわない場合は、 Free
RunとStep Dwellを使用します。

信号のポイン ト間の時間が一定でなければならず、各ポイン トのセ ト リ ング時間が変動する可能性がある場合は、タイマ・

ト リ ガを使用します。 掃引が高速すぎる と、 信号発生器がセ ト リ ングしない可能性があるこ とに注意してください。

信号が特定の最小時間だけセ ト リ ングする必要があ り、 かつポイン ト間の時間が一定でなければならない場合は、 スイ ッ

チング時間 （900 μsまたは5 ms、 オプシ ョ ンによ り異なる） と測定の実行に必要な最小セ ト リ ング時間の和にタイマ ・ ト

リ ガを設定します。

測定で外部機器の同期が必要な場合は、 ハード ウェア ・ ト リ ガの使用を検討して ください。
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図5-27　 フ リーラン、 ステップ持続時間、 タイマ ・ ト リガ用ソフ トキー

Sweep > Configure Step 
Sweep > More

セト リング後に追加の測定持続時間が必要な場合は、 Step Dwellと Free Runの
組み合わせを使用します。

信号の各ポイン トでの最小セト リング時間が決まっていて、ポイン ト間の時間

が一定でな く てもかまわない場合は、 Step DwellとFree Runを使用します。

Sweep > More

信号のポイン ト間の時間が一定でなけれ

ばならず、 各ポイン トのセ ト リング時間

が変動する可能性がある場合は、 Timer
Triggerを使用します。 掃引が高速すぎる

と、 信号発生器がセト リングしないおそ

れがあることに注意して ください。

信号が特定の最小時間だけセ ト リングす

る必要があり、 かつポイン ト間の時間が

一定でなければならない場合は、 スイ ッ

チング時間 （900 μs （オプシ ョ ンUNZ） ま

たは5 ms （標準）） と測定の実行に必要な

最小セ ト リ ング時間の和にTimer Trigger
を設定します。

例 ：信号を3 msの間セ ト リングする必要

があり、 セ ト リ ング時間が0.9 msのオプ

シ ョ ンUNZを搭載している場合は、その和

の3.9 msにタイマ ・ ト リガを設定します。

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。
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LXIの使用 （オプシ ョ ンALB）

注記 LXI class B準拠に関する注意事項

2008年6月の本製品フ ァームウェア・リ リースの時点では、新しいIEEE 1588–2008 PTP (Precision Time Protocol)
を使用したLXI class Bコンプライアンス ・ テス トは利用不可能でした。 本製品は、 LXI class C準拠にLAN ト リ

ガおよび時間同期を追加するこ とによ り、 LXI class B測定器の機能を提供しています。 ドキュ メ ン ト 、 測定器

メニュー、 WebページでLXI class Bへの言及があっても、 LXI class Bへの準拠を保証するものではあ り ません。

LXI Consortiumが仕様変更を承認し、 認証済みのテス ト を提供できるよ うになった時点で、 本製品のLXI class
B準拠の申請が行われる予定です。http://www.lxistandard.org/homeを参照してください。

LXI-Bは、 シ リ アル番号の前半部分がUS/MY/SG4818以上の測定器でのみ使用できます。

LXI (LAN eXtensions for Instruments)規格は、電子計測の世界にインターネッ ト接続機能を導入するものです。LXIでは、

システム ・ インテグレータが測定の効率を改善し、 システムの理解を容易にするために利用できるさまざまなツールが提

供されています。

このセクシ ョ ンでは、 ユーザがLXIの用語と使用モデルについてわかっている と仮定しています。 また、 このセクシ ョ ン

では、 第3章 「基本操作」 の内容の理解を前提と しています。 『プログラ ミ ング ・ ガイ ド』 とwww.lxistandard.orgを参照

してください。

LXIクロックについて

最も単純なテス ト ・ システムでは、 1台のパーソナル ・ コンピュータ (PC)が1台のLXI測定器と LAN経由で接続されます。

PCには独自の内部 （ブラウザ） ク ロ ッ クがあ り、 LXI測定器にはオペレーティング ・ システム ・ ク ロ ッ ク （MS Windows、
Windows CE、 VX Worksなど） とPTPク ロ ッ クの2つのクロ ッ クがあ り ます。 以下の図にこれを示します。

図5-28　 LXIのクロック内蔵PC （ブラウザ ・ クロック） とMXG （オペレーテ ィング ・ システム ・ クロッ クとPTPクロッ ク）

グランドマスタ ・

クロック
マスタ ・ クロック

LXI測定器はオペレーティ ング ・ システム ・

クロッ クとPTPクロックを搭載

クロック内蔵PC
（ブラウザ・クロック）
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PCのブラウザ ・ ク ロ ッ クは、 ローカル時刻を標準の日付／時刻表現で示します。 PCがNTP(Network Time Protocol)サー

バに （LAN経由で） 接続されている場合は、 その時刻は比較的正確です。 しかし、 PCのタイム ・ ゾーンやサマー ・ タ イ

ム ・オフセッ トの設定は測定器と異なる可能性があるために、 PCのブラウザ ・ ク ロ ッ クの時刻は測定器のオペレーティン

グ ・ システム(OS)ク ロ ッ ク と一致しない可能性があ り ます。

LXI測定器には2つのクロ ッ クがあ り ます。測定器のオペレーティング ・ システム ・ ク ロ ッ クは、 PCのブラウザ ・ ク ロ ッ ク

と同様に、時刻を特定の日付／時刻フォーマッ トで示します。 も う 1つのクロ ッ クは、測定器のPTPク ロ ッ クです。 このク

ロ ッ クはマスタ ・ ク ロ ッ ク （システムに存在する場合） と同期されます。 通常、 このPTPク ロ ッ クは、 新しい時刻からの

経過秒数で時刻を示します。

LXI測定器を追加してシステムを拡張した場合は、 システム ・ ク ロ ッ クの数は大幅に増加します。 測定器クロ ッ クの他に、

PTPマスタ ・ ク ロ ッ クおよびPTPグランドマスタ ・ ク ロ ッ クが存在する場合もあ り ます。 また、 テス ト ・ システムに1つま

たは複数の境界クロ ッ クが存在する場合もあ り ます。 境界クロ ッ クは、 ポートに応じてマスタ ・ ク ロ ッ ク と スレーブ ・ ク

ロ ッ クの両方を持っています。

注記 ローカル ・ ク ロ ッ クまたはローカルという概念は、 参照基準によっては混乱を招く可能性があ り ます。 例えば、

現在PCの前にいる とすれば、 ローカルはブラウザ ・ ク ロ ッ クを表します。 測定器の前にいる とすれば、 ローカ

ルは測定器です。 ほとんどのテス ト ・ システムでは、 PC と測定器はすぐ近くにあ り ます。 しかし、 テス ト ・ シ

ステムによっては、 何キロ も離れた場所にあった り、 タ イムゾーンが異なっていた り、 あるいは海の向こ うに

あった りする場合もあ り ます。 また、 SCPIでローカルといった場合は、 測定器のOSク ロ ッ クを表すこ とにも注

意して ください。
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LXI入門

以下に示す設定は、 LXIソフ ト キーの基本的な機能を示します。

注記 LXIサブシステムをオンにする と、 スイ ッチング速度に影響します。

スイ ッチング速度を最高にするには、 使用しないと きにはLXIサブシステムをオフにしてください。

図5-29　 LXIサブシステムの設定

 

各キーの詳細については、 42ページの説明に
従ってキーのヘルプを使用して く ださい。

Utility > More

『プログラ ミング ・ガイ ド』 および 『SCPI Command Reference』 も参照して く ださい。

125ページ

126ページ

 49ページ

LXIサブシステムをオン／オフし

ます。 注記 ： LXI On/Off設定は恒

久的です。

PTP(Precision Time Protocol) ド メ

インを設定します。

LXIイベン ト ・ ド メ インを設定し

ます。

LXI–Bサブシステムをオン (On)にすると、 Status Informationウィンドウが開き、 PTP ド メ インとイベン

ト ・ ド メ インを設定できます。 グランドマスタ ・ クロッ クとマスタ ・ クロックはリモート ・ コマンド

でのみ制御できます。
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図5-30　 LXIト リガ入力イベン トの設定

 

各キーの詳細については、 42ページの説明に
従ってキーのヘルプを使用して く ださい。

イベン ト LAN0～LAN7を
オン／オフします。

Utility > More > LXI

 49ページ

 124ページ

これらは定義済みのデフォルト入力LANイベン ト識別子であり、 削除できません。 入力LANイベン ト

はト リガとして扱われます。 ト リガ ・ イベン ト識別子をオン （On） にし、 ト リガのソースと してLXI
LAN （49ページ） を選択する必要があります。

 126ページ

『プログラ ミング ・ガイ ド』 および 『SCPI Command Reference』 を参照して く ださい。
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図5-31　 LXI出力イベン トの設定

 

Utility > More > LXI

測定器が ト リ ガを

待っ ている こ と を

示します。

測定動作が進行中か

どうかを示します。

測定器がLOを掃引中

かどうかを示します。

測定器がセト リング

中であることを示し

ます

測定器イベン ト の1つ
のエッジだけを送信

LANイベン ト をオフに

します。

測定器イベン トの両方

のエッジが送信される

代表的な動作。

測定器イベン ト LAN0
～LAN7をオン／オフ

します。

 125ページ
 49ページ

 124ページ

これらは定義済みのデフォルト出力LANイベン ト識別子であり、 削除できません。

出力LANイベン トが発生するかどうかは、 LANイベン ト識別子がオン （On） かどうかと、 内

部ステータス ・ イベン トのどれかが発生するかどうかにより決まります。出力LANイベン ト

の信号ステートは、ソースとなる内部ステータス・イベン ト と同じにするか反転させること

ができます。

内部ステータス ・ イベン ト  

各キーの詳細については、 42ページの説明に
従ってキーのヘルプを使用して ください、

『プログラ ミング ・ガイ ド』 および 『SCPI Command Reference』 を参照して ください。
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 性能の最適化

LXIの使用 （オプシ ョ ンALB）
詳細情報

LXIの使用法の詳細については、 AgilentのLXI測定器Webサイ ト を参照してください。

www.agilent.co.jp/find/lxi

Agilent LXIアプリ ケーシ ョ ン ・ ノート ：

• USB、 LAN、 GPIBを使用するためのヒン ト とテクニッ ク （1465-20） 

• LXIに移行する10の理由 （1465-21） 

• GPIBからLXIへの移行 （1465-22） 

• PXI、 VXI、 LXIによるハイブ リ ッ ド ・ テス ト ・ システムの構築 （1465-23） 

• テス ト ・ システムにおけるシンセティ ッ ク測定器の使用法:利点と ト レードオフ （1465-24）

• GPIBからLXIへの移行 （システム ・ ソフ ト ウェア編） （1465-25）

• LAN/LXIを組み込むためのGPIBシステムの変更 （1465-26）
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性能の最適化

USBキーボードの使用
USBキーボードの使用

USBキーボードを使用して、 RF出力ステートや変調ステート を リモート制御した り、 メモ リ ・ シーケンスやレジスタを選

択したりできます。

レジスタ選択、 RF出力ステート、 変調ステートは電源を入れ直すかプリセッ トする と変化しますが、 USBキーボードの制

御ステート とシーケンス選択は変化しません。

注意 不揮発性メモ リに恒久的に保存されていないデータ、 GPIB設定、 または現在のユーザ機器ステートが失われる

のを防ぐために、 MXGの電源をオフにするには、 必ずMXGのフロン ト ・パネルの電源ボタンまたは適切なSCPI
コマンドを使用して ください。 ラ ッ ク ・システムにインス トールされているMXGが、MXGのフロン ト ・パネル・

スイ ッチでな くシステム ・ ラ ッ クの電源スイ ッチによ り電源をオフにされた場合は、 MXGの電源が適切にオフ

にされなかったためにError –310が表示されます。

USBキーボード制御をオフにすると、 USBキーボードは使用不可に
なります。 Auto Recallソフ トキーには影響しません。

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。

USBキーボードのキー

Delete、 Enter　

Insert　

Home、 上向き矢印

End、 下向き矢印

Page Up、 右向き矢印、 ＋

Page Down、 左向き矢印、 –

信号発生器の機能

RFオン／オフ

変調オン／オフ

以下のシーケンス

前のシーケンス

次のステート ・ レジスタのリコール

前のステート ・ レジスタのリコール
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6 パルス変調の使用法 （オプシ ョ ンUNUまたはUNW）

注記 N5161A/62Aでは、 本書に記述されているソフ ト キー ・ メニューと機能は、 WebイネーブルMXGまたはSCPIコ
マンド経由でのみ使用できます。 WebイネーブルMXGの詳細については、 『インス トール ・ ガイ ド』、 『プログラ

ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照してください。

こ こに記載の内容を理解するには、 信号発生器の基本動作についての知識が必要です。 パワー ・ レベル／周波数の設定な

どの機能を簡単に操作できない場合は、 第3章 「基本操作」 （41ページ） を参照して、 内容をよ く理解してください。

• 「パルス特性」 （131ページ）

• 「基本的な手順」 （133ページ）

• 「例」 （133ページ）
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パルス変調の使用法 （オプシ ョ ンUNUまたはUNW）
図6-1　パルス用ソフ トキー

133ページ

133ページ

外部パルス入力からパルス同

期出力までのレイテンシ≒50

～60 ns。

幅 周期

50 ns > 50 ns

20 ns ≦ 50 ns

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

外部パルス信号に対する信号発生器の

応答を決定します。

Normal＝ハイ ・ ステート。

Invert＝ロー ・ ステート。

Low＝安定

TTL信号

15ページおよび19ページ

も参照

各出力コネク タにルー

テ ィ ングする信号を選

択します。

これはメニューの2ページ

目です。

Event 1 BNCにルーティ ング

するマーカを選択します。

Trig out BNC にルー

テ ィ ングするマー

カを選択します。

これらのソフ トキー

は、 N5182Aでのみ使

用できます。

これらのソフ トキー

は、N5182Aでのみ使

用できます。

これらのソ フ ト キーは、

Pulse-Source が Adjustable

Doubletに設定されている

場合のみ使用できます。

Trig Out BNCから送出される信号の

タイプを決定します。

Normal＝ハイ ・ ステート。

Invert＝ロー ・ ステート。
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 パルス変調の使用法 （オプシ ョ ンUNUまたはUNW）
パルス特性
パルス特性

注記 信号器のALCパルス幅仕様を超える超高速パルスまたはデューティ ・サイ クルが異常に長いレベリ ング・パルス

を使用する場合は、 通常はALCをオフにする と便利です （112ページを参照）。

パルス 源 タイプ 周期a

aすべての遅延、 幅、 周期の分解能は10 nsです。

幅と遅延a ト リガ ・ イベン ト を使用b

b内部発生パルスを ト リガするには、 リア ・ パネルのパルス ・ コネクタの信号が20 ns以上ハイを維持する必要があります。

方形
内部フ リーラン ・ パルス列 （50 ％のデュー

ティ ・ サイ クル）。

ユーザ定義のレー ト で

決定されます。
― ―

フ リーラン

（デフォルト ）
内部フ リーラン ・ パルス列 ユーザ定義 ユーザ定義 ―

ト リガ 内部パルス列 ― ユーザ定義 ✓

調整可能な

ダブレッ ト
ト リ ガ ・ イベン ト ごとに2つの内部パルス列。 ―

ユーザ定義 ：

最初のパルスは ト リ ガ信号の立ち上が

りエッジが基準です。

2番目のパルスは最初のパルスの立ち

上がりエッジが基準です。

図6-2 （132ページ） を参照

✓

ト リ ガ

ダブレッ ト
ト リ ガ ・ イベン ト ごとに2つの内部パルス列。 ―

最初のパルスはト リガ信号に従います。

2番目のパルスはユーザ定義です。

図6-3 （132ページ） を参照

✓

ゲーティ ッ ド 内部ゲーティ ッ ド ・ パルス列 ― ユーザ定義 ✓

外部
リ ア ・ パネルのPulseコネクタの外部パルス

信号
― ― ―

外部パルス入力

リア ・パネルの入力については15ページを参照
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パルス変調の使用法 （オプシ ョ ンUNUまたはUNW）
パルス特性
図6-2　調整可能なダブレッ ト

図6-3　 ト リガ ・ ダブレッ ト

最初のパルスの遅延は、 外部ト リガ信号の立ち上がり

から測定されます。

遅延 幅

RF出力

外部ト リガ

2番目のパルスの遅延は、 最初のパルスの立ち上がりから

測定されます。

遅延 幅

パルス2パルス2

パルス1パルス1

2番目のパルスの遅延は、 外部ト リガ信号の立ち上がり

から測定されます。

遅延 幅

RF出力

外部ト リガ

最初のパルスは外部ト リガ

信号に従います。

パルス1 パルス1
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 パルス変調の使用法 （オプシ ョ ンUNUまたはUNW）
基本的な手順
基本的な手順

1. 信号発生器をプリセッ ト します。

2. 搬送波(RF)周波数を設定します。

3. RF振幅を設定します。

4. 変調を設定します ：

a. パルス源を設定します ： Pulse > Pulse Source > 選択を押します。

b. 選択したパルス源のパラ メ タを設定します ：

5. 変調をオンにします ： Pulse Off Onソフ ト キーをOnにします。

PULSEインジケータが表示され、 変調がオンになったこ とが示されます。

6. 変調された信号を信号発生器から出力します ： フロン ト ・ パネルのRF On Offキーを押します。

RF出力LEDが点灯し、 RF Outputコネク タから信号が送られているこ とが示されます。

「搬送波信号の変調」 （61ページ） も参照して ください。

例

以下の例では、 出荷時設定のパルス源と遅延を使用します。

1. 信号発生器をプリセッ ト します。

2. 周波数を2 GHzに設定します。

3. 振幅を0 dBmに設定します。

4. パルス周期を100 μsに設定します。 Pulse > Pulse Period > 100 > usecを押します。

5. パルス幅を24 μsに設定します。 Pulse > Pulse Width > 24 > usecを押します。

6. パルス変調とRF出力をオンにします。

PULSEインジケータが表示され、 RF出力LEDが点灯します。

変調が正常に行われていないよ うであれば、 「RF出力に変調がない」 （316ページ） を参照して ください。

方形 フ リーラン （デフォルト ） ト リ ガ 調整可能な ダブレッ ト ト リガ ・ ダブレッ ト ゲーティ ッ ド 外部

パルス・レート ― ― ― ― ― ―

― パルス周期 ― ― ― パルス周期 ―

― パルス遅延 パルス遅延 パルス遅延 パルス遅延 ― ―

― パルス幅 パルス幅 パルス幅 パルス幅 パルス幅 ―

― ― ― パルス2遅延 ― ― ―

― ― ― パルス2幅 ― ― ―

出力 ： 100 μs周期の24μsパルスによって変調された2 GHz、 0 dBmの搬送波。
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パルス変調の使用法 （オプシ ョ ンUNUまたはUNW）
例
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7 基本的なデジタル動作 ： BBGオプシ ョ ンを

インストールしない場合

注記 N5162Aでは、本書に記述されているソフ ト キー・ メニューと機能は、 WebイネーブルMXGまたはSCPIコマンド

経由でのみ使用できます。WebイネーブルMXGの詳細については、『インス トール・ガイ ド』、『プログラ ミ ング ・

ガイ ド』、 『SCPI Command Reference』 を参照して ください。

こ こに記載の内容を理解するには、 信号発生器の基本動作についての知識が必要です。 パワーレベルや周波数の設定など

の機能に慣れていない場合は、 第3章 「基本操作」 （41ページ） を参照して、 内容をよ く理解してください。

「デュアルARB波形へのリ アルタイム ・ ノ イズの追加」 （249ページ） も参照してください。
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基本的なデジタル動作 ： BBGオプシ ョ ンをインストールしない場合
I/Q変調
I/Q変調

エラー ・ ベク トル振幅に寄与する要因と しては、 以下があ り ます。

• IチャネルとQチャネル間の振幅差、 位相差、 遅延差

• DCオフセッ ト

I/Qメニューに、 I信号とQ信号の差の一部を補正したり、 ノ イズを追加するための調整機能があ り ます。

「搬送波信号の変調」 （61ページ） も参照して ください。

図7-1　 I/Q表示とソフ トキー

以下の表に、 調整の一般的な用途を示します。

表7-1　 I/Q調整の用途

I/Q調整 効果 悪影響

オフセッ ト 搬送波フ ィードスルー DCオフセッ ト

直交角度

EVM誤差 位相スキュー

I/Qイ メージ I/Q経路遅延

このパネルに、 外部I/Q信号のルーテ ィ ング

が表示されます。

このパネルに、 I/Q調整の現在の状態と設定が表示されます。

グレーのテキストの場合は、 I/Q調整はオフになっています。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

I信号の位相を基準にしてQ信号の位相をオフセッ ト します。 直交位相調

整キーは、 °単位を使用します。 この調整は校正されていません。

DCオフセッ ト を設定します。
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基本的なデジタル動作 ： BBGオプシ ョ ンをインストールしない場合
I/Q変調
フロン ト ・ パネル入力の設定

Agilent MXGは、 フロン ト ・パネルのI InputとQ Inputで外部供給のアナログI信号とアナログQ信号を受信し、 それらの信

号で搬送波を変調します。

1. I信号とQ信号をフロン ト ・ パネルのコネクタに接続します。 電圧レベルについては、 「フロン ト ・ パネルの概要 ：

N5181A/82A MXG」 （5ページ） を参照して ください。

a. アナログI信号を信号発生器のフロン ト ・ パネルのI Inputに接続します。

b. アナログQ信号を信号発生器のフロン ト ・ パネルのQ Inputに接続します。

2. I/Q変調器をオンにします。 I/Q Off Onを押してOnにします。

3. RF出力を設定します。

a. 搬送波周波数を設定します。

b. 搬送波振幅を設定します。

c. RF出力をオンにします。

4. 必要に応じてI/Q信号を調整します （136ページ）。
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基本的なデジタル動作 ： BBGオプシ ョ ンをインストールしない場合
I/Q変調
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8 基本的なデジタル動作 （オプシ ョ ン651/652/654）

注記 N5162Aでは、本書で説明するソフ ト キーのメニューと機能は、WebイネーブルMXGまたはSCPIコマンドを介し

てのみ使用できます。 WebイネーブルMXGについては、 『Installation Guide』、 『Programming Guide、 『SCPI
Command Reference』 を参照してください。

こ こに記載の内容を理解するには、 信号発生器の基本動作についての知識が必要です。 パワーレベルや周波数の設定など

の機能に慣れていない場合は、 第3章 「基本操作」 （41ページ） を参照して、 内容をよ く理解してください。

本章で説明する機能は、 オプシ ョ ン651、 652、 または654を備えたベク トル信号発生器でのみ使用するこ とができます。

• 「波形ファ イルの基本」 （140ページ）

• 「波形セグメン トの保存、 ロード、 再生」 （142ページ）

• 「波形シーケンス」 （145ページ）

• 「波形の設定とパラ メータの保存」 （149ページ）

• 「波形マーカの使用」 （155ページ）

• 「波形の ト リガ」 （172ページ）

• 「波形のク リ ッピング」 （179ページ）

• 「波形のスケーリ ング」 （188ページ）

• 「ベースバンド周波数オフセッ トの設定」 （194ページ）

• 「I/Q変調」 （198ページ）

• 「I/Q調整」 （201ページ）

• 「I/Q校正」 （203ページ）

• 「イ コライゼーシ ョ ン ・ フ ィルタの使用」 （205ページ）

• 「デュアルARB リ アルタイム変調フ ィルタでのFIR （有限インパルス応答） フ ィルタの使用」 （207ページ）

• 「FIRテーブル ・ エディ タを使用したFIRフ ィルタの変更」 （213ページ）

• 「 リ アルタイム変調フ ィルタの設定」 （217ページ）

• 「複数のベースバンド ・ ジェネレータ同期」 （218ページ）

• 「オプシ ョ ン 012 （位相コ ヒーレンス用の LO 入力／出力） と複数のベースバンド ・ ジェネレータ同期について」 （225
ページ）

• 「ファームウェア ・ バージ ョ ン ≧A.01.50の波形ライセンス」 （229ページ）

• 「ファームウェア ・ バージ ョ ン < A.01.50の波形5パッ ク ・ ラ イセンス （オプシ ョ ン221～229）」 （237ページ）
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
波形ファイルの基本
関連項目 ：

• 「デュアルARB波形へのリ アルタイム ・ ノ イズの追加」 （249ページ）

• 「 リ アルタイム位相雑音信号劣化」 （258ページ）

• 「マルチトーン/2 トーン波形 （オプシ ョ ン430）」 （295ページ）

波形ファイルの基本

2種類の波形ファ イルがあ り ます。

• セグメン トは、 信号発生器にダウンロードする波形ファイルです。

波形ファ イルの作成方法とダウンロード方法については、 『Programming Guide』 を参照して ください。

• シーケンスは、 信号発生器でユーザが作成するファイルで、 1つ以上の波形ファ イル （セグメン ト 、 別のシーケンス、

または両方） へのポインタを含んでいます。

シーケンスの作成方法については、 145ページを参照してください。

信号発生器のメモリ

信号発生器には2種類のメモ リがあ り ます。

• 揮発性メモ リ。ベースバンド ・ ジェネレータ （BBG） の媒体で、 こ この波形ファ イルを使って再生や編集を行います。

• 不揮発性メモ リ。 内部 （int） または外部 （USB） の媒体で、 こ こに波形ファ イルを保存します。

デュアルARBプレーヤ

注記 MXGの ARB波形ファ イルのキャ ッシュは 128 ファ イルに制限されています。 その結果、 128 ファ イルのキャ ッ

シュ ・ リ ミ ッ ト に達する と、 追加ファ イルが揮発性波形メモ リ （BBG） にロード されるため波形スイ ッチング

速度が大幅に遅くな り ます。

デュアルARB波形プレーヤを使用する と、 （外部または内部） 波形ファ イルの再生、 リネーム、 削除、 保存、 ロード と、 波

形シーケンスの作成が可能です。 デュアルARB波形プレーヤには、 マーカ （155ページ） 機能、 ト リ ガ （172ページ） 機

能、 ク リ ッピング （179ページ） 機能、 スケーリ ング （188ページ） 機能もあ り ます。

このセクシ ョ ンのほとんどの手順は、 以下に示すDual ARBメニューからスタート します。
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波形ファイルの基本
図8-1　Dual ARBのソフ トキー

249ページ

179ページ

188ページ

179ページ

142ページ

デュアルARBがオフのときにARBサンプル ・ クロッ クを設定

した場合は、 新しい設定はデュアルARBプレーヤをオンにし

たときに適用されます。 この設定は、 デュアルARBプレーヤ

のオフとオンを切り替えても有効のままです。

49ページ

149ページ

172ページ

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

注記 ： これは、 2つの

Arbメニューの

最初です。

注記 ： これは、 2つのArb
メニューの2番目です。

145ページ

194ページ

188ページ

188ページ

197ページ

218ページ

これらのソフ トキーは、

Dual ARB Arb Setupメニュー

でのみ使用できます。

155ページ

N5162A/82Aオプシ ョ ン22xで
使用できます。

237ページ

218ページ
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波形セグメン トの保存、 ロード、 再生

注記 MXGの ARB波形ファ イルのキャ ッシュは 128 ファ イルに制限されています。 その結果、 128 ファ イルのキャ ッ

シュ ・ リ ミ ッ ト に達する と、 追加ファ イルが揮発性波形メモ リ （BBG） にロード されるため波形スイ ッチング

速度が大幅に遅くな り ます。

こ こに記載の内容を理解するには、 信号発生器のファ イル ・ メニューについての知識が必要です。 ファイル ・ メニューに

ついて理解するには、 「ファ イルの操作」 （63ページ） を参照して ください。

以下も参照して ください。 「波形シーケンス」 （145ページ）

信号発生器には2種類の波形媒体があ り ます。 不揮発性 （内部またはUSB） と揮発性 （BBG） です。 BBG媒体は作業媒体

と も呼ばれます。 波形ファ イルを再生したり、 編集した り、 シーケンスに含めたりするには、 最初に波形ファ イルをBBG
媒体にロードする必要があるからです。

図8-2　波形セグメン トのソフ トキー

波形セグメン ト をBBG媒体にロードする

波形を再生したり、 編集した り、 シーケンスに含めたりするには、 波形がBBG媒体に存在している必要があ り ます。 信号

発生器の電源を入れ直したり、 信号発生器を リブート した りする と、 BBG媒体のファイルが削除されます。

注記 測定器の電源を入れるたびに、 2個の工場提供セグメン ト RAMP_TEST_WFMと SINE_TEST_WFMが、 BBG媒体に自

動的に作成されます。

メモ リにロード可能な追加のサンプル波形が内部ス ト レージにあ り ます。 工場設定のN5182A と波形について

は、 www.agilent.comをご覧ください。

1. Mode > Dual ARB > Select Waveform > Waveform Segmentsを押します。

155ページ

各キーの詳細については、 42ページの説明に従ってキーの

ヘルプを使用して く ださい。

注記 ： シーケンスを選択すると、 このキーの名前が

Show Waveform Sequence Contentsに変わります。

矢印キーまたはノブを使用して文字

やキャラクタを強調表示します。

これらのキーが変化し、 デフォルト媒体が示されます。

デフォルト媒体の選択方法については、

74ページを参照して く ださい。
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2. Load Storeを押してLoadを強調表示し、 矢印キーを使って必要な波形セグメン ト を強調表示します。

3. 現在選択している媒体にこのセグメン トのコピーがすでに存在し、 それを上書きした くない場合は、 ロードする前に

波形セグメン ト を リネームします （前の手順を参照してください）。

4. Load Segment From （現在選択している） Mediaを押します。

現在選択している媒体からBBG媒体にすべてのファ イルをロードするには、 Load All From （現在選択している） Media
を押します。

波形セグメン ト を内部またはUSB媒体に保存／リネームする

BBGメモ リ内のファイルのコピーを現在選択している媒体 （74ページ） に保存するには、 以下の手順を使用します。 波形

セグメン ト をダウンロード していない場合は、 『Programming Guide』 を参照するか、 工場提供セグメン ト を使用してく

ださい。

1. Mode > Dual ARB > Select Waveform > Waveform Segmentsを押します。

2. Load Storeを押してStoreを強調表示します。

3. 矢印キーを使って保存する波形セグメン ト を強調表示します。

4. 任意でセグメン ト を リネームします。

現在選択している媒体にこのセグメン トのコピーがすでに存在し、 それを上書きした くない場合は、 保存する前に波

形セグメン ト を リネームします。

a. More > Rename Segment > Clear Textを押します。

b. 波形セグメン トの名前を入力します。

c. Enter > Moreを押します。

d. リ ネームされた波形セグメン ト を強調表示します。

5. Store Segment to （現在選択している） Mediaを押します。

6. 保存するすべてのセグメン トに対してステップ3からステップ5を繰り返します。

BBG媒体のすべてのセグメン ト を現在選択している媒体に保存するには、 Store All to （現在選択している） Mediaを押

します。

波形セグメン ト を再生する

1. Mode > Dual ARB > Select Waveformを押します。

2. Segment on BBG Media列で、 再生する波形セグメン ト を強調表示します。

3. Select Waveformを押します。

4. ARB Off OnをOnに設定します。

これによ り選択した波形セグメン トが再生されます。 I/Qインジケータ とARBインジケータがオンにな り、 この波形が

RF搬送波を変調します。
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5. RF出力を設定します。

RF搬送波の周波数と振幅を設定し、 RF出力をオンにします。

波形セグメン トが信号発生器のRF Outputコネクタで使用可能になり ます。

現在の波形選択

アクテ ィブ波形（ARB On）と一緒にインジケータが表示されます。
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波形シーケンス

図8-3　波形シーケンスのソフ トキー

波形シーケンスは、 1つまたは複数の波形セグメン ト または他の波形シーケンス、 あるいは両方に対するポインタを格納

したファイルです。 これによ り、 信号発生器が複数の波形セグメン ト または他のシーケンス、 あるいは両方を再生するこ

とができ、 別の波形を選択するためだけに波形の再生を中止する必要がなくな り ます。

シーケンスを保存する と き、 波形シーケンスがポイン トするセグメン トは自動的に保存されません。 個々のセグメン ト も

保存する必要があ り ます。 そ うでないと、 信号発生器をオフにするかリブート したと きにセグメン トが失われます。 セグ

メン トが内部／外部媒体に存在する場合は、 波形シーケンスを選択する前にセグメン ト をBBG媒体にロードする必要があ

り ます （142ページを参照）。 セグメン ト をBBG媒体にロード していない状態でシーケンスを再生しよ う とする と、 信号発

生器がERROR:629, File format invalid （ファ イル ・ フォーマッ トが無効） を報告します。 これが発生し、 セグメン

トが内部／外部媒体に保存されていない場合は、 同じファイル名を使用してシーケンスがポイン トするセグメン ト を再作

成する と、 シーケンスを再生するこ とができます。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

Mode >
デュアルARB

シーケンス名

シーケンスの内容

168ページを参照

このソフ トキーを表示するには、 波形シーケンスを選択します。

これは2番目の

Arbメニューです。
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シーケンスを作成する

波形シーケンスは、最大1,024個のセグメン ト を格納し、 セグメン ト とその他のシーケンス （ネス ト構造シーケンス） の両

方を持つこ とができます。 信号発生器を使用する と、 再生中にセグメン ト とネス ト構造シーケンスが繰り返す回数を設定

するこ とができます。 ただし、 セグメン トの繰り返し とネス ト構造シーケンスの繰り返しには違いがあ り ます。 各セグメ

ン トは最大65,535回繰り返すこ とができますが、 セグメン トは、 繰り返し回数に関係なく、 単一セグメン ト と してカウン

ト されます。 しかし、 ネス ト構造シーケンスの各繰り返しは、 追加のセグメン ト と してカウン ト されます。

ネス ト 構造シーケンスの繰り返し可能回数の最大値は、 ネス ト 構造シーケンス内のセグ メ ン ト 数と、 許容セグ メ ン ト

（1,024） の残りの数によって決ま り ます。 例えば、 24個のセグメン ト と、 4個のセグメン ト を持つ1個のネス ト構造シーケ

ンスを含むシーケンスを使用する場合は、 ネス ト構造シーケンスの繰り返しは250回に制限されます。

24＋(4 ×250) = 1,024、 1シーケンス当たりのセグメン トの最大数

ネス ト構造シーケンスを繰り返すこ とができる最大回数には制限因子があ り ますが、 ネス ト構造シーケンス内の各セグメ

ン トは最大65,535回繰り返すこ とができます。

例

2個の異なるセグメン ト をそれぞれ1回繰り返す波形シーケンスを作成して保存するには、 以下の手順を使用します。

前提条件 ：波形セグメン ト をBBG媒体 （揮発性メモ リ ） に入れます。 波形セグメン トのBBG媒体へのロード方法について

は、 142ページを参照して ください。

1. 最初のセグメン ト を選択します。

a. Mode > Dual ARB > More > Waveform Sequences > Build New Waveform Sequence > Insert Waveformを押します。

b. 目的の波形セグメン ト を強調表示し、 Insertを押します。

2. 2番目のセグメン ト を選択します。

a. 次の目的の波形セグメン ト を強調表示し、 Insertを押します。

b. Done Insertingを押します。

波形

シーケンス

シーケンスA

シーケンスB

シーケンスA
を4回繰り返す

セグメン ト 1

セグメン ト 2

セグメン ト 3

2個のセグメン ト

9個のセグメン ト

11個のセグメン ト

8個のセグメン ト
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3. 波形シーケンスに名前を付け、 Seqファイル ・ カタログに保存します。

a. More > Name and Storeを押します。

b. ファイル名を入力し、 Enterを押します。

「シーケンスの内容を表示する」 （147ページ） と 「波形セグメン トにマーカ ・ ポイン ト を設定する」 （162ページ） も参照

してください。

シーケンスの内容を表示する

波形シーケンスの内容を表示する方法は2通りあ り ます。

Waveform Sequencesソフ トキーを使用する方法

1. Mode > Dual ARB > More > Waveform Sequencesを押します。

2. 目的のシーケンスを強調表示します。

3. Show Waveform Sequence Contentsを押します。

Select Waveformソフ トキーを使用する方法

1. Mode > Dual ARB > Select Waveformを押します。

2. Sequence On列で、 目的の波形シーケンスを強調表示します。

3. Show Waveform Sequence Contentsを押します。

シーケンスを編集する

波形シーケンスを編集する際に、 以下を実行するこ とができます。

• 各セグメン ト またはネス ト構造シーケンスを再生する回数を変更する

• セグメン ト またはネス ト構造シーケンスをシーケンスから削除する

• セグメン ト またはネス ト構造シーケンスをシーケンスに追加する

• マーカのオンとオフを切り替える （168ページで説明）

• 変更を現在の波形シーケンスに保存するか、 新しいシーケンス と して保存する

変更を保存しないでシーケンス編集メニューを終了する と、 変更が失われます。

シーケンスはSeqファイル ・ カタログに保存されます。

注意 シーケンスで使用しているセグメン ト を編集して再セーブした場合は、 シーケンスはヘッダの RMS 値を自動的

に更新しません。 シーケンスのヘッダ情報 （149ページ） を選択して更新する必要があ り ます。

2つの異なるセグメン ト を持つシーケンスを、最初のセグメン ト を100回繰り返し、 2番目のセグメン ト を200回繰り返すよ

うに編集して、 変更を保存するには、 以下の手順を使用します。

前提条件：2つの異なるセグメン ト を持つ波形シーケンスを作成し、保存します（146ページの前の例を参照してください）。

1. シーケンスを選択します。

Mode > Dual ARB > More > Waveform Sequences > 目的のシーケンスを強調表示する > 
Edit Selected Waveform Sequenceを押します。
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2. 100回繰り返すよ うに最初のセグメン ト を変更します。

最初のセグメン ト ・ エン ト リ を強調表示し、 Edit Repetitions > 100 > Enterを押します。

カーソルが次のエン ト リに移動します。

3. 選択したエン ト リの繰り返しを200に変更します。

Edit Repetitions > 200 > Enterを押します。

4. 前の手順で行った変更を保存します。

More > Name and Store > Enterを押します。

変更を新しいシーケンス と して保存するには ：

a. More > Name and Store > Clear Textを押します。

b. ファイル名 （例えば、 SINE100＋RMP200） を入力します。

c. Enterを押します。

編集したシーケンスが新しい波形シーケンス と して保存されます。

シーケンスを再生する

波形シーケンスを作成していない場合は、 「シーケンスを作成する」 （146ページ） を参照して ください。

注記 波形セグメン ト を個別に、 または波形シーケンスの一部と して再生するには、 セグメン トが BBG 媒体に存在す

る必要があ り ます。 「波形セグメン ト をBBG媒体にロードする」 （142ページ） も参照して ください。

1. 波形シーケンスを選択します。

a. Mode > Dual ARB > Select Waveformを押します。

b. Sequence On列から波形シーケンス （この例ではSINE100＋RMP200） を強調表示します。

c. Select Waveformを押します。

表示に現在選択されている波形が示されます （例えば、 Selected Waveform:SEQ:SINE100+RMP200）。

2. 波形を生成します。

ARB Off Onを押してOnにします。

これによ り選択した波形シーケンスが再生されます。波形シーケンスの生成中、 I/Qインジケータ とARBインジケータ

がオンになり、 この波形がRF搬送波を変調します。

現在の波形選択

アクティブ波形（ARB On）と一緒にインジケータが表示されます。
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3. RF出力を設定します。

a. RF搬送波周波数を設定します。

b. RF出力振幅を設定します。

c. RF出力をオンにします。

波形シーケンスが信号発生器のRF OUTPUTコネクタで使用可能になり ます。

波形の設定とパラメータの保存

こ こでは、 ファ イル ・ヘッダの編集方法と保存方法について説明します。波形ファイル （I/Qデータ、信号発生器が波形セ

グメン ト と して処理） を単にダウンロードする場合は、 信号発生器がファ イル ・ ヘッダと、 波形ファ イルと同じ名前を持

つマーカ・ファ イルを自動的に生成します。最初はファ イル・ヘッダには、信号発生器の設定は保存されていません。マー

カ ・ ファ イルはすべてゼロから成り ます。 所定の波形に対して、 信号発生器の設定とパラ メータをファ イル ・ ヘッダに、

マーカ設定をマーカ ・ ファ イル （155ページ） に保存するこ とができます。保存されている波形ファイルをBBG媒体にロー

ドする と き、 ファ イル ・ ヘッダとマーカ ・ ファ イルの設定が信号発生器に自動的に適用されるので、 波形ファイルを再生

するたびにデュアルARBプレーヤが同じ方法をセッ ト アップします。

図8-4　ヘッダ ・ ユーテ ィ リテ ィのソフ トキー

波形シーケンスを作成する と （146ページで説明） 、 信号発生器が波形シーケンス ・ ヘッダを自動的に作成します。 波形

シーケンス ・ ヘッダは個々の波形セグメン ト ・ ヘッダよ り も優先されます。 波形シーケンスの再生中、 必要なオプシ ョ ン

がすべてインス トールされているか確認する場合以外は、 セグメン ト ・ ヘッダは無視されます。 波形シーケンスを保存す

る と、 ファ イル ・ ヘッダも保存されます。

ファ イル ・ヘッダに示された現在の信号発生器設定のいくつかは、 ソフ ト キー ・ ラベルの一部と して表示され、 その他は

以下の例に示すよ うに、 デュアルARBサマリ ・ ディ スプレイに表示されます。

152ページ

Mode > Dual ARB >
More > Header Utilities

各キーの詳細については、 42
ページの説明に従ってキーの

ヘルプを使用して く ださい。
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表8-1　 フ ァイル ・ ヘッダのエン ト リ

Description （32文字） 波形機能など、 ヘッダ用に入力された説明 （Edit Descriptionソフ ト キーを使って保存／編集、 図8-4を参照） です。

Sample Rate 波形再生レートです。 これは、 Arb Setup メニュー （図8-1 （141ページ） を参照） に設定されているARBサンプリ ング ・ ク

ロ ッ ク ・ レートです。

Runtime Scaling ランタイム ・ スケーリ ング値は、 波形の再生中にリ アルタイムで適用されます。 この設定は、 デュアルARBプレーヤで再生

中のファイルに対してのみ変更できます （191ページを参照）。

RMS 変調器の減衰設定 （141ページを参照） をAutoに設定する と、 ACPRを最適化する際のI/Q変調器の減衰設定の計算に、 この

値が使用されます。 値 ： 0～1.414213562

Marker 1...4 Polarity マーカ極性は、 正または負です （168ページで説明）。

ALC Hold Routing マーカが存在する と、 マーカがALCホールド機能 （157ページで説明） を実行し、 マーカ信号がローのと きにALCを現在の

レベルに保持します。 信号発生器で生成されるすべての波形には、 最初のサンプル ・ ポイン トにマーカがあ り ます。 3つの

ルーティング選択の結果を表示するには、サンプル （マーカ） ポイン トの範囲を選択する必要があ り ます （「波形セグメン ト

にマーカ ・ ポイン ト を設定する」 （162ページ） を参照）。

RF Blank Routing マーカが存在する と、 マーカ信号がローのと きに、 マーカがRFブランキング機能 （166ページで説明） を実行します。 RFブ

ランキングではALCホールド も使用されます。 RFブランキング ・ルーティング機能を使用している場合は、 同じマーカに対

してALCホールド ・ ルーティングを選択する必要はあ り ません。 マーカ信号がハイに移行する と、 Ｒ Ｆブランキングが終了

します。

Mod Attenuation I/Q変調器の減衰設定です （図8-1 （141ページ） に示すArb Setupメニューで設定します）。

BB Freq Offset ベースバンド周波数オフセッ ト （単位Hz） です （194ページを参照）。

AWGN: State リ アルタイム ・ ノ イズがオン （1） かオフ （0） かを示します （249ページを参照）。

ARB サマリ、ファイル・ヘッダ設定
ソフ トキー・ラベル、

ファイル・ヘッダ設定

ソフ トキー・ラベル、

ファイル・ヘッダ設定

このメニューのすべての設定をファイル・ヘッダに保存する

ことができます （表8-1 （150ページ） に、 フ ァイル ・ ヘッダ

に保存されているすべての設定が表示されます）。

Runtime Scalingソフ

トキーは、Dual ARB
メ ニ ューの下での

み使用できます。

194ページを参照
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ヘッダ情報を表示／変更する

以下の例では、 工場提供波形ファ イルRAMP_TEST_WFMを使用します。

1. BBG媒体から、 波形RAMP_TEST_WFMを選択します。

a. Mode > Dual ARB > Select Waveformを押します。

b. Segment On列で、 波形RAMP_TEST_WFMを強調表示します。

c. Select Waveformを押します。

2. Header Utilitiesメニューを開きます。

More > Header Utilitiesを押します。

図8-5に、 工場提供波形RAMP_TEST_WFMのデフォル ト ・ フ ァ イル ・ヘッダを示します。 Header Field列に、 ファ イ

ル ・ ヘッダのパラ メータが表示されます。 パラ メータをすべて見るにはPage Downキーを使用します。

Saved Header Settings列に、 設定のほとんどがUnspecifiedであるこ とが示されます。 Unspecifiedは、 そのパラ

メータに対して保存されている設定がないこ とを意味します。

Current Inst. Settings列に現在の信号発生器の設定が表示されます。 この例では、 これらの設定をファ イル ・

ヘッダに保存します。

注記 ファ イル ・ ヘッダで設定が未指定の場合は、 波形を選択して再生する と、 信号発生器はその設定に対して現在

の値を使用します。

AWGN: C/N Ratio 搬送波対雑音比 （dB単位） です （254ページを参照）。

AWGN: Carrier BW ノ イズ ・ パワーを積分する帯域幅 （単位Hz） です （254ページを参照）。

AWGN: Noise BW 雑音帯域幅 （単位Hz） です （254ページを参照）。

AWGN: Carrier RMS 搬送波帯域幅での搬送波RMSです （254ページを参照）。

Phase Noise State 位相雑音がオン （1） かオフ （0） かを示します （258ページを参照）。

Phase Noise F1 中間周波数特性のレベルの開始周波数です （258ページを参照）。

Phase Noise F2 中間周波数特性のレベルの終了周波数です （258ページを参照）。

Phase Noise Lmid 中間周波数特性のレベルの振幅です （258ページを参照）。

Modulation Filter 選択されている リ アルタイム変調フ ィルタのタイプです （217ページを参照）。

OverRange Protect DACオーバレンジ保護がオン （1） かオフ （0） かを示します （262ページを参照）。

Unique Waveform Id 0 = IDなしです。 割り当てたIDを変更するこ とはできません。

License Required 波形の再生にライセンスが必要かど うかを示します。以下も参照してください。「オプシ ョ ン／ライセンスの表示」（38ページ）

Can be Read Out SCPIまたはFTPを介して波形をクエ リできるかど うかを示します。

表8-1　 フ ァイル ・ ヘッダのエン ト リ （続き）
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図8-5　サンプル ・ ファイル ・ ヘッダ

3. Current Inst. Settings列の情報をファ イル ・ ヘッダに保存します。

Save Setup To Headerを押します。

Saved Header Settings列とCurrent Inst. Settings列に同じ値が表示されています。Saved Header Settings
列に、 ファイル ・ヘッダに保存された設定が表示されます。

4. 設定を編集し、 更新します。

a. ARB Setupメニューに戻り ます。

Return > More > ARB Setupを押します。

このメニューから、ファ イル・ヘッダに保存されている信号発生器の設定の一部にアクセスできます。図8-1 （141
ページ） に、 以下の手順で使用するARB Setupのソフ ト キーを示します。

b. ARBサンプル ・ ク ロ ッ クを5 MHzに設定します。

ARB Sample Clock > 5 > MHzを押します。

c. 波形ランタイム ・ スケーリ ングを60％に設定します。

Waveform Runtime Scaling > 60 > %を押します。

d. Header Utilitiesメニューに戻り ます。

Return > More > Header Utilitiesを押します。

以下の図に示すよ うに、 Current Inst. Settings列に現在の信号発生器のセッ ト アップに対する変更が反映さ

れますが、 保存されているヘッダ値は変更されていません。

波形ファイルの名前

説明の長さは最大32文字です。

Mode > Dual ARB > More > Header Utilities

デフォルトのヘッダ設定 現在の信号発生器の設定

保存されているヘッダ設

定エン ト リをデフォルト

設定にリセッ ト します。

RMS波形電圧を計算するには ：

Calculateを押します。

次にHeader Field情報を参照します。

注記：波形の立ち上がり／立ち下がり時間が長いか、DCオフセッ トがあるか、 ノ イズ*
がすでに波形に追加されている場合 （バースト信号の場合） は、 測定確度を高めるた

めにEdit RMSソフ トキーと Edit AWGN RMS Overrideソフ トキーを使用することをお勧

めします。

*オプシ ョ ン403 Realtime AWGNは、 Header FieldのRMS値に影響しません 。 しかし、 信

号発生器にダウンロード して再生する前に波形に追加されたノイズは、Header Fieldの
RMS値に影響します。

メニューを開いて、Header Fieldに
AWGN:Carrier RMS値の計算に

使用する搬送波RMS値を手動で

定義します。
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e. 現在の設定をファイル ・ ヘッダに保存します。

Save Setup To Headerソフ ト キーを押します。

Current Inst. Settings列からの設定がSaved Header Settings列に表示されています。 これによ り、 新し

い現在の機器設定がファイル ・ ヘッダに保存されます。

波形ファイルを選択した後でファ イル ・ ヘッダに表示された信号発生器の設定を変更した場合は、 変更された設定がヘッ

ダのCurrent Inst. Settings列に表示され、保存されているヘッダ設定の代わりに使用されます。保存されているヘッ

ダ設定を再度適用するには、 再生用の波形を選択し直します。

波形を選択せずにヘッダを表示／編集する

151ページで説明したよう に、波形を選択した後、波形のヘッ ダ情報を表示／編集するこ と ができます。波形ヘッ ダ情報は、

波形を選択しな くても編集できます。 現在選択している波形とは別の波形の波形ヘッダ情報を編集するこ と も可能です。

1. ファイル ・ヘッダのユーティ リ ティ ・ メニューにアクセスします。

Mode > Dual ARB > More > Header Utilities > More > Select Different Headerを押します。

信号発生器は、最後に選択した媒体に存在する波形ファイルのアルファベッ ト順のリ ス ト を表示します。以下の図に、

BBG媒体内の工場提供波形の例を示します。

値は、 2つの列で異なります
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2. 目的のカタログが表示されていない場合は、 カタログを選択します。

3. 目的の波形ファイルを強調表示し、 Select Headerを押します。

信号発生器が、 選択した波形ファ イルのファイル ・ ヘッダを表示します。

4. ヘッダを編集するには、 Moreを押し、 ステップ4 （152ページ） （「ヘッダ情報を表示／変更する」 セクシ ョ ン） の説明

に従って手順を進めます。

アクテ ィブ波形カタログ

アクテ ィブ媒体

タイプ ：

WFM1 = 揮発性セグメン ト

NVWFM = 不揮発性セグメン ト

SEQ = シーケンス

アクテ ィブ ・ カタログ

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

カタログ。アクテ ィブ媒体内のファイ

ルを表示できます。

アクテ ィ ブ媒体の選択の詳細につい

ては、 65ページを参照して ください。

BBG媒体内のファイル
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波形マーカの使用

信号発生器には、 波形セグメン トの特定のポイン ト をマーキングするための4個の波形マーカがあ り ます。 信号発生器が

オンのマーカに遭遇する と、 補助信号が、 マーカ番号に対応する リ ア ・ パネル ・ イベン ト出力にルーティングされます。

• イベン ト 1は、 EVENT 1 BNCコネク タ （19ページを参照） とAUXILIARY I/Oコネク タのピン （20ページを参照） の両

方で使用可能です。

• イベン ト 2は、 TRIG OUT BNCコネク タ （16ページを参照） とAUXILIARY I/Oコネク タのピン （20ページを参照） の

両方で使用可能です。

• イベン ト 3と4は、 AUXILIARY I/Oコネク タのピン （20ページを参照） で使用可能です。

補助出力信号は、 も う 1つの測定器と波形を同期するため、 または波形の所定ポイン トで測定を開始するための ト リガ信

号と して使用するこ とができます。

ALCホールドまたはRFブランキング （ALCホールドを含みます） を開始するためにマーカを設定するこ と もできます。 詳

細については、 「波形マーカの使用」 （155ページ） を参照してください。

関連するマーカ・ファ イルがない波形ファ イルをダウンロードする と、信号発生器はマーカ・ポイン トのないマーカ・ファ

イルを作成します。 工場提供セグメン ト （RAMP_TEST_WFMとSINE_TEST_WFM） の場合は、 最初のサンプルに4個すべての

マーカのマーカ ・ ポイン トがあ り ます。

以下の手順では、 デュアルARBプレーヤでの作業中のマーカの使用方法を示します。 これらの手順で、 マーカ ・ ポイン ト

とサンプル ・ ポイン トの2種類のポイン トについても説明します。 マーカ ・ ポイン トは、 与えられたマーカが波形に設定

されているポイン トです。 各マーカに対して1つ以上のマーカ ・ ポイン ト を設定するこ とができます。 サンプル ・ ポイン

トは、 波形を構成する多数のポイン トの1つです。

波形マーカの使用には、 3つの基本的な手順があ り ます。

「マーカ ・ ポイン ト を波形セグメン トから ク リ アする」 （161ページ）

「波形セグメン トにマーカ ・ ポイン ト を設定する」 （162ページ）

「波形シーケンスのマーカを制御する」 （168ページ）

こ こでは、 以下の情報についても説明します。

• 「波形マーカの概念」 （156ページ）

• 「マーカ ・ ユーティ リ ティにアクセスする」 （160ページ）

• 「波形セグメン トのマーカを表示する」 （161ページ）

• 「マーカ ・ パルスを表示する」 （165ページ）

• 「RFブランキング ・ マーカ機能を使用する」 （166ページ）

• 「マーカ極性を設定する」 （168ページ）
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 155



基本的なデジタル動作 （オプシ ョ ン651/652/654）
波形マーカの使用
波形マーカの概念

信号発生器のデュアルARBには、 波形セグメン トで使用するための4個の波形マーカがあ り ます。 各マーカの極性とマー

カ ・ ポイン ト を （単一サンプル ・ ポイン ト またはある範囲のサンプル ・ ポイン トに） 設定するこ とができます。 各マーカ

は、 ALCホールド、 またはRFブランキングとALCホールドを実行するこ と もできます。

マーカ信号レスポンス

信号発生器は、マーカ信号をベースバンド ・ジェネレータのI信号とQ信号に一致させます。 しかし、振幅などの設定、フ ィ

ルタ、 RF出力経路内のその他のものによ り、 マーカEVENT出力信号と変調RF出力間に遅延が生じる可能性があ り ます。

マーカEVENT出力信号を使用する場合は、信号 （変調RFを基準にしたマーカ） の遅延を観察し、必要に応じてマーカ ・ポ

イン トの位置、 インクルード遅延 （201ページ）、 または両方を リセッ ト します。

マーカ ・ ファイルの作成

付随するマーカ ・ ファ イルがない波形ファイルをダウンロードする と （ 『Programming Guide』 で説明） 、 信号発生器が

マーカ ・ ファ イルを自動的に作成しますが、 マーカ ・ ポイン トは配置しません。

マーカ ・ ポイン トの編集要件

波形セグメン トのマーカ ・ ポイン ト を変更するには、 セグメン トがBBG媒体に存在する必要があ り ます （ 「波形セグメン

ト をBBG媒体にロードする」 （142ページ） を参照）。

マーカの極性設定とルーティング設定を保存する

マーカの極性設定とルーティング設定は、 再設定するか、 信号発生器をプリセッ トするか、 電源を入れ直すまでそのまま

です。 再生する と きに波形が確実に正しい設定が使用される よ う にするには、 マーカの極性またはルーテ ィ ング （RF
BlankingとALC Hold） を設定し、 情報をファ イル ・ ヘッダ （149ページ） に保存します。

注記 マーカ ・ルーティングと極性設定がファ イル・ヘッダに保存されていない波形を使用する際に、前に再生した波

形がRF Blankingを使用していた場合は、RF BlankingをNoneに設定して ください。Noneに設定しないと、RF出
力がないか、 波形が歪む可能性があ り ます。

Marker
ファイル

Bit N

Marker
極性

Marker N
RF Blank Off On

Marker Nマーカが

ローのときRFを
ブランキング

EVENT N

負

正

Set Marker
On Off

Marker N
ALC Hold Off On

Marker Nマーカが

ローのとき

ALCを維持

信号発生器がオンのマーカ （168ページで説明） に遭遇すると、 補助出力信号が生成され、 リア ・パネ

ルにルーティングされます。

イベン ト 1は、 EVENT 1 BNCコネクタ （19ページを参照） とAUXILIARY I/Oコネクタのピン （20ページを

参照） で使用可能です。

イベン ト 2～4は、 AUXILIARY I/Oコネクタのピン （20ページを参照） で使用可能です。

RF Blank Only:ALC Holdを含みます
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ALC Holdマーカ機能

マーカ機能 （ソフ ト キー ・ ラベルのMarker Routingと して説明） は、 マーカ ・ ポイン ト （162ページ） の設定前でも設定後

でも設定できますが、 マーカ ・ ポイン ト を設定する前にマーカ機能を設定する と、 RF出力でパワー ・ スパイ クまたはパ

ワーの損失が発生します。

アイ ドル周期、 バース ト ・ ランプを含む波形信号の場合、 または拡大したダイナミ ッ ク ・ レンジでRFブランキング （166
ページ） が生じないよ うにしたい場合は、 ALCホールド機能を単独で使用します。

ALCホールド ・ マーカ機能は、 マーカによって設定されたサンプル ・ ポイン トの平均値でALC回路を保持します。 正と負

のどちらのマーカ極性の場合も、 ALCは、 マーカ信号がハイに変化する と きにRF出力信号 （搬送波＋変調信号） をサンプ

リ ングします。

注記 波形の出力振幅に影響する可能性があるので、 ALCホールドを100 msを超えて使用しないでください。 よ り長

い時間間隔については、 「パワー ・ サーチ ・ モード」 （113ページ） を参照して ください。

注意 ALCの不適切なサンプリ ングによ り突然のレべリ ングなし状態が生じ、 RF出力にスパイクが発生して、 DUTま

たは接続されている測定器が損傷するこ とがあ り ます。 この状態を防止するために、マーカを設定して、 ALCが

信号内で遭遇する高いパワー ・ レベルを考慮した振幅でサンプリ ングを行う よ うにします。

正 ： 信号は、 オン ・ マーカ ・ ポイン ト時にサンプリ ングされます。

負 ： 信号は、 オフ ・ マーカ ・ ポイン ト時にサンプリ ングされます。

正の極性
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波形マーカの使用
アベレージングの拡大写真

ALCは、 マーカ信号がハイに変化する と きに波形をサンプリ ン

グし、 サンプリ ングした波形の平均を使用してALC回路を設定

します。

こ こで、 ALCはオン ・ マーカ ・ ポイン ト （正極性） 中にサンプ

リ ングします。

Marker Marker

MarkerMarker

正しい使用例

波形 ： 1022ポイン ト

マーカ ・ レンジ ： 95－97
マーカ極性 ： 正

この例は、波形の最大振幅エリ アをサンプリ ングするよ う設定され

たマーカを示しています。マーカは、波形の最小振幅エリ アの十分

前に設定されています。マーカと波形信号間の応答の差を考慮して

います。

レベリングなしのパルス

不適切な使用例

波形 ： 1022ポイン ト

マーカ ・ レンジ ： 110－1022
マーカ極性 ：正

この例は、 同じ波形のロー部分をサンプリ ングするよ うに設定

されたマーカを示しています。 このレベル用にALC変調器回路

を設定します。 信号発生器が高い振幅のパルスに遭遇する と、

通常、 信号発生器にレベリ ングなし状態が発生します。

MarkerMarker
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
波形マーカの使用
サンプル ・ レンジは信号の最初のポイン トで開始

負のレンジを信号とオフ時間のあいだに設定

不適切な使用例

波形 ： 1022ポイン ト

マーカ ・ レンジ ： 110－1022
マーカ極性 ： 負

この図は、 負極性マーカがオン ・ マーカ ・ ポイン ト時にローに変

化するこ とを示しています。 マーカ信号はオフのポイン ト時にハ

イに変化します。 ALCは、 オフ ・ マーカ ・ ポイン ト時に波形をサ

ンプリ ングします。

マーカ・オン マーカ・オン

よ り高い信号レベルの場合は、オン時間とオフ時間をサンプリ ン

グする と、変調器回路が不適切に設定されます。パルスの最初で

振幅が増加します。

Marker
オフ

マーカ・オン
MarkerMarker

オフ オン
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波形マーカの使用
マーカ ・ ユーテ ィ リテ ィにアクセスする

Mode > Dual ARB > More > Marker Utilities

注記 ： これは2番目の

Arbメニューです。

以下の表示は、 波形のI成分とQ成分、 および工場提供セグメン トに設定された

マーカ ・ ポイン ト を示します。

表示に示された最初

のサンプル・ポイン ト

こ れ ら の ソ フ ト キーは、

マーカ表示に示された波形

サンプル ・ ポイン トのレン

ジを変更します。

ソフ トキーを押すたびにサ

ンプル・レンジが約2の倍数

ずつ変化します。

最初のサンプル・

ポイン トの

マーカ・ポイン ト

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

これらのメニューの設定をフ ァ イ

ル・ヘッダに保存することができま

す。 149ページを参照して く ださい。

49ページ
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
波形マーカの使用
波形セグメン トのマーカを表示する

マーカは、 波形セグメ ン ト に適用されます。 セグ メ ン ト （この例では、 工場提供セグ メン ト SINE_TEST_WFMを使用） の

マーカ ・ セッ ト を表示するには、 以下の手順を使用します。

1. 2番目のArbメニュー （160ページ） で、 Marker Utilities > Set Markersを押します。

2. 目的の波形セグメン ト （この例ではSINE_TEST_WFM） を強調表示します。

3. Display Waveform and Markers > Zoom in Maxを押します。

最大ズームイン ・ レンジは28ポイン トです。

Zoom機能を試して、 マーカがどのよ うに表示されるかを観察します。

最大460ポイン ト を表示できます。 サンプル ・ ポイン トのレンジが460ポイン ト を超える と、 表示波形にマーカ位置が表示

されない場合があ り ます。

マーカ ・ ポイン ト を波形セグメン トからクリアする

マーカ ・ ポイン ト を設定する場合は、 マーカ ・ ポイン トは、 すでに存在するポイン ト と置き換わり ません。 既存のポイン

トに追加して設定されます。 マーカは累積されるので、 ポイン ト を設定する前に、 セグメン ト を表示し （161ページ）、 不

要なポイン ト を除去します。すべてのマーカをク リ アする と、 イベン ト出力信号のレベルは0 Vになり ます。セグメン トの

マーカ ・ ポイン ト をク リ アするには、 セグメン トがBBG媒体 （142ページ） に存在する必要があ り ます。

すべてのマーカ ・ ポイン ト をクリアする

1. 2番目のArbメニュー （160ページ） で、 Marker Utilities > Set Markersを押します。

2. 目的の波形セグメン ト （この例ではSINE_TEST_WFM） を強調表示します。

3. 目的のマーカ番号を強調表示します。 Marker 1 2 3 4を押します。

4. 選択したマーカ番号に対して、 選択したセグメン トのすべてのマーカ ・ ポイン ト を除去します。

a. Set Marker Off Range of Pointsを押します。

最初のマーカ ・ ポイン トのソフ ト キーと最後のマーカ ・ ポイン トのソフ ト キーが、 波形の長さに対応します。 工

場提供波形 （SINE_TEST_WFM） には200個のサンプルが含まれています。 設定されているすべてのマーカ ・ ポイ

ン ト をク リ アするには、 レンジが波形の長さ と等し くなければなり ません。

b. Apply To Waveform > Returnを押します。

5. 他のマーカから削除する残りのマーカ ・ ポイン トに対してステップ3から繰り返します。

マーカ ・ ポイン トのレンジをクリアする

以下の例では、 ポイン ト 10−20にマーカ ・ ポイン ト （Marker 1） が設定された波形を使用します。 これによ り、 影響を受

けるマーカ ・ ポイン ト を簡単に表示するこ とができます。 既存のポイン トがレンジに対して設定されているか、 単一ポイ

ン ト （162ページ） と して設定されているかに関係なく、 同じプロセスが適用されます。

1. 2番目のArbメニュー （160ページ） で、 Marker Utilities > Set Markersを押し、 Marker 1を選択します。

2. オフにする最初のサンプル ・ ポイン ト を設定します （この例では13）。
Set Marker Off Range Of Points > First Mkr Point > 13 > Enterを押します。

3. オフにするレンジの最後のマーカ ・ポイン ト を、波形のポイン ト数以下で、 かつステップ2で設定した値 （この例では

17） 以上の値に設定します。
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波形マーカの使用
Last Mkr Point > 17 > Enter > Apply To Waveform > Returnを押します。

右に示すよ うに、 ステップ2 と 3で設定され

たレンジ内のアクテ ィブ ・ マーカのすべて

のマーカ ・ ポイン トがオフになり ます。

マーカの表示方法については、 161ページで

説明しています。

単一マーカ ・ ポイン ト をク リアする

「マーカ ・ ポイン トのレンジをク リ アする」 （161ページ） に説明した手順を使用しますが、 最初のマーカ ・ ポイン ト と最

後のマーカ ・ ポイン ト を、 ク リ アするポイン トの値に設定します。 例えば、 ポイン ト 5のマーカをク リ アする場合は、 最

初の値と最後の値を5に設定します。

波形セグメン トにマーカ ・ ポイン ト を設定する

セグメン トにマーカ ・ ポイン ト を設定するには、 セグメン トがBBG媒体に存在する必要があ り ます （142ページ）。

マーカ ・ ポイン ト を設定する場合は、 マーカ ・ ポイン トは、 すでに存在するポイン ト と置き換わり ません。 既存のポイン

トに追加して設定されます。 マーカは累積されるので、 マーカ ・ ポイン ト をセグメン ト内に設定する前に、 セグメン ト を

表示し （161ページ）、 不要なポイン ト を除去します （161ページ）。

マーカをポイン トのレンジに配置する

1. 2番目のArbメニュー （160ページ） で、 Marker Utilities > Set Markersを押します。

2. 目的の波形セグメン ト を強調表示します。

3. 目的のマーカ番号を選択します。 Marker 1 2 3 4を押します。

4. レンジの最初のサンプル ・ ポイン ト を設定します （この例では10）。

Set Marker On Range Of Points > First Mkr Point > 10 > Enterを押します。

5. レンジの最後のマーカ ・ ポイン ト を、 波形のポイン ト数以下で、 かつ最初のマーカ ・ ポイン トの値以上の値 （この例

では20） に設定します。

Last Mkr Point > 20 > Enterを押します。

6. Apply To Waveform > Returnを押します。

これによ り波形マーカ ・ ポイン トのレンジが設定されます。 以下の図に示すよ うに、 マーカ信号はサンプル ・ ポイン ト 10
で開始し、 サンプル ・ ポイン ト 20で終了します。

マーカの表示方法については、 161ページで説明しています。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
波形マーカの使用
マーカを単一ポイン トに配置する

最初のポイン ト上

1. 2番目のArbメニュー （160ページ） で、 Marker Utilities > Set Markersを押します。

2. 目的の波形セグメン ト を強調表示します。

3. 目的のマーカ番号を選択します。

Marker 1 2 3 4を押します。

4. Set Marker On First Pointを押します。

これによ り、 ステップ3で選択したマーカ番号に対してセグメン トの最初のポイン トにマーカが設定されます。

任意のポイン ト上

「マーカをポイン トのレンジに配置する」 （162ページ） に説明した手順を使用しますが、 最初のマーカ ・ ポイン ト と最後

のマーカ ・ ポイン ト を、 設定するポイン トの値に設定します。 例えば、 ポイン ト 5にマーカを設定する場合は、 最初の値

と最後の値を5に設定します。

一定間隔でマーカを繰り返し配置する

以下の例では、 ポイン トのレンジにマーカを設定し、 各マーカ間の間隔 （スキップするポイン ト数） を指定します。 マー

カの設定を適用する前に間隔を設定する必要があ り ます。 スキップするポイン ト数を、 前に設定したポイン トのレンジに

適用するこ とはできません。

注記 スキップするポイン ト数の値は、 ポイン トのレンジの大きさに制限されます。

1. 既存のマーカ ・ ポイン ト を除去します （156ページ）。

2. 2番目のArbメニュー （160ページ） で、 Marker Utilities > Set Markersを押します。

3. 目的の波形セグメン ト を強調表示します。

4. 目的のマーカ番号を選択します。

Marker 1 2 3 4を押します。

5. レンジの最初のサンプル ・ ポイン ト を設定します （この例では5）。
Set Marker On Range Of Points > First Mkr Point > 5 > Enterを押します。

6. レンジの最後のマーカ ・ ポイン ト を設定します （最後のマーカ ・ ポイン トの値は、 波形のポイン ト数以下で、 かつ最

初のマーカ ・ ポイン ト以上でなければなり ません （この例では25））。
Last Mkr Point > 25 > Enterを押します。

7. スキップするサンプル ・ ポイン トの数を入力します （この例では1）。
# Skipped Points > 1 > Enterを押します。

8. Apply To Waveform > Returnを押します。
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波形マーカの使用
これによ り、 右に示すよ うに、 マーカがマーカ ・

ポイン ト ・ レンジに1ポイン ト ごとに現れます （1
個のサンプル ・ ポイン トがスキップされます）。

マーカの表示方法については、 161ページで説明

しています。

ポイン ト ・ スキップ機能は、 EVENT出力と して

クロ ッ ク信号を作成する と きなどに使用します。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
波形マーカの使用
マーカ ・ パルスを表示する

波形を再生する際に （148ページ）、設定されたオンのマーカのパルスは、マーカ番号に対応する リ ア ・パネルのイベン ト ・

コネク タ／Aux I/Oピンで検出できます。 この例は、 1個以上のマーカ ・ ポイン トが設定されている波形セグメン ト （162
ページ） によって生成されたマーカ ・パルスの表示方法を示しています。プロセスは、波形シーケンスの場合と同じです。

この例では、 デュアルARBプレーヤで工場提供セグメン ト SINE_TEST_WFMを使用します。 工場提供セグメン トの場合は、

以下に示すよ うに、 最初のサンプル ・ ポイン トに4個すべてのマーカのマーカ ・ ポイン トがあ り ます。

1. 最初のArbメニュー （141ページ） で、 Select Waveformを押します。

2. SINE_TEST_WFMセグメン ト を強調表示し、 Select Waveformを押します。

3. ARB Off Onを押してOnにします。

4. Agilent MXGのリア ・ パネルQ OUT出力をオシロスコープのチャネル1入力に接続します。

5. 信号発生器のリア ・ パネルEVENT 1出力をオシロスコープのチャネル2入力に接続します。

マーカ1が存在する と き、 以下の例に示すよ うに、 Agilent MXGがEVENT 1から信号を出力します。

波形セグメ ン トの最初

のサンプル ・ ポイン ト

のマーカ ・ ポイン ト

マーカの表示方法については、 161ページで説明しています。

Q OUT

Event 1信号のマーカ ・パルス
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波形マーカの使用
RFブランキング ・ マーカ機能を使用する

マーカ機能 （Marker Utilities メニューのソフ ト キー ・ ラベルのMarker Routing と して説明） は、 マーカ ・ ポイン トの設定

前でも設定後 （162ページ） でも設定できますが、 マーカ ・ ポイン ト を設定する前にマーカ機能を設定する と、 RF出力が

変化します。 RFブランキングにはALCホールドが含まれます （157ページで説明しています。 レべリ ングなしパワーに関

する 「注意」 を参照して ください） 。 信号発生器は、 マーカ信号がローに移行する と き、 RF出力をブランキングします。

この例は、 前の例 「マーカ ・ パルスを表示する」 の続きです。

1. 工場提供セグメン ト SINE_TEST_WFMを使用して、 Marker 1のポイン ト範囲1～180を設定します （162ページ）。

2. Marker Routingソフ ト キー ・ メニューから、 RF BlankingをMarker 1に割り当てます。

2番目のArbメニュー （160ページ） で、 Marker Utilities > Marker Routing > Pulse/RF Blank > Marker 1を押します。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
波形マーカの使用
マーカ極性 = 正
マーカ極性が正 （デフォルト設定） の場合は、 オフ ・

マーカ・ポイン ト時にRF出力がブランキングされます。

200180ポイン ト 1
Marker

セグメン ト

RF信号

RF信号

200180ポイン ト 1
Marker

セグメン ト

マーカ極性 = 負
マーカ極性が負の場合は、オン ・マーカ ・ポイン ト時に

RF出力がブランキングされます。

約 3.3V

0V

約 3.3V

0V

RF 信号

RF 信号
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波形マーカの使用
マーカ極性を設定する

負のマーカ極性を設定する と、 マーカ信号が反転します。

1. 2番目のArbメニュー （160ページ） で、 Marker Utilities > Marker Polarityを押します。

2. 各マーカに対して、 目的のマーカ極性を設定します。

• デフォルトのマーカ極性は正です。

• それぞれのマーカ極性は独立して設定できます。

「マーカの極性設定とルーティング設定を保存する」 （156ページ） も参照して ください。

166ページで示したよ うに、

正極性 ：  オンのマーカ ・ ポイン トがハイ （約3.3V） です。

負極性 ：  オンのマーカ ・ ポイン トがロー （0V） です。

RFブランキングは、 極性の設定に関係なく信号のロー部分で発生します。

波形シーケンスのマーカを制御する

波形セグメン トで、 オンになっているマーカ ・ ポイン トは補助出力信号を生成します。 信号は、 マーカ番号に対応する リ

ア ・パネルEVENT出力 （「 リ ア ・パネルの概要： N5161A/62A1/81A/82A MXG」 （15ページ） で説明） にルーティングされ

ます。 波形シーケンスの場合は、 セグメン ト ごとにマーカをオンまたはオフにするこ とができます。 すなわち、 シーケン

スの一部のセグメン トのマーカを出力し、 他のセグメン トのマーカは出力しないよ うにするこ とができます。 シーケンス

のマーカ設定を変更するか、 電源を入れ直さない限り、 シーケンスで編集した最後のセグメン トのマーカ設定が、 作成し

た次のシーケンスのすべてのセグメ ン トに適用されます。 波形シーケンスの作成方法については、 「シーケンスを作成す

る」 （146ページ） を参照して ください。
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波形マーカの使用
図8-6　セグメン トのマーカをオン／オフにするための波形シーケンス ・ メニュー

Mode > Dual ARB > More

注記 ： これは2番目のArbメニューです。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

波形シーケンスの作成中に

マーカをオン／オフ

シーケンスを編集して

マーカをオン／オフ
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波形シーケンスのマーカをオン／オフにする

波形シーケンス内の波形セグメン ト を選択して各セグメン トのマーカを個別にオンまたはオフにします。 マーカは、 シー

ケンスの作成時、 またはシーケンスを作成して保存した後でオンまたはオフにするこ とができます。 シーケンスがすでに

保存されている場合は、 変更後にシーケンスを再度保存する必要があ り ます。 マーカ ・ ポイン トがないマーカをオンにし

ても、補助出力には影響があ り ません。 セグメン トにマーカ ・ポイン ト を設定するには、 「波形セグメン トにマーカ ・ ポイ

ン ト を設定する」 （162ページ） を参照して ください。 この例は、 波形シーケンスが存在する と仮定しています。

1. シーケンスのすべての波形セグメン トがBBG媒体に存在するこ とを確認します （142ページを参照）。

2. 2番目のArbメニューから、 Waveform Sequencesを押します。

3. 目的の波形シーケンスを強調表示します。

4. Edit Selected Waveform Sequence > Enable/Disable Markersを押します。

5. マーカを ト グルします。

a. 最初の波形セグメン ト を強調表示します。

b. 必要に応じて、 Toggle Marker 1、 Toggle Marker 2、 Toggle Marker 3、 Toggle Marker 4を押します。

Mkr列のエン ト リ （以下の図を参照） は、 マーカがセグメン トに対してオンであるこ とを示します。列にエン ト リ

がない場合は、 すべてのマーカがセグメン トに対してオフになっています。

c. 順に、 残りの各セグメン ト を強調表示して、 ステップbを繰り返します。

6. Return > More > Name and Storeを押します。

7. テキス ト入力キーを使用してシーケンスを リネームするか （143ページを参照）、 そのままEnterを押して既存の名前で

シーケンスを保存します。

マーカが選択ごとにオンまたはオフにな り、 変更がシーケンス ・ ファ イルに保存されます。

以下の図に、 工場提供波形セグメン トの1つを使用して作成されたシーケンスを示します。 工場提供セグメン トの場合は、

最初のサンプルに4個すべてのマーカのマーカ ・ ポイン トがあ り ます。 この例では、 最初のセグメン トのマーカ1がオン、

2番目のセグメン トのマーカ2がオン、 3番目のセグメン トのマーカ3と4がオンになっています。

各セグメン トでは、 そのセグメン トに対してオンになっているマーカだけがリ ア ・ パネル補助出力信号を生成します。 こ

の例の場合は、 マーカ1補助信号は、 最初のセグメン トに対してのみ現れます。 他のセグメン トに対してオフになってい

るからです。 マーカ2補助信号は2番目のセグメン トに対してのみ現れ、 マーカ3および4補助信号は3番目のセグメン トに

対してのみ現れます。

シーケンス ・ マーカ列

このエン ト リは、 セグメン トに対し

てマーカ3と4がオンになっているこ

とを示します。
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EVENT出力信号を測定器ト リガと して使用する

EVENT出力信号 （マーカ信号） の用途の1
つは、測定機器のト リガです。波形の先頭、

波形の任意の単一ポイン ト、 または波形の

複数ポ イ ン ト で測定を開始する よ う に、

マーカをセッ ト ア ップする こ とができ ま

す。 測定のためにEVENT信号の使用を最適

化するには、 サンプ リ ング ・ レー トの調整

も必要とな り ます。 図の右に、 サンプ リ ン

グ ・ レート を設定する場所を示します。

EVENT出力信号は、 立ち上がりエッジと立

ち下がりエッジで最大±4 nsのジッ タを示

します。 このジッ タは、以下の2つの方法の

いずれかで減少させるこ とができます。

方法1 ： 125 MHz/Nのサンプル ・ ク ロ ッ クを使用します。 Nは正の整数で、 125 MHz/Nが画面にきっち り納まる必要があ り

ます。

例 ： 125 MHz、 62.5 MHz、 31.25 MHz、 25 MHzなど

結果を画面に正確に表示できない場合は、 ジッ タが存在します。

例 ： N = 6にする と、 125 MHz/6 = 20.833 Mhzとなるためジッ タが存在します。 値は、 表示のと きに切り捨てられます。

方法2 ： マーカの間隔が8 nsの倍数になるよ うに、 サンプル ・ ク ロ ッ ク と波形長を選択します。 例 ：最初のポイン トにマー

カを持つ200ポイン ト波形で、サンプル・ ク ロ ッ クが50 MHzの場合は、 マーカの間隔は4 μsになり ます。 4 μsは8 nsの倍数

なので、 ジッ タを抑えるこ とができます。

EVENT出力信号がジッタを示し、 信号が測定ト リガと して使用されている場合は、 波形が、 ジッ タを持つ波形と して誤っ

て表示されます。 この状態が発生した場合は、 ジッ タが出現しない値 （上を参照） にサンプリ ング ・ レート を調整するこ

とができます。 サンプリ ング ・ レート を変更したと きには元の波形との整合性を保持するために、 サンプル値の再計算も

行う必要があ り ます。 以下の図に、 マーカ信号のジッ タ とジッ タの波形に対する影響を示します。

サンプリン

グ ・ レート

設定

この メ ニ ューの設定を フ ァ イル ・

ヘッダに保存するこ とができます。

149ページを参照して ください。

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。

ジッ タが消えた

（サンプリング・レート を最適化したため）

波形にジッ タがあるように見える

（ジッ タを持つ EVENT 信号を使用してト リガしたため）

オシロスコープが波形を ト リガ オシロスコープが EVENT 信号を ト リガ オシロスコープが EVENT 信号を ト リガ

EVENT 出力信号にジッ タが現れる

（サンプリング・レートが最適でないため）
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波形のト リガ

図8-7　 ト リガのソフ トキー

ト リ ガは、 信号発生器が変調信号を伝送するタイ ミ ングを制御するこ とによ り、 データ伝送を制御します。 データ伝送が

1回だけ発生する （Singleモード）、 連続して発生する （Continuousモード）、 または開始と終了を繰り返す （Gatedモード

とSegment Advanceモード） よ うに ト リガを設定するこ とができます。

ト リガ信号には、 正のステート と負のステートが含まれます。 どちらのステート も ト リガに使用するこ とができます。

ト リガ ・ モードを初めて選択したと きや、 ある ト リ ガ ・ モードから別の ト リガ ・ モードへ変更したと きは、 変調信号がト

リガされるまでRF出力に搬送波信号が現れない場合があ り ます。 これは、 信号発生器が、 最初のト リガ ・ イベン トの前に

I信号とQ信号を0ボルトに設定するからです。 RF出力で搬送波信号を保持するために、 初期I電圧と初期Q電圧をゼロ以外

の値に設定した状態でデータ ・ パターンを作成します。

Arbを初めてオンにしたと きやト リ ガ ・ モードを初めて選択したと き、 またはある ト リ ガ ・ モードから別の ト リガ ・ モー

ドへ変更したと きは、 数十ミ リ秒間、 RF出力に搬送波信号が現れない場合があ り ます。 Arbは、 IQ変調器に次の任意波形

のアイ ドルIQrms値を示します。 これによ り、 Arbが ト リガを待つあいだ、 RF搬送波出力が正しい振幅レベルに保持され

ます。 Arbはト リガを受信する と波形の再生を開始するので、 変調RF搬送波に不要な過渡現象が現れません。

波形ト リガの設定には2つのパートがあ り ます。

• タイプは、 再生する と きの波形の動作を指定します （「 ト リ ガ ・ タイプ」 （173ページ） を参照）。

• 信号源は、 変調波形の再生を開始する ト リガの受信方法を指定します （「 ト リ ガ ・ ソース」 （174ページ） を参照）。

Mode > Dual ARB

173ページ

174ページ

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。
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ト リガ ・ タイプ

タイプは ト リガ ・ モードを定義します。 ト リ ガされたと きの波形の再生方法です。

• Continuous モードは、 信号をオフにするか、 別の波形、 ト リ ガ ・ モード、 またはレスポンスを選択するまで、 波形を

繰り返します （Free Run、 Trigger & Run、 Reset & Run）。

• Singleモードは、 波形を1回再生します。

注記 このセッ ト アップの遅延が変化するため、 Single No RetriggerでContinuous Reset & Runモードを使用しないでく

ださい。

No Retrigger ： ト リ ガを早期に受信した場合は、 ト リ ガが無視されます。 再生のギャ ップは、 ト リ ガ周期に依存しま

す。 その時間が過ぎる と、 RFが期待された場所から再び開始します。

Buffered Trigger ： 早期ト リガによ り、 波形は最後まで再生された後、 再び開始します。 RFは、 この早期ト リガに一致

しません。

Restart on Trigger ： ARBは自動的にリセッ ト し、 再度ト リガしますが、 その間に再生にギャ ップが生じます。 ARBは、

ト リガを受信するたびに自動的にリセッ ト します。

• Segment Advanceモードは、 ト リガされた場合のみ、 シーケンスのセグメン ト を再生します。 ト リガ ・ ソースがセグメ

ン ト ごとの再生を制御します （「例 ： セグメン ト ・ アドバンス ・ ト リ ガ」 （175ページ） を参照）。 最後のセグメン ト ・

ループ中にト リガを受信する と、 シーケンスの最初のセグメン ト まで再生されます。

Mode >
Dual ARB > 
Trigger Type

波形を即座にト リガして再生します。波形の再生中に受信したト リガは

無視されます。

ト リガを受信したときに波形を再生します。 後続のト リガは無視され

ます。

ト リガを受信したときに波形を再生します。 後続のト リガによって波形

がリスタート します。

波形は、 ト リガ ・ ソースの非アクテ ィ ブ ・

ステート中は停止し、 アクテ ィ ブ ・ ステー

ト中に再生されます。

波形の再生中に受信した早

期ト リガは無視されます。

波形の再生中に受信した早期

ト リガが、 現在の波形が完了

するまで待って、 完了後に波

形をも う一度再生します。

波形の再生中に受信した早期

ト リガが、 波形を即座にリス

タート します。

シーケンスのセグメ ン ト を1回再生し

ます。繰り返し設定は無視されます。再

生後、デュアルARBプレーヤは停止して

ト リガを待ち、 ト リガを受信すると次

のセグメン トに進みます。 次のセグメ

ン トが最後まで再生されます。

セグメン トの再生中にト リガを受信し

た場合は、 セグメン トが最後まで再生

されます。その後、デュアルARBプレー

ヤは次のセグメン トに進み、 セグメン

ト を最後まで再生します。

シーケンスのセグメン トは、 波形が別のト リガを受信するまで連続して再生されます。

セグメン トの再生中にト リガを受信した場合は、 セグメン トが最後まで再生されます。

その後、 デュアルARBプレーヤは次のセグメン トに進み、 セグメン ト を連続して再生します。
各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 173



基本的なデジタル動作 （オプシ ョ ン651/652/654）
波形のト リガ
• Gatedモードは、 最初のアクティブ ・ ト リ ガ ・ ステートで波形を ト リガした後、 外部からのゲーティング信号に応答し

て波形の再生の開始と停止を繰り返します。 「例 ： ゲーティ ッ ド ・ ト リ ガ」 （176ページ） を参照してください。

ト リガ ・ ソース

外部ト リガの極性

• Continuousモード、 Singleモード、 Segment Advanceモードでは、 Ext Polarityソフ ト キーを使用して外部ト リガ極性

を設定します。

• Gatedモードでは、Active Lowソフ ト キーとActive Highソフ ト キー （173ページ） が外部ト リガ極性を決定します。

Mode >
Dual ARB > 
Trigger Source

Patt Trig In BNCコネクタ

（19ページを参照）

Aux I/Oコネクタ （20ページを参照）

Neg = 信号発生器はト リガ信号がロー ・

ステートのあいだ応答します。

Pos = 信号発生器はト リガ信号がハイ ・

ステートのあいだ応答します。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

Ext Delayがオンになるまで

キーは非アクテ ィブです。
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例 ： セグメン ト ・ アドバンス ・ ト リガ

セグメン ト ・ アドバンス ・ ト リ ガを使用する と、 波形シーケンス内のセグメン トの再生を制御するこ とができます。 この

タイプの ト リガは、 繰り返し値 （147ページ） を無視します。 例えば、 セグメン トの繰り返し値が50の場合は、 セグメン

ト ・ アドバンス ・ ト リ ガ ・ モード と してSingleを選択する と、 セグメン トは1回だけ再生されます。 以下の例では、 2個の

セグメン ト を持つ波形シーケンスを使用します。

波形シーケンスの作成と保存を行っていない場合は、 「シーケンスを作成する」 （146ページ） を参照して ください。

1. 信号発生器をプリセッ ト します。

2. RF出力を設定します。

• 目的の周波数を設定します。

• 目的の振幅を設定します。

• RF出力をオンにします。

3. 再生する波形シーケンスを選択します。

a. Mode > Dual ARB > Select Waveformを押します。

b. Sequence On列で、 波形シーケンス ・ ファ イルを強調表示します。

c. Select Waveformを押します。

4. ト リ ガを以下のよ うに設定します。

• ト リ ガ ・ タイプ ： 連続セグメン ト ・ アドバンス

Trigger Type > Segment Advance > Continuousを押します。

• ト リ ガ ・ ソース ： Triggerハードキー

Trigger Source > Trigger Keyを押します。

5. 波形シーケンスを生成します。

ARB Off Onを押してOnを強調表示します。

6. （オプシ ョ ン） 波形をモニタします。

信号発生器のRF OUTPUTをオシロスコープの入力に接続し、 信号を表示できるよ うにオシロスコープを設定します。

7. 最初の波形セグメン ト を ト リガして、 連続再生を開始します。

Triggerハードキーを押します。

8. 2番目のセグメン ト を ト リガします。

Triggerハードキーを押します。

Triggerハードキーを押すと、 現在再生中のセグメン トが終了し、 次のセグメン トが開始します。

シーケンスの最後のセグメン ト を再生中の場合は、 Triggerハードキーを押すと、 最後のセグメン トが終了したと きに

波形シーケンスの最初のセグメン トが開始します。
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例 ： ゲーテ ィ ッ ド ・ ト リガ

ゲーティ ッ ド ・ ト リ ガを使用する と、 変調波形のオン ・ ステート とオフ ・ ステート を定義するこ とができます。

1. 以下の図に示すよ うに、 ファンクシ ョ ン ・ ジェネレータの出力を信号発生器のリア ・ パネルPAT TRIG INコネク タに

接続します。 この接続は、 すべての外部ト リガ方法に適用可能です。 オプシ ョ ンでオシロスコープを接続する と、 ト

リガ信号のRF出力に対する影響を表示するこ とができます。

2. 信号発生器をプリセッ ト します。

3. RF出力を設定します。

• 目的の周波数を設定します。

• 目的の振幅を設定します。

• RF出力をオンにします。

4. 再生する波形を選択します （シーケンスまたはセグメン ト ）。

a. Mode > Dual ARB > Select Waveformを押します。

b. Segment On列またはSequence On列で、 波形を強調表示します。

c. Select Waveformを押します。

5. ト リ ガを以下のよ うに設定します。

• ト リ ガ ・ タイプ ： ゲーティ ッ ド

Trigger Type > Gatedを押します。

• アクティブ ・ ステート ： ロー

Active Lowを押します。

• ト リ ガ ・ ソース ： 外部

Trigger Source > Extを押します。

• 入力コネクタ ： リ ア ・ パネルPatt Trig In BNC
Ext Source > Patt Trig In 1を押します。
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6. 波形を生成します。 Return > ARB Off Onを押してOnを強調表示します。

7. ファンクシ ョ ン ・ ジェネレータで、 外部ゲーティング ・ ト リ ガ用のTTL信号を設定します。

8. （オプシ ョ ン） 波形をモニタします。

信号発生器の出力と外部ト リガ信号を表示するためにオシロスコープを設定します。 ゲートのアクティブ周期 （この

例ではロー） 中に波形が出力を変調している様子が表示されます。

以下の図にサンプル画面を示します。

変調波形 RF出力

外部からのゲーティング信号

ゲート ・ アクテ ィブ  = ロー
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波形のト リガ
例 ： 外部ト リガ

以下の例を使用して、PATT TRIG IN リ ア ・パネルBNCコネク タでTTLステートがローからハイへ変化したら、変調RF信号

を100 ミ リ秒出力するよ う信号発生器を設定します。

1. 上に示すよ うに、 信号発生器をファンクシ ョ ン ・ ジェネレータに接続します。

2. RF出力を設定します。

• 目的の周波数を設定します。

• 目的の振幅を設定します。

• RF出力をオンにします。

3. 再生する波形を選択します （シーケンスまたはセグメン ト ）。

a. Mode > Dual ARB > Select Waveformを押します。

b. Segment On列またはSequence On列で、 波形を強調表示します。

c. Select Waveformを押します。

4. 波形を生成します。

ARB Off Onを押してOnを強調表示します。

5. 波形ト リガを以下のよ うに設定します。

a. ト リ ガ ・ タイプ ： シングル

Trigger Type > Single > No Retriggerを押します。

b. ト リ ガ ・ ソース ： 外部

Trigger Source > Extを押します。

c. 入力コネクタ ： リ ア ・ パネルPatt Trig In BNC
Ext Source > Patt Trig In 1を押します。

d. 外部ト リガ極性 ： 正

Ext Polarityを押してPosを強調表示します。

e. 外部遅延 ： 100 ms
More > Ext Delayを押してOnを強調表示します。

Ext Delay Time > 100 > msecを押します。

6. ファンクシ ョ ン ・ ジェネレータを設定します。

• 波形 ： 0.1 Hz方形波

• 出力レベル ： 3.5V～5V
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波形のクリ ッピング
波形のクリ ッピング

高いパワー ・ ピークを持つデジタル変調信号によ り相互変調歪みが発生し、 その結果生じたスペク ト ラム ・ リ グロースが

隣接周波数バンドの信号と干渉する場合があ り ます。 ク リ ッピング機能を使用する と、 Iデータ とQデータを最高ピークの

選択した％まで切り取って高いパワー ・ ピークを下げ、 それによってスペク ト ラム ・ リ グロースを減少させるこ とができ

ます。

• 「パワー ・ ピークが大き くなるし くみ」 （180ページ）

• 「ピークがスペク ト ラム ・ リ グロースを引き起こすし くみ」 （182ページ）

• 「ク リ ッピングがピーク対アベレージ ・ パワーを減少させるし くみ」 （183ページ）

• 「円ク リ ッピングを設定する」 （186ページ）

• 「長方形ク リ ッピングを設定する」 （187ページ）

図8-8　 ク リ ッピングのソフ トキー

Mode > Dual ARB > More

clipping type = |I|, |Q|

のときにのみ使用可能

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。
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波形のクリ ッピング
パワー ・ ピークが大き く なるし くみ

ク リ ッピングによ り高いパワー ・ ピークがどのよ うに減少するかを見るには、 信号を作成する と きにピークが大き くなる

し くみを理解するこ とが重要です。

複数のチャネルの加算

I/Q波形は、以下の図に示すよ うに、複数のチャネルの加算によ り作成される場合があ り ます。複数の個別チャネル波形で

同じステート （ハイまたはロー） のビッ トが同時に発生する と、 加算された波形に通常よ り も高いパワー ・ ピーク （正ま

たは負） が発生します。

チャネル波形ではハイ ・ ステートのビッ ト と ロー ・ ステートのビッ トがランダムに起きるので、 通常は相殺され、 複数の

チャネルの加算で高いパワー ・ ピークが発生するこ とはほとんどあ り ません。
180 Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド



 基本的なデジタル動作 （オプシ ョ ン651/652/654）
波形のクリ ッピング
I波形とQ波形の結合

I/Q変調器でI波形とQ波形を結合してRF波形を作成する場合は、 RFエンベロープの大きさは です。 IとQの2乗は

常に正の値になり ます。

以下の図に示すよ うに、 I波形とQ波形で同時に正であるピーク と負であるピークは互いに相殺されず、 結合してよ り大き

なピークを形成します。
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波形のクリ ッピング
ピークがスペク ト ラム ・ リグロースを引き起こすし くみ

波形では、 稀に発生する高いパワー ・ ピークによ り、 以下の図に示すよ うに、 波形のピーク対アベレージ ・ パワー比が上

昇します。

ト ランス ミ ッ タのパワーアンプの利得は、 特定のアベレージ ・ パワーを提供するよ うに設定されているため、 高いピーク

によ りパワーアンプが飽和します。 これが相互変調歪みを引き起こし、 スペク ト ラム ・ リ グロースが生成されます。 スペ

ク ト ラム ・ リ グロースは、 （側波帯と同様に） 搬送波の両側に生じ、隣接周波数バンドまで周波数が広がり ます （以下の図

を参照）。ク リ ッピングは、ピーク対アベレージ・パワー比を減少させるこ とによ り、この問題に対する解決策を提供します。
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波形のクリ ッピング
クリ ッピングがピーク対アベレージ ・ パワーを減少させるし くみ

波形をク リ ッピングする と、 ピーク対アベレージ ・ パワーが減少し、 その結果と してスペク ト ラム ・ リ グロースを減少さ

せる こ とができます。 ク リ ッピングは、 I/Qデータを最高ピークの選択した％まで切り取る こ とによ り、 波形のパワー ・

ピークを制限します。 信号発生器には、 2つのク リ ッピング方法があ り ます。

• 円ク リ ッピングは、 複合I/Qデータに適用されます （Iデータ とQデータが等し く切り取られます）。

図8-9に示すよ うに、 ク リ ッピング ・ レベルはベク トルのすべての位相に対して一定で、 ベク トル表現では円と して現

れます。

• 長方形ク リ ッピングは、 Iデータ とQデータに独立に適用されます。

 図8-10 （184ページ） に示すよ うに、 I と Qに対するク リ ッピング ・ レベルが異なり、 ベク トル表現では長方形と して

現れます。

円ク リ ッピングも長方形ク リ ッピングも、 目的は、 スペク ト ラム ・ リ グロースが減少し、 しかも信号の完全性が損なわれ

ないレベルまで波形をク リ ップするこ とです。 図8-11 （185ページ） の2つの相補累積分布プロッ トに、 波形に円ク リ ッピ

ングを適用した後のピーク対アベレージ ・ パワーの減少を示します。

ク リ ッピング値が小さいほど、 パスするピーク ・ パワーが小さ くな り ます （よ り多くの信号がク リ ッピングされます） 。

ピークは通常、 波形の残りの部分との実質的な干渉なしにク リ ッピングするこ とができます。 多くの場合、 コード化シス

テムに固有の誤差補正によ り、 本来なら ク リ ッピング ・ プロセスで失われるデータも保持するこ とができます。 ただし過

度のク リ ッピングを適用する と、 失われたデータを回復できません。 さまざまなク リ ッピング設定を試して、 必要なデー

タを保持しながらスペク ト ラム ・ リ グロースを減少させる％値を見つけます。

図8-9　円クリ ッピング
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波形のクリ ッピング
図8-10　長方形クリ ッピング
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波形のクリ ッピング
図8-11　 ピーク対アベレージ ・パワーの減少
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波形のクリ ッピング
円クリ ッピングを設定する

この例を使用して円ク リ ッピングを設定し、 波形のピーク対アベレージ ・ パワー比に対する影響を観察します。 円ク リ ッ

ピングは、 複合I/Qデータをク リ ップします （Iデータ とQデータが等し く切り取られます）。 円ク リ ッピングの詳細につい

ては、 「ク リ ッピングがピーク対アベレージ ・ パワーを減少させるし くみ」 （183ページ） を参照して ください。

注意 ク リ ッピングは、非可逆的で、累積されます。 ク リ ッピングを適用する前に波形ファ イルのコピーを保存してく

ださい。

波形ファイルをコピーする

1. 信号発生器のファイルを表示します。 File > Catalog Type > More > Volatile Segmentsを押します。

2. 波形RAMP_TEST_WFMを強調表示します。

3. Copy Fileを押します。

4. コピーに名前を付け （この例では名前はMY_TEST_CIRC）、 Enterを押します。

円クリ ッピングをコピーした波形ファイルに適用する

1. DUAL ARB Waveform Utilitiesメニューを開きます。 Mode > Dual ARB > More > Waveform Utilitiesを押します。

2. ファイルのリ ス トで、 コピーしたファイル （この例ではMY_TEST_CIRC） を強調表示します。

3. CCDFプロ ッ ト を作成します。 Plot CCDFを押します。

4. 波形の曲線の形状と位置を観察します

（右の例では暗い線）。

5. 円ク リ ッピングをアクティブにします。

Return > Clipping > Clipping Typeを押して

|I+jQ|を強調表示します。

6. 円ク リ ッピングを80％に設定します。

Clip |I+jQ| To > 80 > %を押します。

7. I データ と Q データに 80％のク リ ッピングを

適用します。 Apply to Waveformを押します。

8. CCDFプロ ッ トを作成します（右の例を参照）。

Plot CCDFを押します。

9. ク リ ッピング後の波形曲線を観察します。

前のプロ ッ ト と比べてピーク対アベレージ ・

パワーが減少しています。

クリ ッピング前の波形曲線の例

円クリ ッピング後の波形曲線の例
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波形のクリ ッピング
長方形クリ ッピングを設定する

この例を使用して長方形ク リ ッピングを設定します。 長方形ク リ ッピングは、 Iデータ と Qデータを独立に切り取り ます。

長方形ク リ ッピングの詳細については、 「ク リ ッピングがピーク対アベレージ ・パワーを減少させるし くみ」 （183ページ）

を参照してください。

注意 ク リ ッピングは、非可逆的で、累積されます。 ク リ ッピングを適用する前に波形ファ イルのコピーを保存してく

ださい。

波形ファイルをコピーする

1. 信号発生器のファイルを表示します。 File > Catalog Type > More > Volatile Segmentsを押します。

2. 波形RAMP_TEST_WFMを強調表示します。

3. Copy Fileを押します。

4. コピーに名前を付け （この例では名前はMY_TEST_REC）、 Enterを押します。

長方形クリ ッピングをコピーした波形ファイルに適用する

1. DUAL ARB Waveform Utilitiesメニューを開きます。 Mode > Dual ARB > More > Waveform Utilitiesを押します。

2. ファイルのリ ス トで、 コピーしたファイル （この例ではMY_TEST_REC） を強調表示します。

3. CCDFプロ ッ ト を作成します。 Plot CCDFを押します。

4. 波形の曲線の形状と位置を観察します

（右の例では暗い線）。

5. 長方形ク リ ッピングをアクティブにします。

Return > Clipping > Clipping Typeを押して

|I|,|Q|を強調表示します。

6. Iデータの場合80％クリ ッピングを設定します。

Clip |I| To > 80 > %を押します。

7. Qデータの場合40％クリ ッピングを設定します。

Clip |Q| To > 40 > %を押します。

8. 波形に長方形ク リ ッピングを適用します。 Apply to Waveformを押します。

9. CCDFプロ ッ トを作成します（右の例を参照）。

Plot CCDFを押します。

10. ク リ ッピング後の波形曲線を観察します。

前のプロ ッ ト と比べてピーク対アベレージ ・

パワーが減少しています。

クリ ッピング前の波形曲線の例

長方形クリ ッピング後の波形曲線の例
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波形のスケーリング
波形のスケーリング

信号発生器は、波形を復元する と きに補間アルゴ リズム （I/Qデータ ・ ポイン ト間のサンプリ ング） を使用します。一般的

な波形の場合は、 この補間によ りオーバシュートが発生し、 DACオーバレンジ ・ エラーが生成される可能性があ り ます。

この章では、 DACオーバレンジ ・ エラーが発生するし くみと、 波形スケーリ ングを使用してこれらのエラーをなくす方法

について説明します。

• 「DACオーバレンジ ・ エラーが発生するし くみ」 （189ページ）

• 「スケーリ ングによるDACオーバレンジ ・ エラーをなくすし くみ」 （190ページ）

• 191ページと192ページのAgilent MXG波形スケーリ ング ：

— 現在再生中の波形をスケーリ ングするための波形ランタイム ・ スケーリ ング

— 現在再生中の波形、 またはBBG媒体の再生中でない波形フ ァ イルを恒久的にスケー リ ングするための波形ス

ケーリ ング

図8-12　スケーリングのソフ トキー

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

この メ ニ ューの設定を フ ァ イル ・

ヘ ッダに保存するこ とができます。

149ページを参照して く ださい。

波形ランタイム ・ スケーリング、 191ページを参照して く ださい。

波形スケーリング、 192ページを参照して く ださい。
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波形のスケーリング
DACオーバレンジ ・ エラーが発生するし くみ

信号発生器は、デジタルI/Qベースバンド波形をア

ナログ波形に変換する と きに、 補間器フ ィルタを

使用します。 補間器のクロ ッ ク ・ レー トはベース

バンド ・ ク ロ ッ クの4倍なので、補間器は入力ベー

スバンド ・ サンプル間のサンプル ・ ポイン ト を計

算し、 右の図に示すよ うに波形をスムージングし

ます。

DACの補間フ ィルタによ りベースバン ド波形が

オーバシュート します。 ベースバンド波形に高速

立ち上がりエッジがある場合は、 補間器フ ィルタ

のオーバシュートが補間されたベースバンド波形

の成分にな り ます。 このレ応答によ り立ち上がり

エッジのピークに リ ップルやリ ンギングが発生し

ます。 この リ ップルがDACレンジの上限をオーバ

シュートする場合は、 補間器が誤差の多いサンプ

ル ・ ポイン ト を計算し、 リ ップルの真の形状を複

製できません （右の図を参照）。 その結果、信号発

生器がDACオーバレンジ ・ エラーを報告します。
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波形のスケーリング
スケーリングによるDACオーバレンジ ・ エラーをな くすし くみ

スケーリ ングは、 ピーク対アベレージ ・ パワー比などの基

本形状と特性を保持しながら、 ベースバンド波形の振幅を

減少させます。 高速立ち上がりベースバンド波形を十分に

スケーリ ングして補間器フ ィルタのオーバシュートに対し

て適切なマージンが得られるよ うにする と、 補間器フ ィル

タが、 リ ップルの影響を含むサンプル ・ ポイン ト を計算し

て、 オーバレンジ ・ エラーを取り除く こ とができます （右

の図を参照）。

スケーリ ングは波形の基本形状を保持しますが、 過度のス

ケーリ ングは波形の完全性を損な う可能性があ り ます。 例

えば、 ビッ ト分解能が低くな り過ぎる と、 波形が量子化ノ

イズによ り壊れます。最大の確度を実現し、ダイナミ ッ ク ・

レンジを最適化するには、 DACオーバレンジ ・ エラーを除

去するために必要な分だけ波形をスケーリ ングします。最適

なスケーリ ングは、 波形の内容によって異な り ます。
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波形のスケーリング
波形ランタイム ・ スケーリングを設定する

ランタイム ・ スケーリ ングは、再生中に波形データをスケーリ ングします。 ランタイム ・ スケーリ ングは、保存されたデー

タには影響しません。 ランタイム ・ スケーリ ングをセグメン ト またはシーケンスに適用するこ とができ、 スケーリ ング値

はARBがオンでもオフでも設定できます。 このスケーリ ング ・ タ イプは、 DACオーバレンジ ・ エラーの除去に有効です。

ランタイム ・ スケーリ ング調整は累積されません。 スケーリ ング値は、 波形ファ イルの元の振幅に適用されます。 ランタ

イム ・ スケーリ ング設定の保存方法は2通りあ り ます。 保存機能を使用する （71ページ） 方法と、 設定をファ イル ・ ヘッ

ダに保存する （151ページ） 方法です。 ファ イル ・ ヘッダに保存する と、 値が波形ファ イルと一緒に保存され、 Save機能

を使って保存する と、 値が現在の機器設定と して保存されます。

この例を使用して、 現在選択している波形のスケーリ ング方法を学習します。

1. スケーリ ングを適用する波形を選択します。

a. Mode > Dual ARB > Select Waveformを押します。

b. 目的の波形 （セグメン ト またはシーケンス） を強調表示します。

c. Select Waveformを押します。

2. 選択した波形を再生します。 ARB Off Onを押してOnを強調表示します。

3. Waveform Runtime Scaling値を設定します。

a. ARB Setup > Waveform Runtime Scalingを押します。

b. スケーリ ング値を入力します。

信号発生器が新しいスケーリ ング値を波形に自動的に適用します。1つですべての波形を最適化できるよ う な値は

あ り ません。最大ダイナミ ッ ク ・ レンジを実現するには、DACオーバレンジ・エラーを引き起こ さない最大スケー

リ ング値を使用します。

c. Returnを押します。
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波形のスケーリング
波形スケーリングを設定する

波形スケーリ ングは、 波形データに恒久的な影響を与え、 BBG媒体に保存された波形セグメン トにのみ適用される という

点で波形ランタイム ・ スケーリ ングとは異なり ます。 波形のスケーリ ングは、 DACフル ・ スケール （100％） の％と して

アップまたはダウンします。 この方法を使用して波形をスケーリ ングする場合は、 波形ランタイム ・ スケーリ ング値も、

このスケーリ ングに適合するよ う変更する必要があ り ます。

スケーリ ングを行う と、 信号発生器が、 波形ファイルのサンプル値を目的のスケーリ ング値に適合するよ うに恒久的に変

更します。 スケーリ ングを開始する と、 信号発生器は以下の動作を実行します。

• 波形ファ イルの絶対ピーク ・ サンプル値を探します。

• 現在のフル ・ スケールのパーセンテージを指定します。

• 指定した絶対ピーク ・ サンプル ・ スケール値に対する所望のスケール値の割合を計算します。

• 波形ファ イルの各サンプルにこの比を乗算します。

波形をスケーリ ングする と、 分数データの生成、 データの損失、 または両方が起こる可能性があ り ます。 分数データは、

スケーリ ング値を減少または増加するたびにほぼ毎回発生し、 量子化誤差の原因とな り ます。 量子化誤差は、 スケーリ ン

グ ・ ダウンのと きによ り顕著です。 ノ イズ ・ フロアに近づくからです。 信号発生器が分数データを丸めるか、 2のベキ乗

からの結果を使用してスケーリ ング値が導出されたと きは、 データが失われます。 これは、 波形を半分 （2のベキ乗 ： 21 =
2） にスケーリ ングする と、 各波形サンプルが1ビッ ト を失う こ とを意味します。 波形データの変更は補正不能で、 波形の

歪みの原因とな り ます。 スケーリ ングの適用前に元のファイルのコピーを作成してください。

以下の例を使用して波形スケーリ ングを波形ファイルに適用します。このプロセスでは工場提供波形RAMP_TEST_WFMを使

用していますが、 どの波形ファイルでも同じです。

波形ファイルをコピーする

1. BBG媒体の波形ファイルを表示します。 File > Catalog Type > More > Volatile Segmentsを押します。

2. 波形RAMP_TEST_WFMを強調表示します。

3. Copy Fileを押します。

4. コピーに名前を付け （この例では名前はMY_TEST_SCAL）、 Enterを押します。

ピーク ・サンプル

フル ・ スケールの85％ －プリスケーリング

フル ・ スケールの60％－ポスト ・ スケーリング

DACのフル ・ スケールの100％

スケーリング後のサンプル値 = スケーリング比×プリスケール ・サンプル値

スケーリング比 = 目的のスケール値／現在のスケール値

= 60 / 85
= 0.70588

波形の各サンプルに0.70588を乗算すると、

60％ポスト ・ スケーリング波形振幅になります。

元のランプ波形 スケーリング後のランプ波形

= サンプル
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波形のスケーリング
コピーした波形ファイルにスケーリングを適用する

注意 このタイプのスケーリ ングは非可逆的です。スケーリ ング操作で失われたデータを復元できません。スケーリ ン

グ前に波形ファイルのコピーを保存して ください。

1. DUAL ARB Waveform Utilitiesメニューを開きます。

Mode > Dual ARB > More > Waveform Utilitiesを押します。

2. BBG媒体セグメン ト ・ ファ イルのリ ス トで、 コピーしたファイル （この例ではMY_TEST_SCAL） を強調表示します。

3. スケーリ ング値を設定して適用します （この例では70％のスケーリ ングを適用します）。

Scale Waveform Data > Scaling > 70 > % > Apply to Waveformを押します。
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ベースバンド周波数オフセッ トの設定

ベースバンド周波数オフセッ トによ り、 信号発生器のベースバンド ・ ジェネレータ ・ オプシ ョ ンに応じて、 BBG 100 MHz
信号帯域幅内で±50 MHzまでベースバンド周波数をシフ トするために値を指定します。以下の図に、デュアルARBプレー

ヤを使用した制御へのアクセス方法を示しますが、 ARB Setup ソフ ト キーからアクセスした場合の各ARBフォーマッ ト内

のBaseband Frequency Offsetソフ ト キーの場所も、 デュアルARBプレーヤの場合と同じです。

ベースバンド周波数オフセッ トがゼロ以外の値の場合は、 ハード ウェア ・ ローテータがベースバンド信号の位相シフ ト を

累積します。 この残留位相は、 オフセッ ト値がゼロに戻った後も残り ます。 この位相の累積を除去するには、 パーソナリ

ティ を再起動するか、Baseband Frequency Offset Phase Resetソフ ト キーを選択します。このソフ ト キーは、周波数オフセッ

トに起因する位相がゼロになる といつでもグレー表示になり ます。また、信号に非ゼロの残留位相が存在するあいだ、DAC
OverRange Protection機能が、 適用する内部スケーリ ングを自動的に減少します。 周波数オフセッ トがゼロに戻り、 位相

がリセッ ト される と、 スケーリ ングの減少は解除されます。

図8-13　デュアルARBプレーヤのBaseband Frequency Offsetソフ トキー

オフセッ ト機能の一般的な用途と して、 以下があ り ます。

• LOフ ィードスルーから搬送波をオフセッ トする （搬送波周波数における搬送波信号スプリアス）

• ベースバンド信号と外部I入力およびQ入力を合計してマルチキャ リ ア信号を作成する

• 信号発生器のI/Q信号をIFと して使用する

249ページ

信号に入力されたベースバン

ド周波数オフセッ ト値をベー

スバンドに設定します。

位相の累積をクリアして、位相

シフ ト をゼロにします。ベース

バンド信号に突然、位相シフ ト

の不連続が発生します。

このメ ニューの設定をフ ァ イル ・

ヘッダに保存することができます。

149ページを参照して ください。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

249ページ

196ページ

219ページ

188ページ

219ページ
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ベースバンド周波数オフセッ トの設定
注記 ベースバンド周波数オフセッ ト を変更する と、 DACオーバレンジ状態が発生し、 エラー 628, Baseband 
Generator DAC over range （ベースバンド ・ジェネレータDACオーバレンジ） が生成される場合があ り ます。

信号発生器には、この発生を最小限に抑えるための自動スケーリ ング機能が組み込まれています。詳細について

は、 「DACオーバレンジ条件とスケーリ ング」 （196ページ） を参照して ください。

ベースバンド周波数オフセッ ト値は、 ファ イル ・ヘッダのパラ メータ （149ページ） の1つです。 すなわち、 この値を波形

と一緒に保存できます。 保存された周波数オフセッ ト値と一緒に波形を選択する と、 信号発生器が保存されているファ イ

ル ・ ヘッダ値に合わせて現在の値を変更します。 現在の波形に保存されているベースバンド ・ オフセッ ト周波数値がない

場合は、 信号発生器は最後に設定された周波数オフセッ ト値を使用します。

Save機能 （71ページ） を使用して、 この値を信号発生器のセッ ト アップの一部と して保存するこ と もできます。 Save機能

を使って保存されたセッ ト アップをRecall機能でリ コールする と きには、 ベースバンド周波数オフセッ ト値が現在の信号

発生器の設定値になり、 保存されているファイル ・ ヘッダ値は無視されます。

搬送波をLO/搬送波フ ィードスルーからオフセッ トするには、以下の手順を使用します。この例では、デュアルARBプレー

ヤで使用可能な工場提供波形SINE_TEST_WFMを使用します。 この例の出力を表示するには、 信号発生器のRF OUTPUTを

スペク ト ラム ・ アナライザの入力に接続します。

1. 波形を選択して再生します。

a. Mode > Dual ARB > Select Waveformを押します。

b. Segment On BBG Media列で、 SINE_TEST_WFMを選択します。

c. Select Waveformを押します。

2. 波形を生成します。 ARB Off Onを押してOnにします。

3. 搬送波信号を設定します。

a. 搬送波信号を1 GHzに設定します。

b. 振幅を0 dBmに設定します。

c. RF OUTPUTをオンにします。

4. Mode > Dual Arb > ARB Setup > More > Baseband Frequency Offset > 20 MHzを押します。

以下の図に示すよ うに、 変調RF信号が、 搬送波周波数から20 MHzだけオフセッ ト されています。
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DACオーバレンジ条件とスケーリング

ベースバンド周波数オフセッ ト を （0 Hz以外の設定で） 使用する場合は、 DACオーバレンジ条件が発生する可能性があ り

ます。 この場合は、 Agilent MXGがエラーを生成します。 周波数オフセッ ト機能によってこの状態を最小限に抑えるため

に、 Agilent MXGには自動DACオーバレンジ保護機能が組み込まれています。 この機能は、 オフセッ トがゼロ以外の値の

場合は、 I/Qデータを1/ （2の平方根） だけスケーリ ング ・ ダウンします。 この機能はデータを必要以上にスケーリ ングす

る可能性があるため、 通常、 波形のダイナミ ッ ク ・ レンジが狭ま り ます。 これは、 GSMなどの一定振幅の信号を使用する

場合に特に顕著です。

デュアルARBプレーヤの場合は、 この自動オーバレンジ機能をオフにするこ とができます。 オンの場合は、 オフセッ トが

0 Hz以外の値の場合にのみ、デュアルARB信号に対してアクティブにな り ます。図8-14に示すよ うに、デュアルARB DAC
オーバレンジ保護機能の制御は、 重要な経路にあ り ます。

ベースバンド周波数オフセッ トが

0 Hzの変調搬送波

ベースバンド周波数オフセッ トが

20 MHzの変調搬送波 変調RF信号

LO/搬送波フ ィードスルー

100 MHzのスパンに設定されたスペク ト ラム ・ アナライザ
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ベースバンド周波数オフセッ トの設定
図8-14　Dual ARB DAC OverRange Protectionソフ トキーの場所

デュアルARBプレーヤでは、 過度のスケーリ ングを防ぐため、 またはスケーリ ングを手動で実行するために、 この機能を

オフにし、 Waveform Runtime Scalingソフ ト キーを使用してDACオーバレンジ状態を除去します。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

デフォルト設定はオンです。 RealTime Phase Noiseが
オンのときにのみ使用できます（257ページを参照）。

ベースバン ド周波数オフセッ ト機能を使用しなが

ら、 スケーリングを手動で制御するときには、 オフ

にします。 上記のWaveform Runtime Scaling ソ フ ト

キーを使用してスケーリングを手動で調整します。

DACオーバレンジ保護がオフの場合は、 スケーリング

値を減らすことでオーバレンジ状態を除去します （「波

形ランタイム・スケーリングを設定する」 （191ページ）

を参照）。

219ページ
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I/Q変調
I/Q変調

エラー ・ ベク トル振幅には以下の因子が関係します。

• IチャネルとQチャネル間の振幅差、 位相差、 遅延差

• DCオフセッ ト

I/Qメニューでは、I/Q信号源と出力を選択できるほか、I信号とQ信号の差を補正するための調整機能や校正機能もあり ます。

「搬送波信号の変調」 （61ページ） も参照して ください。

図8-15　 I/Q表示とソフ トキー

これらの選択は、

I/Q Routing & Optimization

グラフ ィ ッ クに反映され

ます。
201ページ

このパネルに、 I/Q信号ルーテ ィ ングと

I/Q補正最適化経路の現在の設定が表示

されます。

このパネルに、 I/Q調整の現在のステータスと設定が表示され

ます。 Page UpキーとPage Downキーを使用してこれらのパラ

メータをスクロールします。グレーは非アクテ ィブ （オフ） の

調整を示します。

内部生成されたバースト変調フォーマッ ト とのみ使用されます。

RFバースト変調器をオン／オフにします。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

各経路には異なる最適化値が必要です。経路を選択

することは、経路が要求する固有の最適化値を選択

していることになります。

信号発生器は、選択した最適化値を両方の経路に適

用します。 選択しなかった経路が劣化します。

内部生成のQ信号を反転し、 I成分がQ成分より90度遅れるようにします。

内部I/Qイコライゼーシ ョ ン ・ フ ィルタを開きます。 このフ ィルタを内部

I/Q信号源のRFおよび外部I/Q出力の補正または劣化に使用することがで

きます。

ACP （チャネル外性能） を犠牲にしてEVM （チャネル内性能） の内部I/Qチャネルを最適

化するか、 EVMを犠牲にしてACPを最適化するか選択します。

EVMは、 広い遷移バンドを持つ80％ナイキスト ・ フ ィルタ （100MHz幅） です。 イコライ

ゼーシ ョ ン ・ フ ィルタがアクテ ィブの場合は、 このフ ィルタはアクテ ィブになりません。

ACP も 80％ナイキス ト ・ フ ィルタ （100MHz幅） ですが、 遷移バン ドが非常に狭いため、

広帯域信号の画像が縮小します。 このフ ィルタは、 アクテ ィ ブなイコライゼーシ ョ ン ・

フ ィルタで畳み込まれ、 結果が中央の256タ ップまで切り捨てられます。

SCPIコマンド ：

[:SOURce]:DM:INTernal:CHANnel:OPTimization EVM|ACP

[:SOURce]:DM:INTernal:CHANnel:OPTimization?
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リア ・ パネルのI出力とQ出力を使用する

注記 リ ア ・ パネルのIコネクタ とQコネクタは、 内部BBGを使用しているあいだのみ信号を出力します。

信号発生器は、 搬送波を変調するほか、 内部生成のI信号とQ信号を リ ア ・パネルのIコネク タ とQコネク タにルーティング

します。 これらの出力信号はポス ト DACであるため、 アナログです。 これらのリ ア ・ パネルI信号とQ信号は、 以下に使用

するこ とができます。

• システムの ト ランス ミ ッ タ段をド ライブする

• I/Q変調器などの個別のアナログI成分とQ成分をテス トする

• I信号とQ信号を別の信号発生器にルーティングする

工場デフォルト設定は、 内部生成のI信号とQ信号を、 I/Q変調器およびリア ・ パネルのI出力コネクタ と Q出力コネクタに

ルーティングします。 ただし リ ア ・ パネルの信号を最適化するには （校正係数を適用するには）、 外部I/Q出力経路を選択

する必要があ り ます。

波形を選択して再生する

1. Mode > Dual ARB > Select Waveformを押します。

2. 目的の波形を強調表示します。

3. Select Waveform > ARB Off On to Onを押します。

信号経路を最適化する

1. リ ア ・ パネルのIコネクタおよびQコネク タからのケーブルをDUTまたは別の信号発生器に接続します。

ARBをオンにする と、 信号発生器がI信号とQ信号を リ ア ・ パネルのコネクタに自動的に出力します。 リ ア ・ パネルの

I信号とQ信号を、 別の信号発生器へのI入力とQ入力と して使用するこ とができます。 MXGにはこの目的のために、 フ

ロン ト ・ パネルにコネクタ I InputとQ Inputが装備されています。

2. I/Q > I/Q Correction Optimized Path > Ext I/Q Outputを押します。

経路を最適化する と、 経路インジケータが緑色に変わり ます。

工場デフォルト設定 – RF Output 経路の最適化

リアパネル I/Q 経路の最適化
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
I/Q変調
フロン ト ・ パネルの入力を設定する

信号発生器は、 フロン ト ・ パネルのI Input とQ Inputを通して外部供給されたアナログ I信号と Q信号を受け取り ます。 外

部信号を変調ソース と して使用するか、 外部信号を内部ベースバンド ・ ジェネレータ信号と加算するこ とができます。

1. I信号とQ信号をフロン ト ・ パネルのコネクタに接続します。

a. アナログI信号を信号発生器のフロン ト ・ パネルのI Inputに接続します。

b. アナログQ信号を信号発生器のフロン ト ・ パネルのQ Inputに接続します。

2. フロン ト ・ パネルの入力信号を認識するよ うに信号発生器を設定します。

• 搬送波を変調するには

I/Q > I/Q Source > Externalを押します。

• 加算して搬送波を変調するには

I/Q > I/Q Source > Sumを押します。

BB GEN経路用の波形を選択し、 再生するには、 143ページを参照して ください。

内部BBG （BB GEN） だけが、 I信号とQ信号を リア ・ パネルのI出力とQ出力にルーティングします。

3. 外部のI信号とQ信号のみ （加算なし） を使用する場合は、 I/Q変調器をオンにします。

I/Q Off Onを押してOnにします。

4. RF出力を設定します。

a. 搬送波周波数を設定します。

b. 搬送波振幅を設定します。

c. RF出力をオンにします。

信号発生器の表示 ： I/Q Correction Optimized PathをExt I/Q Output
に設定すると、 両方の経路が校正されます （199ページを参照）。

注記：最適化経路をRFに設定すると、RF Out経路だけが校正されます。

信号発生器の表示 ： I/Q Correction Optimized PathをRF Outputに
設定すると、 両方のRF経路が校正されます （199ページを参照）。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
I/Q調整
I/Q調整

I/Q Adjustmentsを使用して、 雑音の補正や、 I/Q信号への雑音の追加を行います。

I/Q > I/Q Adjustments

波形の再生時にのみ使用可能

オプシ ョ ン 1EL
でのみ使用可能

Q信号の振幅を基準にして I信号の振幅を調整しま

す。 これを内部劣化として使用するか、外部のIお
よびQ出力配線の経路のふぞろいによって起きる

信号経路損失の差を補正するため使用します。

I信号の位相を基準にしてQ信号の位相

をオフセッ ト します。 ベースバン ド直

交位相調整キーは、 度単位で校正され

ます。 外部入力直交位相調整は校正さ

れません。

このキーによって提供される機能は、

I/Q Skewキーによって提供される機能

と同じではありません。

スキューは通常、 雑音の作成、 または大きな帯域幅

の信号でエラー ・ ベク トルを減少させるために使用

します。

I信号とQ信号間の相対時間遅延補正が得られます。 I
信号とQ信号が異なる信号経路を移動すると、時間遅

延差が発生し、 大きな帯域幅変調信号ではEVM誤差

として現れます。

ベースバンド生成中、 I/Q信号に大きさが同じで向き

が反対の時間遅延 （スキュー） を加算すると、 時間

遅延誤差が除去され、内部ベースバンド ・ジェネレー

タで発生した信号の遅延が補正されます。

ト リガとマーカを基準として、 I信号とQ
信号の絶対位相を変更します。

正の値は遅延を追加し、 負の値は信号を

進めます。 この値は、 RF信号に変調され

たベースバンド信号と外部出力信号（Iと

Q） に影響します。設定は、定エンベロー

プ変調では使用できません。外部I入力と

Q入力には影響しません。

オフセッ トは通常、 搬送波リーケージを減少するため、 または搬送波リーケージをシミ ュレートする劣化を作成するために使用します。

Common Mode I/Q Offset Range

Common Mode I/Q Offsetの調整レンジをCoarse （デフォルト） からFine、 またはその反対に変更します。

Coarseレンジは、 ±2.5Vのデフォルト値に対応します。 Fineレンジは、 ±100 mVの値に対応します。

Common Mode I/Q Offset

I信号とQ信号のDCオフセッ ト を同時に調整します。

Diff Mode I Offset

IおよびIバー出力信号のDCオフセッ ト ・ レベルを調整します。 IおよびIバーを独立して調整することはできません。

Diff Mode Q Offset

IおよびIバー出力信号のDCオフセッ ト ・ レベルを調整します。 IおよびIバーを独立して調整することはできません。

DCオフセッ ト値は、 ARBから再生中のRMS波形電圧を

基準に校正されます。 152ページを参照して ください。

I/Q Attenuatorソフ トキーは、RF出力と外部I/Q出力へのI/Q信号に影

響します。

このソフ トキーは、 I/Q最適化経路がExt I/Q Outputに設定され、 デ

ジタル変調パーソナリテ ィがオンのときにアクテ ィ ブです。 この

減衰は、 各パーソナ リ テ ィ のArb Setup メ ニ ューにあるMod
Attenuatorキーを使用して調整するこ ともできます。 この調整は、

I/Q Adjustments On/Offキーによる影響を受けません。

Autoモードを選択すると、 信号発生器が現在の条件に対して I/Q減
衰を自動的に最適化します。 Manualモードを選択した場合は、 I/Q
Attenuationがアクテ ィブ機能になります。 入力した値により、 I/Q
信号の減衰レベルが設定されます。

SCPIコマンド（各パーソナリテ ィのコマンドを参照して く ださい）：

[:SOURce]:RADio:<personality>:IQ:MODulation:ATTen

この機能を使用すると、 IとQを回転し、 RF搬送波の相対位相を調整することで、 内部I/Qチャネ

ルの絶対位相を調整できます。 オプシ ョ ン012の場合は、 これが、 外部LOを持つユニッ トのRF位
相を調整する唯一の方法です。

注記 ： 0 以外のすべての位相オフ

セッ トに対して、 I/Q信号が0.7071だ
けスケール ・ ダウンされます。 I/Q
位相を調整中、 ALCをオフにして一

定パワー ・ レベルを保持する場合

は、 –360または＋360を使用します。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
I/Q調整
I/Q調整、I/Q遅延は、雑音を追加するためではなく、EVENT出力信号（マーカ信号） とRF出力間の遅延の補正に使用します。

表8-2　 I/Q調整の用途

I/Q調整 効果 悪影響

オフセッ ト 搬送波フ ィードスルー DCオフセッ ト

直交角度

EVM誤差 位相スキュー

I/Qイ メージ I/Q経路遅延

I/Qスキュー EVM誤差
高サンプリ ング ・ レート位相スキュー

またはI/Q経路遅延

I/Q利得バランス I/Q振幅差 I/Q利得比

I/Q位相 I/Q位相回転 RF位相調整
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
I/Q校正
I/Q校正

I信号補正と Q信号補正の場合は、 I/Q校正を使用します。 I信号と Q信号のどの面が補正されるかは、 信号が内部生成か外

部生成かに依存します。

I/Q校正を実行する と、 校正データは工場提供校正データよ り も優先されます。 校正ルーチンは、 時間と共に劣化する性

能、 または温度変化によって劣化する性能を改善します。 I/Q校正は、 周囲温度が前の校正時の周囲温度から摂氏±5度以

上変化した場合に実行する必要があ り ます。

注意 ファームウェア ・ リ ビジ ョ ン≧A.01.50の場合は、 I/Q校正の動作は以下のとおりです。

• ユーザI/Q校正は存続します （すなわち、機器プリセッ ト を押した り、電源を入れ直したり しても、ユー

ザI/Q校正がメモ リから削除されません）。

• スタート周波数と ス ト ップ周波数を同じ値に設定した場合は、 校正がその周波数で実行され、 データ

が境界校正配列要素内で存続します。

ファームウェア ・ リ ビジ ョ ン≦A.01.50の場合 ：

• ユーザ I/Q 校正は存続しません （すなわち、 機器プリセッ ト を押した り、 電源を入れ直したりする と、

ユーザI/Q校正がメモ リから削除されます）。

• スタート周波数とス ト ップ周波数を同じ値に設定した場合は、校正が境界校正配列要素で実行され、境

界校正配列要素内で存続します。

補正 内部IおよびQ 外部IおよびQ

オフセッ ト X X

利得バランス X --

直交誤差 X X
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
I/Q校正
I/Q > I/Q Calibration

Calibration type = User

のときにのみ使用可能

DCは、 現在の機器設定のI/Q性能を最適化します。 通常、 数秒で完了

します。 DC校正後に機器設定を変更すると、 DC校正が無効になり、

信号発生器がユーザ校正データ （ユーザ校正データがない場合は工

場提供校正データ） に戻ります。

Userは、 フル校正が不要の場合に、 クイ ッ ク校正を提供します。 校

正のスタート周波数とス ト ップ周波数を指定することにより、 校正

を制限できます。

校正を測定器のフル周波数レンジ未満に制限すると、 残りのレンジ

に工場提供校正データが使用されます。 スタート周波数とス ト ップ

周波数を同じ値に設定した場合は、 校正がその周波数で実行され、

データが境界校正配列要素内で存続します。 情報は、 プリセッ ト し

たり電源を入れ直したり しても保持されます*。

Fullの所要時間は約1分です。 測定器の周波数レンジ全体に対して測

定を実行します。

情報は、プリセッ ト したり電源を入れ直したり しても保持されます*。

*注意

不揮発性メモリに恒久的に保存されないデータ、 GPIB設定、 または

現在のユーザ機器ステートが失われないように、 MXGの電源は、 常

にMXGのフロン ト ・ パネルの電源ボタンまたは適切なSCPIコマンド

を使用してオフにする必要があります。 MXGをラ ッ ク ・ システムに

インス トールしており、 MXGのフロン ト ・ パネルのスイッチでな く

システム・ラ ックの電源スイッチを使って電源をオフにすると、Error
-310 due to the MXG not being powered down correctly （MXGの電源を正

し くオフにしなかったため） が表示されます。

ユーザ生成校正データを削除し、

工場提供校正データを復元します。

注記

DC校正には次の設定が必要です。

• I/Q ： オン

• 最適化経路 ： RF出力

• 信号源 ：内部

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
イコライゼーシ ョ ン ・ フ ィルタの使用
イコライゼーシ ョ ン ・ フ ィルタの使用

イコラ イゼーシ ョ ンFIRファ イルは、 外部で作成し、 SCPI,経由でアップロード して、 後でファ イル ・ システムから選択で

きます（「ファ イルの操作」（63ページ）を参照）。FIRファイル係数のダウンロード方法については、『Programming Guide』
を参照してください。 FIRファ イル係数の手動での処理方法については、 「FIRテーブル・エディ タを使用したFIRフ ィルタ

の変更」 （213ページ） を参照してください。

このフ ィルタを内部I/Q信号源のRFおよび外部I/Q出力の補正または劣化に使用する こ とができます。 このフ ィルタは、

ACP Internal I/Q Channel Optimizationフ ィルタで畳み込まれ （フ ィルタが選択されている場合）、 結果が中央の256タ ッ

プまで切り捨てられます。 イコラ イゼーシ ョ ン ・ フ ィルタは125MHzで動作するので、 イコラ イゼーシ ョ ン ・ フ ィルタが

別のレートでサンプリ ングされている場合は、 選択前にすべてのイコライゼーシ ョ ン ・ フ ィルタを125MHzに対して再サ

ンプリ ングする必要があ り ます。

MXGでは、 イコラ イゼーシ ョ ン ・ フ ィルタComplexまたはRealをサポート します。 これらは、 1サンプル当たり 2個の入力

（I、 Q） と2個の出力 （I、 Q） を持つプログラマブルFIRフ ィルタです。 この256タ ップ ・ フ ィルタには、 2つの動作モード

があ り ます。

注記 最大タ ップ数は、 イコライゼーシ ョ ン ・ フ ィルタの場合は256です （I/Qフ ィルタの場合は、 1タ ップ当たり 2個

の係数があ り ます）。 最小タップ数は2です。

イコラ イゼーシ ョ ン ・ フ ィルタは、 プ リディ ス トーシ ョ ン ・ フ ィルタまたは補正フ ィルタ と も呼ばれます。

イコラ イゼーシ ョ ン ・ フ ィルタはオンにするこ と もオフにするこ と もできます。

フ ィルタのタイプ 説明

Real IサンプルとＱサンプルは、 シングル ・ セッ トの実数係数によって独立してフ ィルタ リ ングされます。

Complex サンプルが、 複素数(I＋jQ)と して処理され、 タイム ・ ド メ インで(I＋jQ)と して指定されたフ ィルタ係数で

畳み込まれます。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
イコライゼーシ ョ ン ・ フ ィルタの使用
図8-16　 Int Equalization Filterのソフ トキー

I/Q > More
各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

SCPIコマンド ：

イコライゼーシ ョ ン ・ フ ィルタのステート ：

[:SOURce]:DM:INTernal:EQUalization:FILTer:STATe { OFF } | ON 
[:SOURce]:DM:INTernal:EQUalization:FILTer:STATe?

イコライゼーシ ョ ン ・ フ ィルタの選択 ：

[:SOURce]:DM:INTernal:EQUalization:FILTer:SELect "filename" 
[:SOURce]:DM:INTernal:EQUalization:FILTer:SELect?

実数フ ィルタをファイル ・ システムに追加するには ：

:MEMory:DATA:FIR "filename", [REAL,] osr, coeff1 [,coeff2 [, coeffN]]
:MEMory:DATA:FIR?"filename"

I/Qフ ィルタをファイル ・ システムに追加するには ：

:MEMory:DATA:FIR "filename", COMPlex, osr, hIRe0, hQIm0 [, hIRe1, 
hQIm1 [, hIReN, hQImN]]
:MEMory:DATA:FIR?"filename"

I/Qシンボル ・ データをファイル ・ システムに追加するには ：

:MEMory:DATA WFM1:filename", <blockdata>

208ページ

イコライゼーシ ョ ン ・ フ ィルタと して選択するために、 FIRフ ィルタのファイル ・ カタログを開きます。 イコライ

ゼーシ ョ ン ・ フ ィルタは通常I/Qで、 オーバサンプリング比1を持つ必要があります。 フ ィルタは256 タ ップ （I/Q
フ ィルタの場合は512係数） 以下にします。 イコライゼーシ ョ ン ・ フ ィルタは125MHzで動作するので、 イコライ

ゼーシ ョ ン ・ フ ィルタをMXGに配置する前に、 すべてのイコライゼーシ ョ ン ・ フ ィルタを125MHzに対して再サン

プリングする必要があります。

内部イコライゼーシ ョ ン ・ フ ィルタをオンにします。

SCPI コマン ドについては、 『SCPI Command Reference』 を

参照して く ださい。

198ページ

注記 ：

FIRテーブル ・ エディ タを使用してフ ィルタの係数を表示します。

213ページを参照して ください。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
デュアルARBリアルタイム変調フ ィルタでのFIR （有限インパルス応答） フ ィルタの使用
デュアルARBリアルタイム変調フ ィルタでのFIR （有限インパルス応答）

フ ィルタの使用

有限インパルス応答フ ィルタは、単一搬送波I/Q波形をI/Qコンスタレーシ ョ ン ・ポイン ト まで圧縮し、 Arb Customの変調

フ ィルタ と同様の遷移を定義するために使用できます（「ARBカスタム変調での有限インパルス応答(FIR)フ ィルタの使用」

（279ページ） を参照）。デュアルARB リ アルタイム変調との主な違いと して、 フ ィルタを波形データ自体では適用せず、波

形の再生時に適用します。

図8-17　 フ ィルタ ・ メニュー

このソフ トキーは、 選択したフ ィルタ ・

Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter >

タイプによって変わります。

選択したフ ィルタ  =Root Nyquistまたは

Nyquistの場合にのみ使用可能

選択したフ ィルタ  = Gaussian
のときにだけ使用可能

213ページ

208ページ

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。

IS95フ ィルタ選択

メニューを開きます。

変調フ ィルタのオン／オフを切り替えます。 このフ ィルタは通常、 I/Qシンボル ・ デシジ ョ ン ・ ポイン

トだけを含むARB波形に適用されます。 変調フ ィルタは次に、 シンボル ・ デシジ ョ ン ・ ポイン ト間の

遷移を有効に定義します。 したがって、 フ ィルタのオーバサンプリング比は2以上にする必要がありま

す。 この機能がアクテ ィブの場合は、 サンプリング ・ クロッ ク ・ レートが実際にシンボル ・ レートに

なります。 また、 フ ィルタは実数である必要があります （217ページを参照）。

205ページ
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
デュアルARBリアルタイム変調フ ィルタでのFIR （有限インパルス応答） フ ィルタの使用
FIRテーブル ・ エディ タを使用したユーザ定義FIRフ ィルタの作成

この手順では、 FIR Valuesテーブル ・ エディ タを使用して、 オーバサンプリ ング比4の8シンボル ・ ウ ィンド ウ同期関数

フ ィルタを作成して保存します。

テーブル ・ エディ タにアクセスする

1. Presetを押します。

2. Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter > Select > Nyquistを押します。

3. Define User FIRを押します。

4. More 1 of 2 > Delete All Rows > Confirm Delete of All Rowsを押します。

これによ り、 図8-18に示すよ うにテーブル ・ エディ タが初期化されます。

図8-18　 FIRフ ィルタ ・ テーブル ・ エディ タを使用したユーザ定義FIRフ ィルタの作成

係数値を入力する

1. Returnソフ ト キーを押してテーブル ・ エディ タの最初のページを取得します。

2. カーソルを使用して、 係数0のValueフ ィールドを強調表示します。

Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter > Define 
User FIR > More 1 of 2 > Delete All Rows > Confirm Delete of All Rows

保存済みのフ ァ イルを選択し

て揮発性メモ リにロード でき

るメニューを開きます。43ペー

ジを参照して く ださい。

214ページ

FIRフ ィルタ係数テーブルに

2つ以上の値が表示されている

ときにだけアクテ ィブです。

各キーの詳細については、キーのヘルプを使用して ください （42ページを参照）。

フ ィ ルタの虚数係数を指定す

るための列を追加します*（虚数

係数はすべて、 最初は0です） 。

Convert to Complex Filter ソ フ ト

キーを選択する と、 Convert to
Real Filter ソ フ ト キーが使用可

能になります。

注意 ： Convert to Real Filter ソ フ

トキーを選択すると、 Imaginary
Values列が削除され、 虚数値が

失われます。

注記 ：

変調フ ィルタは実数で、 OSR （オーバサンプリング比） が2以上である必要があります。

イコライゼーシ ョ ン ・ フ ィルタは通常I/Qで、 OSR （オーバサンプリング比） が1である必要があります。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
デュアルARBリアルタイム変調フ ィルタでのFIR （有限インパルス応答） フ ィルタの使用
3. テンキーを使用して、 表8-3の最初の値 （–0.000076） を入力します。 数値キーを押すと、 アクティブ入力エリアに数

値が表示されます （間違えた場合は、 バッ クスペース ・ キーを使って修正できます）。

4. 16個すべての値を入力するまで、 ステップ1のテーブルからの係数値の入力を続行します。

表8-3　

係数 値 係数 値

0 −0.000076 8 −0.035667

1 −0.001747 9 −0.116753

2 −0.005144 10 −0.157348

3 −0.004424 11 −0.088484

4 0.007745 12 0.123414

5 0.029610 13 0.442748

6 0.043940 14 0.767329

7 0.025852 15 0.972149
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
デュアルARBリアルタイム変調フ ィルタでのFIR （有限インパルス応答） フ ィルタの使用
ミ ラー ・ テーブルを使用して最初の16個の係数を複製する

ウ ィ ンド ウ同期機能フ ィルタでは、 係数の後半は前半と同じですが、 順序が逆になっています。 信号発生器には、 既存の

係数値を逆順で自動的に複製する ミ ラー ・ テーブル機能があ り ます。

1. Mirror Tableを押します。 最後の16個の係数 （16～31） が自動的に生成され、 図8-19 （210ページ） のよ うに、 .これら

のうち最初の係数 （16番） が強調表示されます。

図8-19 

FIRテーブルの係数値は、工場デ

フォルト値であるか、 ユーザに

よって入力された値です。

Goto Row メニューを使って

移動し、 FIR値係数テーブル

に対する変更を行います。
各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
デュアルARBリアルタイム変調フ ィルタでのFIR （有限インパルス応答） フ ィルタの使用
オーバサンプリング比を設定する

注記 変調フ ィルタは実数で、 OSR （オーバサンプリ ング比） は2以上です。

イコラ イゼーシ ョ ン ・ フ ィルタは通常I/Qで、 OSRが1である必要があ り ます （「イ コライゼーシ ョ ン ・ フ ィルタ

の使用」 （205ページ） と 「 リ アルタイム変調フ ィルタの設定」 （217ページ） を参照してください）。

OSR （オーバサンプリ ング比） は、 1シンボル当たりのフ ィルタ係数の数です。 受け付け可能な値の範囲は1～32で、 テー

ブル ・ エディ タの最大許容タ ップ数は1024です。

OSR、 係数の数、 シンボルの数に対する実際のリ ミ ッ トは、 FIRでどの機能を使用するかによって異なり ます。 表8-4を参

照して ください。

変調フ ィルタでは、 オーバサンプリ ング比が内部の最適に選択された値と異なる場合は、 フ ィルタが、 最適なオーバサン

プリ ング比に対して自動的に再サンプリ ングされます。

この例では、 必要なOSRは4 （デフォルト ） であるため、 操作は不要です。

フ ィルタをグラフ ィ ックで表示する

信号発生器には、 フ ィルタを時間と周波数の次元でグラフ ィ ッ ク表示する機能があ り ます。

1. More 1 of 2 > Display FFT （高速フーリエ変換） を押します。

図8-20 （212ページ） を参照してください。

表8-4　

フ ィルタのタイプ OSR （オーバサンプリ ング比） タ ップ数 （最大値） シンボル／係数 （最大値）

イコラ イゼーシ ョ ンa

aI/Qタイ ミング ・ スキュー、 I/Q遅延、 またはACP内部I/Qチャネル最適化機能がアクテ ィブの場合は、

イコライゼーシ ョ ン ・ フ ィルタの有効タ ップ数が減少します。

1　 256　 --　

ARBカスタム変調b

bフ ィルタは、 より高いOSRまたはより低いOSRまでサンプリングできる場合があります。

≧2 --　 512/1024　

デュアルARB

リ アルタイム変調c

cフ ィルタは、 シンボル ・ レートに応じて16以下のOSRまでデシメート されます。

≧2 --　 32/1024　
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
デュアルARBリアルタイム変調フ ィルタでのFIR （有限インパルス応答） フ ィルタの使用
図8-20 

2. Returnを押します。

3. Display Impulse Responseを押します。

図8-21を参照してください。

図8-21 

4.  Return を押して、 メニュー ・ キーに戻り ます。

フ ィルタをメモリに保存する

 ファイルを保存するには、 以下の手順を使用します。

1. Load/Store > Store To Fileを押します。 FIRファイルのカタログが、 使用可能なメモ リ量と一緒に表示されます。

2. 「波形セグメン トの保存、 ロード、 再生」 （142ページ） の説明に従って、 このファイルにFIR_1とい う名前を付けて保

存します。

FIR_1ファ イルは、 一覧の最初のファ イル名です （前に他のFIRファ イルを保存していた場合は、 その他のファ イル名が

FIR_1の下に示されます）。 ファ イルのタイプはFIRで、 ファ イルのサイズは260バイ トです。使用する メモ リ量も表示され

ます。 保存できるファイルの数は、 ファ イルのサイズおよび使用する メモ リ量によって異なり ます。 図8-22を参照してく

ださい。

各キーの詳細については、 キーのヘルプ

を使用して ください （42ページを参照）。

各キーの詳細については、キーのヘルプ

を使用して ください （42ページを参照）。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
FIRテーブル ・ エディ タを使用したFIRフ ィルタの変更
図8-22 

メモ リは、 機器ステート ・ ファ イルと リ ス ト掃引ファ イルによっても共有されます。

このフ ィルタを変調フォーマッ トのカスタマイズに使用できるよ うにな り ます。 または新しいフ ィルタ ・ デザインのベー

スと して使用できます。

FIRテーブル ・ エディ タを使用したFIRフ ィルタの変更

信号発生器のメモ リに保存されたFIRフ ィルタは、FIRテーブル・エディ タを使用して簡単に変更できます。FIRテーブル・

エディ タに、 不揮発性メモ リに保存されたユーザ定義FIRファ イルまたはデフォルト FIRフ ィルタの1つから係数値をロー

ドできます。 次に値を変更し、 新しいファイルを保存できます。

カタログに、ユーザによって前に保存

されたFIRファイルが表示されます。

これらのキーは、内部スト レージ内の

DMOD フ ァ イルのテーブルを管理し

ます。

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
FIRテーブル ・ エディ タを使用したFIRフ ィルタの変更
デフォルトのガウスFIRファイルをロードする

図8-23　デフォルトのガウスFIRファイルをロードする

1. Presetを押します。

2. Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter > Define User FIR > Gaussianを押します。

3. Filter BbT > 0.300 > Enterを押します。

4. Filter Symbols > 8 > Enterを押します。

5. Generateを押します。

注記 変調中の実際のオーバサンプリ ング比は、測定器によって自動的に選択されます。 シンボル・ レート、変調タイ

プの1シンボル当たりのビッ ト数、 シンボル数に応じて、 4～16の範囲の値が選択されます。

6. Display Impulse Responseを押します （図8-24を参照）。

Mode > Dual ARB > Arb Setup > More > Real-Time 
Modulation Filter

これらのソフ トキーは、フ ィルタの

ウィ ンドウ関数（アポディゼーシ ョ

ン機能） を選択します。

各キーの詳細については、キーのヘルプを使用して く ださい （42ページを参照）。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
FIRテーブル ・ エディ タを使用したFIRフ ィルタの変更
図8-24　

7. Returnを押します。

係数を変更する

1. フロン ト ・ パネルの矢印キーを使用して、 係数15を強調表示します。

2. 0 > Enterを押します。

3. Display Impulse Responseを押します。

図8-25　

図8-25 （215ページ） を参照してください。 グラフ ィ ッ ク表示によって便利な ト ラブルシューティング ・ ツールが得ら

れます （この場合は、 係数値がないため、 ガウス応答が不適切であるこ とを示しています）。

4. Returnを押します。

5. 係数15を強調表示します。

6. 1 > Enterを押します。

各キーの詳細については、 キーのヘルプを

使用して く ださい （42ページを参照）。

各キーの詳細については、キーのヘルプ

を使用して ください （42ページを参照）。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
FIRテーブル ・ エディ タを使用したFIRフ ィルタの変更
フ ィルタをメモリに保存する

最大ファ イル名長は23文字です （英数字と特殊文字）。

1. Load/Store > Store To Fileを押します。

2. ファイルにNEWFIR2とい う名前を付けます。

3. Enterを押します。

現在のFIRテーブル・エディ タの内容が不揮発性メモリ内のファ イルに保存され、新しいファイルを表示するためFIRファ

イルのカタログが更新されます。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
リアルタイム変調フ ィルタの設定
リアルタイム変調フ ィルタの設定

リ アルタイム変調フ ィルタは、単一搬送波I/Q波形をI/Qコンスタレーシ ョ ン・ポイン ト まで有効に圧縮した後、Arb Custom
変調の変調フ ィルタ と同様に遷移を制御します。 主な違いと して、 フ ィルタを波形データ自体では適用せず、 波形の再生

時に適用します。 リ アルタイム変調フ ィルタは、 デュアルARB波形にのみ使用できます。

リ アルタイム変調フ ィルタがオンの場合は、 サンプリ ング ・ ク ロ ッ ク ・ レートがシンボル ・ レート と して機能します。 リ

アルタイムARB変調フ ィルタ機能をオンにするには、 サンプリ ング ・ ク ロ ッ ク ・ レート をサンプ リ ング ・ レートの2分の1
に設定する必要があ り ます。 サンプリ ング ・ レートは、 ロード されたオプシ ョ ン65xによって決定されます。

注意 ARBフォーマッ トはシンボル ・ デシジ ョ ン ・ ポイン トの定義では直交I/Qデータのみをサポートするので、

振幅と位相と して指定する必要がある定エンベロープ変調はサポート されません （定エンベロープ変調の

例と してMSKとFSKがあ り ます）。

使用周波数が変わっても、搬送波周波数は同じである必要があ り ます （すなわち、単一搬送波のアプリ ケー

シ ョ ンでのみARB リ アルタイム変調フ ィルタを使用できます）。

図8-26　デュアルARBプレーヤのReal-Time Modulation Filterソフ トキー

207ページ

このメ ニューの設定をフ ァ イル ・

ヘッダに保存することができます。

149ページを参照して ください。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

Mode > Dual ARB > Arb 
Setup > More

これらは、波形に適用できる使用可能

なリアルタイム変調フ ィルタです。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
複数のベースバンド ・ ジェネレータ同期
リ アルタイム変調機能の一般的な用途には、 以下が含まれます。

• 単一搬送波の理想的な直交I/Qシンボル ・デシジ ョ ン ・ ポイン トが既知で、 シンボル ・デシジ ョ ン ・ ポイン トにオーバ

サンプリ ング ・ フ ィルタを適用する場合

• よ り大きな有効MXGメモ リ ・ サイズが必要な場合

• 低速の波形があ り、 OSRが高い方が、 波形が長くならないのでよい場合

リアルタイム変調フ ィルタのセッ ト アップは、 ファ イル ・ ヘッダのパラ メータの1つです （149ページ）。 すなわち、 この

セッ ト アップを波形と一緒に保存できます。 保存された変調フ ィルタのセッ ト アップと一緒に波形を選択する と、 信号発

生器が保存されているファ イル ・ ヘッダのセッ ト アップに合わせて現在のセッ ト アップを変更します。 現在の波形に保存

されている変調フ ィルタのセッ ト アップがない場合は、 信号発生器は最後に設定された変調フ ィルタのセッ ト アップを使

用します。

Save機能 （71ページ） を使用して、 この値を信号発生器のセッ ト アップの一部と して保存するこ と もできます。 Save機能

を使って保存されたセッ ト アップをRecall機能でリ コールする と きには、 変調フ ィルタ値が現在の信号発生器の設定値に

なり、 保存されているファ イル ・ ヘッダ値は無視されます。

リ アルタイム変調フ ィルタを揮発性メモリにロード された現在の波形に適用するには、 以下の手順を使用します。 この例

では、デュアルARBプレーヤで使用可能な工場提供波形SINE_TEST_WFMを使用します。 この例の出力を表示するには、信

号発生器のRF OUTPUTをスペク ト ラム ・ アナライザの入力に接続します。

注記 以下のセッ ト アップでは、 搬送波周波数から 20 MHzだけオフセッ ト されている変調RF信号を作成するために、

「ベースバンド周波数オフセッ トの設定」 （194ページ） のセッ ト アップを完了しているものと します。

1. 変調フ ィルタを設定します ：

Mode > Dual ARB > Arb setup > More > Real-Time Modulation Filter > Select > Root Nyquistを押します。

2. Filter Alpha > .4 > Enterを押します。

これで、変調RF信号に対して、フ ィルタαが0.400、タイプRoot Nyquistのリアルタイム変調フィ ルタが設定されました。

複数のベースバンド ・ ジェネレータ同期

Dual ARBメニューにあるこの機能を使用する と、最大16台のAgilent MXGから成るマスタ／スレーブ・システムをセッ ト

アップできるため、 ベースバンド ・ ジェネレータ （BBG） で波形の再生を同期できます。 システムのカウン トには、 マス

タ と して機能するAgilent MXGが1つ含まれています （「機器セッ ト アップ」 （222ページ） を参照）。

オプシ ョ ン012搭載のMXGを使用する と、 2×2、 3×3、 または4×4 MIMO構成で共通の外部LO信号を共有し、位相コ ヒー

レン ト ・ システムを作成できます。 「オプシ ョ ン012 （位相コ ヒーレンス用のLO入力／出力） と複数のベースバンド ・ ジェ

ネレータ同期について」 （225ページ） とデータ ・ シート を参照して ください。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
複数のベースバンド ・ ジェネレータ同期
図8-27　複数のベースバンド ・ ジェネレータ同期 （BBG同期） のト リガ ・ ソフ トキーと メニューの場所

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

スレーブ測定器の場合は、グレー表示

になります。 マスタ測定器の場合は、

アクテ ィブなままです。

220ページを参照

現在の設定がFree RunまたはGatedの場合は、 BBG同期は、 ト リガ ・ タイプをTrigger and

Runに自動的に変更します。 別の設定が必要な場合は、 BBG同期セッ トアップ ・パラ

メータの設定前または設定後にマスタ、 スレーブ、 または両方で、 手動で設定を行い

ます。

BBG同期の使用中は、 Free RunとGatedを選択できません。

マスタのデフォルト設定。必要に

応じて、測定器をマスタと して指

定した後にこれらの設定を変更

します。

スレーブのデフォルト設定。 測

定器をスレーブと して選択した

後は、 これらの設定にアクセス

できません。

注記 ： BBG同期機能により、 以下のような ト リガ設定が自動的に設定されます。 このプロセスで設定衝突エラーを回避するには、

220ページに示されたBBG同期パラメータを設定する前に、 ト リガ設定を手動で設定します。

142ページを参照

172ページを参照

Negが工場デフォルト設定です。 スレーブ

選択ではPosに変わります。必要に応じて、

スレーブと して選択する前に手動でPosに

変更します。

注記 ： マスタ／スレーブ選択時に、 次のト

リガ設定が真のとき、 設定衝突エラーが発生

します。

マスタ

• Free RunまたはGated ト リガ ・ タイプ

スレーブ

• Free RunまたはGated ト リガ ・ タイプ

• Ext Polarity Negト リガ ・ ソース
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図8-28　複数BBG同期のフロン ト ・ パネル表示

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

マスタ表示と使用可能なソフ トキー

スレーブ表示と使用可能なソフ トキー

Off、 Master、 またはSlaveを選択します。

システム内のすべての測定器に対してベー

スバンド ・ ジェネレータを同期します。

注記 ： すべてのスレーブ測定器でListen

for Syncを押した場合のみ押します。スレー

ブでステータスとしてWaiting For Syncが表

示されます。

マスタは、 次のメ ッセージのいずれかを表示します。

• Out of Sync （同期がずれています）

• In Sync （同期しています）

Sync Slavesを押した後に表示されます

マスタ／スレーブ ・ インジケータと

セッ トアップ ・ ダイアグラム。

押すと、スレーブは、マスタによって開始さ

れる同期信号を待ちます。

注記 ： マスタ測定器でSync Slavesを押す

前に押します。

スレーブは、 次のメ ッセージのいずれかを表示します。

• Out of Sync （同期がずれています）

• Waiting for Sync （同期を待っています）

Listen for Syncを押した後に表示されます

• In Sync （同期しています）

マスタでSync Slavesを押した後に表示されます

マスタ／スレーブ ・ インジケータとセッ トアップ ・

ダイアグラム。システムの最後のスレーブでは一番

下のスレーブ ・ インジケータが緑色です。

Off、 Master、 またはSlaveを選択します。

これは、プリセッ ト しても、電源を入れ

直しても持続する恒久設定です。

これらは、プリセッ ト しても、電源を入れ

直しても持続する恒久設定です。

マスタではグレー表示になり、スレーブで

はアクテ ィブです。
220 Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド
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マスタ／スレーブ ・ システムについて

システム遅延

複数のBBG同期機能によ り、 マスタ と最後のスレーブ間の遅延が±8 ns （特性値） 以内で、 最大16台の信号発生器の波形

生成機能を同期できるシステムが得られます。 この少量の遅延 （±8 ns） は、 I/Q メニューのI/Q Delayソフ ト キーを使用

する と、 さ らにピコ秒の分解能まで減少できます。 遅延を減少するには、 システム内の各信号発生器のBBG信号アライ メ

ン ト を確認／調整します。 遅延の調整の詳細については、 「I/Q調整」 （201ページ） を参照して ください。

遅延値には、EVENT 1コネク タ とPAT TRIGコネク タ間で1 ns未満の伝搬遅延が発生するケーブルに対する補正が含まれます

（「機器セッ ト アップ」 を参照）。推奨ケーブルはAgilent BNCケーブル （パーツ番号10502A） です。伝搬遅延の大きいケー

ブルを使用する と、 信号発生器が正し く同期しない可能性があ り ます。

システム同期

同期は、 マスタ信号発生器が単発現象パルスを送信し、 パルスがシステムの各スレーブまで伝搬した後に発生します。 こ

のイベン トに先立って、 各スレーブは、 このイベン ト ・ パルスを待っているこ とを認識する必要があ り ます。 これは、 シ

ステム設定中に行われます （「セッ ト アップの設定」 （222ページ） を参照）。 同期パルスを正し く送信するために、 各信号

発生器の ト リガ ・ ソース とデュアルARBプレーヤをオフにする必要があ り ます。

マスタ／スレーブ ・ セッ ト アップでは、 スレーブとマスタ と して選択された信号発生器との間にフ ィードバッ ク ・ システ

ムが組み込まれていません。 同期後、 MultiBBG Sync Setup メニューを変更するか、 信号発生器をシステムに追加した場

合に、 マスタがセッ ト アップを自動的に再同期するこ とはあ り ません。 このため、 システム内の信号発生器が、 ステータ

スを間違ってIn Syncと レポートする可能性があ り ます。

システムが、 他の信号を間違って同期パルスと解釈する可能性もあ り、 In Syncステータスが不正確になり ます。 こ う し

たタイプの信号には、 EVENT 1コネクタにルーティングされる連続ト リガやアクティブ ・ マーカが含まれます。 不適切に

接続された リ ア ・ パネル ・ ケーブルによって偽ステータスが作成されるこ と もあ り ます。

1つまたはすべてのMultiBBG Sync Setupメニューで変更を行った後、信号発生器をシステムに追加した後、 または信号発

生器の真のステータス と して疑わしい場合は、 システム全体を再同期する必要があ り ます。 波形ファ イル、 デュアルARB
ステート、 サンプ リ ング ・ レート、 スケーリ ング、 搬送波周波数／振幅など、 MultiBBG Sync Setup メニューの外のパラ

メータに変更を加えても、システムには影響があ り ません。システムを再同期するには、「複数の同期セッ ト アップの変更

とマスタ／スレーブ ・ システムの再同期」 （224ページ） を参照して ください。

システム ・ ト リガ ・ セッ トアップ

複数BBG同期機能では、 各信号発生器の ト リガ選択が制限されます （219ページを参照）。 スレーブと して選択された信号

発生器の場合は、 ト リガ ・ タイプ （制限付き） のみ変更できます。 ト リ ガ ・ ソースは固定で、 リ ア ・ パネルのPAT TRIGコ

ネク タから ト リガを受信するよ う設定されています。 マスタでは、 ト リ ガ ・ タイプ （制限付き） と ト リガ ・ ソースを変更

できます。 ト リ ガ ・ ソースには、 波形を ト リ ガするための3つのオプシ ョ ン と して、 外部 ト リ ガ、 フロン ト ・ パネルの

Triggerキー、 GPIB ト リ ガがあ り ます。

ト リ ガ設定が、 BBG同期機能がサポートする設定と異なる場合は、 219ページで示す設定に自動的に変更されます。 この

変更が発生する と、 Agilent MXGが、 変更をアラートするため設定衝突エラーを生成します。 エラーの生成を回避するに

は、 信号発生器をマスタまたはスレーブと して選択する前に ト リガ設定を適切に設定します。
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システム ・ ト リ ガは、マスタによって開始された同期パルスと同じ方法で伝搬します （「システム同期」 を参照）。 したがっ

て同期パラ メータの変更中はオフにしないと、 偽のIn Syncステータスが発生する可能性があ り ます。

複数BBG同期機能がオフになっている場合は、 信号発生器はト リガ ・ パラ メータを リセッ ト しません。 機能を無効にした

後に波形を再生するには、 ト リガ ・ タイプをFree Runに設定するか、 波形再生を開始するための ト リガを提供します。

機器セッ トアップ

図8-29　複数のベースバンド同期のセッ トアップ

セッ トアップの設定

一般的なパラ メータを設定する

すべての信号発生器で以下の手順を実行します。

1. 搬送波信号の周波数を設定します。

2. 搬送波信号のパワー ・ レベルを設定します。

3. 目的の波形を選択します （142ページを参照）。

Dual ARBをオンにしないでください。

セッ トアップで1～15の
スレーブを使用できます。

Triggerキーを使用していない場合は、外部ト リガ ・ ソースを提

供します。 PAT TRIGコネクタの詳細については、 19ページを参

照して ください。

PAT TRIG

PAT TRIG

PAT TRIG

10MHz出力

REF IN

10MHz出力

REF IN

REF IN

10MHz出力

EVENT 1

EVENT 1

EVENT 1

RF OUTPUT

RF OUTPUT

RF OUTPUT

RF OUTPUT

注記 ： 同期遅延を最小限に抑えるには、 リア ・パネル ・ デイジー ・ チェイン接続のケーブルとして、

Agilent BNCケーブル10502Aを推奨します （221ページを参照）。

PAT TRIG
またはGPIB
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4. ト リ ガを除いて、 マーカ、 サンプル ・ ク ロ ッ クなどの目的の波形パラ メータを設定します。

ベースバンド同期機能では、 マスタ と スレーブの ト リガ選択が制限されます。 現在の ト リガ設定にサポート されてい

ないBBG同期パラ メータが含まれている場合は、 Agilent MXGは設定衝突エラーを生成し、 ト リガ設定を変更します。

設定衝突エラーを回避するには、 複数BBG同期パラ メータを設定する前に、 219ページのよ うに ト リ ガ ・ パラ メータ

を手動で設定します。

5. RF出力をオンにします。

BBG同期のマスタのパラ メータを設定する

1. Mode > Dual ARB > ARB Setup > More > Multi–BBG Sync Setup > Multi–Bbg Sync Type > Masterを押します。

2. Number of Slavesソフ ト キーを使用してスレーブの数を設定します。

3. 必要に応じて、 ト リガ ・ パラ メータを変更します （219ページを参照）。

マスタ信号発生器では、 ト リガ ・ タイプと ト リガ ・ ソースを変更できます。

a. Dual ARBメニューに戻り ます （219ページを参照）。

b. 必要な ト リガのタイプと ソースを設定します。

c. Multi–BBG Sync Setupメニューに戻り ます。

BBG同期のスレーブのパラメータを設定する

1. Mode > Dual ARB > ARB Setup > More > Multi–BBG Sync Setup > Multi–BBG Sync Type > Slaveを押します。

2. Number of Slavesソフ ト キーを使用してスレーブの数を設定します。

3. 信号発生器が占有するスレーブ位置を設定します。

システム内で最大15スレーブを使用できます。

4. Listen for Syncソフ ト キーを押し、ディ スプレイのStatusエリ アにWaiting for Syncが表示されているこ とを確認し

ます。

5. 必要に応じて、 別の ト リガ ・ タイプ ・ パラ メータを選択します。

a. Dual ARBメニューに戻り ます （219ページを参照）。

b. 必要な ト リガのタイプを設定します。

c. Multi–BBG Sync Setupメニューに戻り ます。

6. システム内の各スレーブ信号発生器に対して繰り返します。

システムを同期する

この手順は、 マスタ と スレーブの信号発生器のパラ メータを設定した後に実行します。 システムを再同期する場合は、 手

順 「複数の同期セッ ト アップの変更とマスタ／スレーブ ・ システムの再同期」 （224ページ） を使用して ください。
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1. マスタで、 Sync Slavesソフ ト キーを押します。

注記 マスタ／スレーブ設定を変更した場合、 またはスレーブ測定器を追加した場合は、 スレーブ測定器でListen for 
Syncソフ ト キーを押した後にIn Syncが表示される場合でも、 マスタ／スレーブ ・ システム内のすべての信号

発生器を再同期する必要があ り ます。

2. フロン ト ・パネル・ディ スプレイで、すべての信号発生器にStatusと してIn Syncが示されているこ とを確認します。

波形を ト リガ／再生する

1. すべてのAgilent MXGで、 Mode > Dual ARB > ARB Off Onを押してOnにします。

2. マスタ信号発生器への ト リガ信号の送信を開始します。

複数の同期セッ トアップの変更とマスタ／スレーブ ・ システムの再同期

マスタ／スレーブ ・パラ メータを変更した場合、 または信号発生器 （スレーブ ・ユニッ ト ） をシステムに追加した場合は、

ディ スプレイのStatus部分にIn Syncが表示される場合でも、 システムを再同期する必要があ り ます。

1. ト リ ガ ・ ソースをオフにします。 Triggerキーを使用している場合は、 何もオフにする必要はあ り ません。

ト リガ ・ ソースがオンで、 連続パルス ・ ス ト リームを提供する場合は、 Listen for Syncソフ ト キーを押した後に、 信号

発生器が間違ってステータスをIn Syncと表示する可能性があ り ます。

2. 各信号発生器で、 Mode > Dual ARB > ARB Off Onを押してOffにします。

変更中に信号発生器のDual ARBがオンになっている と、 Listen for Syncソフ ト キーを押した後に、 チェーンの先にあ

る信号発生器が間違ってIn Syncを表示する可能性があ り ます。

3. 各信号発生器で、 ARB Setup > More > Multi–BBG Sync Setupを押します。

4. Multi–BBG Sync Setupメニューで変更を行います。

ステータス ・ メ ッセージと してOut Of Sync （同期がずれています） が表示されます。

5. 各スレーブ信号発生器で、 Listen for Syncを押します。

6. すべてのスレーブのStatusでWaiting for Syncが表示されているこ とを確認します。 ステータス と してIn Syncが
表示されている場合は、 以下の手順を実行します。

a. PATT TRIGからEVENT 1までのケーブルがリア ・ パネルで正し く接続されているこ とを確認します。

ケーブルが取り外されている と、 偽のIn Syncステータスが発生します。

b. ケーブルが接続されている場合は、 ステップ1と2を実行します。

c. Listen for Syncを押し、 ステータス と してWaiting for Syncが表示されているこ とを確認します。

7. マスタ信号発生器で、 Sync Slavesを押します。

8. すべてのマスタ／スレーブ信号発生器で、 ステータス と してIn Syncが表示されているこ とを確認します。

9. プロセス 「波形を ト リガ／再生する」 （224ページ） を実行します。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
オプシ ョ ン012 （位相コヒーレンス用のLO入力／出力） と複数のベースバンド ・ ジェネレータ同期について
オプシ ョ ン012 （位相コヒーレンス用のLO入力／出力） と複数のベースバンド ・

ジェネレータ同期について

注記 このセクシ ョ ンは、前のセクシ ョ ンで説明した複数のベースバンド ・ジェネレータ同期に関する知識を前提と し

ています。 前のセクシ ョ ンをお読みでない場合は、 続行する前に 「複数のベースバン ド ・ ジェネレータ同期」

（218ページ） を参照してください。

オプシ ョ ン012搭載のMXGを使用する と、 2×2、 3×3、 または4×4 MIMO構成で共通の外部LO信号を共有し、位相コ ヒー

レン ト ・ システムを作成できます （「複数のベースバンド ・ ジェネレータ同期」 （218ページ） も参照）。

RF位相コ ヒーレンスは、一般的なSTC/MIMOレシーバ・テス トには必要がない可能性があ り ます。MIMOレシーバは、チャ

ネル状態の一部と して信号源間の位相差を認識し、 それらを補正するからです。 しかし、 ビーム形成システムの研究開発

などの特定のアプリ ケーシ ョ ンには、 RF位相コ ヒーレンスが有効です。

オプシ ョ ン012 （位相コヒーレンス用のLO入力／出力） とMIMOを設定する

標準マルチBBG同期セッ ト アップには、 ケーブルと してAgilent BNCケーブル （パーツ番号10502A） を推奨します。 オプ

シ ョ ン012にも推奨します （図8-29 （222ページ） を参照）。 さ らに、 LO IN/LO OUTからスプ リ ッ タまでの2×2、 3×3、 4
×4 MIMO接続には、 追加ケーブルが必要です （表8-5、 図8-30 （227ページ）、 図8-31 （228ページ） を参照）。

注記 LO出力は、 使用していないと きにはカバーをかけるこ とをお勧めします。

LO In/Outジャンパ ・ ケーブルを取り外した状態で、 測定器がDual ARBモードの場合は、 測定器はレベリ ング

なしにな り、 Unlevelエラー ・ メ ッセージが表示されます。

高確度の性能を実現するには、 すべてのテス ト機器を12時間ウォームアップする必要があ り ます。

位相コ ヒーレン ト設定には以下が必要です。

• 推奨LO入力ド ライブ ・ レベルのレンジを0～6 dBmに設定します。

注記 LO入力ド ライブ ・ レベルを0～6 dBmに設定する と、 測定器がフル周波数および0～55のフル周囲温度範囲で動

作します1。

• I/Q校正とセルフテス トは、 LO In/Outジャンパ・ ケーブルを配置した状態で実行する必要があ り ます。 I/Q校正を実行

できない場合は、 I/Qオフセッ ト を最小限に抑えるために、 ベースバンド ・ オフセッ ト を手動で調整できます。

• 位相コ ヒーレンス機能は、 Dual ARB変調モードにのみ適用します。

• スプ リ ッ タ出力から測定器の入力までのすべてのケーブルを等しい長さにします。

1LO入力の電源要件は温度によって変化します。 20～30度の周囲温度条件でパワー <0 dBmが得られます。

データ ・ シート を参照して ください。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
オプシ ョ ン012 （位相コヒーレンス用のLO入力／出力） と複数のベースバンド ・ ジェネレータ同期について
表8-5　オプシ ョ ン012 （位相コヒーレンス用のLO入力／出力） 機器

MIMO構成 パーツa

aすべてのMIMO構成で、同じ長さのSMAフレキシブル・ケーブルをスプリ ッ タ出力からマスタ／スレーブ測定器の入力まで接続しま

す。 図8-30 （227ページ） と図8-31 （228ページ） を参照して ください。

ケーブル長 注記

2×2 －

11636A　

必要に応じ

－

SMAフレキシブル・ケーブルをパワー・スプ リ ッ

タ出力からマスタ／スレーブMXGの リ ア ・ パネ

ルのLO入力まで接続します。 図8-30 （227ペー

ジ） を参照してください。

パワー ・ ディバイダ、 DC～18 GHz。

www.agilent.comを参照してください。

3×3 －

PS320451/12S　

必要に応じ

－

SMAフレキシブル・ケーブルをパワー・スプ リ ッ

タ出力からスレーブMXGのリ ア ・ パネルのLO入

力まで接続します。 図8-31 （228ページ） を参照

して ください。

3Way Pulser Microwave Corp、 3Way Wilkinson

ディバイダ

4×4 －

PS416452/10S　

必要に応じ

－

SMAフレキシブル・ケーブルをパワー・スプ リ ッ

タ出力からスレーブMXGのリ ア ・ パネルのLO入

力まで接続します。 図8-31 （228ページ） を参照

して ください。

4Way Pulser Microwave Corp、 4Way Wilkinson

ディバイダ

すべて 10502A　 22.86 cm　 図8-30 （227ページ） と図8-31 （228ページ） を参

照して ください。 「複数のベースバンド ・ ジェネ

レータ同期」 （218ページ） も参照してください。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
オプシ ョ ン012 （位相コヒーレンス用のLO入力／出力） と複数のベースバンド ・ ジェネレータ同期について
2×2 MIMO （位相コヒーレンス用のLO入力／出力） 構成

2×2 MIMO （位相コ ヒーレンス用のLO入力／出力） セッ ト アップの場合は、マスタMXGからのLO出力をパワー・スプ リ ッ

タ経由でマスタおよびスレーブMXGへのLO入力と して使用できます。 外部信号源は不要です。

2×2 MIMO構成の位相コ ヒーレン ト信号を生成するには、 マスタMXG LO OUTをパワー ・ スプ リ ッ タ経由でスレーブLO
INに接続します。LO OUTを直接接続する と、複数のスレーブMXGをド ラ イブできる十分な振幅のLO信号が得られるため、

RF出力信号の位相コ ヒーレンスを実現できます。 この例では、 2台のオプシ ョ ン012搭載のMXG信号発生器を接続して位

相コ ヒーレン ト 2×2 MIMOソ リ ューシ ョ ンを作成します。 図8-30を参照してください。

図8-30　 2×2 MIMO （位相コヒーレンス用のLO入力／出力） 機器セッ トアップ

3×3および4×4 MIMO （位相コヒーレンス用のLO入力／出力） 構成

3×3および4×4 MIMO （位相コ ヒーレンス用のLO入力／出力） セッ ト アップの場合は、パワー・ スプ リ ッ タや追加の測定

器で必要となる高いLOパワーを供給するために、 追加のアナログ信号源が必要です。

LO出力の4方向への分割は、 システム内のN5162/82A のLO入力を ド ラ イブするには損失が大き過ぎます。 また、

N5162A/82AのLO出力に対する振幅調整機能もあ り ません。MXGで3×3および4×4構成用の位相コ ヒーレン ト信号を生成

するには、 ベク トルMXGに十分な振幅のLO入力信号を供給するために、 外部マスタLOが必要です （図8-31 （228ページ）

を参照）。

注記 マスタLOはSignal Studioソフ ト ウェアによって制御されませんが、 マスタMXGでのRF周波数のユーザ設定に

よ り、 目的の周波数と振幅に手動で設定する必要があ り ます。

注記 ： 

位相コヒーレンスを最適化するには、 同じ長さのSMAフレキシブル ・ ケーブルを使用して、 双方向スプリ ッ タの出力をオプシ ョ ン012搭載のMXGのLO IN
に接続することをお勧めします （225ページを参照）。

同期遅延を最小限に抑えるには、 EVENT 1コネクタとPAT TRIG BNCコネクタ上でのリア ・パネル・デイジー・チェイン接続のケーブルとして、 Agilent BNC
ケーブル10502Aを推奨します （225ページを参照）。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
オプシ ョ ン012 （位相コヒーレンス用のLO入力／出力） と複数のベースバンド ・ ジェネレータ同期について
図8-31　 3×3および4×4 MIMO （位相コヒーレンス用のLO入力／出力） 機器セッ トアップ

注記 ： 

4方向スプリ ッ タへの入力からオプシ ョ ン012搭載のMXGのLO INと LO OUTまでの接続には、 SMAフレキシブル ・ ケーブルを推奨します （225ページ

を参照）。

位相コヒーレン ト を最適化するには、 同じ長さのSMAフレキシブル ・ ケーブルを使用して、 4方向スプリ ッ タの出力をオプシ ョ ン012搭載のMXGの
LO INに接続することをお勧めします （225ページを参照）。

同期遅延を最小限に抑えるには、 EVENT 1およびPAT TRIG BNCコネクタ上でのリア ・パネル ・ デイジー ・ チェイン接続のケーブルと して、 Agilent
BNCケーブル10502Aを推奨します （225ページを参照）。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・ バージ ョ ン  ≧A.01.50の波形ライセンス
ファームウェア ・ バージ ョ ン  ≧A.01.50の波形ライセンス

波形ライセンスによ り、 自分で生成した波形をライセンス許可し、 Signal Studioアプリ ケーシ ョ ンからダウンロード して

信号発生器で無制限に再生できます。 ライセンス ・オプシ ョ ン221～229では選択した波形を最大5波形、オプシ ョ ン250～
259では最大50波形、 恒久的にライセンス許可できます （すなわち、 波形オプシ ョ ン22xまたはオプシ ョ ン25xは永久固定

波形ライセンスです）。

オプシ ョ ン221～229またはオプシ ョ ン250～259によってライセンス許可された波形を別の波形に交換するこ とはできま

せん。 波形をライセンス許可する と、 そのライセンスは恒久的で、 取り消しや置換はできません。 オプシ ョ ン22xおよび

25x波形ライセンスは、 信号発生器に固有です （信号発生器のシ リアル番号に固有です）。 ラ イセンス許可されたオプシ ョ

ン22xまたはオプシ ョ ン25x波形ファ イルを別の信号発生器に転送する場合は、 再生する前に、 も う 1つの信号発生器内の

別のオプシ ョ ン22xまたはオプシ ョ ン25xでファ イルをライセンス許可する必要があ り ます。

オプシ ョ ン22xまたはオプシ ョ ン25xを取得するには、 N5182A–2xx注文書に付属のN5182A–2xxラ イセンス証明書を参照

してください。 波形ファイルの抽出方法とダウンロード方法については、 『Programming Guide』 を参照してください。

波形ライセンスについて

N76xxB Signal Studioソフ ト ウェアを使用して波形を作成し、 信号発生器にダウンロード します。 各オプシ ョ ン22xでは5
個、 オプシ ョ ン25xラ イセンスでは50個の使用可能スロ ッ トが得られます。 1スロ ッ ト当た り 48時間の試用期間中、波形の

追加と再生が行えます。 この時間、満足する波形が得られるまで何回でも波形を置換できます。 この試用期間が過ぎる と、

スロ ッ ト内の波形は、 恒久的な再生用にスロ ッ トがロ ッ ク されるまで再生できな くな り ますが、 スロ ッ ト をロ ッ クする前

にスロ ッ ト内の波形を選択した別の波形と置換できます。

オプシ ョ ン22xまたはオプシ ョ ン25xの許容数を超える追加波形をライセンス許可するには、まだ所有していない別のオプ

シ ョ ン22xまたはオプシ ョ ン25xを購入する必要があ り ます。 例えば、 オプシ ョ ン250を所有している場合は、 さ らに50ス
ロ ッ ト を追加するにはオプシ ョ ン251を購入します。オプシ ョ ン250～259をすべて追加する と、最大500スロ ッ トが得られ

ます。 オプシ ョ ン221～229をすべて追加する と、最大45スロ ッ トが得られます （同じ信号発生器に対して同じオプシ ョ ン

を再購入する と、 追加の波形ライセンスは供与されません）。

オプシ ョ ンN5182-22xまたはオプシ ョ ンN5182A-25xのインストール

ラ イセンス ・ マネージャまたはUSB媒体を使用して、 波形ライセンス （オプシ ョ ンN5182–22xまたはオプシ ョ ンN5182A–
25x） を信号発生器にロード します。波形ライセンスのロード方法の詳細については、注文書に付属のN5182A–2xxライセ

ンス証明書を参照して ください。

信号発生器波形をライセンス許可する

N76xxB Signal Studioソフ ト ウェアを使用して波形を作成し、信号発生器にダウンロード します。Signal Studioソフ ト ウェ

アの使用方法については、 Signal Studioソフ ト ウェアのヘルプを参照してください。

48時間の試用期間中、 ライセンス ・ スロ ッ トに波形を追加する手順については、 234ページを参照して ください。 試用期

間中、 波形の再生と置換を何回でも行えます。 試用期間が過ぎる と、 恒久的な再生機能用と してスロ ッ トがロ ッ ク される

まで、 スロ ッ ト を再生に利用できな くな り ます。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
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波形ライセンス ・ ソフ トキーの概要

図8-32　波形ライセンス ・ ソフ トキー

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

Mode > Dual ARB > More

注記 ： オプシ ョ ン2xxでライセンス許可された波形を別の波形に交換することはできません。

波形がライセンス ・ スロッ トにロックされると、 そのライセンスは恒久的で、 取り消しや置換はできません。

このソフ トキーは、 測定器にオプシ ョ ン2xxライセンスがインストールされている場合にだけ使用できます。

このソフ トキーを押すと、各スロッ トのライセンス ・ステータスと関連するファイル名が表示され、波形ライ

センス ・ メニューの選択にアクセスできます。

このソフ トキーを使用して、 選択

した波形を最初の使用可能スロッ

トに追加できます。231ページを参

照して ください。

関連ライセンス ・ コマンドについては、 『SCPI
Command Reference』 を参照して ください。

このソフ トキーを使用して、選択

したスロ ッ トの波形を置換でき

ます。 232ページを参照して く だ

さい。

このソフ トキーは、 選択したス

ロッ トの波形をクリアします。

このソフ トキーを使用して、 波

形をスロ ッ ト にロ ッ クできま

す。 試用期間が過ぎたら、 波形

を再生するために波形をロッ ク

する必要があります。232ページ

を参照して ください。

このソフ トキーを使用して、 波

形の追加、 置換、 ク リアを行う

特定のスロ ッ ト を選択できま

す。スロッ トの選択方法には、フ

ロン ト ・ パネルの矢印キーを使

用する方法や、 スロッ ト までス

クロールする方法もあり ます。

231ページを参照して ください。

 
注記 ：波形ライセンスに初めてアクセスしたときに、 すべてのスロッ トにAvailableと
表示されます。 波形をスロッ トに追加した後のライセンス ・ ステータスの説明につい

ては、 表8-6 （233ページ） を参照して ください。

232ページ
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・ バージ ョ ン  ≧A.01.50の波形ライセンス
図8-33　波形ライセンス ・ ソフ トキー

各キーの詳細については、キーのヘルプ

を使用して く ださい（42ページを参照）。

Mode > Dual ARB > More > 
Waveform Licensing > Add 
Waveform to First Available Slot
または

Mode > Dual ARB > More > 
Waveform Licensing > Replace 
Waveform in Slot

波形がすでにライセンス許可されて

いるか、 ライセンスが不要の場合は、

このソフ トキーはグレー表示になり

ます。

このソフ トキーで、Int Storageま
たはUSB Mediaに保存された波

形セグメン トのカタログを表示

します。

このソフ トキーで、 BBGメモリ

に保存された波形のカ タ ログ

を表示します。

波形を選択するには、 矢印

キーを使用し て波形を強

調表示し、Add Waveformを

押します。

注記：オプシ ョ ン2xxでライセンス許可された波形を交換することはできません。スロッ ト

がロックされると、 ロッ クされたスロッ ト内の波形のライセンスは恒久的で、 取り消しや

置換はできません。

関連ライセンス ・ コマンドについて

は、 『SCPI Command Reference』 を参

照して く ださい。追加または置換の対象となる波形は、 BBGメモリ、 内部スト レージ、 USBデバイスから選択できます。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  ≧A.01.50の波形ライセンス
図8-34　波形ライセンス ・ ソフ トキー

各キーの詳細については、キー

のヘルプを使用して く ださい

（42ページを参照）。

Mode > Dual ARB > More > 
Waveform Licensing > Goto Slot

フロン ト ・ パネルのテンキーを使用して特定のスロッ ト番号を入力した後、 このソフ トキーを

押します。

このソフ トキーを押して、 最初のスロッ トに移動します。

このソフ トキーを押して、 ステータスがＡ vailableの最初のスロッ トに移動します。

このソフ トキーを押して、 最後のスロッ トに移動します。 スロッ ト数は、 測定器にインストールさ

れたライセンス ・ オプシ ョ ンの数に依存します。

Mode > Dual ARB > More > Waveform Licensing > 
Lock Waveform in Slot

このソフ トキーは、 信号発生器の内部スト レージ ・ メモリで波形が見つからなかった場合に表

示されます。 このソ フ ト キーを押し て波形を内部ス ト レージに保存し、 Confirm Locking
Waveformソフ トキーをアクテ ィブにします。 ステップ4 （235ページ） を参照して く ださい。

Mode > Dual ARB > More > Waveform 
Licensing > More > More

このソフ トキーを押して、 強

調表示されたスロッ トの波形

を再生します。

このソフ トキーを押して、 名

前に関係な く、 このスロッ ト

に追加されたメモリ内の波形

を見つけます。 検索結果が戻

らない場合は、 元の波形はメ

モリから削除済みで、 見つけ

ることができません。

このソフ トキーを押して、 波形を恒久的なライセンスのためスロッ トにロックすることを確認

します。 波形が内部スト レージに保存されていない場合は、 警告メ ッセージが表示されます。

ステップ4 （235ページ） を参照して ください。

関連ライセンス ・ コマンドについては、 『SCPI
Command Reference』 を参照して く ださい。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・ バージ ョ ン  ≧A.01.50の波形ライセンス
表8-6　波形ライセンス ・ スロッ トのステータス ・ メ ッセージ

Status列 意味 注記

Available　 ス ロ ッ ト に波形が追加されたこ とがあ り ま

せん。

各オプシ ョ ン25xで最初に使用でき る ス ロ ッ ト

数は50スロ ッ ト です。

各オプシ ョ ン22xで最初に使用でき る ス ロ ッ ト

数は5スロ ッ トです。

Locked MM/DD/YY　 スロ ッ トがロ ッ ク され、変更できなくなって

います。

このスロ ッ ト内の波形は、この信号発生器に対し

て無制限の再生がライセンス許可されています。

Remaining Trial Time HH:MM　 スロ ッ トは試用期間中です。試用期間は、波

形を追加した時点から48時間継続します。

試用期間中、 このスロ ッ トの波形に対して再生、

ク リ ア、 別の波形との置換が行えます。

Lock Required　 スロ ッ トの試用期間が過ぎましたが、スロ ッ

トはまだロ ッ ク されていません。

スロ ッ ト のク リ アまたは別の波形との置換が可

能ですが、スロ ッ トがロ ッ ク されるまで波形を再

生するこ とはできません。試用期間の提供はも う

あ り ません。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  ≧A.01.50の波形ライセンス
例 ： Signal Studio波形をライセンス許可する

以下の手順では、 波形ファ イルをライセンス ・ スロ ッ トに追加し、 恒久的な再生のためにスロ ッ ト をロ ッ ク します。

1. Mode > Dual ARB > More > Waveform Utilities > Waveform Licensingを押します。

信号発生器は、 ラベルCatalog of BBG Segment Files in BBG Memoryのファイルのカタログを表示します。

2. 矢印キーを使用して、 ライセンス許可するファ イルを強調表示し、 選択します。

3. Add Waveformを押して、 選択した波形を最初の使用可能スロ ッ トに追加します。

図8-35　波形の追加

Mode > Dual ARB > More > Waveform Licensing> 
Add Waveform to First Available Slot

231ページ

波形N7602BWFM1 のStatus エ リ

アは空で、 Add Waveform ソ フ ト

キーがアクティブです。これは、波

形がライセンス可能であるこ とを

示します。

選択した波形を最初の使

用可能スロ ッ ト に追加し

ます。スロッ トの試用期間

は、波形の追加直後に始ま

ります。

48時間の試用期間中、波形

の再生と置換を何回でも

行えます。

試用期間が過ぎると、 ス

ロ ッ トのラ イセンス ・ ス

テータ スがLock Required
に変化します。 これ以降、

スロ ッ トがロ ッ ク される

まで波形を再生できな く

なります。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・ バージ ョ ン  ≧A.01.50の波形ライセンス
4. 波形をライセンス許可します。

a. Lock Waveform in Slotを押します。

警告が表示されます ： *** Waveform Lock Warning!!!***。 必要に応じて、 Returnを押して、 ラ イセンス許可

したい正しい波形が選択されているこ とを確認します。

図8-36　  波形ロック警告

b. Confirm Locking Waveformを押します。

スロ ッ トのライセンス ・ ステータスがLocked MM/DD/YYに変わり ます。

c. 波形が前に内部ス ト レージにバッ クアップされていない場合は、 警告が表示されます。 *** Waveform Backup
Required （波形のバッ クアップが必要です） !!!***

d. Backup Waveform to Int Storageを押す前に、USB媒体またはコンピュータでこの波形のバッ クアップ・ コピーを作

成します （信号発生器で波形が失われるか、 削除された場合は、 波形を復元できません）。

図8-37　  Backup Waveform To Int Storageソフ トキー

注意 ラ イセンス許可する波形のバッ クアップ ・ コピーを作成するこ とが重要です。 バッ クアップ ・ コピーは信

号発生器に保存しないでください。 波形のすべてのコピーが削除された り、 失われた り した場合は、 波形

の復元方法やライセンスの再割り当て方法はあ り ません。 「ファ イルの操作」 （63ページ） を参照して くだ

さい。

このソフ トキーを押して、 波形を内部スト

レージに保存し、Confirm Locking Waveform
ソフ トキーをアクテ ィブにします。

Confirm Locking Waveform ソ フ ト キー

は、 波形が内部ス ト レージに保存され

るまで非アクティブのままです。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  ≧A.01.50の波形ライセンス
波形ライセンスの警告メ ッセージ

図8-38　

この標準警告は、 ロックする波形

を選択するたびに表示されます。

この通知は、使用可能なライセン

ス ・ スロッ トの1つがオプシ ョ ン

2xxによって使用されよ う と して

いることを示します。

測定器の内部ス ト レージか

ら フ ァ イルが削除 さ れた

り、 失われたり した場合に

備えて、 常に波形のバッ ク

アップ ・ コピーを別の不揮

発性メモリに作成します。

この警告は、内部スト レージまた

はUSB媒体に保存されていない

波形をロ ッ ク しよ う と したとき

に表示されます （すなわち、波形

を不揮発性メモリに保存しない

と、 波形をロッ クできません） 。

Backup Waveform To Int Storageソ
フ トキーを押します。

この警告は、内部スト レージまた

はUSB媒体 （不揮発性メモリ） に

メモリ不足などの問題が存在し、

波形を不揮発性メモリに保存で

きなかった場合に表示されます。

この警告は、 BBGまたは内部スト

レージに波形フ ァ イルが見つか

らなかった場合に表示されます。

波形をロックするには、波形が測

定器に存在するこ と を確認する

必要があります。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
ファームウェア ・ バージ ョ ン  < A.01.50の波形5パック ・ ライセンス

（オプシ ョ ン221～229）

波形5パッ ク ・ ラ イセンスを使用する と、 最大45個のSignal Studio波形の作成、 生成、 恒久的なライセンス許可が可能で

す （各オプシ ョ ン22xで、 5波形のライセンス許可が可能です （オプシ ョ ン221、 222、 223、 229））。

信号発生器を使用して、 これらの波形のライセンスを管理します。 例えば、 信号発生器を使用してライセンス許可する個

別の波形を選択できます。 また、 現在ライセンス許可されているすべての波形のリ ス ト を表示できます。

波形5パック ・ ライセンスについて

5パッ クによってラ イセンス許可された波形を交換するこ とはできません。 波形をラ イセンス許可する と、 そのラ イセン

スは恒久的で、 取り消しや交換はできません。 オプシ ョ ン22x波形ライセンスは、 信号発生器に固有です （信号発生器の

シ リ アル番号に固有です）。

波形5パッ ク ・ ラ イセンスを使用する と、 信号を作成／生成し、 保存して信号発生器で無制限に使用できます （すなわち、

波形5パッ ク ・ オプシ ョ ン22xは永久固定の波形ライセンスです）。

Signal Studioソフ ト ウェアを使用して波形を作成し、 信号発生器の揮発性メモ リにダウンロード して再生します。 満足す

る波形が得られたら、 ライセンス許可する前に波形を不揮発性メモリに保存する必要があ り ます。

ラ イセンス許可されたオプシ ョ ン22x波形ファ イルを別の信号発生器に転送する場合は、 再生する前に、 も う 1つの信号発

生器内の別のオプシ ョ ン22xでファ イルをライセンス許可する必要があ り ます。 波形ファ イルの抽出方法とダウンロード

方法については、 『Programming Guide』 を参照して ください。

オプシ ョ ン22xの許容数を超える追加波形をライセンス許可するには、まだ所有していない別のオプシ ョ ン22xを購入する

必要があ り ます。 例えば、 オプシ ョ ン221をすでに所有し、 残りのライセンスが2つしかなく、 さ らに10個の波形が必要な

場合は、オプシ ョ ン222と223を購入する と、 さ らに10個の波形をライセンス許可するための十分なライセンスが得られま

す。 これによ り、 オプシ ョ ン223で2つのライセンスが残り ます （同じ信号発生器に対してオプシ ョ ン221を二度目に再購

入する と、 追加の波形5パッ ク ・ ラ イセンスは供与されません）。

波形をライセンス許可した後、 同じ信号発生器で使用するために、 異なるファ イル名を使用して波形のコピーを作成でき

ます。 元のファイルも、 波形ライセンスに影響を与えるこ とな く リネームできます。

オプシ ョ ン22xを使用して、14日間の無料試用ライセンス中にダウンロード したN76xxB Signal Studioソフ ト ウェアの波形

をライセンス許可するこ と もできます。 すべてのN76xxB Signal Studioソフ ト ウェア製品には、 14日間の試用期間 （試用

ライセンス） があ り ます。 この14日間の試用ライセンスを使用する と、 試用期間中に波形をダウンロード して再生できま

す。 こ う した波形は、 波形セグメン ト ・ カタログのステータス ・ メ ッセージ ・ エ リ アでTRLによって示されます。 試用期

間が過ぎる と、 TRL メ ッセージは削除されますが、 波形は残り ます。 TRL メ ッセージが消えた後にこれらの波形をライセ

ンス許可できます。

波形5パッ クには、 ファームウェア ・ バージ ョ ン≧A.01.20が必要です。

オプシ ョ ンN5182A-22x波形5パック ・ ライセンスをインス トールする

• ラ イセンス ・ マネージャまたはUSB媒体を使用して、 波形5パッ ク ・ ラ イセンス （オプシ ョ ンN5182A-22x） を信号発

生器にロード します。 波形5パッ ク ・ ラ イセンスのロード方法の詳細については、 N5182A22xラ イセンス証明書を参

照して ください。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
信号発生器の波形ファイルをライセンス許可する

1. 波形を作成します。

a. 目的のN76xxB Signal Studioソフ ト ウェアをダウンロード します。 N76xxB Signal Studioソフ ト ウェアのダウン

ロード方法については、 N5182A–22xラ イセンス証明書を参照して ください。

b. N76xxB Signal Studioソフ ト ウェアを使用して波形を作成し、 信号発生器にダウンロード します。 Signal Studio
ソフ ト ウェアのヘルプを参照して ください。

波形5パック ・ ライセンス ・ ソフ トキーの概要

図8-39　波形5パック ・ ライセンス ・ ソフ トキー

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

239ページ

Mode > Dual ARB > More > 
Waveform Utilities >

245ページ

このソフ トキーは、 測定器に

オプシ ョ ン22xがインス ト ー

ルされている場合にだけ使用

できます。

注記 ： 5パックによってライセンス許可された波形を交換することはできません。

波形をライセンス許可すると、 そのライセンスは恒久的で、 取り消しや交換はできません。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
図8-40　Add a Waveform to 5–Packソフ トキー

各キーの詳細については、

42ページの説明に従って

キーのヘルプを使用し て

く ださい。

Mode > Dual ARB > More > 
Waveform Utilities > 5–Pack 
Licensing > Add Waveforms to 
5–Pack

このソフ トキーは、追加できるセキュ

ア波形と、使用可能なスロッ ト を持つ

波形5パック ・ ライセンスが存在する

場合にのみアクテ ィ ブです （すなわ

ち、波形がすでにライセンス許可され

ているか、 ライセンスが不要の場合

は、ソフ トキーがグレー表示になりま

す）。 243ページを参照して ください。

このソフ トキーで、 Int
Storage または USB
Mediaに保存された波

形セグ メ ン ト のカ タ

ログを表示します。

このソ フ ト キーで、

BBG メモリに保存さ

れた波形のカタログ

を表示します。

波形ファイルの名前とステータスを表示します。 表8-7 （240ページ） を参照して ください。

波形5パック・ライセンス

のいずれかを受け取るた

め波形を選択するには、

矢印キーを使用して波形

を 強 調 表 示 し、 Add
Waveformを押します。

注記 ： 5パックによってライセンス許可された波形を交換す

ることはできません。波形をライセンス許可すると、そのラ

イセンスは恒久的で、 取り消しや交換はできません。

関連する5パック ・ライセンス・ コマンド

については、 『SCPI Command Reference』
を参照して ください。
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 239



基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
表8-7　内部スト レージ[またはUSB媒体]内のセグメン ト ・ フ ァイルのカタログに対する波形5パック ・ ライセンスの

ステータス ・ メ ッセージ

ステータス ・ メ ッセージ 意味 注記

空のフ ィールド ステータス ・ メ ッセージがない場合は、 波形はラ イ

センス可能です。

試用 （TRL） ラ イセンスの期限が終了

する と、 波形がライセンス可能にな り

ます （すなわち、 TRL波形のステータ

ス ・ メ ッセージが空のフ ィールドにな

り ます）。

ラ イセンス許可されたオプシ ョ ン22x

波形ファ イルを別のN5182A信号発生

器にダウンロード した場合は、 そのも

う 1つの信号発生器で波形がラ イセン

ス可能にな り ます （すなわち、 ステー

タス ・ メ ッセージ ・ フ ィールドが空に

な り ます）。

5–Pack Licensed この波形は、オプシ ョ ン22xによってライセンス許可

されています。

5–Pack License Not Required このステータス ・ メ ッセージは以下に適用されます。

Agilent MXGで提供される無料の波形

（例えば、 RAMP_TEST_WFM、 SINE_TEST_WFMなど）

カスタマ作成波形

有効なライセンスを持つ波形

（例えば、試用 （TRL） ラ イセンス、Advanced Design 

System （ADS） など）。

試用 （TRL） ラ イセンスの期限が終了

する と、 波形がライセンス可能にな り

ます （すなわち、 TRL波形のステータ

ス ・ メ ッセージが空のフ ィールドにな

り ます）。

ラ イセンス許可されたオプシ ョ ン22x

波形ファ イルを別のN5182A信号発生

器にダウンロード した場合は、 そのも

う 1つの信号発生器で波形がラ イセン

ス可能にな り ます （すなわち、 ステー

タス ・ メ ッセージ ・ フ ィールドが空に

な り ます）。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
例 ： Signal Studio波形をライセンス許可する

以下の手順では、単一波形ファ イルを波形5パッ ク ・ ラ イセンスに追加します。図8-42 （243ページ） を参照して ください。

2. 波形を内部メモリに保存する方法は2つあ り ます。

注記 波形5パッ ク ・ ラ イセンスで波形をライセンス許可するには、 波形を内部ス ト レージまたはUSB媒体に保存する

必要があ り ます。

a. Backup Waveform To Int Storageソフ ト キーを使用してファイルを内部ス ト レージに保存します。

1. Return > Return > More > Waveform Utilities > 5–Pack Licensing > Add Waveforms to 5–Packを押します。

2. Backup Waveform To Int Storageを押します （図8-41を参照）。

図8-41　Backup Waveform To Int Storageソフ トキー

3. ステップ3 （サブステップd） に移動します。

b. Backup Waveform to Int Storageソフ ト キーを使用して波形がすでに信号発生器に保存されている場合は、ステップ

dに進みます。

1. それ以外の場合は、 ARB SegmentsメニューのLoad Storeソフ ト キーを使用して、 波形を内部ス ト レージに保

存します。 「ファ イルの操作」 （63ページ） を参照してください。

2. 波形を内部ス ト レージ （内部媒体） に保存したらステップ3に進みます。

3. 波形をライセンス許可します。

a. Return > Return > More > Waveform Utilities > 5–Pack Licensing > Add Waveforms to 5–Packを押します。

信号発生器は、 ラベルCatalog of BBG Segment Files in BBG Memoryのファイルのカタログを表示します。

b. 矢印キーを使用して、 ライセンス許可するファ イルを強調表示し、 選択します。

c. Add Waveformを押します。

警告が表示されます ： *** Waveform Licensing Warning!!!***。 必要に応じて、 Returnを押して、 ラ イセン

ス許可したい正しい波形が選択されているこ とを確認します。 それ以外の場合は、 次の手順に進みます （図8-42
（243ページ） を参照）。

d. Confirm Adding Waveform to 5–Packを押します。

ディ スプレ イがCatalog of BBG Segment Files in BBG Memoryに戻 り、 フ ァ イルのStatus列のラベルが

5–Pack Licensedになり ます （図8-42 （243ページ） を参照）。

このソフ トキーを押して、 波形を

内部ストレージに保存し、Confirm
Adding Waveform To 5–Packソフ ト

キーをアクティブにします。

Confirm Adding Waveform To 5–Pack
ソ フ ト キーは、 波形が内部ス ト

レージに保存されるまで非ア ク

ティブのままです。

各キーの詳細については、 42ページの説明に従って

キーのヘルプを使用して ください。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
e. USB媒体またはコンピュータでこの波形のバッ クアップ ・ コピーを作成します （信号発生器で波形が失われるか、

削除された場合は、 波形を復元できません）。

注意 5パッ ク波形のバッ クアップ ・ コピーを作成するこ とが重要です。 バッ クアップ ・ コピーは、 コンピュータ

や他の媒体に保存する必要があ り ます。 バッ クアップ ・ コピーを信号発生器に保存しないでください。 波

形のすべてのコピーが削除された り、 失われた り した場合は、 波形の復元方法やライセンスの再割り当て

方法はあ り ません。 「ファ イルの操作」 （63ページ） を参照して ください。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
図8-42　Add a Waveform to 5–Packソフ トキー

Mode > Dual ARB > More > 
Waveform Utilities > 5–Pack 
Licensing > Add Waveforms to 
5–Pack

239ページ

波形N7602BWFM1のStatusエリ

アは空で、 Add Waveform ソ フ ト

キーがアクテ ィ ブです。 これは、

波形がライセンス可能であること

を示します。

N7602B-WFM1のステータスが5-Pack Licensedになり、

Add Waveformソフ トキーがアクテ ィブでな く なります。

この警告メ ッセー

ジは、 これがラ イ

センス許可してい

る波形が目的の波

形であるこ とを確

認する最後の機会

であるこ とを示し

ます。 選択された

波形を確認してい

ない場合は、Return
を押し、 選択を確

認します。

ライセンス許可用に

選択された波形がラ

イセンス許可したい

波形であることを確

認 し た ら、 Confirm
Adding Waveform To
5–Packを押します。

注意! この手順は元

に戻すことができま

せん。

重要! ライセンス許可され
た波形は、常に測定器とは
別の場所 （コンピュータ、
USB 媒体など） にバッ ク
アップします。

各キーの詳細については、 キーのヘルプを

使用して く ださい （42ページを参照）。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
波形5パックの履歴の使用

Waveform 5–Pack Historyソフ ト キーを使用して、 信号発生器で波形5パッ ク ・ ファ イルを管理できます。 5–Pack History
ソフ ト キーを以下に使用できます。

• 特定の波形5パッ ク ・ ラ イセンス波形のリ ス ト を、そのライセンス許可された波形から流用された任意の リネームされ

たファ イルを含めて作成する

• 信号発生器上のすべてのライセンス許可された波形と ライセンス許可されていない波形のリ ス ト を作成する

Waveform 5–Pack Historyソフ ト キーの説明については、 図8-43 （245ページ） を参照してください。

5–Pack Historyソフ ト キーは、 波形5パッ ク ・ ファ イルを前に不揮発性メモリ （内部ス ト レージまたはUSB媒体） に保存し

た場合にのみアクティブにな り ます。 ただし、 5–Pack Historyソフ ト キーは、不揮発性メモリで入手できなくなったライセ

ンス許可済みの波形ファイルの履歴を ト ラ ッキングします （すなわち、 波形ファ イルが内部ス ト レージから削除されてし

まった場合や、測定器に接続されていない USB媒体に存在する場合に、 5–Pack Historyソフ ト キーはアクティブのままで

す）。 5パッ ク履歴は、 Redemption Date、 Waveform ID、 Original Filenameのカタログを保持します。

注記 内部ス ト レージまたはUSB媒体のカタログを表示できますが、 両方を同時に表示するこ とはできません。

内部ス ト レージからUSB媒体に切り替える と きに、 測定器でError -230, Data corrupt or staleが表示さ

れる場合があ り ますが、 エラーの原因は通常、 同じ名前のファ イルが見つかったためです。 ただし、 ファ イル

は、元の5パッ ク ・ ラ イセンス許可済みの内部ス ト レージ ・ ファ イルとは異なる波形ファイル （異なるWaveform
IDを持つファ イル） です。
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
図8-43　Waveform 5–Pack Historyソフ トキー

各キーの詳細については、 42ペー

ジの説明に従ってキーのヘルプ

を使用して ください。

Mode > Dual ARB > More > 
Waveform Utilities > 5–Pack 
Licensing > 5–Pack History 前に保存された波形5パック ・ ライセンスを持

つ波形が存在するときにだけ使用可能です。

このエリアに、 波形がライセンス許可された日付、 一意の波形ID、 波形が最初に取得されたときの

元のファイル名が表示されます。

使用済みの波形ライセンス

の数および使用可能な合計

波形ライセンス ・ スロ ッ ト

の数を表示します （この例

では、 45ライセンスのうち3
ライセンスが使用されてい

ます）。

このソフ トキーを押して、 現在のフ ァイル名

に関係な く、 強調表示された波形のすべての

コピーを検索します。 検索結果が戻らない場

合は、 元の波形は削除済みで、 見つけるこ と

ができません。

この画面には、 オプシ ョ ン22x
によってライセンス許可され

ているすべての波形が表示さ

れます。

Locationはメモリです。

*内部スト レージ

*BBGメモリ、 または

*USB媒体

注記 ：

1) この例では、 波形N7602B_1_COPY3がInt Storageに保存され、 BBG Memoryで再生されています。

2) この例では、 Int Storageが不揮発性記憶場所として選択されています。 USB媒体に保存されている5パック波形を表示するには、

USB媒体をデフォルト ・ ス ト レージとして選択する必要があります。 63ページを参照して ください。

Find Waveformを押すと、元の保存された

波形のコピーが、 測定器に表示されます

（例えば、

N7602B_1_COPY1、
N7602B_1_COPY2、
N7602B_1_COPY3）。
この例では、 元のファイル名N7602B_1
は、 元のファイルが削除されたか、 名前

が変更されたため見つかり ませんでし

た。しかし3つのコピーが見つかりました

（N7602B_1_COPY3がInt Storage と

BBG Memoryの両方で見つかりました）。
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
例 ： 波形5パック ・ ライセンスの履歴を検索する

以下の手順を使用して、 内部ス ト レージまたはUSB媒体のライセンス許可された波形5パッ ク ・ ファ イルのカタログを作

成します。 以下の手順については、 図8-44 （246ページ） を参照してください。

以下の手順では、 ラベルN7602B-WFM1の波形5パッ ク ・ ファ イルのカタログを生成します。

1. 信号発生器 ：

a. Mode > Dual ARB > More > Waveform Utilities > 5–Pack Licensing > 5–Pack Historyを押します。

b. 矢印キーを使用して、 カタログ ・ ファ イルN7602B-WFM1を強調表示します。

c. Find Waveformを押します。

測定器は、Waveform 5-Pack Search Resultsという タイ トルのカタログを表示します。 このカタログには、波

形5パッ ク ・ ラ イセンスでラ イセンス許可された元のファ イルのコピーである、 ファ イルの一覧が表示されます

（名前はN7602B-WFM1） 。 この例では、 コピーは現在、 BBG メモ リ と内部ス ト レージに存在し、 名前はそれぞれ

N7602B-WFM1とN7602B-WFM1_COPYです。 図8-44 （246ページ） を参照してください。

注記 ファイルが見つからない場合は、 ステップ e （242 ページ） で作成されたバッ クアップ ・ コピーを再ロードでき

ます。

図8-44　Waveform 5–Pack History Find Waveformソフ トキーの使用

Mode > Dual ARB > More > 
Waveform Utilities > 5–Pack 
Licensing > 5–Pack History 強調表示されたフ ァ イルN7602B-WFM1

は、 この例で作成された波形です （各ラ

イセンス波形に対して固有の波形IDが表

示されています）。

元の5パッ ク ・ ラ イセンス波形

N7602B-WFM1は
N7602B-WFM1_COPY に変更さ

れ、Internal Storageに保存

されて、 BBG Memoryで再生さ

れています。

Find Waveformを押したときに波

形がリ ス ト に示されない場合

は、 BBG Memory、 Internal 
Storage、USB Mediaで波形を

見つけることができません。

各キーの詳細については、 42ページ

の説明に従ってキーのヘルプを使用

して く ださい。

 247ページを参照
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 基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
5パック ・ ライセンスに関連するすべての波形を検索する

以下の手順では、 BBGメモ リ と内部ス ト レージのすべての波形5パッ ク ・ ファ イルのカタログを表示します。

1. 信号発生器 ：

a. Mode > Dual ARB > More > Waveform Utilities > 5–Pack Licensing > Find All Waveformsを押します。

測定器はタイ トルWaveform 5-Pack Search Resultsのカタログを表示します。 図8-45を参照してください。

注記 ファイルが見つからない場合は、 ステップ e （242 ページ） で作成されたバッ クアップ ・ コピーを再ロードでき

ます。

図8-45　Waveform 5–Pack History Find All Waveformsソフ トキーの使用

Mode > Dual ARB > More > Waveform Utilities > 
5–Pack Licensing > 5–Pack History > Find All 
Waveforms
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基本的なデジタル動作 （オプシ ョ ン651/652/654）
フ ァームウェア ・バージ ョ ン  < A.01.50の波形5パック ・ ライセンス （オプシ ョ ン221～229）
波形5パックの警告メ ッセージ

図8-46　

この標準警告は、ライセンス許可

する波形を選択するたびに表示

されます。この通知は、使用可能

なライセンス ・ スロッ トの1つが

オプシ ョ ン22xによって使用され

よう と していることを示します。

測定器の内部スト レージか

ら フ ァ イルが削除された

り、 失われたり した場合に

備えて、 常に波形のバック

アップ ・ コピーを別の不揮

発性メモリに作成します。

この警告は、内部スト レージまた

はUSB媒体に保存されていない

波形をライセンス許可しよ う と

したときに表示されます（すなわ

ち、波形を不揮発性メモリに保存

しないと、波形をライセンス許可

できません） 。 Backup Waveform
To Int Storage ソ フ ト キーを押し

ます。

この警告は、内部スト レージまた

はUSB媒体 （不揮発性メモリ） に

メモリ不足などの問題が存在し、

波形を不揮発性メモ リに保存で

きなかった場合に表示されます。

この警告は、 ライセンス許可し

ているフ ァイルが内部ス ト レー

ジまたはUSB媒体 （不揮発性メ

モリ） にバッ クアップされてい

ないが、 同じ名前のファイルが

すでに内部ス ト レージまたは

USB媒体に存在する場合に表示

されます。
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9 リアルタイム ・ ノ イズの信号への追加

（オプシ ョ ン403）

注記 N5162Aでは、 本書に記述されているソフ ト キー ・ メニューと機能は、 Webイネーブル MXGまたはSCPIコマン

ド経由でのみ使用できます。 Webイネーブル MXGの詳細については、 『インス トール ・ガイ ド』、 『プログラ ミ ン

グ ・ ガイ ド』、 『SCPI Command Reference』 を参照してください。

こ こに記載の内容を理解するには、 信号発生器の基本動作についての知識が必要です。 パワー ・ レベル／周波数の設定な

どの機能を簡単に操作できない場合は、 第3章 「基本操作」 （41ページ） を参照して、 内容をよ く理解してください。

この機能は、 オプシ ョ ン431を搭載したN5162A/82A Agilent MXGベク トル信号発生器でのみ使用できます。 オプシ ョ ン

431には、 オプシ ョ ン651、 652、 654のいずれかが必要です。

本章では、相加性白色ガウス雑音 （AWGN） 波形ジェネレータの使用例を示します。AWGN波形ジェネレータは、オプシ ョ

ン403を搭載したベク トル信号発生器でのみ使用するこ とができます。

• 「デュアルARB波形へのリ アルタイム ・ ノ イズの追加」 （249ページ）

• 「Real Time I/Q Baseband AWGNの使用」 （255ページ）

デュアルARB波形へのリアルタイム ・ ノ イズの追加

注記 波形へのリ アルタイム ・ ノ イズ(AWGN)の追加に関するこのセクシ ョ ンの手順は、カスタムARB、マルチ トーン、

2 トーンの各変調にも適用可能です。

オプシ ョ ン403を搭載したベク トル信号発生器を使用する と、 デュアルARB波形プレーヤで変調波形を再生しながら、 搬

送波にリアルタイムで相加性白色ガウス雑音(AWGN)を追加するこ とができます。この機能は、各ARBフォーマッ ト と、ス

タンドアロン ・ メニューで使用できます （図9-7 （255ページ） を参照）。
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リアルタイム ・ ノ イズの信号への追加 （オプシ ョ ン403）
デュアルARB波形へのリアルタイム ・ ノ イズの追加
図9-1　Real Time I/Q Baseband AWGNソフ トキー

251ページを参照

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

表示にノ イズの状態 （オンまたはオフ）

が示されます。

図9-6 （254ページ） に、 これら

の設定の詳細を示します。

これは、 スタンドアロンのRealTime AWGN
と、 Modulation Modeメニューの2ページ目

です （255ページを参照）。

ARB リアル ・ ノ イズAWGNの静的なグ

ラフ ィ ック表現 （値が変化してもグラ

フ ィ ックは更新されません）

値の間の関係がARB リアルタイムAWGNの静的グラフ ィ ッ クに

表示されます。

全ノイズ・パワーは、占有雑音帯域幅(NBW * 1.25)全体のノイズ・

パワーです。

251ページを参照

251ページを参照

選択した搬送波対雑音比の、 ノ イズを積分す

る帯域幅。 通常、 搬送波帯域幅(CBW)は搬送

波の占有帯域幅です。

フラ ッ ト ・ ノ イズ帯域幅(NBW) ：実際のフラッ

ト ・ ノ イズ帯域幅(NBW)。搬送波の帯域幅より

少し広く なります （一般的に1.6倍程度）。

占有帯域幅＝ （1.25 * フラッ ト ・ ノ イズ帯域幅）

252ページを参照

Carrier Bit Rate ソ フ ト キーは搬送波のビ ッ

ト ・ レート を設定します （デフォルトの搬送

波ビッ ト ・ レートは1 bps）。

Carrier Bit Rateソフ トキーは、Carrier to Noise
Ratio Format ソ フ ト キーがEb/Noに設定され

ている場合のみ使用できます。 253ページも

参照して く ださい。
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 リアルタイム ・ ノ イズの信号への追加 （オプシ ョ ン403）
デュアルARB波形へのリアルタイム ・ ノ イズの追加
図9-2　Real Time I/Q Baseband AWGN - Power Control Modeソフ トキー

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。
Mode > Dual ARB > Arb Setup >
Real-Time AWGN Setup

パワー制御モード としてTotalを選択す

ると、 全パワーと C/Nが独立変数、 搬

送波パワーと全ノ イズ ・パワーが従属

変数になります。 従属変数の搬送波パ

ワーと全ノイズ・パワーは、全パワー、

C/N、 およびその他のノ イズ設定によ

り設定されます。 どれかのノ イズ ・ パ

ラ メータ を調整する と、 全パワーと

C/N を最新の設定値を維持するよ う

に、 搬送波パワーと全ノ イズ ・ パワー

が変更されます。

パワー制御モード と してCarrierを選

択すると、搬送波パワーとC/Nが独立

変数、全パワーと全ノイズ・パワーが

従属変数になります。従属変数の全パ

ワーと全ノイズ・パワーは、搬送波パ

ワー、 C/N、およびその他のノイズ設

定により設定されます。どれかのノイ

ズ・パラ メータを調整すると、搬送波

パワーとC/Nを最新の設定値を維持

するように、全パワーと全ノイズ・パ

ワーが変更されます。

パワー制御モード としてTotal Noiseを
選択すると、 全ノ イズ ・パワーとC/N
が独立変数、全パワーと搬送波パワー

が従属変数になります。従属変数の全

パワーと搬送波パワーは、 全ノ イズ ・

パワー、 C/N、 およびその他のノイズ

設定により設定されます。どれかのノ

イズ・パラ メータを調整すると、全ノ

イズ ・パワーとC/Nを最新の設定値を

維持するように、全パワーと搬送波パ

ワーが変更されます。

図9-6 （254ページ） に、 これら

の設定の詳細を示します。

252ページを参照
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リアルタイム ・ ノ イズの信号への追加 （オプシ ョ ン403）
デュアルARB波形へのリアルタイム ・ ノ イズの追加
図9-3　Real Time I/Q Baseband AWGN - Noise Muxメニューのソフ トキー

リアルタイムI/QベースバンドAWGNのEb/No調整ソフ トキー

この機能を使えば、 AWGNのC/NをEb/No （ビッ ト あた りのエネルギーをレシーバでのノ イズ ・パワー密度で割った値、 す

なわちビッ ト あた りの信号対雑音比） フォーマッ トで設定できます。 これには、 搬送波のビッ ト ・ レートがわかっている

必要があ り ます。 図9-4 「252ページEb/No搬送波ビッ ト式」 を参照して ください。

図9-4　 Eb/No搬送波ビッ ト式

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

Mode > Dual ARB > Arb Setup >
Real-Time AWGN Setup > More

相加性雑音の診断制御を可能にしま

す。 これにより、 ノ イズのみ、 搬送波

のみ、 またはノ イズと搬送波の和を、

内蔵ベースバンド ・ ジェネレータから

出力できます。 ALCがオフの場合は、

この機能により、搬送波またはノイズ

の寄与を、全パワーと独立に直接測定

できます。 自動変調減衰と RMS パ

ワー・サーチのRMSレベルの判定に関

しては、 システムはノイズと搬送波の

両方が出力に存在するかのよ うに動

作します。

図9-6 （254ページ） に、 これ

らの設定の詳細を示します。

Carrier Bit Rateソ フ

トキーは、Carrier to
Noiset ソ フ ト キー

が Eb/No に設定さ

れている場合のみ

使用できます。

C
N Bd
------------
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N0
-------⎠

⎞ dB 10 10
bitRate

carrierBandwidth
--------------------------------------------------------⎠

⎞
⎝ ⎠
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 リアルタイム ・ ノ イズの信号への追加 （オプシ ョ ン403）
デュアルARB波形へのリアルタイム ・ ノ イズの追加
図9-5　 リアルタイムI/QベースバンドAWGNのEb/No調整ソフ トキー

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

Mode > Dual ARB > Arb Setup > Real-Time AWGN Setup

搬送波対雑音比(C/N)またはビ ッ ト あ

たりのエネルギーをレシーバでのノ イ

ズ ・パワー密度で割った値(Eb/No)のい

ずれかを、 搬送波帯域幅内の搬送波パ

ワーと ノ イズ ・パワーの比を制御する

変数として選択します。Eb/Noを選択し

た場合は、 AWGN Setup メ ニューの2
ページ目に、Eb/No値を計算するための

Carrier Bit Rate ソ フ ト キーが表示され

ます。

図9-6 （254ページ） に、 これ

らの設定の詳細を示します。

C/Nを選択

Eb/Noを選択

ソフ トキーが使用できるかどうかは、

Carrier to Noise Ratio Format ソ フ ト

キーの設定 （C/NまたはEb/No） によ

り異なります。

Carrier Bit Rateソフ トキーは搬送波のビッ ト・

レー ト を設定します （デフ ォル ト の搬送波

ビッ ト ・ レートは1 bps）。

Carrier Bit Rateソフ トキーは、Carrier to Noise
Ratio Formatソフ トキーがEb/Noに設定されて

いる場合のみ使用できます。

搬送波ビッ ト ・ レートの式については、

42ページを参照して く ださい。

Carrier to Noise Ratio Formatソフ トキーをEb/Noに設定すると、

Eb/Noが表示されます。

アクテ ィ ブなソフ トキー

は、 Carrier to Noise Ratio
Formatの選択（C/Nまたは

Eb/No） によ り変化し ま

す。 以下を参照して く だ

さい。

リアルタイムAWGNをオンにするまで

グレー表示
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リアルタイム ・ ノ イズの信号への追加 （オプシ ョ ン403）
デュアルARB波形へのリアルタイム ・ ノ イズの追加
図9-6　搬送波対雑音比の成分

例

工場提供波形SINE_TEST_WFMを使って1 GHz、 –10 dBmの搬送波を変調した後、 40 MHzの搬送波帯域幅で30 dBの搬送

波対雑音比を持つ45 MHz帯域幅の信号を使ってノ イズを適用するには、 以下の手順を使用します。

1. 信号発生器をプリセッ ト し、 以下を設定します。

• 周波数 ： 1 GHz
• 振幅 ： –10 dBm
• RF出力 ： オン

2. 工場提供波形SINE_TEST_WFMを選択します。

a. Mode > Dual ARB > Select Waveformを押します。

b. SINE_TEST_WFMを強調表示し、 Select Waveformを押します。

3. デュアルARBプレーヤをオンにします。 ARB Off Onを押してOnを強調表示します。

4. ARBサンプル ・ ク ロ ッ クを50 MHzに設定します。 ARB Setup > ARB Sample Clock > 50 > MHzを押します。

5. Real-time Noise Setupを押し、 以下を設定します。

• 搬送波対雑音比 ： 30 dB
• 搬送波帯域幅 ： 40 MHz
• 雑音帯域幅 ： 45 MHz
• リ アルタイム ・ ノ イズ ： オン

信号発生器の表示パワー ・ レベル （–10 dBm） にはノ イズ ・ パワーが含まれます。

搬送波帯域幅

(CBW)

RMS （全搬送波パワー）

C

搬送波帯域幅

(CBW)

搬送波

ノイズ N

雑音帯域幅(NBW)＝
フラ ッ トなノイズ

帯域幅

搬送波は追加されたノイズ・パワー

のために大き く見えます。

搬送波帯域幅(CBW)は通常は搬送波の占有帯域幅で

あり、 雑音帯域幅はフラッ トな雑音帯域幅(NBW)です。
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 リアルタイム ・ ノ イズの信号への追加 （オプシ ョ ン403）
Real Time I/Q Baseband AWGNの使用
Real Time I/Q Baseband AWGNの使用

図9-7　Real Time I/Q Baseband AWGNのソフ トキー

10 MHz帯域幅のノ イズを500 MHz、 –10 dBmの搬送波に適用するには、 以下の手順を使用します。

1. ノ イズを設定します。

a. 信号発生器をプリセッ ト します。

b. Mode > More > Real Time I/Q Baseband AWGNを押します。

c. Bandwidth > 10 > MHzを押します。

2. ノ イズを発生します。

ARB Off Onを押してOnを強調表示します。

発生中には、 AWGNインジケータ とI/Qインジ

ケータがアクティブになり ます （右の図を参

照）。 RF搬送波の変調にAWGNを使用できる

よ うにな り ます。

3. RF出力を設定します。

• 周波数 ： 500 MHz

• 振幅 ： –10 dBm

• RF出力 ： オン

信号発生器のRF OUTPUTコネク タでAWGNを持つ搬送波を使用できるよ うになり ます。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 255
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Real Time I/Q Baseband AWGNの使用
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10 リアルタイム位相雑音信号劣化 （オプシ ョ ン432）

注記 N5162Aでは、本書に記述されているソフ ト キー・ メニューと機能は、 WebイネーブルMXGまたはSCPIコマンド

経由でのみ使用できます。WebイネーブルMXGの詳細については、『インス トール・ガイ ド』、『プログラ ミ ング ・

ガイ ド』、 『SCPI Command Reference』 を参照して ください。

こ こに記載の内容を理解するには、 信号発生器の基本動作についての知識が必要です。 パワー ・ レベル／周波数の設定な

どの機能を簡単に操作できない場合は、 第3章 「基本操作」 （41ページ） を参照して、 内容をよ く理解してください。

この機能は、 オプシ ョ ン431を搭載したN5162A/82A Agilent MXGベク トル信号発生器でのみ使用できます。 オプシ ョ ン

431には、 オプシ ョ ン651、 652、 654のいずれかが必要です。

この章には、 位相雑音信号劣化オプシ ョ ンの機能を使用するためのソフ ト キー ・ マップと、 この機能の使用方法を記載し

ます。

• 「 リ アルタイム位相雑音信号劣化」 （258ページ）

• 「Agilent MXGの位相雑音形状および相加性位相雑音信号劣化」 （259ページ）

• 「位相雑音調整について」 （261ページ）

• 「DACオーバーレンジ条件とスケーリ ング」 （262ページ）
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リアルタイム位相雑音信号劣化 （オプシ ョ ン432）
リアルタイム位相雑音信号劣化
リアルタイム位相雑音信号劣化

この機能では、 2個の周波数ポイン ト と振幅値を制御するこ とによ り、 信号発生器の位相雑音性能を低下させるこ とがで

きます。信号発生器は、Agilent MXGが通常発生する位相雑音に加えて、 この位相雑音を発生します。 この機能は、各ARB
フォーマッ ト と、 スタンドアロン ・ メニューで使用できます。 次の図では、 スタンドアロン ・ メニューとデュアル任意波

形発生器で各コン ト ロールにアクセスする方法を示していますが、各任意波形フォーマッ トでの位置と ソフ ト キーは、デュ

アル任意波形発生器の場合と同じです。

図10-1　スタンドアロンおよびデュアル任意波形発生器のリアルタイム位相雑音用ソフ トキー

フラッ トな中間周波数特性の

終了周波数。

フラッ トな中間周波数特性の

開始周波数。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください

機能をオフにした場合でも、

表示は更新されます。

これらの設定の説明については、 次を参

照して ください ：

「Agilent MXGの位相雑音形状および相加

性位相雑音信号劣化」 （259ページ）

フラ ッ ト中間周波数領域

f1と f2で指定

このソフ トキーは、 すべて

の任意波形フォーマッ トで

使用できます。

フラッ トな中間周波数特性の振幅

（Lmidとは、中間周波数特性のレベ

ル振幅を表します）。

注記 ：位相雑音信号劣化は、 信号発生器のベース位相雑音に追加されます。

スタンドアロン ・ メニュー

波形を再生せずにCW出力に位相雑音

を追加するために使用します。
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 リアルタイム位相雑音信号劣化 （オプシ ョ ン432）
Agilent MXGの位相雑音形状および相加性位相雑音信号劣化
Agilent MXGの位相雑音形状および相加性位相雑音信号劣化

フラッ トな中間周波数のオフセッ ト

–50 dBc/Hz–50 dBc/Hz

位相雑音信号劣化のない位相雑音プロッ ト

Agilent MXGは、明確な形状を持つ位相雑音プロッ ト

を示します。中間周波数のオフセッ トは、約3 kHzオ
フセッ トから約70 kHzオフセッ トまでの位相雑音振

幅のレベリング （フラ ッ ト化） によって特徴付けら

れます。

近傍と遠端のオフセッ トは、 傾斜特性を示します

（中間周波数のオフセッ トの前後の領域）。

位相雑音の劣化は、 次の設定に基づいて、 中間周波数特性を移動するか、 振幅を変化させるこ とによって実現されます。

• 中間周波数特性のスタート周波数(f1)
• 中間周波数特性のス ト ップ周波数(f2)
• 中間周波数特性の振幅(Lmid)

f1 f2

中間周波数特性

–50 dBc/Hz–50 dBc/Hz

振幅

(Lmid)

このプロッ トは、 変更前の位相雑音形状と、 それ

ぞれの値が変更する場所を示します。
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リアルタイム位相雑音信号劣化 （オプシ ョ ン432）
Agilent MXGの位相雑音形状および相加性位相雑音信号劣化
フラ ッ トな中間周波数

f1

f2

オフセッ ト特性 (Lmid)

位相雑音信号劣化を加えた位相雑音プロッ ト

–50 dBc/Hz –50 dBc/Hz

フラ ッ トな中間周波数の

オフセッ ト特性 (Lmid)

相加性
位相雑音なし

結果の位相
雑音プロッ ト

位相雑音をオンにすると、信号発生器のベース位相

雑音に追加されます。

変更されるのは中間周波数特性だけですが、これら

の変更は位相雑音形状全体に影響します。近傍と遠

端のオフセッ ト特性は、 周波数オフセッ トの1オク

ターブあたり約20 dBc/Hzの傾きで変化します。

左に示す結果の位相雑音プロッ トは、 次の設定に

よるものです。

• f1＝100 Hz
• f2＝1 kHz
• 振幅(Lmid)＝–70 dBc

–20 dBc/Hzの
傾き

f1 f2

–70 dBc

100 Hz 1 kHz

信号劣化に対して入力された周波数値は、 RF出力で観察される正確な値ではあ り ません。 入力された値は、 信号発生器

が実際の値を計算するために使用する指針とな り ます。 詳細については、 「位相雑音調整について」 （261ページ） を参照

してください。

設定 （f1、 f2、 Lmid） の結果を見るには、 フロン ト ・ パネル ・ グラフ （下と 258ページ） を使用するか、 測定機器で位相

雑音プロ ッ ト を表示します （上の図はAgilent E4440A PSA＋オプシ ョ ン226によるもの）。

–50 dBc/Hz –50 dBc/Hz

信号発生器のフロン ト ・ パネル ・ プロッ ト ：

• f1＝100 Hz
• f2＝1 kHz
• Lmid＝–70 dBc

f1の値はf2以下に設定する必要があります。 そう

でない場合、 f2の値がf1と等し く変更されます。逆

に、 f2をf1より小さい値に設定した場合、 f1の値が

f2と等し く変更されます。
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 リアルタイム位相雑音信号劣化 （オプシ ョ ン432）
位相雑音調整について
位相雑音調整について

信号発生器は、 Lmid （振幅）、 f1 （スタート周波数）、 f2 （ス ト ップ周波数） の3つの設定に基づいて、 結果の位相雑音形

状を決定します。

Lmidの範囲はf2に関連しており、 f2の値が増加する と、 Lmidの上限は減少します。 現在のLmidの設定が新しいf2の設定

に対して大きすぎる場合、 Lmidの値が変更され、 変更を通知するエラーが発生します。 また、 実際のLmidの値は入力さ

れた値から0.28 dBc/Hzずれる可能性があ り ます。

周波数設定 （f1 と f2） は、 RF OUTPUTでの実際の周波数オフセッ ト値の計算に使用される指針に過ぎません。 すなわち、

入力されたスタート周波数とス ト ップ周波数は近似値であ り、 測定機器に表示される値と正確には一致しない場合があ り

ます。

f1およびf2パラ メータの効果は、 変化する対数スケールに基づきます。 このスケールは、 f2の値によって決ま り ます。 f2
の値が大きいほどスケールも大きいので、 この動作は周波数設定が高いほど観察しやすくな り ます。 このこ とがはっき り

するのは、 f1またはf2の値を変更しても f1またはf2の位置がほとんどあるいは全く変化しない場合です。 これは、図10-2に
示すよ うに、 信号発生器のフロン ト ・ パネル位相雑音グラフで簡単に見るこ とができます。 この動作によ り、 f2周波数の

値が大き くなるほど、 周波数調整は粗くな り ます。

図10-2　 f1と f2の周波数設定の動作

f1 と f2の値の効果を正確に知るには、 フロン ト ・ パネル ・ グラフを表示するか、 測定を行う必要があ り ます。 フロン ト ・

パネル ・ グラフは、 LXIインタフェース経由でリモートでも表示できます。 LXIインタフェースの詳細については、 『プロ

グラ ミ ング ・ ガイ ド』 を参照して ください。

フロン ト ・ パネル位相雑音グラフのための

f1およびf2ソフ トキー設定

f1は、 12.1 MHzを設定するまで周波数が変化しま

せんでした。すなわち、周波数オフセッ ト を変更

するには1.6 MHzの増加が必要でした。

f2は、40 MHzを設定するまで周波数が変化しませ

んでした。すなわち、周波数オフセッ ト を変更す

るには10 MHzの増加が必要でした。

f1 ： 元の10.5 MHzの設定

f1 ： オフセッ ト位置を移動した

12.1 MHzの設定

f2 ： 元の30 MHzの設定

f2 ： オフセッ ト位置を移動した

40 MHzの設定

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい
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DACオーバーレンジ条件とスケーリング

位相雑音信号劣化を使用する と、 DACオーバーレンジ条件が生じ、 Agilent MXGがエラーを発生する場合があ り ます。 位

相雑音信号劣化機能を使用していると きにこの条件が発生する機会を減らすために、Agilent MXGには、I/Qデータをスケー

ル ・ ダウンする自動DACオーバーレンジ保護機能が装備されています。 これによ り、 実際の必要よ り も大き くデータがス

ケーリ ングされる可能性があるため、 通常は波形のダイナミ ッ ク ・ レンジが低下します。 これは特に、 GSMなどの振幅が

一定の信号を使用する場合に顕著になり ます。

デュアル任意波形発生器を使用する場合は、自動オーバーレンジ保護をオフにできます （工場設定はオン）。デュアルARB
DACオーバーレンジ保護機能のコン ト ロールは、 図10-3に示すキー ・ パスにあ り ます。

図10-3　デュアルARB DACオーバーレンジ保護ソフ トキーの位置

デュアル任意波形発生器では、過大なスケーリ ングを避けるため、または単に手動でスケーリ ングを行うために、オーバー

レンジ保護をオフにし、Waveform Runtime Scalingソフト キーを使用してDACオーバーレンジ条件をな くすこと ができます。

自動機能をオフにした場合は、 DACオーバーレンジ条件をなくす他の方法と して、 条件が修正されるまでf2、 Lmidまたは

その両方の値を減らす方法があ り ます。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください

DACオーバーレンジ保護をオフにした場合は、 スケー

リング値を小さ く してオーバーレンジ条件をな く しま

す （「波形ランタイム ・ スケーリングを設定する」 （191
ページ） を参照）。

デフォルト設定はオンです。

オフにした場合は、位相雑音信号劣化オプシ ョ ンを

使用する際にスケーリングを手動で制御します。ス

ケー リ ング を手動で調整するには、 上に示す

Waveform Runtime Scaling ソ フ ト キーを使用し

ます。
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11 カスタム ・ デジタル変調 （オプシ ョ ン431）

注記 N5162Aでは、本書に記述されているソフ ト キー・ メニューと機能は、 WebイネーブルMXGまたはSCPIコマンド

経由でのみ使用できます。WebイネーブルMXGの詳細については、『インス トール・ガイ ド』、『プログラ ミ ング ・

ガイ ド』、 『SCPI Command Reference』 を参照して ください。

こ こに記載の内容を理解するには、 信号発生器の基本動作についての知識が必要です。 パワー ・ レベル／周波数の設定な

どの機能を簡単に操作できない場合は、 第3章 「基本操作」 （41ページ） を参照して、 内容をよ く理解してください。

この機能は、 オプシ ョ ン431を搭載したN5162A/82A Agilent MXGベク トル信号発生器でのみ使用できます。 オプシ ョ ン

431には、 オプシ ョ ン651、 652、 654のいずれかが必要です。

• 「カスタム変調」 （264ページ）

• 「任意波形発生器の使用」 （269ページ）

• 「ARBカスタム変調での有限インパルス応答(FIR)フ ィルタの使用」 （279ページ）

• 「FIRテーブル ・ エディ タによるFIRフ ィルタの変更」 （284ページ）

• 「差動エンコード」 （287ページ）
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カスタム変調
カスタム変調

カスタム変調には、 TETRAやDECTなどの内蔵の変調規格と、 BPSKや16QAMなどの定義済みの変調方式があ り、 信号の

作成に使用できます。 また、 デジタル ・ フォーマッ トの属性を柔軟に変更するためにも使用できます。

ARBカスタム変調波形発生器

信号発生器のARB波形発生器モードは、 チャネル外テス ト ・ アプ リ ケーシ ョ ン用に設計されています。 このモードでは、

ランダムな通信ト ラフ ィ ッ クをシ ミ ュレートするデータ ・ フォーマッ ト を発生して、 コンポーネン ト ・ テス ト用の入力信

号に使用できます。 ARB波形発生器モードには他に以下のよ うな機能があ り ます。

• シングル／マルチキャ リ ア信号の構成。 最大100個のキャ リ アを構成できます。

• 信号発生器のフロン ト ・ パネル ・ インタフェースからの波形ファ イルの作成。

波形ファ イルをランダム ・ データ と して作成し、 コンポーネン ト ・ テス トの入力信号に使用して、 隣接チャネル漏洩電力

(ACP)などのデバイス性能を測定できます。 ARB波形発生器をオンにする と、 AUTOGEN_WAVEFORMとい う ファ イルが自動

的に作成されます。 このファイルは、 名前を変更して信号発生器の不揮発性メモリに保存できます。 このファイルは、 後

で揮発性メモ リにロード して、 デュアルARB波形プレーヤから再生できます。

詳細については、 「波形ファイルの基本」 （140ページ） と 「動作モード」 （4ページ） を参照して ください。
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カスタム変調
図11-1　  ARB Custom Modulationソフ トキー

266ページ

194ページ

140ページ

276ページ

このソフ トキーは、 選択した

変調モードに応じて変化します。

MulticarrierがOnの場合のみ

使用可能。

MulticarrierがOffの場合のみ

使用可能。

276ページ

現在のARB カスタム変調設定を

オンにします。

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。

172ページ

141ページ

297ページ

302ページ
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図11-2　  Quick Setupソフ トキー

267ページ

279ページ

275ページ

Mode > ARB Custom Modulation > Single Carrier Setup

268ページ

このソフ トキー ・ ラベルには、

現在選択されている変調規格

が表示されます。

Symbol Rateソフ トキーを押し、

必要に応じてテンキーで値を

変更します。

Symbol Rateの最大範囲のデ

フォルト値 （初期値） は、Quick
Setupソフ トキーで選択した変

調規格に応じて異なります。

これらの定義済みの変調規格のどれかを選択

した場合は、 セッ ト ア ップのコンポーネン ト

（フ ィルタ、 シンボル・ レート、変調方式など）

のデフォルト値が自動的に指定されます。

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。

Default ： このソフ トキーは、 以下の

デフォルト設定を選択します。

Modulation Type＝QPSK

Symbol Rate＝1 Msps

Filter＝Root Nyquist

Filter Alpha＝0.5
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カスタム変調
図11-3　Mode Typeソフ トキー

279ページ

266ページ

268ページ

Mode > ARB Custom Modulation > Single 
Carrier Setup

271ページ

ASK(Amplitude Shift Keying)の
変調度を設定します。

対称FSK(Frequency Shift Keying)の
周波数偏移値を設定します。

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。

271ページ

271ページ
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図11-4　Store Custom Dig Mod Stateソフ トキー

以前に保存したデジ タル変調(DMOD)
ファイルがカタログに表示されます。

274ページ

Mode > ARB Custom Modulation > Single Carrier Setup > Store Custom Dig Mod State

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。
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任意波形発生器の使用

このセクシ ョ ンでは、 コンポーネン ト ・ デザインをテス トするためのカスタムTDMAデジタル変調を含む、 デュアル任意

波形(ARB)ファイルを作成する方法を説明します。

図11-5　波形へのカスタム変調の追加

定義済みのカスタムTDMAデジタル変調の使用

このセクシ ョ ンでは、 以下の作業の実行方法を説明します。

• 「定義済みのEDGEセッ ト アップの選択」 （269ページ）

• 「波形の発生」 （269ページ）

• 「RF出力の設定」 （270ページ）

定義済みのEDGEセッ トアップの選択

1. Presetを押します。

2. ARB Custom Modulationメニュー （269ページ） で、 Single Carrier Setup > Quick Setup > EDGEを押します。

波形の発生

Digital Modulation Off Onを押します。

これによ り、 ステ ップで選択された定義済みのEDGE ステー ト を持つ波形が発生し ます。 デ ィ スプレ イがDig Mod
Setup:EDGEに変わり ます。波形発生中には、DIGMODおよびI/Qインジケータが表示され、定義済みのデジタル変調ステー

トが揮発性メモ リ (BBG)に記憶されます。 波形はRF搬送波を変調しています。

279ページ

268ページ

このソフ トキー ・ ラベルは、 現在の

変調方式を反映して更新されます。

Mode > ARB Custom Modulation > Single Carrier Setup

267ページ

275ページ

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。
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RF出力の設定

1. RF出力周波数を891 MHzに設定します。

2. 出力振幅を–5 dBmに設定します。

3. RF On/Offを押します。

定義済みのEDGE信号が信号発生器のRF OUTPUTコネク タで使用可能になり ます。
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カスタムTDMAデジタル変調ステートの作成

この手順では、 カスタマイズした変調方式、 シンボル ・ レート、 フ ィルタ リ ングによるシングル ・ キャ リ アNADCデジタ

ル変調をセッ ト アップする方法を説明します。

図11-6　デジタル変調フ ィルタの設定

このソフ トキー ・ ラベルは、 現在の

変調規格を反映して更新されます。

Mode > ARB Custom Modulation > Single Carrier Setup

275ページ

このソフ トキーは、

フ ィ ルタの帯域幅

パラ メータ （α） を

設定します。デフォ

ルトのα値は、 選択

した変調規格 （279
ページを参照）と変

調方式 （267ページ

を参照）に応じて異

なります。

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。

このソフ トキーは、

フ ィ ルタの形状を

設定します。

272ページ

ユーザ定義I/Qコンスタレーシ ョ ン

またはユーザ定義FSK周波数マ ッ

ピングをテーブルに挿入し、 現在

の変調方式に適用できる メニュー

を開きます。 また、 I/Q と FSKのど

ちらに対しても、 差動ステー ト ・

マッピングを指定できます。

IS-95フ ィルタを選択する

メニューを開きます。
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図11-7　デジタル変調方式の変更

このセクシ ョ ンでは、 以下の作業の実行方法を説明します。

• 「デジタル変調セッ ト アップの選択」 （272ページ）

• 「RF出力の設定」 （270ページ）

• 「フ ィルタの選択」 （273ページ）

• 「RF出力の設定」 （273ページ）

デジタル変調セッ トアップの選択

1. Presetを押します。

2. ARB Custom Modulationメニュー （271ページ） で、 Single Carrier Setup > Quick Setup > NADCを押します。

変調方式とシンボル ・ レートの変更

1. ARB Custom Modulation メニュー （271ページ） で、 Single Carrier Setup > Modulation Type > Select > PSK > QPSK and
OQPSK > QPSKを押します。

2. Return > Symbol Rate > 56 > kspsを押します。

注記：これはPSKメ

ニ ューの2ページ

目です。

注記 ： これはQPSK
メニューの2ページ

目です。

Mode > ARB Custom Modulation > Single Carrier Setup >
Modulation Type > Select

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。

これらのソフ トキー

は、既存のユーザI/Q
またはユーザ FSK
フ ァ イルを選択し、

現在の変調方式に適

用 す る た め の メ

ニューを開きます。
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フ ィルタの選択

1. Setup Modメニュー （271ページ） で、 Filter > Select > Nyquistを押します。

2. Return > Returnを押します。

波形の発生

Digital Modulation Off Onを押します。

これによ り、 前のセクシ ョ ンで作成したカスタム ・ シングル ・ キャ リ アNADCデジタル変調ステート を持つ波形が発生し

ます。 ディ スプレイがDig Mod Setup:NADC (Modified)に変わり ます。 波形発生中は、 DIGMODおよびI/Qインジケータ

が表示され、 カスタム ・ シングル ・ キャ リ ア ・デジタル変調ステートが揮発性メモ リに記憶されます。 波形はRF搬送波を

変調しています。

このカスタム ・ シングル ・ キャ リ アNADCデジタル変調ステート を不揮発性メモ リに保存する方法については、 「カスタム

TDMAデジタル変調ステートの保存」 （273ページ） を参照して ください。

RF出力の設定

1. RF出力周波数を835 MHzに設定します。

2. 出力振幅を0 dBmに設定します。

3. RF On/Offを押します。

ユーザ定義NADC信号がRF OUTPUTコネク タで使用可能になり ます。

カスタムTDMAデジタル変調ステートの保存

この手順では、 カスタム ・ デジタル変調ステート とカスタム ・ マルチキャ リ ア ・ デジタル変調ステート を不揮発性メモ リ

に保存する方法を説明します。

カスタム ・ シングル ・ キャ リ ア ・デジタル変調ステート をまだ作成していない場合は、 前のセクシ ョ ン （「カスタムTDMA
デジタル変調ステートの作成」 （271ページ）） の手順を実行しておいてください。
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図11-8　 カスタム ・ デジタル変調ステートの保存

1. ト ップレベルのARB Custom Modulation メニューに戻り ます。 このメニューの最初のソフ ト キーはDigital Modulation
Off Onです。

2. ARB Custom Modulationメニュー （274ページ） で、 Single Carrier Setup > Store Custom Dig Mod State > Store To Fileを押

します。

アクティブ入力エリ アにCatalog of DMOD Files内のファ イル名がすでに入力されている場合は、 以下のキーを押

します ： Clear Text

3. アルファベッ ト ・ キーとテンキーを使用して、 23文字以内のファイル名 （例 ： NADCQPSK） を入力します。

4. Enterを押します。

ユーザ定義のシングル ・ キャ リ ア ・ デジタル変調ステートが不揮発性メモリに保存されます。

注記 RF出力の振幅、周波数、動作ステート設定は、ユーザ定義デジタル変調ステート ・ファ イルには保存されません。

ユーザが以前に保存したDMODファイ

ルがカタログに表示されます。

Mode > ARB Custom Modulation > Single 
Carrier Setup

43ページ

これらのキーは、 内部記憶装置上の

DMOD フ ァ イルのテーブルを管理し

ます。

各キーの詳細については、キーのヘルプを使用して ください（42ページを参照）。
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カスタムTDMAデジタル変調ステートのリコール

この手順では、 カスタム ・ デジタル変調ステート を不揮発性メモ リから リ コールする方法を説明します。

ユーザ定義シングル・ キャ リ ア ・デジタル変調ステート をまだ作成して保存していない場合は、前のセクシ ョ ン （「カスタ

ムTDMAデジタル変調ステートの作成」 （271ページ） と 「カスタムTDMAデジタル変調ステートの保存」 （273ページ）） の

手順を実行した後、 信号発生器をプリセッ ト して、 揮発性ARBメモ リに記憶されているユーザ定義デジタル変調波形をク

リ アします。

図11-9　 カスタムTDMAデジタル変調ステートのリコール

1. Quick Setupメニューで、 Custom Digital Mod Stateを押します。

2. 目的のファイル （例 ： NADCQPSK） を強調表示します。

3. Select File > Returnを押します。

4. Digital Modulation Off Onを押してOnを強調表示します。

カスタム ・デジタル変調波形が揮発性メモリに再作成されます。 波形作成が終わる と、 カスタム ・デジタル変調波形をRF
出力に変調できるよ うにな り ます。

RF出力の設定方法については、 「RF出力の設定」 （270ページ） を参照して ください。

Mode > ARB Custom Modulation > Single Carrier Setup > 
Quick Setup

強調表示されているファイルを

測定器メモリにロード します。

これらのキーは、内部記憶装置上の

DMOD フ ァ イルのテーブルを管理

します。

各キーの詳細については、 キーのヘルプを

使用して く ださい （42ページを参照）。
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カスタム ・ マルチキャリアTDMAデジタル変調ステートの作成

この手順では、 カスタム3キャ リ アEDGEデジタル変調ステート を作成するこ とによ り、定義済みのマルチキャ リ ア ・デジ

タル変調セッ ト アップをカスタマイズする方法を説明します。

このセクシ ョ ンでは、 以下の実行方法を説明します。

• 「マルチキャ リ ア ・ デジタル変調セッ ト アップの作成」 （277ページ）

• 「搬送波周波数オフセッ トの変更」 （277ページ）

• 「搬送波パワーの変更」 （277ページ）

• 「波形の発生」 （277ページ）

• 「RF出力の設定」 （277ページ）

図11-10　マルチキャリア ・ デジタル変調セッ トアップの作成

Mode > ARB Custom Modulation

Multicarrier Setupテーブルの値または

マルチキャリア・ メニューの値（Carrier
Setup、# of Carriers、Freq Spacing、Carrier
Phases） が変更されたときにアクテ ィ

ブになります。

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。
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マルチキャリア ・ デジタル変調セッ トアップの作成

1. Presetを押します。

2. Mode > ARB Custom Modulation > Multicarrier Off On to Onを押します。

3. Multicarrier Setup > Select Carrier and Initialize Table > Carrier Setup > EDGE > Doneを押します。

搬送波周波数オフセッ トの変更

1. 行2の搬送波のFreq Offsetの値(500.000 kHz)を強調表示します。

2. –625 > kHzを押します。

搬送波パワーの変更

1. 行2の搬送波のPowerの値(0.00 dB)を強調表示します。

2. –10 > dBを押します。

これで、 以下の図に示すよ うに、 搬送波の周波数オフセッ トが–625 kHzでパワー ・ レベルが–10.0 dBmのカスタム2
キャ リ アEDGE波形ができました。

波形の発生

Return > Digital Modulation Off Onを押します。

これによ り、 前のセクシ ョ ンで作成したカスタム ・ マルチキャ リ アEDGEステート を持つ波形が発生します。 ディ スプレ

イがDig Mod Setup:Multicarrier (Modified)に変わり ます。 波形発生中には、 DIGMODおよびI/Qインジケータが表

示され、 新しいカスタム ・ マルチキャ リ アEDGEステートが揮発性メモ リに記憶されます。 波形はRF搬送波を変調してい

ます。

このカスタム ・ マルチキャ リ アEDGEステート を不揮発性メモ リに保存する方法については、 「カスタム ・ マルチキャ リ ア

TDMAデジタル変調ステートの保存」 （278ページ） を参照して ください。

RF出力の設定

1. RF出力周波数を890.01 MHzに設定します。

2. 出力振幅を–10 dBmに設定します。

3. RF On/Offを押します。

カスタム ・ マルチキャ リ アEDGE信号がRF OUTPUTコネク タで使用可能になり ます。

Digital Modulationがすでにオンになってい

る場合は、 変更を適用して、 更新された値

に基づ く新しいカスタム・マルチキャリア・

デジ タル変調波形を発生するには、 Apply
Multicarrierを押す必要があります。

各キーの詳細については、キーのヘルプ

を使用して ください（42ページを参照）。
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カスタム ・ マルチキャリアTDMAデジタル変調ステートの保存

この手順では、 カスタム ・ マルチキャ リ アTDMAデジタル変調ステート を不揮発性メモリに保存する方法を説明します。

カスタム ・ マルチキャ リ ア ・ デジタル変調ステート をまだ作成していない場合は、 前のセクシ ョ ン （ 「カスタム ・ マルチ

キャ リ アTDMAデジタル変調ステートの作成」 （276ページ）） の手順を実行しておいてください。

図11-11　  カスタム ・ マルチキャリアの保存ソフ トキー

1. ト ップレベルのDigital Modulationメ ニューに戻り ます。このメ ニューの最初のソフ トキーはDigital Modulation Off Onです。

2. Multicarrier Setup > More > Load/ Store > Store To Fileを押します。

アクティブ入力エリアにCatalog of MDMOD Files内のファ イル名がすでに入力されている場合は、以下のキーを押

します ： Clear Text

3. アルファベッ ト ・ キーとテンキーを使用して、 23文字以内のファイル名 （例 ： EDGEM1） を入力します。

4. Enterを押します。

ユーザ定義のマルチキャ リ ア ・ デジタル変調ステートが不揮発性メモリに保存されます。

注記 RF出力の振幅、周波数、動作ステート設定は、ユーザ定義デジタル変調ステート ・ファ イルには保存されません。

アクテ ィブ ・ マルチキャリアTDMAデジタル変調ステートへの変更の適用

デジタル変調方式が使用されている （Digital Modulation Off OnがOnに設定されている） 状態で、Multicarrier Setupテー

ブル ・ エディ タに変更を加えた場合は、 更新された波形を発生するためには変更を適用する必要があ り ます。

Multicarrier Setupテーブル・エディ タで、 Apply Multicarrierを押して、変更を適用し、更新された値に基づく新しいカ

スタム ・ マルチキャ リ ア ・ デジタル変調波形を発生します。

43ページ

Fixed ： すべての搬送波が0位相に設定さ

れます。

Random ： すべての搬送波がランダムな

位相値に設定されます。

各キーの詳細については、 キーのヘルプを

使用して く ださい （42ページを参照）。
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ARBカスタム変調での有限インパルス応答(FIR)フ ィルタの使用

有限インパルス応答フ ィルタは、 発生された波形のシンボル ・ デシジ ョ ン ・ ポイン ト間の遷移を微調整するために使用で

きます。

図11-12　 Filterメニュー

FIRテーブル ・ エディ タによるユーザ定義FIRフ ィルタの作成

この手順では、 FIR Valuesテーブル・エディ タを使用して、オーバーサンプリ ング比が4の8シンボル・ ウ ィンド ウsinc関
数フ ィルタを作成します。

テーブル ・ エディ タへのアクセス

1. Presetを押します。

2. Mode > ARB Custom Modulation > Single Carrier Setup > Select > Nyquistを押します。

3. Filter > Define User FIRを押します。

4. More 1 of 2 > Delete All Rows > Confirm Delete of All Rowsを押します。

これによ り、 テーブル ・ エディ タが図11-13のよ うに初期化されます。

Mode > ARB Custom Modulation > Single Carrier Setup > Filter

これは、現在のFIR
フ ィルタを、 現在

の変調方式に対す

る工場インス トー

ル済みのデフォル

ト ・ フ ィルタ設定

に置き換えます。

このソフ トキーは、 選択した

フ ィルタ ・ タイプに応じて変化します。

選択されているフ ィルタが以下の場合のみ使用可能 ：

Root NyquistまたはNyquist

選択されているフ ィルタが以下

の場合のみ使用可能 ： Gaussian

284ページDual ARB Modulationにの

み適用されます。 139ペー

ジを参照して ください。

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。

IS95フ ィルタ選択メ

ニューを開きます。
Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド 279



カスタム ・ デジタル変調 （オプシ ョ ン431）
ARBカスタム変調での有限インパルス応答(FIR)フ ィルタの使用
図11-13　 FIR Filterテーブル ・ エディ タによるユーザ定義FIRフ ィルタの作成

係数値の入力

1. Returnソフ ト キーを押して、 テーブル ・ エディ タの1ページ目に移動します。

2. カーソルを使って、 係数0のValueフ ィールドを強調表示します。

3. テンキーを使って、 表11-1の最初の値 （–0.000076） を入力します。 数字キーを押すと、 アクティブ入力エリ アに数字

が表示されます （間違えた場合はバッ クスペース ・ キーで修正できます）。

4. 同じ手順を繰り返して、 ステップ1のテーブルの係数値16個をすべて入力します。

表11-1　

係数 値 係数 値

0 −0.000076 8 −0.035667

1 −0.001747 9 −0.116753

2 −0.005144 10 −0.157348

Mode > ARB Custom Modulation> Single Carrier Setup > Filter > Define 
User FIR > More 1 of 2 > Delete All Rows > Confirm Delete of All Rows

保存されている フ ァ イルを

選択 し て揮発性 メ モ リ に

ロー ドするためのメ ニュー

を開きます。 43ページを参照

して ください。

208ページ

以下の場合のみアクテ ィブ ：

FIRフ ィルタ係数テーブルに2
個以上の値が表示されている

場合。

各キーの詳細については、キーのヘルプを使用して ください （42ページを参照）。

注記 ：

変調フ ィルタは通常実数であり、 オーバーサンプリング比(OSR)が2以上です。

イコライゼーシ ョ ン ・ フ ィルタは通常複素数であり、 オーバーサンプリング比(OSR)が1です （デュアルARBのみ）。
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3 −0.004424 11 −0.088484

4 0.007745 12 0.123414

5 0.029610 13 0.442748

6 0.043940 14 0.767329

7 0.025852 15 0.972149

表11-1　

係数 値 係数 値
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ミ ラー ・ テーブルによる最初の16個の係数の複製

sinc関数のウ ィンド ウ ・ フ ィルタでは、 後半分の係数は前半分の係数の逆順に一致します。 信号発生器には、 既存の係数

値を自動的に逆順で複製する ミ ラー ・ テーブル機能があ り ます。

1. Mirror Tableを押します。 図11-14 （282ページ） に示すよ うに、 最後の16個の係数 （16～31） が自動的に作成され、 そ

の最初のもの （16番目） が強調表示されます。

図11-14　

オーバーサンプリング比の設定

注記 変調フ ィルタは実数で、 オーバーサンプリ ング比(OSR)が2以上でなければなり ません。

オーバサンプリ ング比(OSR)とは、 フ ィルタの係数の個数をシンボル数で割った値です。 使用可能な値の範囲は1～32で、

テーブル ・ エディ タで使用できるシンボル数とオーバーサンプリ ング比の組み合わせの最大値は1024です。 ただし、 測定

器ハード ウェアの実際の制限は、 シンボル32個、 オーバーサンプリ ング比4～16、 係数512個です。 したがって、 32個よ り

多くのシンボルや512個よ り多くの係数を入力した場合は、 測定器はフ ィルタを使用できません。 オーバーサンプリ ング

比が内部で選択された最適な値と異なる場合は、 フ ィルタは自動的に最適なオーバーサンプリ ング比に再サンプリ ングさ

れます。

この例では、 必要なOSRは4で、 デフォルト値と一致するため、 操作は不要です。

フ ィルタのグラフ ィ カル表現の表示

信号発生器には、 フ ィルタを時間と周波数の両方の次元でグラフ ィカルに表示する機能があ り ます。

1. More 1 of 2 > Display FFT （高速フーリエ変換） を押します。

図11-15 （283ページ） を参照して ください。

FIRテーブルの係数値は、工場

デフ ォル ト 値から得る こ と

も、 ユーザが入力することも

できます。

Goto Rowメニューを使えば、

FIR Values係数テーブル内を

移動して変更を加えるこ と

ができます。各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。
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図11-15　

2. Returnを押します。

3. Display Impulse Responseを押します。

図11-16を参照してください。

図11-16　

4.  Returnを押して、 メニュー ・ キーに戻り ます。

フ ィルタのメモリへの保存

 ファイルを保存するには、 以下の手順を使用します。

1. Load/Store > Store To Fileを押します。 FIRファイルのカタログが、 使用可能メモリ容量と と もに表示されます。

2. 「波形セグメン トの保存、 ロード、 再生」 （142ページ） で説明した手順で、 このファ イルをFIR_1という名前で保存し

ます。

FIR_1ファイルが最初のファ イル名と して リ ス ト されます （他のFIRフ ィルタを保存してある場合は、その他のファ イル名

はFIR_1の下に表示されます）。 ファ イル ・ タイプはFIRで、 ファ イルのサイズは260バイ トです。使用中のメモ リ容量も表

示されます。保存可能なファ イルの数は、 ファ イルのサイズと、使用中のメモ リ容量に依存します。図11-17を参照してく

ださい。

各キーの詳細については、キーのヘルプ

を使用して ください（42ページを参照）。

各キーの詳細については、キーのヘルプ

を使用して ください （42ページを参照）。
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図11-17　

機器ステート ・ ファ イルと リ ス ト掃引ファイルも同じ メモ リ を使用します。

このフ ィルタは、 変調方式をカスタマイズするために使用したり、 新しいフ ィルタ ・ デザインの基礎と して使用した りで

きます。

FIRテーブル ・ エディ タによるFIRフ ィルタの変更

信号発生器のメモ リに保存されているFIRフ ィルタは、 FIRテーブル・エディ タを使用して簡単に変更できます。 不揮発性

メモ リに保存されているユーザ定義FIRファ イルまたはデフォルトのFIRフ ィルタから、 FIRテーブル ・ エディ タに係数値

をロードできます。 その後、 値を変更して新しいファ イルを保存できます。

ユーザが以前に保存したFIRフ ァイルが

カタログに表示されます。

これらのキーは、 内部記憶装置上の

DMODファイルのテーブルを管理し

ます。

各キーの詳細については、キーのヘルプを使用して く ださい（42ページを参照）。
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デフォルトのガウシアンFIRファイルのロード

図11-18　デフォルトのガウシアンFIRファイルのロード

1. Presetを押します。

2. Mode > ARB Custom Modulation > Single Carrier Setup > Quick Setup > NADCを押します。

3. Filter > Define User FIR > More 1 of 2 > Load Default FIR > Gaussianを押します。

4. Filter BbT > 0.300 > Enterを押します。

Mode > ARB Custom Modulation > Single Carrier 
Setup

こ れ ら の ソ フ ト キ ーは、

フ ィルタのウ ィ ン ドウ関数

（アポデ ィゼーシ ョ ン関数）

を選択します。

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。
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5. Filter Symbols > 8 > Enterを押します。

6. Generateを押します。

注記 変調中の実際のオーバーサンプリ ング比は、測定器が自動的に選択します。 シンボル・ レート、変調方式のシン

ボルあたりのビッ ト数、 シンボル数に応じて、 4～16の範囲の値が選択されます。

7. Display Impulse Responseを押します （図11-19を参照）。

図11-19　

8. Returnを押します。

係数の変更

1. フロン ト ・ パネルの矢印キーを使用して、 係数15を強調表示します。

2. 0 > Enterを押します。

3. Display Impulse Responseを押します。

図11-20　

各キーの詳細については、キーのヘルプを

使用して く ださい （42ページを参照）。

各キーの詳細については、キーのヘルプ

を使用して ください （42ページを参照）。
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図11-20 （286ページ） を参照してく ださい。 グラフィ ッ ク表示は、 有効なト ラブルシューティ ング・ ツールになる場合

があ り ます（この例では、係数値が1つ欠落しているため、正し くないガウシアン応答が生じているこ とがわかり ます）。

4. Returnを押します。

5. 係数15を強調表示します。

6. 1 > Enterを押します。

フ ィルタのメモリへの保存

ファイル名の最大の長さは23文字です （英数字と特殊文字）。

1. Load/Store > Store To Fileを押します。

2. ファイル名をNEWFIR2と します。

3. Enterを押します。

現在のFIRテーブル・エディ タの内容が不揮発性メモリ上のファ イルに保存され、 FIRファイルのカタログが更新されて新

しいファイルが表示されます。

差動エンコード

差動エンコード とは、 デジタル ・ エンコード方式の1つであ り、 特定の信号ステートでなく信号の変化によ り 2進値を表現

するものです。 差動エンコードでは、 ユーザ定義のI/QまたはFSK変調のバイナリ ・データが、 変調プロセス中に、 差動ス

テート ・ マップで定義されたシンボル ・ テーブル ・ オフセッ トによ りエンコード されます。

例えば、信号発生器のデフォルトの4QAM I/Q変調を考えます。デフォルトの4QAMテンプレートに基づくユーザ定義変調

の場合は、 I/Q Valuesテーブル ・エディ タには、 2つの異なる値1.000000と–1.000000を使用してI/Q平面上にマッピング

された4つのシンボル （00、 01、 10、 11） を表すデータが含まれます。 以下の図は、 4QAM変調を表すI/Q Valuesテーブ

ル ・ エディ タです。
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以下の図は、 4QAM変調のI/Qステート ・ マップを示します。

差動エンコードでは、 シンボル ・ テーブルのステート間の相対オフセッ ト を使用して、 ユーザ定義の変調方式をエンコー

ド します。 Differential State Mapテーブル ・ エディ タを使ってシンボル ・ テーブル ・ オフセッ ト値を入力し、 それに

関連するデータ値に基づいてI/Qステート ・マップを通じた遷移が行われます。データ値が変調されている と きは、差動ス

テート ・マップに記録されたオフセッ ト値を使用して、 シンボル・ テーブル・オフセッ ト値で定義された方向と距離でI/Q
ステート ・ マップ上の遷移を行う こ とによ り、 データがエンコード されます。

値＋1を入力する と、 以下の図に示すよ うに、 I/Qステート ・ マップ上で1ステートの順方向遷移が起こ り ます。

注記 以下のI/Qステート ・ マップの図は、 特定のシンボル ・ テーブル ・ オフセッ ト値で起こ り う るすべてのステート

遷移を示します。 実際のステート間遷移は、 変調開始時のステートによ り異な り ます。

例と して、 以下のデータ／シンボル ・ テーブル ・ オフセッ ト値を考えます。

表11-2　

データ オフセッ ト値

00000000 ＋1

00000001 –1

第 1 シンボル

異なる値：+1, +1
データ＝ 00000000

第 2 シンボル

異なる値：–1, +1
データ＝ 00000001

第 4 シンボル

異なる値：+1, –1
データ＝ 00000011

第 3 シンボル

異なる値：–1, –1
データ＝ 00000010

12

3 4
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注記 シンボルあたりのビッ ト数は、 以下の式で表されます。 この式はシーリ ング関数なので、 xの値に小数部がある

場合は、 xは1つ上の整数に切り上げられます。

こ こでx＝シンボルあたりのビッ ト数、 y＝差動ステートの数です。

00000010 ＋2

00000011 0

表11-2　

データ オフセッ ト値
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これらのシンボル ・ テーブル ・ オフセッ トからは、 次に示すいずれかの遷移が起こ り ます。

ユーザ定義のデフォルト 4QAM I/Qマップに対して適用した、 第1シンボル （データ00） から始まる、 データ ・ ス ト リーム

（2ビッ ト ・ シンボルで） 0011100001に対する差動エンコード遷移を以下の図に示します。

データ値 00000001

1 ステート逆方向遷移
シンボル・テーブル・オフセッ ト –1

データ値 00000010

2 ステート順方向遷移
シンボル・テーブル・オフセッ ト＋ 2

データ値 00000011

遷移なし
シンボル・テーブル・オフセッ ト 0

データ値 00000000

1 ステート順方向遷移
シンボル・テーブル・オフセッ ト＋ 1
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前の図からわかるよ うに、第1シンボルと第4シンボルは、同じデータ値(00)を持つので、同じステート遷移 （1ステート順

方向） を起こします。差動エンコードでは、 シンボルの値は位置を定義するのではなく、 I/Qステート ・ マップ上の遷移の

方向と距離を定義します。

差動エンコードの使用

信号発生器のDifferential State Mapテーブル ・ エディ タを使用する と、 ユーザ定義I/Qおよびユーザ定義FSK変調に

対応する差動ステート ・マップを変更できます。 この手順では、 ユーザ定義I/Q変調を作成した後、 ユーザ定義変調に対す

る差動エンコードを設定し、 アクティブにして、 適用します。 詳細については、 「差動エンコード」 （287ページ） を参照

してください。

ユーザ定義I/Q変調の設定

1. Presetを押します。

2. フォーマッ ト ・ タイプに応じて以下のキー ・ シーケンスを実行します。

カスタム ・ フォーマッ トの場合

Mode > ARB Custom Modulation > Single Carrier Setup > Modulation Type > Define User I/Q >

More 1 of 2 > Load Default I/Q Map > QAM > 4QAMを押します。

データ値 シンボル・テーブル・オフセッ ト
00
01
10
11

+1
–1
+2
+0

データ＝ 0011100001

{{

{ {

{

第 5 シンボル第 1 シンボル
第 3 シンボル

第 4 シンボル第 2 シンボル

第 1 

第 2

第 3
第 5 第 4
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差動エンコード
TMDAフォーマッ トの場合

Mode > ARB Custom Modulation > Single Carrier Setup > Quick Setup （目的のフォーマッ ト ） >
Modulation Type > Define User I/Q > More 1 of 2 > Load Default I/Q Map > QAM > 4QAMを押します。

これによ り、 デフォルトの4QAM I/Q変調がロード され、 I/Qテーブル ・ エディ タに表示されます。

デフォルトの4QAM I/Q変調には、 2つの異なる値 （1.000000と –1.000000） を使用してI/Q平面上にマッピングされた4つ
のシンボル （00、 01、 10、 11） を表すデータが含まれます。 変調プロセスにおいては、 データの各シンボルに対応するシ

ンボル・テーブル・オフセッ ト値に基づいて、これら4つのシンボルの間の移動が起こ り ます。図11-21を参照して ください。

図11-21　

Differential State Mapテーブル ・ エディ タへのアクセス

Configure Differential Encodingを押します。

これによ り、 Differential State Mapテーブル ・ エディ タが図のよ うに開きます。 この時点で、 第1シンボルのデータ

(00000000)が表示され、 カーソルはオフセッ ト値の入力を受け付ける状態になり ます。 これから、 ユーザ定義デフォルト

4QAM I/Q変調のカスタム差動エンコードを作成できます。 図11-22 （292ページ） を参照してください。

図11-22　

データ シンボル・テーブル・オフセッ ト値入力エリア
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 カスタム ・ デジタル変調 （オプシ ョ ン431）
差動エンコード
差動ステート ・ マップの編集

1. 1 > Enterを押します。

これによ り、 シンボル ・ テーブル・オフセッ ト 1が追加されて、第1シンボルがエンコード されます。データ値0が変調

される場合は、 シンボルはステート ・ マップ上で値1だけ順方向に回転します。

2. ＋/– > 1 > Enterを押します。

これによ り、 シンボル ・ テーブル ・ オフセッ ト –1が追加されて、 第2シンボルがエンコード されます。 データ値1が変

調される場合は、 シンボルはステート ・ マップ上で値1だけ逆方向に回転します。

注記 この時点で、 変調のビッ ト数はシンボルあたり 1ビッ トです。 最初の2つのデータ値 （00000000と00000001） に

関しては、 最後のビッ ト （0と1） だけが意味があ り ます。

3. 2 > Enterを押します。

これによ り、 シンボル ・ テーブル ・ オフセッ ト 2が追加されて、 第3シンボルがエンコード されます。 データ値10が変

調される場合は、 シンボルはステート ・ マップ上で値2だけ順方向に回転します。

4. 0 > Enterを押します。

これによ り、 シンボル ・ テーブル ・ オフセッ ト 0が追加されて、 第4シンボルがエンコード されます。 データ値11が変

調される場合は、 シンボルはステート ・ マップ上で回転しません。

注記 この時点で、変調のビッ ト数はシンボルあたり 2ビッ トです。データ値00000000、00000001、00000010、00000011
に対して、 シンボル値はそれぞれ00、 01、 10、 11です。

カスタム差動エンコードの適用

Return > Differential Encoding Off Onを押します。

これによ り、 ユーザ定義変調にカスタム差動エンコードが適用されます。

注記 信号発生器ディ スプレイのDifferential State Mapの隣に(UNSTORED)が表示されています。差動ステート ・

マップは、 作成の対象となったユーザ定義変調に関連付けられます。

カスタム差動ステート ・マップを保存するには、対象となるユーザ定義変調を保存する必要があ り ます。保存し

ない場合は、 I/QまたはFSKテーブル ・ エディ タを終了する と きにConfirm Exit From Table Without Savingソフ ト

キーを押すと、 シンボル ・ テーブル ・ オフセッ ト ・ データは削除されます。
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12 マルチトーン/2トーン波形 （オプシ ョ ン430）

注記 N5162Aでは、 本書に記述されているソフ ト キー ・ メニューと機能は、 Webイネーブル MXGまたはSCPIコマン

ド経由でのみ使用できます。 Webイネーブル MXGの詳細については、 『インス トール ・ガイ ド』、 『プログラ ミ ン

グ ・ ガイ ド』、 『SCPI Command Reference』 を参照してください。

こ こに記載の内容を理解するには、 信号発生器の基本動作についての知識が必要です。 パワー ・ レベル／周波数の設定な

どの機能を簡単に操作できない場合は、 「基本操作」 （41ページ） を参照して、 内容をよ く理解してください。

この機能は、 オプシ ョ ン430を搭載したN5162A/82A Agilent MXGベク トル信号発生器でのみ使用できます。 オプシ ョ ン

430には、 オプシ ョ ン651、 652、 654のいずれかが必要です。

カスタム2トーン波形の作成

Two-Toneメニューでは、 ユーザ定義2 トーン波形の定義と変更を実行できます。 2 トーン波形は、 デュアル任意波形発生

器から発生します。

「2 トーン変調の使用」 （296ページ） のセクシ ョ ンでは、 以下の作業の実行方法を説明します。

• 「2 トーン波形の作成」 （297ページ）

• 「2 トーン波形の表示」 （298ページ）

• 「搬送波フ ィードスルーの最小化」 （299ページ）

• 「2 トーン波形の整列の変更」 （300ページ）

カスタム ・ マルチトーン波形の作成

Multitone Setupテーブル ・ エディ タでは、 ユーザ定義マルチ トーン波形の定義、 変更、 保存を実行できます。 マルチ

トーン波形は、 デュアル任意波形発生器から発生します。

「マルチトーン変調の使用」 （302ページ） では、 以下の作業の実行方法を説明します。

• 「Multitone Setupテーブル ・ エディ タの初期化」 （302ページ）

• 「 トーンのパワーと トーンの位相の設定」 （303ページ）

• 「 トーンの削除」 （303ページ）

• 「波形の発生」 （303ページ）

• 「RF出力の設定」 （304ページ）
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2トーン変調の使用
2トーン変調の使用

この章の以下のセクシ ョ ンでは、 2 ト ーン ・ モードについて説明し ます。 このモードは、 オプシ ョ ン430を搭載した

N5162A/82A Agilent MXGベク トル信号発生器でのみ使用できます。

• 「2 トーン波形の作成」 （297ページ）

• 「2 トーン波形の表示」 （298ページ）

• 「搬送波フ ィードスルーの最小化」 （299ページ）

• 「2 トーン波形の整列の変更」 （300ページ）

以下も参照して ください。 「波形の設定とパラ メータの保存」 （149ページ）

注記 2 トーン波形の特性と2 トーンの規格については、Agilentのアプリ ケーシ ョ ン ・ ノート 1410を参照して ください。

このアプリ ケーシ ョ ン ・ ノート をダウンロードするには、 Webサイ ト http://www.agilent.co.jpにアクセスし、電

子計測のページで 「AN 1410」 を検索してください。
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 マルチトーン/2 トーン波形 （オプシ ョ ン430）
2トーン変調の使用
2トーン変調用ソフ トキー

2トーン波形の作成

この手順では、 基本的な中心対称の2 トーン波形を作成する方法を示します。

1. 信号発生器をプリセッ ト します。

2. 信号発生器のRF出力周波数を6 GHzに設定します。

3. 信号発生器のRF出力振幅を–10 dBmに設定します。

4. Mode > Two-Tone > Freq Separation > 10 > MHzを押します。

5. Two Tone Off Onを押してOnにします。

6. RF出力をオンにします。

信号発生器のRF OUTPUTコネク タで2 トーン信号が使用可能になり ます。 図12-1 （298ページ） に、 すべての手順を実行

した後の信号発生器のディ スプレイを示します。 T-TONE、 I/Qインジケータが表示され、 RF ON、 MOD ON がオンにな り、

信号のパラ メータ設定が信号発生器ディ スプレイのステータス ・ エ リ アに表示されています。

Freq SeparationまたはAlignmentソフ トキーに変更が加えられ

た場合のみ使用可能になります。
Two ToneがOnのときに使用可能になります。

Two-Toneがオンのときにアクテ ィブ

になります。

ソフ トキーの使用法については、

141ページを参照して く ださい。

249ページ

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。

302ページ

258ページ

141ページを参照

（2トーンのArb SetupはDual Arb Setupと同様です）

例外 ：

> Waveform Runtime Scalingソフ トキーがない

> MultiBBG Sync Setupソフ トキーがない

> DAC Over-Range Protectionソフ トキーがない
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図12-1　

2トーン波形の表示

この手順では、 2 トーン波形とそのIMD成分を表示するよ うにスペク ト ラム ・ アナライザを設定する方法を示します。実際

のキー操作は、 使用するスペク ト ラム ・ アナライザのモデルによ り異なる可能性があ り ます。

1. スペク ト ラム ・ アナライザをプ リセッ ト します。

2. 搬送波周波数を6 GHzに設定します。

3. 周波数スパンを60 MHzに設定します。

4. 振幅を10 dBスケール、 –10 dBm基準に設定します。

5. 分解能帯域幅を整列してノ イズ ・ フロアを下げ、 IMD成分が表示されるよ うにします。 この例では、 9.1 kHzの設定を

使用しています。

6. ピーク ・ ディテク タをオンにします。

7. 減衰を4 dBに設定して、 スペク ト ラム ・ アナライザの入力ミ キサがオーバド ライブされないよ うにします。

図12-2 （299ページ） に示すよ うに、 中心搬送波周波数が6 GHzの2 トーン波形が見られるはずです。 この他に、 発生した

トーンの上下に10 MHz間隔でIMD成分が見られます。 また、 中心周波数に搬送波フ ィードスルーのスパイクがあ り、 中心

搬送波周波数の上下に10 MHz間隔で搬送波フ ィードスルーの歪み成分が見られます。

Mode > Two-Tone

各キーの詳細に

ついては、キーの

ヘルプを使用し

て く だ さ い （42
ページを参照）。
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 マルチトーン/2 トーン波形 （オプシ ョ ン430）
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図12-2　

搬送波フ ィードスルーの最小化

この手順では、 搬送波フ ィードスルーを最小化し、 トーンとその相互変調歪み成分の間のパワーの差を測定する方法を示

します。 この手順を開始する前に、 測定器のI/Q校正が最近実行されたこ とを確認する必要があ り ます。 I/Q校正の手順に

ついては、 「I/Q校正」 （203ページ） を参照してください。

この手順は、 前の手順からの続きです。

1. スペク ト ラム ・ アナライザで、 分解能帯域幅を約100～200 msの掃引速度に対して設定します。 これによ り、 整列中

に搬送波フ ィードスルーのスパイ クを動的に表示できます。

2. 信号発生器で、 I/Q > I/Q Adjustments > I/Q Adjustments Off Onを押してOnにします。

3. Internal Baseband Adjustments > I Offsetを押し、 スペク ト ラム ・ アナライザで搬送波フ ィードスルーを観察しながら、

回転ノブを回します。 Iオフセッ ト を適切な方向に変更する と、 フ ィードスルーのレベルが下がり ます。 レベルをでき

るだけ低く します。

4. Q Offsetを押し、 回転ノブを回して、 さ らに搬送波フ ィードスルー ・ レベルを下げます。

5. ステップ3と4を繰り返して、 搬送波フ ィードスルー ・ レベルをできる限り低く します。

6. スペク ト ラム ・ アナライザで、 分解能帯域幅を元の設定に戻します。

7. 波形アベレージングをオンにします。

 

相互変調歪み

2 トーン・

チャネル

搬送波フ ィードスルー歪み

搬送波

フ ィードスルー

各キーの詳細については、 キーのヘルプを使用して ください （42ページを参照）。
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8. マーカを作成し、 2 トーンの1つのピークに配置します。

9. デルタ ・ マーカを作成し、 隣接する相互変調成分のピークに配置します。 これはマーカのある トーンから10 MHz離れ

た位置に存在するはずです。

10. トーンとその歪み成分との間のパワーの差を測定します。

ディ スプレイは図12-3 （300ページ） のよ うになるはずです。 この最適化された2 トーン信号を使用して、 被試験デバイス

から発生したIMD成分を測定できます。

搬送波フ ィードスルーは、 時間と温度によ り変化します。 したがって、 信号を最適化するために定期的にIとQのオフセッ

ト を再調整する必要があ り ます。

図12-3　

2トーン波形の整列の変更

この手順では、 2 トーン波形を中心搬送波周波数を基準にして左または右に整列する方法を示します。 この整列によ り、 1
つのトーンの周波数が搬送波周波数と同じになるので、 搬送波フ ィードスルーは隠されます。 ただし、 左または右揃えか

ら生じるイ メージ周波数干渉によ り、 2 トーン信号にわずかな歪みが生じる可能性があ り ます。 この手順は、 前の手順か

らの続きです。

1. 信号発生器で、 Mode > Two Tone > Alignment Left Cent Rightを押してLeftにします。

2. Apply Settingsを押して、 波形を再発生します。

 

メイン・マーカ

デルタ・マーカ

最小化された

搬送波フ ィードスルー

各キーの詳細については、

キーのヘルプを使用して く

ださい （42ページを参照）
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注記 2 トーン ・ ジェネレータの動作中 （Two Tone Off OnがOnに設定されている と き） に設定を変更した場合は、 更新

された波形を発生するには、 Apply Settingsソフ ト キーを押して変更を適用する必要があ り ます。 変更を適用す

る と、 ベースバンド ・ ジェネレータは新しい設定を使用して2 トーン波形を作成し、 ARBメモ リ内の既存の波形

を置き換えます。

3. スペク ト ラム ・ アナライザで、 表示の更新速度を上げるために波形アベレージングを一時的にオフにします。 図 12-4
に示すよ うに、 左揃えされた2 トーン波形が表示されるはずです。

図12-4　

搬送波周波数

上のトーンを

相互変調歪み

2 トーン・

チャネル

搬送波周波数に整列

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。
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マルチトーン変調の使用

マルチトーン変調用ソフ トキー

Multitone Setupテーブル ・ エディ タの初期化

1. Presetを押します。

2. Mode > Multitoneを押します。

3. Initialize Table > Number of Tones > 5 > Enterを押します。

4. Freq Spacing > 20 > kHzを押します。

303ページ

302ページ

このソフ トキーは、 テーブル ・ エディ タで現在のマル

チ トーン波形に変更が加えられている場合のみアク

テ ィ ブになります。 変更を適用するにはこのソフ ト

キーを押す必要があります。

304ページ

304ページ

Multitoneがオンのときにアクテ ィブ

になります。

ソフ トキーの使用法については、

次を参照して く ださい ： 140ページ

140ページ

141ページを参照

（マルチトーンのARB SetupはDual Arb Setupと同様です）

例外 ：

> Waveform Runtime Scalingソフ トキーがない

> MultiBBG Sync Setupソフ トキーがない

> DAC Over-Range Protectionソフ トキーがない

各キーの詳細については、 キーのヘルプを使用して

ください （42ページを参照）。
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図12-5

5. Doneを押します。

5つの トーンが20 kHz間隔で配置されたマルチトーン ・ セッ ト アップができました。 中央の トーンは搬送波周波数に配置

され、 他の4つのトーンは中央のトーンから20 kHzステップの間隔で配置されています。

トーンのパワーと トーンの位相の設定

1. 行2の トーンのPower列の値(0 dB)を強調表示します。

2. Edit Table > Edit Item > –4.5 > dBを押します。

3. 行2の トーンのPhase列の値(0)を強調表示します。

4. Edit Item > 123 > degを押します。

トーンの削除

1. 行4の トーンのState列の値(On)を強調表示します。

2. Toggle Stateを押します。

波形の発生

Return > Multitone Off Onを押してOnを強調表示します。

これによ り、前のセクシ ョ ンで定義したパラ メータによるマルチ トーン波形が発生します。波形発生中は、 M-TONEおよび

I/Qインジケータがオンになり、 マルチトーン波形が揮発性メモ リに記憶されます。 波形はRF搬送波を変調しています。

マルチ ト ーンの位相値に影響を

与えるRandom Seedソフ トキーは

以下の例では使用されてな く、単

に参考のために示されています。

各キーの詳細については、 キーのヘルプを使用して く ださい （42ページを参照）。
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マルチトーン/2トーン波形 （オプシ ョ ン430）
マルチトーン変調の使用
RF出力の設定

1. RF出力周波数を100 MHzに設定します。

2. 出力振幅を0 dBmに設定します。

3. RF On/Offを押します。

マルチトーン波形が信号発生器のRF OUTPUTコネク タで使用可能になり ます。

アクテ ィブなマルチトーン信号への変更の適用

マルチトーン ・ジェネレータが使用されている （Multitone Off OnがOnに設定されている） 状態で、Multitone Setupテー

ブル ・ エディ タに変更を加えた場合は、 更新された波形を発生するためには変更を適用する必要があ り ます。

Multitone Setupテーブル・エディ タで、以下のキーを押して、変更を適用し、更新された値に基づく新しいマルチトー

ン波形を発生します ： Apply Multitone

マルチトーン波形の保存

この例では、マルチ トーン波形を保存する方法を示します。マルチトーン波形をまだ作成していない場合は、前のセクシ ョ

ン （「カスタム ・ マルチトーン波形の作成」 （295ページ）） の手順を実行しておいてください。

1. Load/Store > Store To Fileを押します。

アクティブ入力エリアにCatalog of MTONE Files内のファ イル名がすでに入力されている場合は、以下のキーを押

します （43ページを参照） ：

Edit Keys > Clear Text

2. アルファベッ ト ・キーとテンキーを使用して、23文字以内のファ イル名（例：5TONE） を入力します（43ページを参照）。

3. Enterを押します。

マルチトーン波形がCatalog of MTONE Filesに保存されます。

注記 RF 出力の振幅、 周波数、 動作ステート設定は、 マルチトーン波形ファ イルには保存されません。 同様に、 マル

チ トーン設定は機器ステートには保存されません。 したがって、 後ですべての設定を復元できるよ うにするに

は、 機器ステート とマルチトーン設定の両方を保存しておく必要があ り ます。
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 マルチトーン/2 トーン波形 （オプシ ョ ン430）
マルチトーン変調の使用
マルチトーン波形のリコール

この手順では、 マルチ トーン波形を信号発生器のメモ リ ・ カタログから リ コールする方法を説明します。

マルチトーン波形をまだ作成して保存していない場合は、 前のセクシ ョ ン （ 「カスタム ・ マルチトーン波形の作成」 （295
ページ） と 「マルチトーン波形の保存」 （304ページ） ） の手順を実行した後、 信号発生器をプリセッ ト して、 揮発性ARB
メモ リに記憶されているマルチトーン波形をク リ アします。

1. Mode > Multitoneを押します。

2. Load/Storeを押します。

3. 目的のファイル （例 ： 5TONE） を強調表示します。

4. Load From Selected File > Confirm Load From Fileを押します。

5. Multitone Off Onを押してOnを強調表示します。

ファームウェアがマルチトーン波形をARBメモ リに作成します。波形作成が終わる と、マルチ トーン波形をRF出力に変調

できるよ うにな り ます。

RF出力の設定方法については、 「RF出力の設定」 （304ページ） を参照して ください。
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マルチトーン/2トーン波形 （オプシ ョ ン430）
マルチトーン変調の使用
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13 セキュア環境での作業

注記 N5161A/62Aの場合、 本書に記述されているソフ ト キー ・ メニューと機能は、 WebイネーブルMXGまたはSCPI
コマンド経由でのみ使用できます。 WebイネーブルMXGの詳細については、 『インス トール ・ ガイ ド』、 『プログ

ラ ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照してください。

• 「メモ リ ・ タ イプについて」 （307ページ）

• 「メモ リからのデータの除去 （オプシ ョ ン006のみ）」 （310ページ）

• 「セキュア ・ ディ スプレイの使用 （オプシ ョ ン006のみ）」 （313ページ）

メモリ ・ タイプについて

信号発生器にはいくつかのメモ リ ・タ イプがあ り、それぞれ特定の種類のデータを記憶するために用いられます。機密デー

タを除去する前に、 各メモ リ ・ タ イプがどのよ うに使用されているかを理解する必要があ り ます。 以下の表に、 基本測定

器とオプシ ョ ンのベースバンド ・ ジェネレータで使用される メモ リ ・ タ イプを示します。

表13-1　基本測定器メモリ

メモ リ ・タイプ

とサイズ

通
常
操
作
中

に

書
き
込
み
可
能

?

電
源

を
オ

フ
に

し
た

と
き

デ
ー

タ
を
保
持

?

目的／内容 データ入力方法 測定器内の位置と注記

メ イン・ メモ リ

（RAM）

32 MB

はい いいえ ファームウェア動作メモリ

ユーザ ・データなし

オペレーティング ・

システム

CPUボード、 バッテ リ ・ バッ クアップなし。

メ イン・ メモ リ

（フラ ッシュ）

8 MB

はい はい 工場校正／設定データ

aユーザ ・ ファ イル ・ システム。

フラ ッ ト ネス校正、 機器ステート、

掃引リ ス トが含まれます。

ファームウェア ・

アップグレード と

ユーザ保存データa

CPUボード （ファームウェア ・ メモ リ と同じチップ、 ただ

し別に管理）

このメモリ ・ チップには8 Mバイ トのユーザ ・データ （こ

こで説明） の他に8 Mバイ トのファームウェア ・ メモ リが

含まれているため、 フルチップ消去は望まし く あ り ませ

ん。 Erase and Sanitize機能を実行する と、 ユーザ ・データ

領域が選択的に完全に消去されます。
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セキュア環境での作業
メモリ ・ タイプについて
a アナログ測定器のみ

ファーム

ウェア・ メモ リ

（フラ ッシュ）

8 MB

いいえ はい メ イン ・ ファームウェア ・

イ メージ

工場インス トール済みま

た は フ ァ ー ム ウ ェ ア ・

アップグレード

CPUボード （メ イン ・ フラ ッシュ ・ メモ リ と同じチップ、

ただし別に管理）

通常操作では、 このメモ リ を上書きする こ とはできませ

ん。 メモ リは、 フ ァームウェア ・ インス トール中または

アップグレード ・ プロセス中にのみ上書きされます。

このメモリ ・ チップには8 Mバイ トのユーザ ・データの他

に8 Mバイ トのファームウェア ・ メモ リ （こ こで説明） が

含まれているため、 フルチップ消去は望まし く あ り ませ

ん。 Erase and Sanitize機能を実行する と、 ユーザ ・データ

領域が選択的に完全に消去されます。

ブート ロム ・

メモ リ

（EEPROM）

8 kB

いいえ はい CPUブート アップ ・ パラ メータ

ユーザ ・データなし

工場でプログラム CPUボード

通常操作では、LAN設定の場合を除いて、このメモリが上

書きまたは消去されるこ とはあ り ません。この読取り専用

データは、 工場でプログラムされます。
はい はい LAN設定 フロン ト ・ パネル入力

またはリモート入力

校正データ

（フラ ッシュ）

256 kB

いいえ はい 工場校正／設定データの

バッ クアップ

ユーザ ・データなし

工場またはサービスのみ RFボード

LCD

ディ スプレイ ・

メモ リ （RAM）

160 kB

いいえ いいえ 表示バッファ オペレーティング ・

システム

RFボード、 バッテ リ ・ バッ クアップなし。

フロン ト ・

パネル・ メモ リ

（フラ ッシュ）

32 kB

いいえ いいえ フロン ト ・ パネル ・ キーボード ・

コン ト ローラ ・ ファームウェア

ユーザ ・データなし

オペレーティング ・

システム

フロン ト ・ パネル ・ ボード

表13-1　基本測定器メモリ （続き）

メモ リ ・タイプ

とサイズ

通
常
操
作
中

に

書
き
込
み
可
能

?

電
源

を
オ

フ
に

し
た

と
き

デ
ー

タ
を
保
持

?
目的／内容 データ入力方法 測定器内の位置と注記
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 セキュア環境での作業
メモリ ・ タイプについて
表13-2　ベースバンド ・ ジェネレータ ・ メモリ （オプシ ョ ン651、 652、 654）

メモ リ ・ タイプと

サイズ

通
常
操
作
中

に

書
き
込
み
可
能

?

電
源

を
オ

フ
に

し
た

と
き

デ
ー

タ
を
保
持

?

目的／内容 データ入力方法 注記

波形メモ リ

（RAM）

≦320 MB

はい いいえ 波形

（ヘッダとマーカ ・データを含む）

通常ユーザ操作 バッテ リ ・ バッ クアップなし。

恒久的メモ リ

（フラ ッシュ）a

4 GB

aシリアル番号<MY4818xxxx、 US4818xxxx、 SG4818xxxxの場合、 恒久的メモリ＝512 MBです。

はい はい すべてのユーザ ・データ 通常ユーザ操作 Erase and Sanitize機能を実行する と、 ユーザ ・データが

完全に消去されます。

校正データ ・ メモ リ

（フラ ッシュ）

128 kB

いいえ はい ユーザ ・データなし 工場またはサービスのみ
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セキュア環境での作業
メモリからのデータの除去 （オプシ ョ ン006のみ）
メモリからのデータの除去 （オプシ ョ ン006のみ）

信号発生器を安全な開発環境から移動する と きには、 装備された複数のセキュ リ ティ機能を使用して、 機密情報を測定器

から除去するこ とができます。 セキュ リ テ ィ機能には、 リ モー ト操作用と して同じ働きを持つSCPIコマンド もあ り ます

（“System Subsystem (:SYSTem)”コマンド。 『SCPI Command Reference』 を参照してください）。

注意 信号発生器には、 いくつかのメモ リ ・ タ イプ （表13-1 （307ページ） と表13-2 （309ページ） で説明） があ り、 そ

れぞれ特定の種類のデータを記憶するために使用されます。機密データを除去する前に、各メモ リ ・ タ イプがど

のよ うに使用されているかを理解する必要があ り ます。

Erase All

除去 ： すべてのユーザ ・ ファ イル、 ユーザ ・ フラ ッ ト ネス校正、 ユーザI/Q校正を除去します。

リセッ ト ： すべてのテーブル ・ エディ タを元の工場値にリセッ ト し、 ユーザ ・ データ と設定へのアクセスや

表示ができないよ うにします。

実行しない操作 ： メモ リ を削除しません。

消去にかかる時間 ： 通常< 1分。 ファ イルの数に依存します。

開始方法 ： File > More > Security > Erase All > Confirm Eraseを押します。

注記 File > Delete All Files とは異な り ます。 この操作は、 すべてのユーザ ・ ファ イルを削除しますが、 テーブル ・ エ

ディ タを リセッ ト しません。

311ページ

下を参照

「セキュア ・ モード」

（312ページ） を参照

65ページ

各キーの詳細については、42ページ

の説明に従ってキーのヘルプを使

用して ください
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 セキュア環境での作業
メモリからのデータの除去 （オプシ ョ ン006のみ）
Erase and Overwrite All

Erase Allと同じ動作を実行します。それに加えて、National Industry Security Program Operating Manual (NISPOM) DoD
5220.22–Mに準拠して、 各種のメモ リ ・ タイプをク リ ア／上書きします。

CPUフラ ッシュ すべてのアドレス可能な位置をランダムな文字で上書きした後、 フラ ッシュ ・ ブロ ッ クを消去し

ます。 チップ消去と同じ目的を達成できます。 消去後にシステム ・ ファ イルが復元されます。

開始方法 ： File > More > Security > Erase and Overwrite All > Confirm Eraseを押します。

Erase and Sanitize All

Erase and Overwrite Allと同じ動作を実行した後、さ らに上書き動作を追加します。この機能を実行後、National Industry
Security Program Operating Manual (NISPOM) DoD 5220.22–Mに適合したサニタイゼーシ ョ ンを行うため、以下に説明す

る追加手順を手動で実行する必要があ り ます。

開始方法 ： File > More > Security > Erase and Sanitize All > Confirm Sanitizeを押します。

消去時に削除されない恒久ステート情報の削除

恒久ステート

恒久ステート設定には、 定義済みのリ ミ ッ ト内で変更可能な機器セッ ト アップ情報が含まれます。 例えば、 ディ スプレイ

の輝度／コン ト ラス ト 、 GPIBアドレスなどです。 ベク トル ・ モデルでは、 ユーザI/Q校正も この領域に保存されます。

次のキー操作またはSCPIコマンドを使用して、 I/Q校正ファイルをク リ アし、 信号発生器の電源投入、 プリセッ ト、 *RST
コマンドに影響されない動作ステート を工場設定値に設定できます。

測定器のセッ トアップ

• Agilent MXGのフロン ト ・パネルで、次のキーを押します：Utility > Power On/Preset > Restore System Settings to Default
Values > Confirm Restore Sys Settings to Default Values

• または、 次のコマンドをAgilent MXGに送信します ： :SYSTem:PRESet:PERSistent

CPUフラ ッシュ すべてのアドレス可能な位置をランダムな文字で上書きした後、 フラ ッシュ ・ ブロ ッ クを消去します。 チップ

消去と同じ目的を達成できます。 消去後にシステム ・ ファ イルが復元されます。

BBG永久メモ リ

（フラ ッシュ）

（ベク トル測定器のみ） すべてのアドレス可能な位置をランダムな文字で上書きした後、 フラ ッシュ ・ブロ ッ ク

を消去します。 チップ消去と同じ目的を達成できます。 消去後にシステム ・ ファ イルが復元されます。
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メモリからのデータの除去 （オプシ ョ ン006のみ）
LANセッ トアップ

LANセッ ト アップ （ホス ト名、 IPアドレス、 サブネッ ト ・ マスク、 デフォルト ・ ゲート ウェイ） 情報は、 信号発生器の電

源投入や*RSTコマンドによって初期化されません。 この情報を変更またはク リ アするには、新しいデータを入力する必要

があ り ます。

ユーザI/Q校正ファイル （ベク トル ・ モデルのみ）

ユーザ定義I/Q校正が実行された場合、校正ファイル・データを削除するには、次の手順で校正ファ イルをデフォルトに設

定します。

• フロン ト ・ パネルで、 次のキーを押します ： I/Q > I/Q Calibration > Revert to Default Cal Settings

• または、 次のコマンドをAgilent MXGに送信します ： :CAL:IQ:DEF

セキュア ・ モード

注意 セキュア ・ モードを （Confirm を押して） オンにする と、 モードをオフにした り、 セキュ リ ティ ・ レベルを下げ

たりする操作はできな くな り ます。次に電源を入れ直したと きに、指定したセキュ リ ティ ・ レベルの消去動作が

実行されます。セキュア ・モードをオンにした後は、電源を入れ直すまでセキュ リ ティ ・ レベルを上げるこ と し

かできません。 例えば、 EraseをOverwriteに変更するこ とはできますが、 逆の操作はできません。

電源を入れ直すと、 セキュ リ ティ ・ レベルの選択は同じままですが、 セキュア ・ モードがオンにな り ません。

不揮発性メモ リに永久的に保存されていないデータ、 GPIB設定、 または現在のユーザ機器ステートが失われる

のを防ぐために、 MXGの電源をオフにする場合は、 必ずMXGのフロン ト ・ パネルの電源ボタンまたは適切な

SCPIコマンドを使用してください。 ラ ッ ク ・ システムにインス トールされているMXGが、 MXGのフロン ト ・ パ

ネル ・ スイ ッチでな くシステム ・ ラ ッ クの電源スイ ッチによって電源をオフにされた場合は、 MXGの電源が適

切にオフにされなかったためにError –310が表示されます。

セキュア ・ モードでは、 次回、 測定器の電源を入れ直したと きに、 選択したSecurity Level動作が自動的に適用されます。

レベルを設定する場合 ： File > More > Security > Security Levelを押し、 以下から選択します。

— None ＝ 工場プリセッ ト 。 ユーザ情報が失われません。

— Erase ＝ Erase All
— Overwrite ＝ Erase and Overwrite All
— Sanitize ＝ Erase and Sanitize All

オンにする場合 ： File > More > Security > Enter Secure Mode > Confirmを押します。

ソフ ト キーがSecure Mode Activatedに変わり ます。

機能しない測定器のセキュア

測定器が機能せず、 セキュ リ ティ機能を使用できない場合は、測定器からプロセッサ ・ボード と、 （ベク トル測定器の場合

は） A4メモ リ ・ チップを取り出す必要があ り ます。 これらのアセンブリ を取り出したら、 以下のオプシ ョ ンのいずれかを

選択します。

• ボードを破棄し、 測定器を修理施設に送り ます。 新しいボードを搭載し、 測定器の修理と校正を行います。 測定器が

保証期間内であれば、 新しいボードの料金は請求されません。
312 Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド



 セキュア環境での作業
セキュア ・ ディスプレイの使用 （オプシ ョ ン006のみ）
• 機能している別の測定器がある場合、 ボードをその測定器に搭載し、 メモ リ を消去します。 ボードを機能しない測定

器に再度搭載し、 修理と校正のため修理施設に送り ます。 現在機能している測定器でボードが機能しない場合、 機能

しないボードを破棄し、 測定器の障害の原因がボードであるこ とを修理オーダに記載します。 測定器が保証期間内で

あれば、 新しいボードの料金は請求されません。

ボードを取り出して交換する方法については、 『Service Guide』 を参照してください。

セキュア ・ ディスプレイの使用 （オプシ ョ ン006のみ）

この機能は、 権限のないユーザが測定器のディ スプレイを読んだり、 フロン ト ・ パネルから現在の設定を不正に変更した

りするこ とを防止します。以下の図に示すメ ッセージを除いて、ディ スプレイがブランクになり、フロン ト ・パネルのキー

が無効になり ます。

ディ スプレイ とフロン ト ・ パネル ・ キーを再度使用可能にするには、 電源を入れ直します。
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セキュア ・ ディスプレイの使用 （オプシ ョ ン006のみ）
図13-1　Secure Displayソフ トキー

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して く ださい。

周波数セキュリテ ィ をオンに

し、 周波数注釈表示をブラン

クにします。また、周波数、振

幅、 掃引ソフ トキーをオフに

します。 この機能はプリセッ

トするとオフになります。
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注記 N5161A/62Aでは、 本書に記述されているソフ ト キー ・ メニューと機能は、 WebイネーブルMXGまたはSCPIコ
マンド経由でのみ使用できます。 WebイネーブルMXGの詳細については、 『インス トール ・ ガイ ド』、 『プログラ

ミ ング ・ ガイ ド』、 『SCPI Command Reference』 を参照してください。

• 「ディ スプレイ」 （316ページ）

• 「信号発生器のロ ッ クアップ」 （316ページ）

• 「RF出力」 （316ページ）

— RF出力がない

— 電源のシャ ッ ト ダウン

— RF出力に変調がない

— RF出力パワーが低過ぎる

— 歪み

— スペク ト ラム ・ アナライザと一緒に動作中の信号断

— ミ キサと一緒に動作中の信号断

• 「掃引」 （320ページ）

— 掃引をオフにできない

— 掃引がハングしたよ うに見える

— 不適切な リ ス ト掃引待ち時間

— リ コールされたレジスタにリ ス ト掃引情報がない

— リ ス ト掃引またはステップ掃引で振幅が変化しない

• 「内部メディア ・ データ ・ ス ト レージ」 （321ページ）

— 機器ステート を保存したが、 レジスタが空か、 間違ったステートが含まれている

• 「USBメディア ・ データ ・ ス ト レージ」 （321ページ）

— 測定器がUSBメディア接続を認識するが、 ファ イルを表示しない

• 「プ リセッ ト 」 （321ページ）

— 信号発生器が応答しない

— Presetを押すとユーザ ・ プ リセッ ト を実行する

• 「エラー ・ メ ッセージ」 （322ページ）

• 「フロン ト ・ パネルのテス ト 」 （323ページ）

• 「セルフテス トの概要」 （324ページ）

• 「ラ イセンス」 （326ページ）

• 「Agilent Technologiesへの問合せ方法」 （326ページ）

— 信号発生器をAgilentに返送する
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ディスプレイ

ディスプレイが暗すぎて読めない

輝度と コン ト ラス トが最小値に設定されています。 「ディ スプレイの設定」 （26ページ） の図を使用して輝度と コン ト ラス

トのソフ ト キーを探し、 値を調整してディ スプレイが見えるよ うにします。

USBメディア使用時にディスプレイが真っ暗になる

測定器がUSBメディアを使用し始めたと きにメディアを取り外すと、 画面が真っ暗になるこ とがあ り ます。 測定器の電源

を入れ直して ください。

信号発生器のロックアップ
• 信号発生器がリモート ・ モード （画面にRインジケータが表示されます） でないこ とを確認します。 リモート ・ モード

を終了し、 フロン ト ・ パネルをアンロ ッ クするには、 Local Cancel/(Esc)を押します。

• 信号発生器が、 フロン ト ・ パネル操作を防止するローカル ・ ロ ッ クアウ トになっていないこ とを確認します。 ローカ

ル ・ ロ ッ クアウ トについては、 『プログラ ミ ング ・ ガイ ド』 を参照して ください。

• 信号発生器の画面に進捗度バーが表示される場合は、 操作が進行中です。

• 信号発生器をプリセッ ト します。

• 信号発生器の電源を入れ直します。

RF出力

RF出力がない

• RF ON/OFF LED （5ページを参照） をチェッ ク します。 オフの場合は、 RF On/Offを押して出力をオンにします。

• 振幅が信号発生器のレンジ内に設定されているこ とを確認します。

• 測定器が波形を再生中の場合は、 マーカ極性とルーティング設定が正しいこ とを確認します （ 「マーカの極性設定と

ルーティング設定を保存する」 （156ページ） を参照）。

電源のシャッ トダウン

電源が機能しない場合は、 修理または交換が必要です。 測定器のサービスを自分で行えない場合は、 修理のため信号発生

器をAgilentサービス ・ センタに送り ます （「Agilent Technologiesへの問合せ方法」 （326ページ） を参照）。

RF出力に変調がない

Mod On/Off LEDと<変調> Off Onソフ ト キーをチェッ ク し、両方がオンになっているこ とを確認します。「搬送波信号の変

調」 （61ページ） も参照して ください。

ベク トル信号発生器でのデジタル変調の場合は、 内部I/Q変調器がオンであるこ とを確認します （I/Qインジケータが表示

されます）。

外部変調ソースを使用する場合は、外部ソースがオンで、信号発生器の指定リ ミ ッ ト内で動作しているこ とを確認します。
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RF出力パワーが低過ぎる

• ディ スプレイのAMPLITUDEエリ アにOFFSインジケータが表示されている場合は、 オフセッ ト を解除します。

Amptd > More 1 of 2 > Amptd Offset > 0 > dBを押します。 「出力オフセッ トの設定」 （115ページ） も参照してください。

• ディ スプレイのAMPLITUDEエリ アにREFインジケータが表示されている場合は、 基準モードをオフにします。

1. Amptd > More > Amptd Ref Off Onを押し、 Offを強調表示します。

2. 出力パワーを目的のレベルにリセッ ト します。

「出力基準の設定」 （116ページ） も参照してください。

• 信号発生器を外部ミキサと一緒に使用している場合は、 318ページを参照して ください。

• 信号発生器をスペク ト ラム ・ アナライザと一緒に使用している場合は、 317ページを参照して ください。

• パルス変調がオンの場合は、 ALCをオフにし、 パルス幅が仕様内であるこ とをチェッ ク します。

歪み

波形シーケンスのセグメン ト を編集して再セーブした場合は、 シーケンスはヘッダにス ト アされたRMS値を自動的に更新

しません。 そのため、 出力信号に歪みが生じます。 シーケンスのヘッダ情報を表示し、 RMS値を再計算します （149ペー

ジを参照）。

スペク ト ラム ・ アナライザと一緒に動作中の信号断

注意 MXGの損傷や性能低下を避けるために、 RF入力の逆パワー ・ レベルが最大33 dBm(2W)を超えないよ うにして

ください。 www.agilent.co.jpのTips for Preventing Signal Generator Damageも参照してください。

信号発生器をプリセレクシ ョ ンのないスペク ト ラム ・ アナライザと一緒に使用する場合は、逆電力の影響によ り RF出力に

問題が生じます。 レべリ ングなし動作モード （112ページで説明） を使用して ください。

周波数によっては、 スペク ト ラム ・ アナライザのLOフ ィードスルーがRF入力ポートで＋5 dBm に達する場合があ り ます。

LOフ ィードスルーとRF搬送波の周波数差がALC帯域幅よ り小さいと、LOの逆電力が信号発生器のRF出力を振幅変調する

可能性があ り ます。 不要AMの周波数は、 スペク ト ラム ・ アナライザのLOフ ィードスルーと信号発生器のRF搬送波の周波

数差に一致します。

逆電力の問題は、 いずれかのレベリ ングなし動作モードを使用する と解決できます。

以下を参照して ください。

• 「ALCオフ ・ モード」 （112ページ）

および

• 「パワー ・ サーチ ・ モード」 （113ページ）
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ミキサと一緒に動作中の信号断

注意 MXGの損傷や性能低下を避けるために、 RF入力の逆パワー ・ レベルが最大33 dBm(2W)を超えないよ うにして

ください。 www.agilent.co.jpのTips for Preventing Signal Generator Damageも参照してください。

ミ キサとの低振幅結合動作中の信号発生器RF出力の信号断を修正するには、 減衰を追加し、 RF出力の振幅を増加します。

右の図に、 信号発生器が低振幅信号

を ミ キサに供給する際の設定を示し

ます。

内部レべリ ングされた信号発生器の

RF出力 （およびALC レベル） は–8
dBmです。 ミ キサは＋10 dBmのLO
でド ラ イブされ、 LO-RFアイ ソレー

シ ョ ンは15 dBです。 結果の–5 dBm
のLOフ ィードスルーが、信号発生器

のRF出力コネクタに入り、 内部ディ

テク タに届きます。

周波数によっては、 このLOフ ィード

スルー ・ エネルギーのほ と んどが

ディテク タに入り ます。 ディテク タ

は周波数に関係な く全入力パワーに

応答するので、 この余分のエネル

ギーによ り ALCがRF出力を減少さ

せます。 この例では、 ディテク タの逆電力が実際にALCレベルよ り大き く、 これによ りRF出力で信号断が起こ り ます。

ミキサ

LO 

ALCレベル

＝–8 dBm

RFレベル

制御

信号発生器

出力制御

ディテクタ

が–8 dBmの

ALCレベル

を測定

ディテクタ

が–5 dBmの

逆電力を測定

LOフ ィードスルー

＝–5 dBm

RF出力

＝–8 dBm

LOレベル

＝＋10 dBm

IF 

ALCへの逆電力の影響
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右に示す解決策は同様の構成です

が、信号発生器のRF出力と ミ キサの

入力の間に10 dBアッテネータを接

続しています。信号発生器のALCレ

ベルは、＋2 dBmまで増加し、10 dB
アッテネータを通って伝送し、 ミ キ

サ入力で要求された–8 dBmの振幅

を実現します。

元の構成と比較して、 ALCレベルは

10 dB高く な り ますが、 アッテネー

タがLOフ ィードスルー（および信号

発生器のRF出力） を10 dBだけ減少

し ます。 減衰構成を使用する と、

デ ィ テ ク タには必要な＋2 dBmの

信号と、不要な–15 dBmのLOフ ィー

ドスルーが供給されます。必要エネ

ルギーと不要エネルギー間のこの

17 dBの差によ り、 信号発生器のRF
出力レベルに最大0.1 dBのシフ トが生じます。

ミキサ

LO 

ALCレベル／RF出力

＝＋2 dBm

RFレベル

制御

信号発生器

出力制御

ディテクタ

が＋2 dBmの

ALCレベルを

測定

ディテクタ

が–15 dBmの

逆電力を測定

LOフ ィードスルー

＝–5 dBm

RF出力

＝–8 dBm

LOレベル

＝＋10 dBm

IF 

逆電力の解決策

10 dB 
ATTEN
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掃引
掃引

掃引をオフにできない

Sweep > Sweep > Offを押します。

掃引がハングしたように見える

掃引の現在のステータスは、 進捗度バーに陰影表示の長方形と して示されます （「掃引出力の設定」 （48ページ） を参照）。

掃引がハングしたよ うに見える場合は、 以下をチェッ ク します。

1. 以下のキー ・ シーケンスのいずれかで掃引をオンにします。

Sweep > Sweep > Freq
Sweep > Sweep > Amptd

Sweep > Sweep > Waveform （ベク トル測定器のみ）

2. 掃引がシングル ・ モードの場合は、 Single Sweepソフ ト キーを押します。

3. 掃引ト リガ （Sweep Triggerソフ ト キーによって示されます） がFree Runに設定されていない場合は、 Free Runに設定

し、 掃引ト リガが発生しないために掃引がブロ ッ ク されているかど うかを判定します。

4. ポイン ト ・ ト リ ガ （Point Triggerソフ ト キーによって示されます） がFree Runに設定されていない場合は、 Free Run
に設定し、 ポイン ト ・ ト リ ガが発生しないために掃引がブロ ッ ク されているかど うかを判定します。

5. 待ち時間を1秒に設定し、 待ち時間が長すぎるか短すぎて表示できないのかど うかを判定します。

6. ステップ掃引またはリ ス ト掃引に2個以上のポイン トが設定されているこ とを確認します。

不適切なリス ト掃引待ち時間

1. Sweep > More > Configure List Sweepを押します。

2. リ ス ト掃引の待ち時間値が正確であるこ とをチェッ ク します。

3. 待ち時間値が不適切な場合は、 値を編集します。

待ち時間値が正しい場合は、 次の手順に進みます。

4. Moreを押し、 Dwell Type List Stepソフ ト キーがListに設定されているこ とを確認します。

Stepが選択されている場合は、 信号発生器が、 リ ス ト掃引ではなく ステップ掃引用に設定された待ち時間を使用して

リ ス ト ・ ポイン ト を掃引します。

「掃引出力の設定」 （48ページ） も参照してください。

リコールされたレジスタにリスト掃引情報がない

リ ス ト掃引情報は、 機器ステート ・ レジスタに機器ステートの一部と してス ト アされません。 現在のリ ス ト掃引だけが信

号発生器で使用可能です。 リ ス ト掃引データは、 測定器カタログにス ト アできます （ 「保存されているファ イルのロード

（ リ コール）」 （68ページ） を参照）。

リス ト掃引またはステップ掃引で振幅が変化しない

掃引タイプが振幅 （Amptd） に設定されているこ とを確認します。 掃引タイプを周波数 （Freq） または波形に設定したと

きには、 振幅が変化しません。
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内部メディア ・ データ ・ ス ト レージ

機器ステート を保存したが、 レジスタが空か、 間違ったステートが含まれている

使用する予定だったレジスタ番号が空か、 間違った機器ステートが含まれている場合は、 レジスタ 99を リ コールします。

99よ り も大きなレジスタ番号を選択した場合は、 信号発生器が機器ステート をレジスタ99に自動的に保存します。

「機器ステート ・ ファ イルの場合」 （70ページ） も参照して ください。

USBメディア ・ データ ・ ス ト レージ

測定器がUSBメディア接続を認識するが、 ファイルを表示しない

USB メディアが他の測定器またはコンピュータで機能する場合は、 単に信号発生器と互換性がない可能性があ り ます。 別

のUSBメディアを使用してください。互換性のあるUSBメディアの詳細については、http://www.agilent.co.jp/find/mxgを
参照して ください。

プリセッ ト

信号発生器が応答しない

信号発生器がプリセッ トに応答しない場合は、 測定器がリモート ・ モードであるために、 キーパッ ドがロ ッ ク されている

可能性があ り ます。

リモート ・ モードを終了し、 プ リセッ ト ・ キーをアンロ ッ クするには、 Local Cancel/(Esc)を押します。

Presetを押すとユーザ ・ プリセッ ト を実行する

この動作は、 以前の製品との互換性のためのSCPIコマンドを使用する と発生します。 信号発生器を通常使用に戻すには、

コマンド:SYST:PRESet:TYPE NORMを送信します。

SCPIコマンドについては、 『SCPI Command Reference』 を参照して ください。
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エラー ・ メ ッセージ

エラー ・ メ ッセージのタイプ

イベン トが複数タイプのエラーを生成するこ とはあ り ません。 例えば、 問合せエラーを生成するイベン トは、 デバイス固

有エラー、 実行エラー、 コマンド ・ エラーを生成しません。

問合せエラー （–499～–400） は、 測定器の出力待ち行列制御が、 IEEE 488.2第6章に記述されたメ ッセージ交換プロ ト コ

ルに関する問題を検出したこ とを示します。 このク ラスのエラーは、 イベン ト ・ ステータス ・ レジスタの問合せエラー ・

ビッ ト （ビッ ト 2） をセッ ト します （IEEE 488.2、 セクシ ョ ン11.5.1）。 これらのエラーは、 IEEE 488.2, 6.5に記述されて

いる メ ッセージ交換プロ ト コル ・ エラーに対応します。 この場合は、

• 出力待ち行列に存在するか処理待ち中のデータがないと きに、 データを読み出そ う と しています。 または

• 出力待ち行列のデータが失われました。

デバイス固有エラー （–399～–300、 201～703、 800～810） は、 おそら くハード ウェアまたはファームウェアの異常な状

態によ り、 デバイス操作が正し く完了しなかったこ とを示します。 これらのコードは、 セルフテス ト応答エラーにも使用

されます。 このク ラスのエラーは、 イベン ト ・ ステータス ・ レジスタのデバイス固有エラー ・ ビッ ト （ビ ッ ト 3） をセッ

ト します （IEEE 488.2、 セクシ ョ ン11.5.1）。

正のエラーの<error_message>文字列は、 SCPIでは定義されていません。 正のエラーは、 測定器が、 GPIBシステム内、 測

定器のファームウェアまたはハード ウェア内、 ブロ ッ ク ・ データの転送中、 あるいは校正中にエラーを検出したこ とを示

します。

実行エラー （–299～–200） は、 測定器の実行制御ブロッ クによってエラーが検出されたこ とを示します。 このク ラスのエ

ラーは、 イベン ト ・ ステータス ・ レジスタの実行エラー ・ ビッ ト （ビ ッ ト 4） をセッ ト します （IEEE 488.2、 セクシ ョ ン

11.5.1）。 この場合は、

• ヘッダに続く <PROGRAM DATA>要素が、 デバイスによって有効な入力の範囲外と評価されたか、 デバイスの機能に

適合していません。 または

• 有効なプログラム ・ メ ッセージが、 何らかのデバイス状態のために正し く実行できませんでした。

実行エラーは、 丸めや数式評価操作が完了した後に報告されます。 例えば、 数値データ要素の丸めは、 実行エラーと して

報告されません。

コマンド ・ エラー （–199～–100） は、 測定器のパーサがIEEE 488.2構文エラーを検出したこ とを示します。 このク ラスの

エラーは、 イベン ト ・ ステータス ・ レジスタのコマンド ・ エラー ・ ビッ ト （ビ ッ ト 5） をセッ ト します （IEEE 488.2、 セ

クシ ョ ン11.5.1）。 この場合は、

• IEEE 488.2構文エラーがパーサによって検出されています （IEEE 488.2規格に違反した制御－デバイス ・ メ ッセージ

を受信しました。 考えられる違反には、 デバイス ・ リ ッ スン形式に違反するデータ要素や、 デバイスが受け入れるこ

とができないタイプのデータ要素が含まれます）、 または

• 認識されないヘッダを受信しました。 これには、 不適切なデバイス固有ヘッダや、 誤っているか実装されていない

IEEE 488.2共通コマンドが含まれます。

エラー ・ メ ッセージ ・ ファイル

エラー ・ メ ッセージの完全な リ ス トは、 測定器に付属のCDROMに収録されています。 エラー ・ メ ッセージ ・ ファ イルに

は通常、 エラーの意味をさらに明確にするため、 各エラーと共に説明が含まれています。 エラー ・ メ ッセージは数字でリ

ス ト されています。同じエラー番号に対して複数のメ ッセージを リ ス トする場合は、メ ッセージはアルファベッ ト順になっ

ています。
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 ト ラブルシューテ ィ ング
フロン ト ・ パネルのテス ト
フロン ト ・ パネルのテスト

すべての表示ピクセルを選択した色に設定します。

通常動作に戻すには、 任意のキーを押します。

RF On/Off、 Mod on/Off、 More LEDを点滅させます。

正しい操作 ：

Full CCW＝–10
Full CW＝10

キーボード ・ マップを表示します。

キーを押すと、 マップにキーの位置が示されます。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。
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ト ラブルシューテ ィ ング
セルフテス トの概要
セルフテストの概要

セルフテス トは、 信号発生器のさまざまな機能をチェッ クする一連の内部テス トです。 セルフテス トは、 リモート Webイ

ンタフェース経由でも実行できます。 WebイネーブルMXGの詳細については、 『プログラ ミ ング ・ ガイ ド』 を参照して く

ださい。

各キーの詳細については、 42ページの説明に

従ってキーのヘルプを使用して ください。

診断セルフ ・ テス ト を自動的に

実行します。

セルフテスト ・サマリには現在

のステータスが表示されます。

Test Editor表示でテーブルを開き、

ユーザが特定のテス ト を選択して

詳細を表示できるようにします。

Utility > Instrument Info

強調表示されたテス トの

詳細情報を表示します。42
ページを参照して く ださ

強調表示された操作を実

行します。

選択された操作をすべて

実行します。

強調表示された操作を選

択または選択解除します。

すべての操作を選択また

は選択解除します。

フ ェールが発生するまで

選択されたテス ト を繰り

返し実行します。

Go Toメニューを開きます。

セルフテスト ・ メニューに

ナビゲーショ ン ・キーを追

加します。
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 ト ラブルシューテ ィ ング
セルフテス トの概要
注記 1E1オプシ ョ ンがない （アッテネータがない） N5183A MXGでは、Self Test Summaryウ ィンド ウに次の警告メ ッ

セージが表示されます。

アッテネータを持つ測定器の場合は、 セルフテストの実行前にアッテネータが自動的に最大値に設定され、 終了時に公称値にリセッ ト されます。
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ト ラブルシューテ ィ ング
ライセンス
ライセンス

注記 測定器にA.01.50 ファームウェアがロード されている場合は、 購入から 2年経つと、 MXGに次のタイムベース ・

エラー ・ メ ッセージが表示されるこ とがあ り ます。 "AUS license expires in xxd days. （AUSラ イセンス

がxxd日後に期限切れになり ます） Contact Agilent Technologies to renew." （Agilentに連絡して更新し

て ください） このエラー・ メ ッセージは、 90日間に3回繰り返されます （1回目は残り 90～60日、 2回目は残り 59
～30日、 最後は残り 30～0日）。

このメ ッセージは無視してかまいません。このエラーはMXGの性能に関する問題を示すものではあ り ません。ど

れかのソフ ト キーを押すと、 メ ッセージはク リ アされ、 測定器は正常に使用できます。

新しいバージ ョ ンのファームウェアをダウンロードする と、AUSラ イセンス関連のエラー・ メ ッセージは表示さ

れなくな り ます。

タイムベース ・ ライセンスが動作しな く なった

• 測定器の時間または日付が進められたために、 タイムベース ・ ラ イセンスの有効期限が終了した可能性があ り ます。

• 測定器の時間または日付が約25時間以上過去に戻されたために、 測定器がタイムベース ・ ラ イセンスを無視している

可能性があ り ます。

時間と日付を設定する際の詳細と注意については、 28ページを参照して ください。

タイムベース ・ ライセンスをロードできない

測定器の時間または日付が約25時間以上過去に戻されたために、 測定器がタイムベース ・ ラ イセンスを無視している可能

性があ り ます。

時間と日付を設定する際の詳細と注意については、 28ページを参照して ください。

Agilent Technologiesへの問合せ方法

• 電子計測へのニーズに関わるサポート、 および最寄りのAgilentオフ ィ スに関する情報 ：

http://www.agilent.co.jp/find/assist

• アクセサリ またはドキュ メン ト ： http://www.agilent.co.jp/find/mxg

• 新しいファームウェア ・ リ リース ： http://www.agilent.co.jp/find/upgradeassistant

インターネッ トにアクセスできない場合は、 フ ィールド ・ エンジニアにお問い合わせください。

注記 通信や電話で信号発生器について説明する際には、モデル番号とシ リ アル番号全体を使用してください。Agilent
の営業担当は、 この情報を使用してお使いのユニッ トが保証期間内にあるかど うかを判断します。

信号発生器をAgilentに返送する

信号発生器をサービスのためAgilent Technologiesに返送するには、 以下の手順に従ってください。

1. 信号発生器の問題に関して、 できるだけ多くの情報を収集します。
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 ト ラブルシューテ ィ ング
Agilent Technologiesへの問合せ方法
2. インターネッ ト （http://www.agilent.co.jp/find/assist） に掲載されている最寄りの地域の電話番号に連絡します。 イ

ンターネッ トにアクセスできない場合は、 Agilentフ ィールド ・ エンジニアにお問い合わせください。

信号発生器とその状態に関する情報をお伝えいただいた後で、 修理のための信号発生器の返送先についての情報をお

知らせします。

3. 信号発生器を送る際には、 信号発生器を適切に保護するため、 元の出荷時の梱包材料を使用する （可能な場合） か、

同様の梱包材料を使用します。
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ト ラブルシューテ ィ ング
Agilent Technologiesへの問合せ方法
328 Agilent N5161A/62A/81A/82A/83A MXG信号発生器ユーザーズ ・ ガイ ド



用語集

A

Active Entry （アクティブ ・ エン ト リ ）　現在選択されて

編集可能になっているエン ト リ またはパラ メータ

ARB　任意波形発生器

AWG　任意波形発生器。 相加性白色ガウス雑音

B

BBG Media （BBG媒体）　ベースバン ド ・ ジェネレータ ・

メディアÅB揮発性メモ リで、こ こで波形ファ イルが再生ま

たは編集されます。

BNC Connector （BNCコネクタ）　

Bayonet Neill-Concelmanコネク タ。同軸ケーブルを終端す

るために使用されるRFコネクタのタイプです。

C

CCW　反時計回り

C/N　搬送波対雑音比

CW　連続波。 時計回り

D

DHCP　ダイナミ ッ ク ・ ホス ト通信プロ ト コル

Dwell Time （持続時間）　 ステップ掃引(49ページを参照)
で、 信号がセ ト リ ングし、 掃引が以下のポイン トに移動す

る前に測定を実行できる時間。

E

EVM　エラー・ベク トル振幅。理想基準信号と測定信号間

の与えられた時間におけるベク トル差の大きさです。
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Filter factor Alpha （フ ィルタ係数α）　フィ ルタのα係数。

ルート ・ ナイキス ト ・ フ ィルタ とナイキス ト ・ フ ィルタに

対してのみ有効です。

Filter Factor BbT （フ ィルタ係数BbT）　 フ ィルタの帯域

幅ビッ ト時間(BbT)。ガウシアン・フ ィルタに対してのみ有

効です （αに類似）。 BbTは、 GSM規格では0.3、 DECT規格

では0.5と定義されています。

G

Gaussian filter （ガウシアン ・ フ ィルタ）　ガ ウ シ ア ン ・

フ ィルタは、 符号間干渉(ISI)がゼロではあ り ません。 無線

システムのアーキテクチャを設計する際に、 システムでど

の程度のISIが許容できるかを判断し、それをノ イズおよび

干渉と組み合わせる必要があ り ます。 ガウシアン ・ フ ィル

タは、 タイム ・ ド メ イン と周波数ド メ インの両方でガウシ

アン形状を持ち、 ルート ・ ナイキス ト ・ フ ィルタ とは異な

り リ ンギングがあ り ません。 このフ ィルタのタイム ・ ド メ

インでの効果は比較的短く、 各シンボルが有意な相互作用

を持つ （すなわちISIが生じる） のは前後のシンボルとの間

だけです。 このため、 特定のシンボルのシーケンスが相互

作用する可能性が少なく、 増幅器の作成が容易である と と

もに効率も改善できます。

GPIB　汎用インタフェース ・バス。テス ト機器で広く使用

されている8ビッ トのパラレル ・ バスです。

H

Hardkey （ハードキー）　測定器上のラベルが付いたボタン

I

IF　中間周波数

Int Media （内部メディア）　内部メディア。 信号発生器の

不揮発性メモリで、こ こに波形ファイルがス ト アされます。

IP　 インターネッ ト ・ プロ ト コル。 イーサネッ ト ・ ネッ ト

ワークで広く使用されているTCP/IPプロ ト コル・ スイート

のネッ ト ワーク層です。
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L

LAN　 ローカル ・ エ リ ア ・ ネッ ト ワーク

LO　局部発振器

LXI　測定用のLAN拡張。 小型および中型システムにモ

ジュラ方式、 柔軟性、 性能を提供する、 業界標準のイーサ

ネッ ト ・テク ノ ロジーをベースのした測定プラ ッ ト フォー

ムです。http://www.lxistandard.orgも参照して ください。

M

Modulation Format （変調フォーマッ ト ）　カスタム変調、

2 トーン、 マルチトーンのいずれか。

Modulation Mode （変調モード）　デュアルARB、 カスタ

ム変調、 2 トーン、 マルチ トーンのいずれか。

Modulation Standard （変調規格）　携帯電話の規格

（NADC、 PDC、 PHSなど） を表す。

変調方式　 さ まざまなI/Q コ ンス タ レーシ ョ ン ・ タ イプ

（PSK、 MSK、 FSK、 C4FMなど） を表す。

N

Non−volatile （不揮発性）　電源を入れ直しても消えない

こ と （USBメディアに保存されたファ イルなど）。

Nyquist filter （ナイキス ト ・ フ ィルタ）　 コサイン ・ フ ィ

ルタ と も呼ばれます。 このフ ィルタの特性は、 インパルス

応答がシンボル ・ レート で リ ンギングを起こすこ とです。

中央のシンボル時間 （目的のもの） 以外のシンボル時間で

は応答がゼロになるので、隣接するシンボル同士がシンボ

ル時間で干渉しません。

P

Persistent （恒久）　プ リセッ ト 、ユーザ・プ リセッ ト 、 ま

たは電源の入れ直しによ り影響を受けないこ と。

Point-to-point Time （ポイン ト ツーポイン ト時間）　

ステップ掃引 （49ページを参照） で、 持続時間、 処理時
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間、 スイ ッチング時間、 セ ト リ ング時間の合計

R

Rectangular filter （方形フ ィルタ）　理想ローパス ・ フ ィ

ルタ と も呼ばれます。 このフ ィルタは、 きわめて急峻な

カッ トオフ特性を持っています。通過帯域は信号のシンボ

ル・レート と等し く設定されます。係数の数が有限なので、

フ ィルタは定義済みの長さを持ち、 理想的ではあ り ませ

ん。 カッ トオフ帯域に生じる リ ップルは、 ハミ ング窓関数

を使用するこ とで最小化できます。 このフ ィルタは、 ACP
を最高にするために適しています。 このフ ィルタでは、 シ

ンボル長を32以上にするこ とが推奨されます。

Root Nyquist filter （ルート ・ ナイキス ト ・ フ ィルタ）　

ルート ・ コサイン ・ フ ィルタ と も呼ばれます。 このフ ィル

タの特性は、 インパルス応答がシンボル・ レートで リ ンギ

ングを起こすこ とです。中央のシンボル時間（目的のもの）

以外のシンボル時間では応答がゼロになるので、隣接する

シンボル同士がシンボル時間で干渉しません。 ルート ・ナ

イキス ト ・ フ ィルタでは、信号に強いフ ィルタ リ ングをか

けても、シンボル時間でシンボル同士が干渉し合う こ とが

あ り ません。これは、ISIから生じるエラーなしに情報を伝

送するために重要です。 ただし、 シンボル （決定） 時間以

外の時間には、 ISIが存在します。 このフ ィルタを2つカス

ケード接続する と、伝達関数がナイキス ト ・ フ ィルタ と一

致します。 1つを ト ランス ミ ッ タ、 1つをレシーバに使用す

れば、 システム全体でISIがゼロ という ISIフ ィルタの特性

を示します。

RMS　実効値。時間変化する信号の実効値 （与えられた抵

抗で等価の熱量を生成するために必要な等価DC電圧）。 正

弦波の場合は、 RMS＝0.707×ピーク値です。

S

Softkey （ソフ ト キー）　測定器ディ スプレ イに沿って配

置されたボタン。ディ スプレイ上でボタンの横に表示され

ている機能を実行します。

T

TCP　伝送制御プロ ト コル。 イーサネッ ト と インターネッ

ト で使用されている最も一般的な ト ランスポー ト層のプ

ロ ト コルです。
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Terminator （ターミネータ）　入力を完了するための単位

インジケータ （Hz、 dBmなど）。 例えば、 入力が100 Hzの
場合は、 Hzがターミネータです。

Type-N Connector （N型コネクタ）　同軸ケーブルの結合

に使用されるネジ式RFコネクタ

U

USB　ユニバーサル・シ リ アル・バス。http://www.usb.org
も参照してください。

User FIR （ユーザFIR）　ユーザ定義の係数値のセッ ト を

選択します。 FIR値テーブルの各行には、 それぞれ1つの係

数値が含まれます。 係数値の数は、 選択したオーバーサン

プリ ング比の倍数でなければなり ません。 各係数は、 IとQ
の両方の成分に適用されます。

V

Volatile （揮発性）　電源を入れ直すと 消えるこ と （BBG メ

ディアに保存されたファイルなど）。
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索引
記号

# pointsソフ ト キー , 52
# Skipped Pointsソフ ト キー , 160
ΦM

DCオフセッ ト、 除去, 79
インジケータ , 11, 13
ソフ ト キー , 77, 79
ハードキー , 77

数字

10 MHz OUTコネクタ , 17, 23
100Base-T LANケーブル, 31
128 QAMソフ ト キー , 267
1410、 アプ リ ケーシ ョ ン ・ ノート , 296
16-Lvl FSKソフ ト キー , 267
16QAMソフ ト キー , 267
256 QAMソフ ト キー , 267
2-Lvl FSKソフ ト キー , 267
2 トーン , 264, 296–301
2 トーン波形、 セッ ト アップ, 295
2 トーン用ソフ ト キー , 297
32QAMソフ ト キー , 267
430、 オプシ ョ ン

2 トーン, 296
2 トーン ・ モード , 296
マルチトーン ・ モード , 302

4-Lvl FSKソフ ト キー , 267
4QAMソフ ト キー , 267
5パッ ク

警告メ ッセージ, 248
ステータス ・ メ ッセージ, 240
ラ イセンス , 237
ラ イセンス、 インス トール, 237
ラ イセンス、 概要, 237
ラ イセンス、 波形ファ イル, 238
履歴、 波形ファ イル, 244

628、 エラー , 194
64QAMソフ ト キー , 267
651/652/654、 オプシ ョ ン

2 トーン ・ モード , 296
説明, 4
マルチトーン ・ モード , 302

670/671/672、 オプシ ョ ン

説明, 4
8557D GPIB onlyソフ ト キー , 33, 35
8648A/B/C/D GPIB onlyソフ ト キー , 33, 35
8656B,8657A/B GPIB onlyソフ ト キー , 33, 35
8-Lvl FSKソフ ト キー , 267

A
ACP, 264
Activate Secure Displayソフ ト キー , 26
Active Highソフ ト キー , 173
Active Lowソフ ト キー , 173
AC電源コンセン ト , 15, 21
Add Comment Toソフ ト キー , 70

Adjust Phaseソフ ト キー , 45, 47
Adjustable doubletソフ ト キー , 130
Advanced Settingsソフ ト キー , 31
Aeroflexソフ ト キー , 33, 35
Agilent MXG

動作モード , 4
Agilentセールスおよびサービス ・ オフ ィ ス , 326
ALC

OFFインジケータ , 11, 13
オフ ・ モード , 112
設定, 47
ソフ ト キー , 45, 47, 160
ホールド , 156, 157

ALC入力

コネクタ , 24
Allソフ ト キー , 64
AM

インジケータ , 11, 13
外部変調源, 79
広帯域, 79
コネクタ , 16, 22
ソフ ト キー , 77
ハードキー , 77

AMPTDハードキー , 45, 47
APCO 25 w/C4FMソフ ト キー , 266
APCO 25 w/CQPSKソフ ト キー , 266
Apply To Waveformソフ ト キー , 160
ARB, 264

ソフ ト キー , 140, 171, 250, 251, 252, 253, 258
定義, 329
波形ク リ ッピング, 179
プレーヤ、 デュアル, 140

Arb Segmentソフ ト キー , 69
Arb Sequenceソフ ト キー , 69
Arb Setup

ソフ ト キー , 217
ARBカスタム

FIRテーブル ・ エディ タ , 284
FIRフ ィルタ , 279

ARMEDインジケータ , 11, 13
ASK Depthソフ ト キー , 267
ASKソフ ト キー , 267
ATTEN HOLDインジケータ , 11, 13
Atten/ALC Controlソフ ト キー , 45, 47
AUTOGEN_WAVEFORMファ イル, 264
auto-IP, 31
Auto-IPソフ ト キー , 31
Automatically Use USB Media If Presentソフ ト キー , 64
Autoソフ ト キー

(DHCP/Auto-IP), 31
Auto, 112
Recall, 128

AUX I/Oコネク タ , 20
Auxiliary Software Optionsソフ ト キー , 38
AWGN

インジケータ , 11, 13
ソフ ト キー , 255
追加, 249
Agilent N5181A/82A MXG信号発生器ユーザーズ ・ ガイ ド 333



索引
定義, 329
デュアルARBプレーヤ, 249

AWGNソフ ト キー , 250, 251, 252, 253

B
Bandwidthソフ ト キー , 255
BB GEN, 200
BBG

Memory to USBソフ ト キー , 69
Memoryソフ ト キー , 69
Segmentsソフ ト キー , 64, 149
媒体, 140, 142
メディア （定義） , 329
ルーティング, 200

BBG同期, 218
機器セッ ト アップ, 222
再同期, 224
システム , 221
システム遅延, 221
セッ ト アップの設定, 222
ト リ ガ ・ セッ ト アップ, 221

BbT, 329
Binaryソフ ト キー , 64
Bk Spハードキー , 43
Bluetoothソフ ト キー , 266, 267
BNC, 329
Bright Colorソフ ト キー , 26
Brightnessソフ ト キー , 26
Buffered Trigソフ ト キー , 173
Build New Waveform Sequenceソフ ト キー , 145, 169
Burst Envelopeソフ ト キー , 198
Busソフ ト キー , 49

C
C/N, 329
C4FMソフ ト キー , 267
Calculateソフ ト キー , 149
Calibration Typeソフ ト キー , 203
Cancelハードキー , 6
Carrier Bandwidthソフ ト キー , 250, 251, 252, 253
Carrier to Noiseソフ ト キー , 250, 251
Carrier+Noiseソフ ト キー , 250, 252, 253
Carrierソフ ト キー , 250, 251, 252, 253
Catalog Typeソフ ト キー , 64, 65, 69, 149
ccw, 329
CDPDソフ ト キー , 266, 267
Channel Bandソフ ト キー , 45, 47
Channel Numberソフ ト キー , 45, 47
Clearソフ ト キー

Error Queue(s), 75
Header, 149
テキス ト , 43

Config Typeソフ ト キー , 31
Configureソフ ト キー

Cal Array, 91
List Sweep, 49, 57
Step Array, 91

Step Sweep, 52
ステップ掃引, 49

Confirm Load From Fileソフ ト キー , 68
Connection Monitoringソフ ト キー , 31
Connection Typeソフ ト キー

Sockets, 94
USB, 94
VXI-11, 94

Continuousソフ ト キー , 173
Contrastソフ ト キー , 26
Copy &ソフ ト キー

Play Sequence, 68
Play Waveform, 68
Select User Flatness, 68
Select User Flatness Corrections, 68

Copyソフ ト キー

All Files, 69
File, 64
File to Instrument, 64, 69
File to USB, 69

Create Directoryソフ ト キー , 64, 69
Custom ARBソフ ト キー , 265
cw, 329
CW (no modulation)ソフ ト キー , 57
CWモード

説明, 4

D
DACオーバーレンジ保護

位相雑音, 262
DACオーバレンジ ・ エラー , 189, 194
DACオーバレンジ保護

ベースバンド周波数オフセッ ト , 196
Dark Colorソフ ト キー , 26
DCFMΦ/DCfM Calソフ ト キー , 77
DCオフセッ ト , 136
DCオフセッ ト 、 除去, 79
DECTソフ ト キー , 266
Default Gatewayソフ ト キー , 31
Defaultソフ ト キー , 266
Deleteソフ ト キー

All Regs in Seq, 70
All Segments On Int Media, 142
All Segments On USB Media, 142
All Sequences, 70, 128
File, 64
File or Directory, 64, 66, 69, 74
Item, 57
Row, 57
Seq, 128
Seq Reg, 70
All Waveformsソフ ト キー , 169
すべてのシーケンス ・ ファ イル, 64
すべての波形, 145
選択された波形, 145, 169
波形シーケンス , 169

DETHTRインジケータ , 12, 13
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Deviceソフ ト キー , 45, 47
DHCP, 31, 329
DHCPソフ ト キー , 31
Diff Modeソフ ト キー , 201
DIGBUSインジケータ , 12, 14
Displayed Caseソフ ト キー , 43
Displayソフ ト キー

Case, 43
Waveform And Markers, 160
表示, 25

DNS Server Overrideソフ ト キー , 31
DNS Serverソフ ト キー , 31
Domain Nameソフ ト キー , 31
Dual ARB

ソフ ト キー , 141
プレーヤ, 140

Dwell Typeソフ ト キー , 57
Dynamic DNS Namingソフ ト キー , 31
Dynamic Hostname Servicesソフ ト キー , 31

E
E4428C、 E4438Cソフ ト キー , 33, 35
E442xB、 E443xBソフ ト キー , 33, 35
E8241A、 E8244A、 E8251A、 E8254Aソフ ト キー , 33, 35
E8247C、 E8257C、 E8267Cソフ ト キー , 33, 35
E8257D、 E8267Dソフ ト キー , 33, 35
EDGE

カスタム ・ デジタル変調、 定義済み, 269
EDGEソフ ト キー , 266
Editing Keysソフ ト キー , 43
Editing Modeソフ ト キー , 43
Editソフ ト キー

Noise RMS Override, 149
RMS, 149
繰り返し , 169
説明, 149
選択された波形シーケンス , 145, 169

EEPROM, 307
Enable/Disable Markersソフ ト キー , 145, 169
Enter Directoryソフ ト キー , 68
Errorハードキー , 75
ERRインジケータ , 12, 14
Escハードキー , 6
EVENT

コネクタ、 AUX I/O, 20
コネクタ、 BNC, 19, 155
出力, 155
出力ジッ タ , 171

EVENT出力のジッ タ , 171
EVM, 329
EVM誤差, 136
Execute Calソフ ト キー , 203
EXT CLOCKコネクタ , 18
EXT REFインジケータ , 11, 12, 13, 14
Extソフ ト キー

Ext, 49
Pulse, 130

F
Fileハードキー , 64, 73
First Mkr Pointソフ ト キー , 160
First Sample Pointソフ ト キー , 160
FIRテーブル ・ エディ タ

ARBカスタム , 284
アクセス , 208, 279
オーバーサンプリ ング比、 設定, 282
オーバサンプリ ング比、 設定, 211
係数、 値の入力, 208, 280
係数、 複製, 210, 282
係数、 変更, 215, 286
デュアルARB, 208, 213
ファ イル、 ロード , 214, 285
フ ィルタ
作成, 208, 279
変更, 213, 284
保存, 212, 216, 283, 287

FIRフ ィルタ

Hamming, 214, 285
Hann, 285
Hanning, 214
Kaiser, 214, 285
ARBカスタム , 279
アポディゼーシ ョ ン設定, 214, 285
ウ ィンド ウ設定, 214, 285
作成, 208, 279
使用法, 207, 279
変更, 213, 284
保存, 212, 283

Fixedソフ ト キー , 112
Flatnessソフ ト キー , 91
FM

DCオフセッ ト 、 除去, 79
インジケータ , 12, 14
外部変調源, 79
コネクタ , 16, 22
ソフ ト キー , 77
ハードキー , 77

Free Runソフ ト キー , 49, 119, 173
Free-Runソフ ト キー , 130
Freq Devソフ ト キー , 267
Freqソフ ト キー , 91
FREQハードキー , 45, 47
FSKソフ ト キー , 267
FTP Serverソフ ト キー , 32

G
Gatedソフ ト キー , 130, 173
Go To Default Pathソフ ト キー , 64, 66, 74
Goto Rowソフ ト キー , 57, 64
GPIB

コネクタ , 17, 23
セッ ト アップ, 30
ソフ ト キー

Address, 30
Setup, 30
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定義, 329
GSMソフ ト キー , 266

H
Helpハードキー , 7, 42
Hostnameソフ ト キー , 31
HP 3300A、 エ ミ ュレーシ ョ ン, 128

I
I Offsetソフ ト キー , 201
I OUTコネク タ , 18
I/O Configソフ ト キー , 25
I/Q

Int Equalization Filterのソフ ト キーの場所, 206
最適化, 199
信号経路、 最適化, 199
信号、 整列, 156
ソフ ト キー , 136, 198–204, 206
調整, 136, 201
波形、 ク リ ッピング, 179
フロン ト ・ パネルの入力、 使用, 137, 200
変調, 136, 198
リ ア ・ パネル出力, 18
リ ア ・ パネル出力、 使用, 199

IF, 329
Import Waveformソフ ト キー , 169
Incr Setハードキー , 8
Insertソフ ト キー

Item, 57
Row, 57
挿入, 145
波形, 145
波形シーケンスの内容, 145

Install Assemblyソフ ト キー , 39
Install licensesソフ ト キー , 68
Int Equalization Filter

ソフ ト キー , 206
Int Phase Polarityソフ ト キー , 198
Internal Baseband Adjustmentsソフ ト キー , 201
Internal Storage to USBソフ ト キー , 69
Internal/USB Storage Selectionソフ ト キー , 64
IP

Addressソフ ト キー , 31
auto, 31
アドレス、 設定, 31
定義, 329

IQマップ、 QAM変調, 288
Iコネクタ , 7

L
LAN

Services Setupソフ ト キー , 30
Setupソフ ト キー , 30
コネクタ , 17, 23
セッ ト アップ, 31
定義, 330

Last Mkr Pointソフ ト キー , 160
Lastソフ ト キー , 27
LCDディ スプレイ ・ メモ リ , 307
LED, 8, 10

点滅テス ト , 323
フロン ト ・ パネル, 8, 10
変調, 62

Listソフ ト キー , 64
LO, 330
Load From Selected Fileソフ ト キー , 66, 68
Load Listソフ ト キー , 68
Load/Storeソフ ト キー , 57, 66, 68
Loadソフ ト キー

Cal Array From Step Array, 91
From Selected File, 67, 68
Load/Store, 57, 67, 68
Sweep List, 68

Localハードキー , 6
LVDS

MXG, 2
PXB, 2

LXI, 330
ク ロ ッ クについて, 122
サブシステムの設定, 124
出力イベン トの設定, 126
使用法, 122
ト リ ガ入力イベン トの設定, 125
入門, 124

LXI、 オプシ ョ ンALB, 122, 124
Lインジケータ , 12, 14

M
Manualソフ ト キー , 112

Config Settings, 31
Manual, 31
Mode, 49
Point, 49

Markerソフ ト キー , 160
Mod On/Offハードキー , 7, 61, 62
Mod On/Off、 オプシ ョ ンUNT, 77
Mod Typeソフ ト キー , 267
Modeハードキー , 141, 250, 251, 252, 253, 255, 258
Modulatedソフ ト キー , 112
Modulator Attenソフ ト キー , 255
Monochromeソフ ト キー , 26
MSKソフ ト キー , 267
Multitoneソフ ト キー , 302
MULTインジケータ , 12, 14
MXG

LVDS, 2
MXG ATE N5161A/82Aのフロン ト ・ パネル機能, 9, 10

N
NADCソフ ト キー , 266
Name And Storeソフ ト キー , 169
Next REGソフ ト キー , 128
Next SEQソフ ト キー , 128
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No actionソフ ト キー , 68
No Retriggerソフ ト キー , 173
Noise Bandwidthソフ ト キー , 250
Noise Muxソフ ト キー , 252, 253
Noiseソフ ト キー , 250, 252, 253

O
OFFSインジケータ , 12, 14
Options Infoソフ ト キー , 38
Output Blankingソフ ト キー , 45, 47
Output Muxソフ ト キー , 250

P
Page Upハードキー , 6
PAT TRIG INコネク タ , 19
Patt Trig Inソフ ト キー , 174
PDCソフ ト キー , 266
Phase Ref Setソフ ト キー , 45, 47
PHSソフ ト キー , 266
Plot CDDFソフ ト キー , 188
PM Config

Calibrate Sensor, 94
Zero Sensor, 94

PM Configソフ ト キー

Connection Type, 94
PM VXI-11 Device Name, 94
Power Meter IP Address, 94
Power Meter IP Port, 94

Point Triggerソフ ト キー , 49
Power Control Modeソフ ト キー , 251
Power Search Referenceソフ ト キー , 112
Powerソフ ト キー

On, 27
On/Preset, 25
Search, 112

Presetソフ ト キー

Language, 27
List, 57, 91
Preset, 27

Prev REGソフ ト キー , 128
Prev SEQソフ ト キー , 128
Proceed With Reconfigurationソフ ト キー , 31, 32
PSKソフ ト キー , 267
Pulse/RF Blankソフ ト キー , 160
Pulseソフ ト キー , 49
Pulseハードキー , 130
PWTソフ ト キー , 266
PXB

LVDS互換性, 2
PXBとのLVDS互換性, 2

Q
Q Offsetソフ ト キー , 201
QAMソフ ト キー , 267
QAM変調のIQマップ, 288
Quadrature Angle Adjustmentソフ ト キー , 136, 201

Quick Setupソフ ト キー , 266
Qコネク タ , 8

R
RAM, 307, 309
Recallキー

Instrument State, 64, 68
Reg, 128
State, 68
ハードキー , 128

Recallハードキー , 70
REF INコネクタ , 17, 22
Ref Oscillator Ext Bandwidthキー , 46
Ref Oscillator Ext Freqキー , 46
Ref Oscillator Sourceソフ ト キー , 45, 47
Ref Oscillator Tuneキー , 29
REFインジケータ , 12, 14
Remote Languageソフ ト キー , 30, 33, 35
Remove Assemblyソフ ト キー , 39
Rename Fileソフ ト キー , 64
Rename Segmentソフ ト キー , 142
Reset & Runソフ ト キー , 173
Restart on Trigソフ ト キー , 173
Restoreソフ ト キー

LAN Settings to Default Values, 31
System Settings to Default Values, 27

Returnハードキー , 8
Reverse Power Protectionソフ ト キー , 27
Revert to Default Cal Settingsソフ ト キー , 203
RF

出力
コネク タ , 7
設定, 46
ト ラブルシューティング, 316
レベリ ング、 外部, 104–111

ハードキー , 7
ブランキング
設定、 保存, 156
マーカ機能, 166

RF During Power Searchソフ ト キー , 112
RF Outputソフ ト キー , 198, 199
RFC NETBIOS Namingソフ ト キー , 31
RMS, 330
RMSソフ ト キー , 112
Rohde & Schwarzソフ ト キー , 33, 35
Route Connectorsソフ ト キー , 49, 130
Route Toソフ ト キー , 49, 130
RPGテス ト , 323
Rインジケータ , 12, 14

S
SAVE Seq Regソフ ト キー , 70
Save Setup To Headerソフ ト キー , 149
Saveハードキー , 70
Scale Waveform Dataソフ ト キー , 188
SCPI

ソフ ト キー , 33, 35
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有効化, 32
リ ファレンスの内容, xiii

Screen Saverソフ ト キー , 26
Securityソフ ト キー , 64
Segment Advanceソフ ト キー , 173
Select Seqソフ ト キー , 128
Selectソフ ト キー

Color Palette, 26
Internal File(s) to Copy to USB, 69
Reg, 70
Seq, 70
Waveform, 57

Selectハードキー , 43
Sequenceソフ ト キー , 64, 149
Set Markerソフ ト キー , 160
Showソフ ト キー

Alpha Table, 43
波形シーケンス , 145
波形シーケンスの内容, 145, 169

Signal Studio, 3
Signal Studioラ イセンス , 37
Single Sweepソフ ト キー , 49
Singleソフ ト キー , 173
Sockets SCPIソフ ト キー , 32
Source Settledソフ ト キー , 49, 130
Spanソフ ト キー , 112
Specify Default Storage Path for User Mediaソフ ト キー , 64
Squareソフ ト キー , 130
Stateソフ ト キー , 64
Step Dwellソフ ト キー , 52, 119
Step Spacingソフ ト キー , 52
Step/Knob Ratioソフ ト キー , 28
Storage Typeソフ ト キー , 66, 74
Store Custom Dig Mod Stateソフ ト キー , 268
Store To Fileソフ ト キー , 66, 67, 68
Stored Segmentsソフ ト キー , 64, 149
Subnet Maskソフ ト キー , 31
Sumソフ ト キー , 198
Sweepソフ ト キー , 49–??, 69, 130, ??–61
SWEEPハードキー , 49
SWMANインジケータ , 12, 14
Sインジケータ , 12, 14

T
TCP, 330, 331
TCP Keep Aliveソフ ト キー , 31
TDMA

カスタム ・ デジタル変調、 定義済み, 269
TDMAデジタル変調, 269
TETRAソフ ト キー , 266
Time/Dateソフ ト キー , 28
Timer Triggerソフ ト キー , 49, 119
Toggleソフ ト キー , 169
Total Noiseソフ ト キー , 251
Totalソフ ト キー , 251
Trig

inコネクタ , 16, 22

outコネク タ , 16, 22, 49
出力信号, 49

Triggeredソフ ト キー , 130
Triggerソフ ト キー

Doublet, 130
Key, 49
Out Polarity, 49
ト リ ガ, 130

Tインジケータ , 12, 14

U
UNLEVELインジケータ , 12, 14
UNLOCKインジケータ , 12, 14
Unspecifiedソフ ト キー , 149
UNT、 オプシ ョ ン, 4
UNU、 オプシ ョ ン , 4
UNW、 オプシ ョ ン , 4
Up Directoryソフ ト キー , 64, 66, 69
Update in Remoteソフ ト キー , 26
urls, 3, 29, 37, 326
USB

to BBG Memoryソフ ト キー , 69
to Internal Storageソフ ト キー , 69
キーボード、 使用, 128
ソフ ト キー

Keyboard Control, 128
ファ イル ・ マネージャ , 64, 65

定義, 331
デバイス ・ コネク タ , 17, 23
ト ラブルシューティング, 321
ホス ト ・ コネク タ , 5, 9
メディアの接続, 74

Userソフ ト キー

Configure Power Meter, 91
Current Directory As Default Path, 66
Do Cal, 91
Flatness, 45, 47, 64
Flatness Corrections, 69
Span, 112
User, 27
フラ ッ ト ネス補正, 91

Useソフ ト キー

As, 68
Current Directory As Default Path, 64, 74
Only Internal Storage, 64
Only USB Media, 64

Utilityソフ ト キー , 39
Utilityハードキー , 25

V
View Next Error Pageソフ ト キー , 75
View Previous Error Pageソフ ト キー , 75
VXI-11、 有効化, 32
VXT-11 SCPIソフ ト キー , 32

W
Waveformソフ ト キー
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Waveform, 49, 57
ラ イセンス , 38

Web Serverソフ ト キー , 32
WINITインジケータ , 12, 14

Z
Zoomソフ ト キー , 160
Z軸出力

コネクタ , 23

あ

アクティブ
エン ト リ , 329
入力エリ ア, 11

アドバンス、 セグメン ト , 175
アドレス、 GPIB, 30
アナログ変調, 4, 77
アプリ ケーシ ョ ン ・ ノート

1410, 296
アポディゼーシ ョ ン設定、 FIRフ ィルタ , 285, 214
α, 329
イコラ イゼーシ ョ ン
フ ィルタ , 205
フ ィルタ、 ユーザ, 205

位相雑音
DACオーバーレンジおよびスケーリ ング, 262
信号劣化, 257
説明とプロ ッ ト , 259
ソフ ト キー , 258
調整, 261

位相スキュー , 136
イ メージ, 136
インジケータ , 11, 13
インス トール ・ ガイ ドの内容, xiii
インタフェース

GPIB, 30
LAN, 31

ウ ィンド ウ設定、 FIRフ ィルタ , 285, 214
エラー ・ メ ッセージ, 75

DACオーバレンジ, 189, 194
タイプ, 322
表示エリ ア, 13
ファ イル, 322
メ ッセージ ・ フォーマッ ト , 75

円ク リ ッピング, 183, 186
エン ト リ、 アクテ ィブ, 329
オーバーレンジ ・ エラー、 DAC, 262
オーバシュート , 189
オーバレンジ ・ エラー、 DAC, 189, 196
オプシ ョ ン

UNT, 4
UNU, 4
UNW, 4
430

2 トーン ・ モード , 296
マルチトーン ・ モード , 302

651/652/654

2 トーン ・ モード , 296
説明, 4
マルチトーン ・ モード , 302

670/671/672、 説明, 4
有効化, 25, 37
リ ソース , 3

オプシ ョ ン221～229, 237
オプシ ョ ン22x, 237
オプシ ョ ン250～259, 229
オプシ ョ ンALB、 LXI, 122, 124
オプシ ョ ンU01, 99, 101
内部チャネル補正, 99, 101

オプシ ョ ンUNT
Mod On/Offハードキー , 77

オフセッ ト , 136
I/Q, 201
出力、 使用法, 115
ベースバンド周波数, 194

オン／オフ ・ スイ ッチ, 8, 10

か

回転ノブ, 43
ガイ ド、 内容, xiii
外部

I信号とQ信号, 200
基準発振器、 使用法, 46
ト リ ガ, 178
ト リ ガ ・ ソース , 176, 178
変調源, 79
メディア, 74, 321

外部ソフ ト キー
外部, 198
出力, 201
入力, 201
入力Iオフセッ ト , 136
入力Qオフセッ ト , 136

外部用ソフ ト キー
Delay, 174
Delay Time, 174
I/Q Output, 198, 199
Source, 174

外部レベリ ング, 104–111
ソフ ト キー , 104

外部レベリ ング、 設定, 108
概要、 信号発生器, 1
ガウシアン
定義, 329

ガウシアン ・ フ ィルタ、 デフォルトのロード , 285
ガウス、 AWGNを参照

ガウス ・ フ ィルタ、 デフォル トのロード , 214
拡張子、 ファ イル, 68
角度、 直交, 136
カスタム

TDMAデジタル変調, 269
マルチキャ リ アTDMA波形

作成, 276
カスタム任意波形発生器, 4
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カスタム変調
波形への追加, 269
波形、 への追加, 269

カスタム ・ モード , 264
カタログ、 ステート ・ ファ イル, 73
カラー ・ パレッ ト 、 ディ スプレイ , 26
キー
数字, 6
テス ト , 323
特定のキーも参照
のヘルプ, 42
フロン ト ・ パネル, 5, 9
無効にする , 313

キーボード、 使用, 128
黄色のLED, 8, 10
規格、 変調, 330
機器

ステート
レジスタ、 データ ・ ス ト レージを参照

機器セッ ト アップ, 222
機器、 ユーザ ・ フラ ッ ト ネス補正, 92, 93
基準発振器のチューニング、 内部, 29
基準発振器、 外部, 46
基準、 使用法, 116
揮発性メモ リ , 140, 142
揮発性、 定義, 331
基本的な操作、 基本操作を参照
機密、 セキュ リ テ ィを参照
極性、 外部ト リガ, 174
極性、 マーカ、 設定, 168
ク イ ッ ク ・ セッ ト アップ

Defaultソフ ト キー

設定, 266
ク リ ッピング
円, 183, 186
ソフ ト キー , 179
長方形, 184, 187

ク ロスオーバー ・ ケーブル, 31
ク ロ ッ ク、 サンプ リ ング ・ レート , 20
係数値、 入力, 208, 280
経路遅延, 136
ゲーティ ッ ド ・ ト リ ガ, 174, 176
ケーブル

クロスオーバー , 31
マルチBBG同期, 221

ケーブル、 100Base-T LAN, 31
恒久設定

定義, 330
デフォルトの復元, 27
リ セッ ト , 42

恒久的
メモ リ , 309

工場設定、 復元, 27, 31, 203
校正

I/Q, 203
ソフ ト キー , 203
データ , 307
データ ・ メモ リ , 309

広帯域AM, 79

コサイン ・ フ ィルタ
コネク タ
外部ト リ ガ ・ ソース , 176, 178
信号のルーティング, 49
フロン ト ・ パネル, 5, 9
リ ア ・ パネル

N5161A, 15
N5162A, 15
N5181A, 15
N5182A, 15
N5183A, 21

コ メン ト 、 追加および編集 （機器ステート ） , 71
コン ト ラス ト調整, 26
コンポーネン ト ・ テス ト , 264

さ

サーチ、 パワー , 113
サーバ、 有効化, 32
サービス

Agilentオフ ィ ス , 326
ガイ ドの内容, xiii
リ クエス ト ・ インジケータ , 12, 14

最適化、 I/Q, 136, 198
再同期、 マルチBBG, 224
雑音

I/Q調整, 136
雑音帯域幅ファ ク タ , 249
差動エンコード , 287
差動エンコード、 シンボルあたりのビッ ト数, 289
差動ステート ・ マップ、 シンボルあたりのビッ ト数, 289
サンプリ ング ・ レート ・ ク ロ ッ ク , 20
サンプリ ング ・ レート ・ ソフ ト キー , 171
シーケンス
再生, 148
波形, 145
ファ イル ・ ヘッダ, 149
編集, 147
マーカ制御, 168

シーリ ング関数、 シンボルあたりのビッ ト数, 289
時間、 持続, 329
時間、 設定, 28
時間／日付基準ポイン ト , 28
システム ・デフォルト 、 復元, 27
持続時間, 57, 329
実効値, 330
周波数

オフセッ ト , 115
オフセッ ト 、 ソフ ト キー , 194
オフセッ ト 、 ベースバンド , 194
基準, 116
乗数, 117
ステップ掃引, 53
設定, 45, 47
ソフ ト キー , 45, 47
ハードキー , 7, 8, 45, 47
表示エリ ア, 11
変調, 77
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周波数単位, 45
出力、 掃引, 48
手動制御、 掃引, 61
乗数、 使用法, 117
情報、 メモ リから除去, 310
シ リ アル ・ データ、 同期, 20
信号源安定信号, 49
信号発生器

モード , 4
信号劣化、 リ アルタイム

位相雑音, 257
振幅

オフセッ ト , 115
基準, 116
設定, 45, 47
掃引のト ラブルシューティング, 320
ハードキー , 45, 47
表示エリ ア, 12
変調, 77

シンボルあたりのビッ ト数、 式, 289
スイ ッチ、 電源, 8, 10
スキュー、 I/Q, 201
スク リーン ・ セーバ設定, 26
スケーリ ングのソフ ト キー , 188
ステート、 恒久, 330
ステップ掃引
間隔, 49
使用法, 49
ト ラブルシューティング, 320

ステップ配列 （ユーザ ・ フラ ッ ト ネス） , 96
ユーザ ・ フラ ッ ト ネス補正も参照

スペク ト ラム ・ リ グロース , 182
スペク ト ラム ・アナライザ、信号断の ト ラブルシューティング, 317
正弦波, 330
性能、 最適化, 81
セールス、 Agilentオフ ィ ス , 326
セキュア
ディ スプレイ , 313
モード , 312

セキュ リテ ィ , 307
セグメン ト

アドバンス ・ ト リ ガ, 175
ソフ ト キー , 142
ファ イル ・ ヘッダ, 149
保存、 ロード、 再生, 142
ロード , 142

セグメン ト ・ アドバンス ・ ト リ ガ, 173
設定、 位相雑音, 261
設定、 恒久, 330
説明とプロ ッ ト 、 位相雑音, 259
セルフテス ト , 324
選択用ソフ ト キー

Different Header, 149, 153
Header, 149

掃引
outコネク タ , 15, 21, 49
インジケータ , 12, 14
出力信号, 49

手動制御, 61
ステップ, 49
ソフ ト キー , 49–61, 130
対数, 49
ト ラブルシューティング, 320
ハードキー , 49
波形、 を含む, 59
モード , 4
リ ス ト ・ ステータス情報, 58
リ ス ト ・ パラ メータ , 58
リ ニア, 49

掃引出力, 48
相加性白色ガウス雑音、 AWGNを参照

操作、 基本, 41
操作、 リモート , 30
測定器

8757Dスカラ ・ ネッ ト ワーク ・ アナライザ, 55
スカラ ・ ネッ ト ワーク ・ アナライザ, 55
ステート

ソフ ト キー , 69
波形との対応付け, 71
ファ イル, 70, 73

ソフ ト キー
Adjustments, 25
Info, 25
オプシ ョ ン , 38

ファームウェア、 アップグレード , 29
ソケッ ト 、 有効化, 32
ソフ ト キー
位置, 5
定義, 330
特定のキーも参照
のヘルプ, 42
ラベル ・ エ リ ア, 13

た

ターミネータ , 331
待機 （黄色） LED, 8, 10
タイムベース ・ ラ イセンス , 28, 326
ダブレッ ト

ソフ ト キー , 130
調整可能, 132
ト リ ガ, 132

遅延
I/Q, 201
複数BBG同期, 221

調整
I/Q, 136, 201
直交位相, 201
リ アルタイム位相雑音, 261

長方形ク リ ッピング, 184, 187
直交位相調整, 201
直交角度, 136
ディ スプレイ

概要, 13
概要、 N5161A/62A, 13
セキュア, 313
設定, 26
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ト ラブルシューティング, 316
ブランキング, 313
メモ リ , 307

データ
記憶装置

コ メン ト 、 追加および編集, 71
タイプ, 74

校正, 307
消去, 310
除去, 310
シ リ アル ・ 同期, 20
ス ト レージ
使用法, 63
ト ラブルシューティング, 321

入力用ソフ ト キー , 43
ファ イル, 63–70

テキス ト入力ソフ ト キー , 142
テキス ト ・ エ リ ア （ディ スプレイ上） , 13
デジタル信号からアナログ波形, 189
デジタル動作, 139, 229, 237
デジタル変調

2 トーン, 296–301
IQマップ、 QAM, 288
TDMA, 269
フォーマッ ト , 4
マルチトーン , 302–305

デジタル変調方式
変更, 272

デジタル ・ バス , 19
テス ト 、 セルフ , 324
テス ト 、 セルフWeb-Enabled, 324
テス ト 、 フロン ト ・ パネル, 323
デフォルト設定

システム、 復元, 42
復元, 27, 31, 203

デュアルARB, 264
FIRテーブル ・ エディ タ , 208, 213
ソフ ト キー , 250, 251, 252, 253, 258
マルチBBG同期, 218
ユーザ定義FIR, 208
リ アルタイム ・ ノ イズ, 249
リ アルタイム変調, 217

デュアルARBプレーヤ, 5
デュアルARB リ アルタイム

フ ィルタ , 207
デュアル任意波形発生器, 5
デュアル表示、 パワー ・ メータ , 82
テンキー , 6
電源

スイ ッチ, 8, 10
電源 （緑色） LED, 8, 10
動作

モード , 4
動作モード , 4
トーカ ・ モード ・ インジケータ , 12, 14
特長, 2
ト ラブルシューティング, 315
ト リ ガ

開始, 6
ゲーティ ッ ド , 174, 176
コネクタ , 16, 22
セグメン ト ・ アドバンス , 173
ソフ ト キー , 172
ハードキー , 6
波形, 172
複数BBG同期, 221

機器セッ ト アップ, 222
ト リ ガ設定ソフ ト キー , 121
ト リ ガ用ソフ ト キー

& Run, 173
Source, 172
タイプ, 172

な

ナイキス ト ・ フ ィルタ
定義, 330

ナイキス ト ・ フ ィルタ、 選択, 273
内部

基準発振器、 使用法, 29
内部メディア, 74, 329
ノ イズ, 249
ノブ, 8, 28, 43

は

ハードキー
概要, 5, 9
定義, 329
特定のキーも参照
のヘルプ, 42

媒体
タイプ, 140

波形
2 トーン , 296–301
概要, 140
カスタム変調の追加, 269
機器ステートの保存, 71
ク リ ッピング, 179
シーケンス , 145
スケーリ ング, 188
セグメン トのソフ ト キー , 142
掃引の, 59
デジタル ・ ベースバンド波形から , 189
ト リ ガ, 172
波形5パッ ク , 244
ファ イル ・ ヘッダ, 149
複数BBG同期, 218
保存、 ロード、 再生, 142
マーカ, 155, 156
マルチ トーン , 302–305
メモ リ , 309
ラ イセンス , 37

波形5パッ ク

インス トール, 237
使用法, 237
ステータス ・ メ ッセージ, 240
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ラ イセンス , 237
ラ イセンス、 概要, 237
ラ イセンス、 警告メ ッセージ, 248
ラ イセンス、 波形ファ イル, 238
履歴、 使用, 244
履歴、 波形ファ イル, 244

波形用ソフ ト キー
Segments, 142
Utilities, 188
シーケンス , 145, 169
ランタイム ・ スケーリ ング, 188

波形ライセンス、 オプシ ョ ン25x
使用法, 229
ステータス ・ メ ッセージ, 233
波形の置換, 231
波形の追加, 231
波形ライセンス ・ ソフ ト キー , 231
バッ クアップ警告, 236
ファ イル欠落警告, 236
ラ イセンス、 インス トール, 229
ラ イセンス、 概要, 229
ラ イセンス、 警告メ ッセージ, 236
ラ イセンス ・ ステータス ・ メ ッセージ, 233
ロ ッ ク警告, 236

バッ クスペース ・ ハードキー , 43
発振器、 外部基準, 46
発振器、 内部基準, 29
パラ メータ、 波形の保存, 149
パルス

インジケータ , 12, 14
高速, 112
コネクタ , 16, 22
同期信号, 49
特性, 131
ビデオ信号, 49
変調, 129
マーカ、 表示, 165

パルス変調, 4
パルス用ソフ ト キー , 130
パワー

コンセン ト , 15, 21
サーチ, 113
サーチ、 設定, 115
自動サーチ, 115
設定, 45, 47
センサ、 モデル, 92, 93
ソフ ト キー , 25, 27, 112
電源、 ト ラブルシューティング, 316
投入、 設定, 27
ト ラブルシューティング, 317
ピーク対アベレージ、 減少, 183
メータ , 90, 95
ユーザ設定可能、 最大, 47

パワー単位, 45
パワー ・ サーチ基準, 113
パワー ・ メータ
設定, 95

U2000A/01A/02A/04A, 95
U2000シ リーズ, 95

デュアル表示, 82
パワー ・ メータ設定用ソフ ト キー
パワー ・ メータ用ソフ ト キー
搬送波

設定, 46
ソフ ト キー , 250, 251, 252, 253
帯域幅, 249
対ノ イズ比, 249
フ ィードスルー , 136
変調, 61

搬送波フ ィードスルー、 最小化, 299
ピーク対アベレージ ・ パワー、 減少, 183
ピクセル ・ テス ト , 323
歪み、 ト ラブルシューティング, 317
日付、 設定, 28
表示

エラー ・ メ ッセージ ・ エ リ ア, 13
概要, 5
概要、 N5181A/82A/83A, 11
ソフ ト キー , 25, 43, 160
ソフ ト キー ・ ラベル, 13
テキス ト ・ エ リ ア, 13
テス ト , 323

ファームウェア
アップグレード , 29, 326
メモ リ , 307

ファ イル
拡張子, 68
カタログ、 データ ・ ス ト レージを参照
操作, 63

ファ イル ・ヘッダ
異なるファ イルの表示, 153
作成, 149
編集, 151
例, 152

フ ィードスルー , 136
フ ィードスルー、 搬送波、 最小化, 299
フ ィルタ

FIR, 207, 279
イコ ラ イゼーシ ョ ン , 205
ガウシアン、 デフォルトのロード , 285
ガウス、 デフォルトのロード , 214
ナイキス ト 、 選択, 273
有限インパルス応答, 207, 279
ユーザ、 イコラ イゼーシ ョ ン, 205
リ アルタイム変調
ソフ ト キーの場所, 217

フ ィルタDual ARB, 207
フ ィルタ、 補間器, 189
ブート ロム ・ メモ リ , 307
不揮発性メモ リ , 140
不揮発性、 定義, 330
フラ ッシュ ・ メモ リ , 307
フラ ッ ト ネス補正
プリセッ ト
使用法, 42
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設定, 27
ト ラブルシューティング, 321
ハードキー位置, 7

プリ ファレンス、 設定, 25
プログラ ミ ング ・ ガイ ドの内容, xiii
フロン ト ・ パネル

I/Q入力、 使用, 137
概要, 5, 9
キーを無効にする , 313
ディ スプレイ , 13
ディ スプレイ、 N5161A, 13
ディ スプレイ、 N5181A, 11
ディ スプレイ、 N5182A, 11
ディ スプレイ、 N5183A, 11
テス ト , 323
ノブの分解能, 28

平方根レイズド ・ コサイン ・ フ ィルタ
ベースバンド , 20

I/Q出力コネク タ , 18
ク リ ッピング, 179
雑音インジケータ , 11, 13
周波数オフセッ ト

ソフ ト キーの場所, 194
周波数オフセッ ト 、 設定, 194
信号の加算, 200
信号を整列, 156
ソフ ト キー , 194
直交位相調整, 201
ノ イズ, 249
波形をアナログに変換, 189
メモ リ , 140, 307
リ アルタイムI/Q AWGN, 250, 251, 252, 253, 255

ベースバンド周波数オフセッ ト
DACオーバレンジおよびスケーリ ング, 196
ソフ ト キー , 194

ベースバンド ・ ジェネレータ , 264
2 トーン ・ モード , 296
カスタム任意波形モード , 4
デュアルARBモード , 5
複数BBG同期, 218
マルチトーン ・ モード , 4, 5, 302

ベク トル動作, 139, 229, 237
ヘッダ ・ ユーティ リ ティのソフ ト キー , 149
変調

AM, 77
FM, 77
I/Q, 136, 198
アナログ, 4
位相, 77
インジケータ , 12, 14
外部変調源、 使用法, 79
作成, 61
デジタル, 4
同時, 63
ト ラブルシューティング, 316
パルス , 4, 129
搬送波信号, 61
リ アルタイム ・ フ ィルタ、 ソフ ト キー , 217

ポイン ト ツーポイン ト時間, 330
方形フ ィルタ

定義, 330
方式、 変調, 330
補間器フ ィルタ , 189
保護、 DACオーバレンジ

ベースバンド ・ オフセッ ト周波数, 196
保護、 DACオーバーレンジ

位相雑音信号劣化, 262
ホス ト名、 設定, 31
補正配列 （ユーザ ・ フラ ッ ト ネス） , 96

表示, 97
ユーザ ・ フラ ッ ト ネス補正も参照

補正、 内部チャネル, 99, 101

ま

マーカ
周波数

N5183A, 55
ステップ掃引, 55

マーカ、 信号を整列, 156
マーカ、 波形, 155–171
待ち行列、 エラー , 75
待ち時間、 ト ラブルシューティング, 320
マニュアル, xiii
マニュアル、 内容, xiii
マルチBBG同期, 218
機器セッ ト アップ, 222
再同期, 224
システム遅延, 221
システム同期, 221
セッ ト アップの設定, 222
ト リ ガ ・ セッ ト アップ, 221

マルチBBGの同期, 218
機器セッ ト アップ, 222
再同期, 224
システム遅延, 221
システム同期, 221
セッ ト アップの設定, 222
ト リ ガ ・ セッ ト アップ, 221

マルチキャ リ アTDMA波形

作成, 276
マルチキャ リ ア、 Defaultソフ ト キー

マルチキャ リ ア ・ セッ ト アップ
APCO 25 w/C4FM, 276
APCO 25 w/CQPSK, 276
Bluetooth, 276
CDPD, 276
DECT, 276
Default, 276
EDGE, 276
GSM, 276
NADC, 276
PDC, 276
PHS, 276
PWT, 276
TETRA, 276

マルチキャ リ ア ・ セッ ト アップ ・ ソフ ト キー , 276
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マルチ トーン , 264, 302–305
マルチ トーン波形、 セッ ト アップ, 295
マルチ トーン ・ モード , 4, 5
ミ キサ、 信号断のト ラブルシューティング, 318
緑色のLED, 8, 10
ミ ラー ・ テーブル、 係数の複製, 210, 282
明度調整, 26
メ イン ・ メモ リ , 307
メ ッセージ、 エラー , 322
メ ッセージ、 警告

5パッ ク ・ ラ イセンス , 248
オプシ ョ ン25xラ イセンス , 236
波形5パッ ク ・ ラ イセンス , 248

メディア
USB, 74, 321
BBG, 329
記憶装置, 74
消去, 310
タイプ, 307
内部, 329
フラ ッシュ ・ ド ラ イブ, 74

メニュー ・ キー , 6, 43
メモ リ
メディアも参照
からデータを消去, 310
タイプ, 307

モード、 変調, 330
モノ ク ロ ・ ディ スプレイ、 設定, 26

や

矢印キー , 43
有限インパルス応答フ ィルタ

使用法, 207, 279
ユーザ

ファ イル、 バッ クアップおよび復元, 63
フラ ッ ト ネス補正, 90
プリセッ ト , 42
プリセッ ト 、 ト ラブルシューティング, 321
マニュアルの内容, xiii

ユーザFIR
定義, 331

ユーザ定義FIR
デュアルARB, 208

用語集, 329

ら

ラ イセンス
Signal Studio, 37
サービス ・ ソフ ト ウェア, 37
タイムベース , 28
ト ラブルシューティング, 326
波形, 37
表示, 37
マネージャ , 37

ランタイム ・ スケーリ ング, 191
リ アルタイム

AWGN

ソフ ト キー , 250, 251, 252, 253
I/Q Baseband AWGNソフ ト キー , 255
位相雑音, 257

DACオーバーレンジおよびスケーリ ング, 262
信号劣化, 257
説明とプロ ッ ト , 259
ソフ ト キー , 258
調整, 261

ノ イズ, 249
変調フ ィルタ , 217
変調フ ィルタ、 設定, 217

リ アルタイム変調
デュアルARB, 217

リ アルタイム変調フ ィルタ
ソフ ト キー , 217

リ ア ・ パネル
I/Q出力, 199
概要

N5161A, 15
N5162A, 15
N5181A, 15
N5182A, 15
N5183A, 21

リ グロース、 スペク ト ラム , 182
リ ス ト掃引
使用法, 57
ステータス情報, 58
ト ラブルシューティング, 320
波形, 59
パラ メータ , 58

リ ス ト ・ モード値, 58
リ スナ ・ モード ・ インジケータ , 12, 14
理想ローパス ・ フ ィルタ
リ ップル, 189
リ ニア掃引, 49
リ ファレンス、 内容, xiii
リモート操作用プリ ファレンス , 30
リモート ・ インタフェース、 HP 3300Aエミ ュレーシ ョ ン , 128
リモート ・ オペレーシ ョ ン ・ インジケータ , 12, 14
リ ンギング, 189
ルーティング

I/Q, 136, 198
マーカ

ALCホールド , 157
RFブランキング, 166
設定の保存, 156

ルート , 330
ルート ・ コサイン ・ フ ィルタ
ルート ・ ナイキス ト ・ フ ィルタ
定義, 330

例
5パッ ク ・ ラ イセンス、 追加, 241
5パッ ク ・ ラ イセンス、 履歴, 246
FIRフ ィルタ

作成, 208, 279
変更, 213, 284

波形5パッ ク ・ ラ イセンス、 追加, 241
波形5パッ ク ・ ラ イセンス、 履歴, 246
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波形ライセンス、 オプシ ョ ン25x
スロ ッ トのロ ッ ク , 234
波形の追加, 234

レイズド ・ コサイン ・ フ ィルタ
レシーバ ・ テス ト , 264
レジスタの リ コール、 ト ラブルシューティング, 320
レベリ ング

ALCオフ , 112
外部, 104–111

レベリ ングなし動作, 112
連続ステップ掃引の例, 60
連続波

説明, 4
連続波出力, 46
ロード用ソフ ト キー

All From Int Media, 142
All From USB Media, 142
Segment From Int Media, 142
Segment From USB Media, 142
Store, 142

ログ掃引, 49
ロ ッ クアップ、 ト ラブルシューティング , 316
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